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Abstract

				This document describes how to get started with decision services, process services, and planning solutions in Red Hat Process Automation Manager.
			






Preface




			As a developer of business decisions and processes , you can use Red Hat Process Automation Manager to develop decision services and process services using a variety of available assets. You can also use Red Hat build of OptaPlanner to find the optimal solution to planning problems based on a set of limited resources and under specific constraints.
		

Making open source more inclusive




			Red Hat is committed to replacing problematic language in our code, documentation, and web properties. We are beginning with these four terms: master, slave, blacklist, and whitelist. Because of the enormity of this endeavor, these changes will be implemented gradually over several upcoming releases. For more details, see our CTO Chris Wright’s message.
		

Part I. Getting started with decision services in Red Hat Process Automation Manager





				As a business rules developer, you can use Business Central in Red Hat Process Automation Manager or the Red Hat Process Automation Manager DMN modeler in VS Code to design a variety of decision services. Red Hat Process Automation Manager provides example projects with example business assets directly in Business Central as a reference. This document describes how to create and test an example traffic violation project based on the Traffic_Violation sample project included in Business Central. This sample project uses a Decision Model and Notation (DMN) model to define driver penalty and suspension rules in a traffic violation decision service. You can follow the steps in this document to create the project and the assets it contains, or open and review the existing Traffic_Violation sample project.
			

				For more information about the DMN components and implementation in Red Hat Process Automation Manager, see Designing a decision service using DMN models.
			
Prerequisites
	
						Red Hat JBoss Enterprise Application Platform 7.4 is installed. For installation information, see Red Hat JBoss Enterprise Application Platform 7.4 Installation Guide.
					
	
						Red Hat Process Automation Manager is installed and configured with KIE Server. For more information see Installing and configuring Red Hat Process Automation Manager on Red Hat JBoss EAP 7.4.
					
	
						Red Hat Process Automation Manager is running and you can log in to Business Central with the developer role. For more information, see Planning a Red Hat Process Automation Manager installation.
					




Chapter 1. Sample projects and business assets in Business Central




				Business Central contains sample projects with business assets that you can use as a reference for the rules, processes, or other assets that you create in your own Red Hat Process Automation Manager projects. Each sample project is designed differently to demonstrate process automation, decision management, or business optimization assets and logic in Red Hat Process Automation Manager.
			
Note

					Red Hat does not provide support for the sample code included in the Red Hat Process Automation Manager distribution.
				


				The following sample projects are available in Business Central:
			
	
						Course_Scheduling: (Business optimization) Course scheduling and curriculum decision process. Assigns lectures to rooms and determines a student’s curriculum based on factors such as course conflicts and class room capacity.
					
	
						Dinner_Party: (Business optimization) Guest seating optimization using guided decision tables. Assigns guest seating based on each guest’s job type, political beliefs, and known relationships.
					
	
						Employee_Rostering: (Business optimization) Employee rostering optimization using decision and solver assets. Assigns employees to shifts based on skills.
					
	
						Evaluation_Process: (Process automation) Evaluation process using business process assets. Evaluates employees based on performance.
					
	
						IT_Orders: (Process automation and case management) Ordering case using business process and case management assets. Places an IT hardware order based on needs and approvals.
					
	
						Mortgages: (Decision management with rules) Loan approval process using rule-based decision assets. Determines loan eligibility based on applicant data and qualifications.
					
	
						Mortgage_Process: (Process automation) Loan approval process using business process and decision assets. Determines loan eligibility based on applicant data and qualifications.
					
	
						OptaCloud: (Business optimization) Resource allocation optimization using decision and solver assets. Assigns processes to computers with limited resources.
					
	
						Traffic_Violation: (Decision management with DMN) Traffic violation decision service using a Decision Model and Notation (DMN) model. Determines driver penalty and suspension based on traffic violations.
					


Accessing sample projects and business assets in Business Central




					You can use the sample projects in Business Central to explore business assets as a reference for the rules or other assets that you create in your own Red Hat Process Automation Manager projects.
				
Prerequisites
	
							Business Central is installed and running. For installation options, see Planning a Red Hat Process Automation Manager installation.
						


Procedure
	
							In Business Central, go to Menu → Design → Projects. If there are existing projects, you can access the samples by clicking the MySpace default space and selecting Try Samples from the Add Project drop-down menu. If there are no existing projects, click Try samples.
						
	
							Review the descriptions for each sample project to determine which project you want to explore. Each sample project is designed differently to demonstrate process automation, decision management, or business optimization assets and logic in Red Hat Process Automation Manager.
						
	
							Select one or more sample projects and click Ok to add the projects to your space.
						
	
							In the Projects page of your space, select one of the sample projects to view the assets for that project.
						
	
							Select each asset to explore how the project is designed to achieve the specified goal or workflow. Some of the sample projects contain more than one page of assets. Click the left or right arrows in the upper-right corner to view the full asset list.
						
Figure 1.1. Asset page selection
[image: Navigate through asset pages]



	
							In the upper-right corner of the project Assets page, click Build to build the sample project or Deploy to build the project and then deploy it to KIE Server.
						
Note

								You can also select the Build & Install option to build the project and publish the KJAR file to the configured Maven repository without deploying to a KIE Server. In a development environment, you can click Deploy to deploy the built KJAR file to a KIE Server without stopping any running instances (if applicable), or click Redeploy to deploy the built KJAR file and replace all instances. The next time you deploy or redeploy the built KJAR, the previous deployment unit (KIE container) is automatically updated in the same target KIE Server. In a production environment, the Redeploy option is disabled and you can click Deploy only to deploy the built KJAR file to a new deployment unit (KIE container) on a KIE Server.
							

								To configure the KIE Server environment mode, set the org.kie.server.mode system property to org.kie.server.mode=development or org.kie.server.mode=production. To configure the deployment behavior for a corresponding project in Business Central, go to project Settings → General Settings → Version, toggle the Development Mode option, and click Save. By default, KIE Server and all new projects in Business Central are in development mode. You cannot deploy a project with Development Mode turned on or with a manually added SNAPSHOT version suffix to a KIE Server that is in production mode.
							


							To review project deployment details, click View deployment details in the deployment banner at the top of the screen or in the Deploy drop-down menu. This option directs you to the Menu → Deploy → Execution Servers page.
						





Chapter 2. Red Hat Process Automation Manager BPMN and DMN modelers




				Red Hat Process Automation Manager provides the following extensions or applications that you can use to design Business Process Model and Notation (BPMN) process models and Decision Model and Notation (DMN) decision models using graphical modelers.
			
	
						Business Central: Enables you to view and design BPMN models, DMN models, and test scenario files in a related embedded designer.
					

						To use Business Central, you can set up a development environment containing a Business Central to design business rules and processes, and a KIE Server to execute and test the created business rules and processes.
					

	
						Red Hat Process Automation Manager VS Code extension: Enables you to view and design BPMN models, DMN models, and test scenario files in Visual Studio Code (VS Code). The VS Code extension requires VS Code 1.46.0 or later.
					

						To install the Red Hat Process Automation Manager VS Code extension, select the Extensions menu option in VS Code and search for and install the Red Hat Business Automation Bundle extension.
					

	
						Standalone BPMN and DMN editors: Enable you to view and design BPMN and DMN models embedded in your web applications. To download the necessary files, you can either use the NPM artifacts from the NPM registry or download the JavaScript files directly for the DMN standalone editor library at https://<YOUR_PAGE>/dmn/index.js and for the BPMN standalone editor library at https://<YOUR_PAGE>/bpmn/index.js.
					


Installing the Red Hat Process Automation Manager VS Code extension bundle




					Red Hat Process Automation Manager provides a Red Hat Business Automation Bundle VS Code extension that enables you to design Decision Model and Notation (DMN) decision models, Business Process Model and Notation (BPMN) 2.0 business processes, and test scenarios directly in VS Code. VS Code is the preferred integrated development environment (IDE) for developing new business applications. Red Hat Process Automation Manager also provides individual DMN Editor and BPMN Editor VS Code extensions for DMN or BPMN support only, if needed.
				
Important

						The editors in the VS Code are partially compatible with the editors in the Business Central, and several Business Central features are not supported in the VS Code.
					

Prerequisites
	
							The latest stable version of VS Code is installed.
						


Procedure
	
							In your VS Code IDE, select the Extensions menu option and search for Red Hat Business Automation Bundle for DMN, BPMN, and test scenario file support.
						

							For DMN or BPMN file support only, you can also search for the individual DMN Editor or BPMN Editor extensions.
						

	
							When the Red Hat Business Automation Bundle extension appears in VS Code, select it and click Install.
						
	
							For optimal VS Code editor behavior, after the extension installation is complete, reload or close and re-launch your instance of VS Code.
						



					After you install the VS Code extension bundle, any .dmn, .bpmn, or .bpmn2 files that you open or create in VS Code are automatically displayed as graphical models. Additionally, any .scesim files that you open or create are automatically displayed as tabular test scenario models for testing the functionality of your business decisions.
				

					If the DMN, BPMN, or test scenario modelers open only the XML source of a DMN, BPMN, or test scenario file and displays an error message, review the reported errors and the model file to ensure that all elements are correctly defined.
				
Note

						For new DMN or BPMN models, you can also enter dmn.new or bpmn.new in a web browser to design your DMN or BPMN model in the online modeler. When you finish creating your model, you can click Download in the online modeler page to import your DMN or BPMN file into your Red Hat Process Automation Manager project in VS Code.
					


Configuring the Red Hat Process Automation Manager standalone editors




					Red Hat Process Automation Manager provides standalone editors that are distributed in a self-contained library providing an all-in-one JavaScript file for each editor. The JavaScript file uses a comprehensive API to set and control the editor.
				

					You can install the standalone editors using the following methods:
				
	
							Download each JavaScript file manually
						
	
							Use the NPM package
						


Procedure
	
							Install the standalone editors using one of the following methods:
						

							Download each JavaScript file manually: For this method, follow these steps:
						
	
									Download the JavaScript files.
								
	
									Add the downloaded Javascript files to your hosted application.
								
	
									Add the following <script> tag to your HTML page:
								
Script tag for your HTML page for the DMN editor

										

<script src="https://<YOUR_PAGE>/dmn/index.js"></script>


									
Script tag for your HTML page for the BPMN editor

										

<script src="https://<YOUR_PAGE>/bpmn/index.js"></script>


									




							Use the NPM package: For this method, follow these steps:
						
	
									Add the NPM package to your package.json file:
								
Adding the NPM package

										

npm install @kie-tools/kie-editors-standalone


									

	
									Import each editor library to your TypeScript file:
								
Importing each editor

										

import * as DmnEditor from "@kie-tools/kie-editors-standalone/dist/dmn"
import * as BpmnEditor from "@kie-tools/kie-editors-standalone/dist/bpmn"


									




	
							After you install the standalone editors, open the required editor by using the provided editor API, as shown in the following example for opening a DMN editor. The API is the same for each editor.
						
Opening the DMN standalone editor

								

const editor = DmnEditor.open({
  container: document.getElementById("dmn-editor-container"),
  initialContent: Promise.resolve(""),
  readOnly: false,
  origin: "",
  resources: new Map([
    [
      "MyIncludedModel.dmn",
      {
        contentType: "text",
        content: Promise.resolve("")
      }
    ]
  ])
});


							

							Use the following parameters with the editor API:
						
Table 2.1. Example parameters
	Parameter	Description
	 
											container
										

										 	 
											HTML element in which the editor is appended.
										

										 
	 
											initialContent
										

										 	 
											Promise to a DMN model content. This parameter can be empty, as shown in the following examples:
										

										 	
													Promise.resolve("")
												
	
													Promise.resolve("<DIAGRAM_CONTENT_DIRECTLY_HERE>")
												
	
													fetch("MyDmnModel.dmn").then(content ⇒ content.text())
												



										 
	 
											readOnly (Optional)
										

										 	 
											Enables you to allow changes in the editor. Set to false (default) to allow content editing and true for read-only mode in editor.
										

										 
	 
											origin (Optional)
										

										 	 
											Origin of the repository. The default value is window.location.origin.
										

										 
	 
											resources (Optional)
										

										 	 
											Map of resources for the editor. For example, this parameter is used to provide included models for the DMN editor or work item definitions for the BPMN editor. Each entry in the map contains a resource name and an object that consists of content-type (text or binary) and content (similar to the initialContent parameter).
										

										 




							The returned object contains the methods that are required to manipulate the editor.
						
Table 2.2. Returned object methods
	Method	Description
	 
											getContent(): Promise<string>
										

										 	 
											Returns a promise containing the editor content.
										

										 
	 
											setContent(path: string, content: string): void
										

										 	 
											Sets the content of the editor.
										

										 
	 
											getPreview(): Promise<string>
										

										 	 
											Returns a promise containing an SVG string of the current diagram.
										

										 
	 
											subscribeToContentChanges(callback: (isDirty: boolean) ⇒ void): (isDirty: boolean) ⇒ void
										

										 	 
											Sets a callback to be called when the content changes in the editor and returns the same callback to be used for unsubscription.
										

										 
	 
											unsubscribeToContentChanges(callback: (isDirty: boolean) ⇒ void): void
										

										 	 
											Unsubscribes the passed callback when the content changes in the editor.
										

										 
	 
											markAsSaved(): void
										

										 	 
											Resets the editor state that indicates that the content in the editor is saved. Also, it activates the subscribed callbacks related to content change.
										

										 
	 
											undo(): void
										

										 	 
											Undoes the last change in the editor. Also, it activates the subscribed callbacks related to content change.
										

										 
	 
											redo(): void
										

										 	 
											Redoes the last undone change in the editor. Also, it activates the subscribed callbacks related to content change.
										

										 
	 
											close(): void
										

										 	 
											Closes the editor.
										

										 
	 
											getElementPosition(selector: string): Promise<Rect>
										

										 	 
											Provides an alternative to extend the standard query selector when an element lives inside a canvas or a video component. The selector parameter must follow the <PROVIDER>:::<SELECT> format, such as Canvas:::MySquare or Video:::PresenterHand. This method returns a Rect representing the element position.
										

										 
	 
											envelopeApi: MessageBusClientApi<KogitoEditorEnvelopeApi>
										

										 	 
											This is an advanced editor API. For more information about advanced editor API, see MessageBusClientApi and KogitoEditorEnvelopeApi.
										

										 








Chapter 3. Creating and executing DMN and BPMN models using Maven




				You can use Maven archetypes to develop DMN and BPMN models in VS Code using the Red Hat Process Automation Manager VS Code extension instead of Business Central. You can then integrate your archetypes with your Red Hat Process Automation Manager decision and process services in Business Central as needed. This method of developing DMN and BPMN models is helpful for building new business applications using the Red Hat Process Automation Manager VS Code extension.
			
Procedure
	
						In a command terminal, navigate to a local folder where you want to store the new Red Hat Process Automation Manager project.
					
	
						Enter the following command to use a Maven archtype to generate a project within a defined folder:
					
Generating a project using Maven archetype

							

mvn archetype:generate \
    -DarchetypeGroupId=org.kie \
    -DarchetypeArtifactId=kie-kjar-archetype \
    -DarchetypeVersion=7.67.0.Final-redhat-00024


						

						This command generates a Maven project with required dependencies and generates required directories and files to build your business application. You can use the Git version control system (recommended) when developing a project.
					

						If you want to generate multiple projects in the same directory, specify the artifactId and groupId of the generated business application by adding -DgroupId=<groupid> -DartifactId=<artifactId> to the previous command.
					

	
						In your VS Code IDE, click File, select Open Folder, and navigate to the folder that is generated using the previous command.
					
	
						Before creating the first asset, set a package for your business application, for example, org.kie.businessapp, and create respective directories in the following paths:
					
	
								PROJECT_HOME/src/main/java
							
	
								PROJECT_HOME/src/main/resources
							
	
								PROJECT_HOME/src/test/resources
							



						For example, you can create PROJECT_HOME/src/main/java/org/kie/businessapp for org.kie.businessapp package.
					

	
						Use VS Code to create assets for your business application. You can create the assets supported by Red Hat Process Automation Manager VS Code extension using the following ways:
					
	
								To create a business process, create a new file with .bpmn or .bpmn2 in PROJECT_HOME/src/main/resources/org/kie/businessapp directory, such as Process.bpmn.
							
	
								To create a DMN model, create a new file with .dmn in PROJECT_HOME/src/main/resources/org/kie/businessapp directory, such as AgeDecision.dmn.
							
	
								To create a test scenario simulation model, create a new file with .scesim in PROJECT_HOME/src/test/resources/org/kie/businessapp directory, such as TestAgeScenario.scesim.
							



	
						After you create the assets in your Maven archetype, navigate to the root directory (contains pom.xml) of the project in the command line and run the following command to build the knowledge JAR (KJAR) of your project:
					
mvn clean install

						If the build fails, address any problems described in the command line error messages and try again to validate the project until the build is successful. However, if the build is successful, you can find the artifact of your business application in PROJECT_HOME/target directory.
					
Note

							Use mvn clean install command often to validate your project after each major change during development.
						





				You can deploy the generated knowledge JAR (KJAR) of your business application on a running KIE Server using the REST API. For more information about using REST API, see Interacting with Red Hat Process Automation Manager using KIE APIs.
			

Chapter 4. Creating the traffic violations project in Business Central




				For this example, create a new project called traffic-violation. A project is a container for assets such as data objects, DMN assets, and test scenarios. This example project that you are creating is similar to the existing Traffic_Violation sample project in Business Central.
			
Procedure
	
						In Business Central, go to Menu → Design → Projects.
					

						Red Hat Process Automation Manager provides a default space called MySpace. You can use the default space to create and test example projects.
					

	
						Click Add Project.
					
	
						Enter traffic-violation in the Name field.
					
	
						Click Add.
					
Figure 4.1. Add Project window
[image: Add project window]



						The Assets view of the project opens.
					




Chapter 5. Decision Model and Notation (DMN)




				Decision Model and Notation (DMN) is a standard established by the Object Management Group (OMG) for describing and modeling operational decisions. DMN defines an XML schema that enables DMN models to be shared between DMN-compliant platforms and across organizations so that business analysts and business rules developers can collaborate in designing and implementing DMN decision services. The DMN standard is similar to and can be used together with the Business Process Model and Notation (BPMN) standard for designing and modeling business processes.
			

				For more information about the background and applications of DMN, see the OMG Decision Model and Notation specification.
			
Creating the traffic violations DMN decision requirements diagram (DRD)




					A decision requirements diagram (DRD) is a visual representation of your DMN model. Use the DMN designer in Business Central to design the DRD for the traffic violations project and to define the decision logic of the DRD components.
				
Figure 5.1. DRD for the Traffic Violations example
[image: DRD for the Traffic Violations example]


Prerequisites
	
							You have created the traffic violations project in Business Central.
						


Procedure
	
							On the traffic-violation project’s home page, click Add Asset.
						
	
							On the Add Asset page, click DMN. The Create new DMN window is opened.
						
	
									In the Create new DMN window, enter Traffic Violation in the DMN name field.
								
	
									From the Package list, select com.myspace.traffic_violation.
								
	
									Click Ok. The DMN asset in the DMN designer is opened.
								



	
							In the DMN designer canvas, drag two DMN Input Data input nodes onto the canvas.
						
Figure 5.2. DMN Input Data nodes
[image: DMN Input Data nodes]



	
							In the upper-right corner, click the 
							[image: Properties]
							 icon.
						
	
							Double-click the input nodes and rename one to Driver and the other to Violation.
						
	
							Drag a DMN Decision decision node onto the canvas.
						
	
							Double-click the decision node and rename it to Fine.
						
	
							Click the Violation input node, select the Create DMN Information Requirement icon and click the Fine decision node to link the two nodes.
						
Figure 5.3. Create DMN Information Requirement icon
[image: Create DMN Information Requirement icon]



	
							Drag a DMN Decision decision node onto the canvas.
						
	
							Double-click the decision node and rename it to Should the driver be suspended?.
						
	
							Click the Driver input node, select the Create DMN Information Requirement icon and click the Should the driver be suspended? decision node to link the two nodes.
						
	
							Click the Fine decision node, select the Create DMN Information Requirement icon, and select the Should the driver be suspended? decision node.
						
	
							Click Save.
						
Note

								As you periodically save a DRD, the DMN designer performs a static validation of the DMN model and might produce error messages until the model is defined completely. After you finish defining the DMN model completely, if any errors remain, troubleshoot the specified problems accordingly.
							





Creating the traffic violations DMN custom data types




					DMN data types determine the structure of the data that you use within a table, column, or field in a DMN boxed expression for defining decision logic. You can use default DMN data types (such as string, number, or boolean) or you can create custom data types to specify additional fields and constraints that you want to implement for the boxed expression values. Use the DMN designer’s Data Types tab in Business Central to define the custom data types for the traffic violations project.
				
Figure 5.4. The custom data types tab
[image: The custom data types tab]



					The following tables list the tDriver, tViolation, and tFine custom data types that you will create for this project.
				
Table 5.1. tDriver custom data type
	Name	Type
	 
									tDriver
								

								 	 
									Structure
								

								 
	 
									Name
								

								 	 
									string
								

								 
	 
									Age
								

								 	 
									number
								

								 
	 
									State
								

								 	 
									string
								

								 
	 
									City
								

								 	 
									string
								

								 
	 
									Points
								

								 	 
									number
								

								 



Table 5.2. tViolation custom data type
	Name	Type
	 
									tViolation
								

								 	 
									Structure
								

								 
	 
									Code
								

								 	 
									string
								

								 
	 
									Date
								

								 	 
									date
								

								 
	 
									Type
								

								 	 
									string
								

								 
	 
									Speed Limit
								

								 	 
									number
								

								 
	 
									Actual Speed
								

								 	 
									number
								

								 



Table 5.3. tFine custom data type
	Name	Type
	 
									tFine
								

								 	 
									Structure
								

								 
	 
									Amount
								

								 	 
									number
								

								 
	 
									Points
								

								 	 
									number
								

								 



Prerequisites
	
							You created the traffic violations DMN decision requirements diagram (DRDs) in Business Central.
						


Procedure
	
							To create the tDriver custom data type, click Add a custom Data Type on the Data Types tab, enter tDriver in the Name field, and select Structure from the Type list.
						
	
							Click the check mark to the right of the new data type to save your changes.
						
Figure 5.5. The tDriver custom data type
[image: The tDriver custom data type]



	
							Add each of the following nested data types to the tDriver structured data type by clicking the plus sign next to tDriver for each new nested data type. Click the check mark to the right of each new data type to save your changes.
						
	
									Name (string)
								
	
									Age (number)
								
	
									State (string)
								
	
									City (string)
								
	
									Points (number)
								



	
							To create the tViolation custom data type, click New Data Type, enter tViolation in the Name field, and select Structure from the Type list.
						
	
							Click the check mark to the right of the new data type to save your changes.
						
Figure 5.6. The tViolation custom data type
[image: The tViolation custom data type]



	
							Add each of the following nested data types to the tViolation structured data type by clicking the plus sign next to tViolation for each new nested data type. Click the check mark to the right of each new data type to save your changes.
						
	
									Code (string)
								
	
									Date (date)
								
	
									Type (string)
								
	
									Speed Limit (number)
								
	
									Actual Speed (number)
								



	
							To add the following constraints to the Type nested data type, click the edit icon, click Add Constraints, and select Enumeration from the Select constraint type drop-down menu.
						
	
									speed
								
	
									parking
								
	
									driving under the influence
								



	
							Click OK, then click the check mark to the right of the Type data type to save your changes.
						
	
							To create the tFine custom data type, click New Data Type, enter tFine in the Name field, select Structure from the Type list, and click Save.
						
Figure 5.7. The tFine custom data type
[image: The tFine custom data type]



	
							Add each of the following nested data types to the tFine structured data type by clicking the plus sign next to tFine for each new nested data type. Click the check mark to the right of each new data type to save your changes.
						
	
									Amount (number)
								
	
									Points (number)
								



	
							Click Save.
						



Assigning custom data types to the DRD input and decision nodes




					After you create the DMN custom data types, assign them to the appropriate DMN Input Data and DMN Decision nodes in the traffic violations DRD.
				
Prerequisites
	
							You have created the traffic violations DMN custom data types in Business Central.
						


Procedure
	
							Click the Model tab on the DMN designer and click the Properties [image: diagram properties]
							 icon in the upper-right corner of the DMN designer to expose the DRD properties.
						
	
							In the DRD, select the Driver input data node and in the Properties panel, select tDriver from the Data type drop-down menu.
						
	
							Select the Violation input data node and select tViolation from the Data type drop-down menu.
						
	
							Select the Fine decision node and select tFine from the Data type drop-down menu.
						
	
							Select the Should the driver be suspended? decision node and set the following properties:
						
	
									Data type: string
								
	
									Question: Should the driver be suspended due to points on his driver license?
								
	
									Allowed Answers: Yes,No
								



	
							Click Save.
						



					You have assigned the custom data types to your DRD’s input and decision nodes.
				

Defining the traffic violations DMN decision logic




					To calculate the fine and to decide whether the driver is to be suspended or not, you can define the traffic violations DMN decision logic using a DMN decision table and context boxed expression.
				
Figure 5.8. Fine expression
[image: Fine expression decision table]


Figure 5.9. Should the driver be suspended expression
[image: Should the driver be suspended expression decision table]


Prerequisites
	
							You have assigned the DMN custom data types to the appropriate decision and input nodes in the traffic violations DRD in Business Central.
						


Procedure
	
							To calculate the fine, in the DMN designer canvas, select the Fine decision node and click the Edit icon to open the DMN boxed expression designer.
						
Figure 5.10. Decision node edit icon
[image: Decision node edit icon]



	
							Click Select expression → Decision Table.
						
Figure 5.11. Select Decisiong Table logic type
[image: Select logic type menu]



	
							For the Violation.Date, Violation.Code, and Violation.Speed Limit columns, right-click and select Delete for each field.
						
	
							Click the Violation.Actual Speed column header and enter the expression Violation.Actual Speed - Violation.Speed Limit in the Expression field."
						
	
							Enter the following values in the first row of the decision table:
						
	
									Violation.Type: "speed"
								
	
									Violation.Actual Speed - Violation.Speed Limit: [10..30)
								
	
									Amount: 500
								
	
									Points: 3
								

									Right-click the first row and select Insert below to add another row.
								




	
							Enter the following values in the second row of the decision table:
						
	
									Violation.Type: "speed"
								
	
									Violation.Actual Speed - Violation.Speed Limit: >= 30
								
	
									Amount: 1000
								
	
									Points: 7
								

									Right-click the second row and select Insert below to add another row.
								




	
							Enter the following values in the third row of the decision table:
						
	
									Violation.Type: "parking"
								
	
									Violation.Actual Speed - Violation.Speed Limit: -
								
	
									Amount: 100
								
	
									Points: 1
								

									Right-click the third row and select Insert below to add another row.
								




	
							Enter the following values in the fourth row of the decision table:
						
	
									Violation.Type: "driving under the influence"
								
	
									Violation.Actual Speed - Violation.Speed Limit: -
								
	
									Amount: 1000
								
	
									Points: 5
								



	
							Click Save.
						
	
							To define the driver suspension rule, return to the DMN designer canvas, select the Should the driver be suspended? decision node, and click the Edit icon to open the DMN boxed expression designer.
						
	
							Click Select expression → Context.
						
	
							Click ContextEntry-1, enter Total Points as the Name, and select number from the Data Type drop-down menu.
						
	
							Click the cell next to Total Points, select Literal expression from the context menu, and enter Driver.Points + Fine.Points as the expression.
						
	
							In the cell below Driver.Points + Fine.Points, select Literal Expression from the context menu, and enter if Total Points >= 20 then "Yes" else "No".
						
	
							Click Save.
						

							You have defined how to calculate the fine and the context for deciding when to suspend the driver. You can navigate to the traffic-violation project page and click Build to build the example project and address any errors noted in the Alerts panel.
						





Chapter 6. Test scenarios




				Test scenarios in Red Hat Process Automation Manager enable you to validate the functionality of business rules and business rule data (for rules-based test scenarios) or of DMN models (for DMN-based test scenarios) before deploying them into a production environment. With a test scenario, you use data from your project to set given conditions and expected results based on one or more defined business rules. When you run the scenario, the expected results and actual results of the rule instance are compared. If the expected results match the actual results, the test is successful. If the expected results do not match the actual results, then the test fails.
			

				Red Hat Process Automation Manager includes both the new Test Scenarios designer and the former Test Scenarios (Legacy) designer. The default designer is the new test scenarios designer, which supports the testing of both rules and DMN models and provides an enhanced overall user experience with test scenarios. If required, you can continue to use the legacy test scenarios designer, which supports rule-based test scenarios only.
			
Important

					The legacy test scenarios designer is deprecated from Red Hat Process Automation Manager version 7.3.0. It will be removed in a future Red Hat Process Automation Manager release. Use the new test scenarios designer instead.
				


				You can run the defined test scenarios in a number of ways, for example, you can run available test scenarios at the project level or inside a specific test scenario asset. Test scenarios are independent and cannot affect or modify other test scenarios. You can run test scenarios at any time during project development in Business Central. You do not have to compile or deploy your decision service to run test scenarios.
			

				You can import data objects from different packages to the same project package as the test scenario. Assets in the same package are imported by default. After you create the necessary data objects and the test scenario, you can use the Data Objects tab of the test scenarios designer to verify that all required data objects are listed or to import other existing data objects by adding a New item.
			
Important

					Throughout the test scenarios documentation, all references to test scenarios and the test scenarios designer are for the new version, unless explicitly noted as the legacy version.
				

Testing the traffic violations using test scenarios




					Use the test scenarios designer in Business Central to test the DMN decision requirements diagrams (DRDs) and define decision logic for the traffic violations project.
				
Figure 6.1. Test scenario for the traffic violations example
[image: Test scenario for the traffic violations example]


Prerequisites
	
							You have successfully built the traffic violations project in Business Central.
						


Procedure
	
							On the traffic-violation project’s home screen, click Add Asset to open the Add Asset screen.
						
	
							Click Test Scenario to open the Create new Test Scenario dialog.
						
	
									Enter Violation Scenarios in the Test Scenario field.
								
	
									From the Package list, select com.myspace.traffic_violation.
								
	
									Select DMN as the Source type.
								
	
									From the Choose a DMN asset list, select the path to the DMN asset.
								
	
									Click Ok to open the Violation Scenarios test scenario in the Test Scenarios designer.
								



	
							Under Driver column sub-header, right-click the State, City, Age, and Name value cells and select Delete column from the context menu options to remove them.
						
	
							Under Violation column sub-header, right-click the Date and Code value cells and select Delete column to remove them.
						
	
							Enter the following information in the first row of the test scenarios:
						
	
									Scenario description: Above speed limit: 10km/h and 30 km/h
								
	
									Points (under Given column header): 10
								
	
									Type: "speed"
								
	
									Speed Limit: 100
								
	
									Actual Speed: 120
								
	
									Points: 3
								
	
									Amount: 500
								
	
									Should the driver be suspended?: "No"
								

									Right-click the first row and select Insert row below to add another row.
								




	
							Enter the following information in the second row of the test scenarios:
						
	
									Scenario description: Above speed limit: more than 30 km/h
								
	
									Points (under Given column header): 10
								
	
									Type: "speed"
								
	
									Speed Limit: 100
								
	
									Actual Speed: 150
								
	
									Points: 7
								
	
									Amount: 1000
								
	
									Should the driver be suspended?: "No"
								

									Right-click the second row and select Insert row below to add another row.
								




	
							Enter the following information in the third row of the test scenarios:
						
	
									Scenario description: Parking violation
								
	
									Points (under Given column header): 10
								
	
									Type: "parking"
								
	
									Speed Limit: leave blank
								
	
									Actual Speed: leave blank
								
	
									Points: 1
								
	
									Amount: 100
								
	
									Should the driver be suspended?: "No"
								

									Right-click the third row and select Insert row below to add another row.
								




	
							Enter the following information in the fourth row of the test scenarios:
						
	
									Scenario description: DUI violation
								
	
									Points (under Given column header): 10
								
	
									Type: "driving under the influence"
								
	
									Speed Limit: leave blank
								
	
									Actual Speed: leave blank
								
	
									Points: 5
								
	
									Amount: 1000
								
	
									Should the driver be suspended?: "No"
								

									Right-click the fourth row and select Insert row below to add another row.
								




	
							Enter the following information in the fifth row of the test scenarios:
						
	
									Scenario description: Driver suspended
								
	
									Points (under Given column header): 15
								
	
									Type: "speed"
								
	
									Speed Limit: 100
								
	
									Actual Speed: 140
								
	
									Points: 7
								
	
									Amount: 1000
								
	
									Should the driver be suspended?: "Yes"
								



	
							Click Save.
						
	
							Click the Play icon 
							[image: dmn play icon]
							 to check whether the test scenarios pass or fail.
						
Figure 6.2. Test scenario execution result for the traffic violations example
[image: Test scenario execution result for the traffic violations example]



							In case of failure, correct the errors and run the test scenarios again.
						





Chapter 7. DMN model execution




				You can create or import DMN files in your Red Hat Process Automation Manager project using Business Central or package the DMN files as part of your project knowledge JAR (KJAR) file without Business Central. After you implement your DMN files in your Red Hat Process Automation Manager project, you can execute the DMN decision service by deploying the KIE container that contains it to KIE Server for remote access and interacting with the container using the KIE Server REST API.
			

				For information about including external DMN assets with your project packaging and deployment method, see Packaging and deploying an Red Hat Process Automation Manager project.
			
Executing a DMN service using the KIE Server REST API




					Directly interacting with the REST endpoints of KIE Server provides the most separation between the calling code and the decision logic definition. The calling code is completely free of direct dependencies, and you can implement it in an entirely different development platform such as Node.js or .NET. The examples in this section demonstrate Nix-style curl commands but provide relevant information to adapt to any REST client.
				

					When you use a REST endpoint of KIE Server, the best practice is to define a domain object POJO Java class, annotated with standard KIE Server marshalling annotations. For example, the following code is using a domain object Person class that is annotated properly:
				
Example POJO Java class

						

@javax.xml.bind.annotation.XmlAccessorType(javax.xml.bind.annotation.XmlAccessType.FIELD)
public class Person implements java.io.Serializable {

    static final long serialVersionUID = 1L;

    private java.lang.String id;
    private java.lang.String name;
    @javax.xml.bind.annotation.adapters.XmlJavaTypeAdapter(org.kie.internal.jaxb.LocalDateXmlAdapter.class)
    private java.time.LocalDate dojoining;

    public Person() {
    }

    public java.lang.String getId() {
        return this.id;
    }

    public void setId(java.lang.String id) {
        this.id = id;
    }

    public java.lang.String getName() {
        return this.name;
    }

    public void setName(java.lang.String name) {
        this.name = name;
    }

    public java.time.LocalDate getDojoining() {
        return this.dojoining;
    }

    public void setDojoining(java.time.LocalDate dojoining) {
        this.dojoining = dojoining;
    }

    public Person(java.lang.String id, java.lang.String name,
            java.time.LocalDate dojoining) {
        this.id = id;
        this.name = name;
        this.dojoining = dojoining;
    }

}


					

					For more information about the KIE Server REST API, see Interacting with Red Hat Process Automation Manager using KIE APIs.
				
Prerequisites
	
							KIE Server is installed and configured, including a known user name and credentials for a user with the kie-server role. For installation options, see Planning a Red Hat Process Automation Manager installation.
						
	
							You have built the DMN project as a KJAR artifact and deployed it to KIE Server:
						
mvn clean install

							For more information about project packaging and deployment and executable models, see Packaging and deploying an Red Hat Process Automation Manager project.
						

	
							You have the ID of the KIE container containing the DMN model. If more than one model is present, you must also know the model namespace and model name of the relevant model.
						


Procedure
	
							Determine the base URL for accessing the KIE Server REST API endpoints. This requires knowing the following values (with the default local deployment values as an example):
						
	
									Host (localhost)
								
	
									Port (8080)
								
	
									Root context (kie-server)
								
	
									Base REST path (services/rest/)
								



							Example base URL in local deployment for the traffic violations project:
						

							http://localhost:8080/kie-server/services/rest/server/containers/traffic-violation_1.0.0-SNAPSHOT
						

	
							Determine user authentication requirements.
						

							When users are defined directly in the KIE Server configuration, HTTP Basic authentication is used and requires the user name and password. Successful requests require that the user have the kie-server role.
						

							The following example demonstrates how to add credentials to a curl request:
						
curl -u username:password <request>

							If KIE Server is configured with Red Hat Single Sign-On, the request must include a bearer token:
						
curl -H "Authorization: bearer $TOKEN" <request>

	
							Specify the format of the request and response. The REST API endpoints work with both JSON and XML formats and are set using request headers:
						
JSON

								

curl -H "accept: application/json" -H "content-type: application/json"


							
XML

								

curl -H "accept: application/xml" -H "content-type: application/xml"


							

	
							Optional: Query the container for a list of deployed decision models:
						

							[GET] server/containers/{containerId}/dmn
						

							Example curl request:
						
curl -u wbadmin:wbadmin -H "accept: application/xml" -X GET "http://localhost:8080/kie-server/services/rest/server/containers/traffic-violation_1.0.0-SNAPSHOT/dmn"

							Sample XML output:
						
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<response type="SUCCESS" msg="Ok models successfully retrieved from container 'traffic-violation_1.0.0-SNAPSHOT'">
    <dmn-model-info-list>
        <model>
            <model-namespace>https://kiegroup.org/dmn/_60b01f4d-e407-43f7-848e-258723b5fac8</model-namespace>
            <model-name>Traffic Violation</model-name>
            <model-id>_2CD7D1AA-BD84-4B43-AD21-B0342ADE655A</model-id>
            <decisions>
                <dmn-decision-info>
                    <decision-id>_23428EE8-DC8B-4067-8E67-9D7C53EC975F</decision-id>
                    <decision-name>Fine</decision-name>
                </dmn-decision-info>
                <dmn-decision-info>
                    <decision-id>_B5EEE2B1-915C-44DC-BE43-C244DC066FD8</decision-id>
                    <decision-name>Should the driver be suspended?</decision-name>
                </dmn-decision-info>
            </decisions>
            <inputs>
                <dmn-inputdata-info>
                    <inputdata-id>_CEB959CD-3638-4A87-93BA-03CD0FB63AE3</inputdata-id>
                    <inputdata-name>Violation</inputdata-name>
                    <inputdata-typeref>
                        <namespace-uri>https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8</namespace-uri>
                        <local-part>tViolation</local-part>
                        <prefix></prefix>
                    </inputdata-typeref>
                </dmn-inputdata-info>
                <dmn-inputdata-info>
                    <inputdata-id>_B0E810E6-7596-430A-B5CF-67CE16863B6C</inputdata-id>
                    <inputdata-name>Driver</inputdata-name>
                    <inputdata-typeref>
                        <namespace-uri>https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8</namespace-uri>
                        <local-part>tDriver</local-part>
                        <prefix></prefix>
                    </inputdata-typeref>
                </dmn-inputdata-info>
            </inputs>
            <itemdefinitions>
                <dmn-itemdefinition-info>
                    <itemdefinition-id>_9C758F4A-7D72-4D0F-B63F-2F5B8405980E</itemdefinition-id>
                    <itemdefinition-name>tViolation</itemdefinition-name>
                    <itemdefinition-itemcomponent>
                        <dmn-itemdefinition-info>
                            <itemdefinition-id>_0B6FF1E2-ACE9-4FB3-876B-5BB30B88009B</itemdefinition-id>
                            <itemdefinition-name>Code</itemdefinition-name>
                            <itemdefinition-typeref>
                                <namespace-uri>https://kiegroup.org/dmn/_60b01f4d-e407-43f7-848e-258723b5fac8</namespace-uri>
                                <local-part>string</local-part>
                                <prefix></prefix>
                            </itemdefinition-typeref>
                            <itemdefinition-itemcomponent/>
                            <itemdefinition-iscollection>false</itemdefinition-iscollection>
                        </dmn-itemdefinition-info>
                        <dmn-itemdefinition-info>
                            <itemdefinition-id>_27A5DA18-3CA7-4C06-81B7-CF7F2F050E29</itemdefinition-id>
                            <itemdefinition-name>date</itemdefinition-name>
                            <itemdefinition-typeref>
                                <namespace-uri>https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8</namespace-uri>
                                <local-part>date</local-part>
                                <prefix></prefix>
                            </itemdefinition-typeref>
                            <itemdefinition-itemcomponent/>
                            <itemdefinition-iscollection>false</itemdefinition-iscollection>
                        </dmn-itemdefinition-info>
                        <dmn-itemdefinition-info>
                            <itemdefinition-id>_8961969A-8A80-4F12-B568-346920C0F038</itemdefinition-id>
                            <itemdefinition-name>type</itemdefinition-name>
                            <itemdefinition-typeref>
                                <namespace-uri>https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8</namespace-uri>
                                <local-part>string</local-part>
                                <prefix></prefix>
                            </itemdefinition-typeref>
                            <itemdefinition-itemcomponent/>
                            <itemdefinition-iscollection>false</itemdefinition-iscollection>
                        </dmn-itemdefinition-info>
                        <dmn-itemdefinition-info>
                            <itemdefinition-id>_7450F12A-3E95-4D5E-8DCE-2CB1FAC2BDD4</itemdefinition-id>
                            <itemdefinition-name>speed limit</itemdefinition-name>
                            <itemdefinition-typeref>
                                <namespace-uri>https://kiegroup.org/dmn/_60b01f4d-e407-43f7-848e-258723b5fac8</namespace-uri>
                                <local-part>number</local-part>
                                <prefix></prefix>
                            </itemdefinition-typeref>
                            <itemdefinition-itemcomponent/>
                            <itemdefinition-iscollection>false</itemdefinition-iscollection>
                        </dmn-itemdefinition-info>
                        <dmn-itemdefinition-info>
                            <itemdefinition-id>_0A9A6F26-6C14-414D-A9BF-765E5850429A</itemdefinition-id>
                            <itemdefinition-name>Actual Speed</itemdefinition-name>
                            <itemdefinition-typeref>
                                <namespace-uri>https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8</namespace-uri>
                                <local-part>number</local-part>
                                <prefix></prefix>
                            </itemdefinition-typeref>
                            <itemdefinition-itemcomponent/>
                            <itemdefinition-iscollection>false</itemdefinition-iscollection>
                        </dmn-itemdefinition-info>
                    </itemdefinition-itemcomponent>
                    <itemdefinition-iscollection>false</itemdefinition-iscollection>
                </dmn-itemdefinition-info>
                <dmn-itemdefinition-info>
                    <itemdefinition-id>_13C7EFD8-B85C-43BF-94D3-14FABE39A4A0</itemdefinition-id>
                    <itemdefinition-name>tDriver</itemdefinition-name>
                    <itemdefinition-itemcomponent>
                        <dmn-itemdefinition-info>
                            <itemdefinition-id>_EC11744C-4160-4549-9610-2C757F40DFE8</itemdefinition-id>
                            <itemdefinition-name>Name</itemdefinition-name>
                            <itemdefinition-typeref>
                                <namespace-uri>https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8</namespace-uri>
                                <local-part>string</local-part>
                                <prefix></prefix>
                            </itemdefinition-typeref>
                            <itemdefinition-itemcomponent/>
                            <itemdefinition-iscollection>false</itemdefinition-iscollection>
                        </dmn-itemdefinition-info>
                        <dmn-itemdefinition-info>
                            <itemdefinition-id>_E95BE3DB-4A51-4658-A166-02493EAAC9D2</itemdefinition-id>
                            <itemdefinition-name>Age</itemdefinition-name>
                            <itemdefinition-typeref>
                                <namespace-uri>https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8</namespace-uri>
                                <local-part>number</local-part>
                                <prefix></prefix>
                            </itemdefinition-typeref>
                            <itemdefinition-itemcomponent/>
                            <itemdefinition-iscollection>false</itemdefinition-iscollection>
                        </dmn-itemdefinition-info>
                        <dmn-itemdefinition-info>
                            <itemdefinition-id>_7B3023E2-BC44-4BF3-BF7E-773C240FB9AD</itemdefinition-id>
                            <itemdefinition-name>State</itemdefinition-name>
                            <itemdefinition-typeref>
                                <namespace-uri>https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8</namespace-uri>
                                <local-part>string</local-part>
                                <prefix></prefix>
                            </itemdefinition-typeref>
                            <itemdefinition-itemcomponent/>
                            <itemdefinition-iscollection>false</itemdefinition-iscollection>
                        </dmn-itemdefinition-info>
                        <dmn-itemdefinition-info>
                            <itemdefinition-id>_3D4B49DD-700C-4925-99A7-3B2B873F7800</itemdefinition-id>
                            <itemdefinition-name>city</itemdefinition-name>
                            <itemdefinition-typeref>
                                <namespace-uri>https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8</namespace-uri>
                                <local-part>string</local-part>
                                <prefix></prefix>
                            </itemdefinition-typeref>
                            <itemdefinition-itemcomponent/>
                            <itemdefinition-iscollection>false</itemdefinition-iscollection>
                        </dmn-itemdefinition-info>
                        <dmn-itemdefinition-info>
                            <itemdefinition-id>_B37C49E8-B0D9-4B20-9DC6-D655BB1CA7B1</itemdefinition-id>
                            <itemdefinition-name>Points</itemdefinition-name>
                            <itemdefinition-typeref>
                                <namespace-uri>https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8</namespace-uri>
                                <local-part>number</local-part>
                                <prefix></prefix>
                            </itemdefinition-typeref>
                            <itemdefinition-itemcomponent/>
                            <itemdefinition-iscollection>false</itemdefinition-iscollection>
                        </dmn-itemdefinition-info>
                    </itemdefinition-itemcomponent>
                    <itemdefinition-iscollection>false</itemdefinition-iscollection>
                </dmn-itemdefinition-info>
                <dmn-itemdefinition-info>
                    <itemdefinition-id>_A4077C7E-B57A-4DEE-9C65-7769636316F3</itemdefinition-id>
                    <itemdefinition-name>tFine</itemdefinition-name>
                    <itemdefinition-itemcomponent>
                        <dmn-itemdefinition-info>
                            <itemdefinition-id>_79B152A8-DE83-4001-B88B-52DFF0D73B2D</itemdefinition-id>
                            <itemdefinition-name>Amount</itemdefinition-name>
                            <itemdefinition-typeref>
                                <namespace-uri>https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8</namespace-uri>
                                <local-part>number</local-part>
                                <prefix></prefix>
                            </itemdefinition-typeref>
                            <itemdefinition-itemcomponent/>
                            <itemdefinition-iscollection>false</itemdefinition-iscollection>
                        </dmn-itemdefinition-info>
                        <dmn-itemdefinition-info>
                            <itemdefinition-id>_D7CB5F9C-9D55-48C2-83EE-D47045EC90D0</itemdefinition-id>
                            <itemdefinition-name>Points</itemdefinition-name>
                            <itemdefinition-typeref>
                                <namespace-uri>https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8</namespace-uri>
                                <local-part>number</local-part>
                                <prefix></prefix>
                            </itemdefinition-typeref>
                            <itemdefinition-itemcomponent/>
                            <itemdefinition-iscollection>false</itemdefinition-iscollection>
                        </dmn-itemdefinition-info>
                    </itemdefinition-itemcomponent>
                    <itemdefinition-iscollection>false</itemdefinition-iscollection>
                </dmn-itemdefinition-info>
            </itemdefinitions>
            <decisionservices/>
        </model>
    </dmn-model-info-list>
</response>

							Sample JSON output:
						
{
  "type" : "SUCCESS",
  "msg" : "OK models successfully retrieved from container 'Traffic-Violation_1.0.0-SNAPSHOT'",
  "result" : {
    "dmn-model-info-list" : {
      "models" : [ {
        "model-namespace" : "https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8",
        "model-name" : "Traffic Violation",
        "model-id" : "_2CD7D1AA-BD84-4B43-AD21-B0342ADE655A",
        "decisions" : [ {
          "decision-id" : "_23428EE8-DC8B-4067-8E67-9D7C53EC975F",
          "decision-name" : "Fine"
        }, {
          "decision-id" : "_B5EEE2B1-915C-44DC-BE43-C244DC066FD8",
          "decision-name" : "Should the driver be suspended?"
        } ],
        "inputs" : [ {
          "inputdata-id" : "_CEB959CD-3638-4A87-93BA-03CD0FB63AE3",
          "inputdata-name" : "Violation",
          "inputdata-typeRef" : {
            "namespace-uri" : "https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8",
            "local-part" : "tViolation",
            "prefix" : ""
          }
        }, {
          "inputdata-id" : "_B0E810E6-7596-430A-B5CF-67CE16863B6C",
          "inputdata-name" : "Driver",
          "inputdata-typeRef" : {
            "namespace-uri" : "https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8",
            "local-part" : "tDriver",
            "prefix" : ""
          }
        } ],
        "itemDefinitions" : [ {
          "itemdefinition-id" : "_13C7EFD8-B85C-43BF-94D3-14FABE39A4A0",
          "itemdefinition-name" : "tDriver",
          "itemdefinition-typeRef" : null,
          "itemdefinition-itemComponent" : [ {
            "itemdefinition-id" : "_EC11744C-4160-4549-9610-2C757F40DFE8",
            "itemdefinition-name" : "Name",
            "itemdefinition-typeRef" : {
              "namespace-uri" : "https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8",
              "local-part" : "string",
              "prefix" : ""
            },
            "itemdefinition-itemComponent" : [ ],
            "itemdefinition-isCollection" : false
          }, {
            "itemdefinition-id" : "_E95BE3DB-4A51-4658-A166-02493EAAC9D2",
            "itemdefinition-name" : "Age",
            "itemdefinition-typeRef" : {
              "namespace-uri" : "https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8",
              "local-part" : "number",
              "prefix" : ""
            },
            "itemdefinition-itemComponent" : [ ],
            "itemdefinition-isCollection" : false
          }, {
            "itemdefinition-id" : "_7B3023E2-BC44-4BF3-BF7E-773C240FB9AD",
            "itemdefinition-name" : "State",
            "itemdefinition-typeRef" : {
              "namespace-uri" : "https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8",
              "local-part" : "string",
              "prefix" : ""
            },
            "itemdefinition-itemComponent" : [ ],
            "itemdefinition-isCollection" : false
          }, {
            "itemdefinition-id" : "_3D4B49DD-700C-4925-99A7-3B2B873F7800",
            "itemdefinition-name" : "City",
            "itemdefinition-typeRef" : {
              "namespace-uri" : "https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8",
              "local-part" : "string",
              "prefix" : ""
            },
            "itemdefinition-itemComponent" : [ ],
            "itemdefinition-isCollection" : false
          }, {
            "itemdefinition-id" : "_B37C49E8-B0D9-4B20-9DC6-D655BB1CA7B1",
            "itemdefinition-name" : "Points",
            "itemdefinition-typeRef" : {
              "namespace-uri" : "https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8",
              "local-part" : "number",
              "prefix" : ""
            },
            "itemdefinition-itemComponent" : [ ],
            "itemdefinition-isCollection" : false
          } ],
          "itemdefinition-isCollection" : false
        }, {
          "itemdefinition-id" : "_A4077C7E-B57A-4DEE-9C65-7769636316F3",
          "itemdefinition-name" : "tFine",
          "itemdefinition-typeRef" : null,
          "itemdefinition-itemComponent" : [ {
            "itemdefinition-id" : "_79B152A8-DE83-4001-B88B-52DFF0D73B2D",
            "itemdefinition-name" : "Amount",
            "itemdefinition-typeRef" : {
              "namespace-uri" : "https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8",
              "local-part" : "number",
              "prefix" : ""
            },
            "itemdefinition-itemComponent" : [ ],
            "itemdefinition-isCollection" : false
          }, {
            "itemdefinition-id" : "_D7CB5F9C-9D55-48C2-83EE-D47045EC90D0",
            "itemdefinition-name" : "Points",
            "itemdefinition-typeRef" : {
              "namespace-uri" : "https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8",
              "local-part" : "number",
              "prefix" : ""
            },
            "itemdefinition-itemComponent" : [ ],
            "itemdefinition-isCollection" : false
          } ],
          "itemdefinition-isCollection" : false
        }, {
          "itemdefinition-id" : "_9C758F4A-7D72-4D0F-B63F-2F5B8405980E",
          "itemdefinition-name" : "tViolation",
          "itemdefinition-typeRef" : null,
          "itemdefinition-itemComponent" : [ {
            "itemdefinition-id" : "_0B6FF1E2-ACE9-4FB3-876B-5BB30B88009B",
            "itemdefinition-name" : "Code",
            "itemdefinition-typeRef" : {
              "namespace-uri" : "https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8",
              "local-part" : "string",
              "prefix" : ""
            },
            "itemdefinition-itemComponent" : [ ],
            "itemdefinition-isCollection" : false
          }, {
            "itemdefinition-id" : "_27A5DA18-3CA7-4C06-81B7-CF7F2F050E29",
            "itemdefinition-name" : "Date",
            "itemdefinition-typeRef" : {
              "namespace-uri" : "https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8",
              "local-part" : "date",
              "prefix" : ""
            },
            "itemdefinition-itemComponent" : [ ],
            "itemdefinition-isCollection" : false
          }, {
            "itemdefinition-id" : "_8961969A-8A80-4F12-B568-346920C0F038",
            "itemdefinition-name" : "Type",
            "itemdefinition-typeRef" : {
              "namespace-uri" : "https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8",
              "local-part" : "string",
              "prefix" : ""
            },
            "itemdefinition-itemComponent" : [ ],
            "itemdefinition-isCollection" : false
          }, {
            "itemdefinition-id" : "_7450F12A-3E95-4D5E-8DCE-2CB1FAC2BDD4",
            "itemdefinition-name" : "Speed Limit",
            "itemdefinition-typeRef" : {
              "namespace-uri" : "https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8",
              "local-part" : "number",
              "prefix" : ""
            },
            "itemdefinition-itemComponent" : [ ],
            "itemdefinition-isCollection" : false
          }, {
            "itemdefinition-id" : "_0A9A6F26-6C14-414D-A9BF-765E5850429A",
            "itemdefinition-name" : "Actual Speed",
            "itemdefinition-typeRef" : {
              "namespace-uri" : "https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8",
              "local-part" : "number",
              "prefix" : ""
            },
            "itemdefinition-itemComponent" : [ ],
            "itemdefinition-isCollection" : false
          } ],
          "itemdefinition-isCollection" : false
        } ],
        "decisionServices" : [ ]
      } ]
    }
  }
}

	
							Execute the model:
						

							[POST] server/containers/{containerId}/dmn
						
Note

								The attribute model-namespace is automatically generated and is different for every user. Ensure that the model-namespace and model-name attributes that you use match those of the deployed model.
							


							Example curl request:
						
curl -u wbadmin:wbadmin -H "accept: application/json" -H "content-type: application/json" -X POST "http://localhost:8080/kie-server/services/rest/server/containers/traffic-violation_1.0.0-SNAPSHOT/dmn" -d "{ \"model-namespace\" : \"https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8\", \"model-name\" : \"Traffic Violation\", \"dmn-context\" : {\"Driver\" : {\"Points\" : 15}, \"Violation\" : {\"Type\" : \"speed\", \"Actual Speed\" : 135, \"Speed Limit\" : 100}}}"

							Example JSON request:
						
{
  "model-namespace" : "https://kiegroup.org/dmn/_60B01F4D-E407-43F7-848E-258723B5FAC8",
  "model-name" : "Traffic Violation",
  "dmn-context" :
  {
    "Driver" :
    {
  	   "Points" : 15
    },
  	"Violation" :
    {
  		"Type" : "speed",
  		"Actual Speed" : 135,
  		"Speed Limit" : 100
  	}
  }
}

							Example XML request (JAXB format):
						
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<dmn-evaluation-context>
    <dmn-context xsi:type="jaxbListWrapper" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
        <type>MAP</type>
        <element xsi:type="jaxbStringObjectPair" key="Violation">
            <value xsi:type="jaxbListWrapper">
                <type>MAP</type>
                <element xsi:type="jaxbStringObjectPair" key="Type">
                    <value xsi:type="xs:string" xmlns:xs="http://www.w3.org/2001/XMLSchema">speed</value>
                </element>
                <element xsi:type="jaxbStringObjectPair" key="Speed Limit">
                    <value xsi:type="xs:decimal" xmlns:xs="http://www.w3.org/2001/XMLSchema">100</value>
                </element>
                <element xsi:type="jaxbStringObjectPair" key="Actual Speed">
                    <value xsi:type="xs:decimal" xmlns:xs="http://www.w3.org/2001/XMLSchema">135</value>
                </element>
            </value>
        </element>
        <element xsi:type="jaxbStringObjectPair" key="Driver">
            <value xsi:type="jaxbListWrapper">
                <type>MAP</type>
                <element xsi:type="jaxbStringObjectPair" key="Points">
                    <value xsi:type="xs:decimal" xmlns:xs="http://www.w3.org/2001/XMLSchema">15</value>
                </element>
            </value>
        </element>
    </dmn-context>
</dmn-evaluation-context>
Note

								Regardless of the request format, the request requires the following elements:
							
	
										Model namespace
									
	
										Model name
									
	
										Context object containing input values
									




							Example JSON response:
						
{
  "type": "SUCCESS",
  "msg": "OK from container 'Traffic-Violation_1.0.0-SNAPSHOT'",
  "result": {
      "dmn-evaluation-result": {
          "messages": [],
          "model-namespace": "https://kiegroup.org/dmn/_7D8116DE-ADF5-4560-A116-FE1A2EAFFF48",
          "model-name": "Traffic Violation",
          "decision-name": [],
          "dmn-context": {
              "Violation": {
                "Type": "speed",
                "Speed Limit": 100,
                "Actual Speed": 135
              },
              "Should Driver be Suspended?": "Yes",
                "Driver": {
                  "Points": 15
                },
                "Fine": {
                  "Points": 7,
                  "Amount": 1000
                }
            },
      "decision-results": {
          "_E1AF5AC2-E259-455C-96E4-596E30D3BC86": {
              "messages": [],
              "decision-id": "_E1AF5AC2-E259-455C-96E4-596E30D3BC86",
              "decision-name": "Should the Driver be Suspended?",
              "result": "Yes",
              "status": "SUCCEEDED"
            },
          "_D7F02CE0-AF50-4505-AB80-C7D6DE257920": {
              "messages": [],
              "decision-id": "_D7F02CE0-AF50-4505-AB80-C7D6DE257920",
              "decision-name": "Fine",
              "result": {
                "Points": 7,
                "Amount": 1000
              },
          "status": "SUCCEEDED"
        }
      }
    }
  }
}

							Example XML (JAXB format) response:
						
<?xml version="1.0" encoding="UTF-8" standalone="yes"?>
<response type="SUCCESS" msg="OK from container 'Traffic_1.0.0-SNAPSHOT'">
    <dmn-evaluation-result>
        <model-namespace>https://kiegroup.org/dmn/_A4BCA8B8-CF08-433F-93B2-A2598F19ECFF</model-namespace>
        <model-name>Traffic Violation</model-name>
        <dmn-context xsi:type="jaxbListWrapper" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
            <type>MAP</type>
            <element xsi:type="jaxbStringObjectPair" key="Violation">
                <value xsi:type="jaxbListWrapper">
                    <type>MAP</type>
                    <element xsi:type="jaxbStringObjectPair" key="Type">
                        <value xsi:type="xs:string" xmlns:xs="http://www.w3.org/2001/XMLSchema">speed</value>
                    </element>
                    <element xsi:type="jaxbStringObjectPair" key="Speed Limit">
                        <value xsi:type="xs:decimal" xmlns:xs="http://www.w3.org/2001/XMLSchema">100</value>
                    </element>
                    <element xsi:type="jaxbStringObjectPair" key="Actual Speed">
                        <value xsi:type="xs:decimal" xmlns:xs="http://www.w3.org/2001/XMLSchema">135</value>
                    </element>
                </value>
            </element>
            <element xsi:type="jaxbStringObjectPair" key="Driver">
                <value xsi:type="jaxbListWrapper">
                    <type>MAP</type>
                    <element xsi:type="jaxbStringObjectPair" key="Points">
                        <value xsi:type="xs:decimal" xmlns:xs="http://www.w3.org/2001/XMLSchema">15</value>
                    </element>
                </value>
            </element>
            <element xsi:type="jaxbStringObjectPair" key="Fine">
                <value xsi:type="jaxbListWrapper">
                    <type>MAP</type>
                    <element xsi:type="jaxbStringObjectPair" key="Points">
                        <value xsi:type="xs:decimal" xmlns:xs="http://www.w3.org/2001/XMLSchema">7</value>
                    </element>
                    <element xsi:type="jaxbStringObjectPair" key="Amount">
                        <value xsi:type="xs:decimal" xmlns:xs="http://www.w3.org/2001/XMLSchema">1000</value>
                    </element>
                </value>
            </element>
            <element xsi:type="jaxbStringObjectPair" key="Should the driver be suspended?">
                <value xsi:type="xs:string" xmlns:xs="http://www.w3.org/2001/XMLSchema">Yes</value>
            </element>
        </dmn-context>
        <messages/>
        <decisionResults>
            <entry>
                <key>_4055D956-1C47-479C-B3F4-BAEB61F1C929</key>
                <value>
                    <decision-id>_4055D956-1C47-479C-B3F4-BAEB61F1C929</decision-id>
                    <decision-name>Fine</decision-name>
                    <result xsi:type="jaxbListWrapper" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
                        <type>MAP</type>
                        <element xsi:type="jaxbStringObjectPair" key="Points">
                            <value xsi:type="xs:decimal" xmlns:xs="http://www.w3.org/2001/XMLSchema">7</value>
                        </element>
                        <element xsi:type="jaxbStringObjectPair" key="Amount">
                            <value xsi:type="xs:decimal" xmlns:xs="http://www.w3.org/2001/XMLSchema">1000</value>
                        </element>
                    </result>
                    <messages/>
                    <status>SUCCEEDED</status>
                </value>
            </entry>
            <entry>
                <key>_8A408366-D8E9-4626-ABF3-5F69AA01F880</key>
                <value>
                    <decision-id>_8A408366-D8E9-4626-ABF3-5F69AA01F880</decision-id>
                    <decision-name>Should the driver be suspended?</decision-name>
                    <result xsi:type="xs:string" xmlns:xs="http://www.w3.org/2001/XMLSchema" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">Yes</result>
                    <messages/>
                    <status>SUCCEEDED</status>
                </value>
            </entry>
        </decisionResults>
    </dmn-evaluation-result>
</response>





Chapter 8. Additional resources



	
						Designing a decision service using DMN models
					
	
						Testing a decision service using test scenarios
					
	
						Managing projects in Business Central
					
	
						Interacting with Red Hat Process Automation Manager using KIE APIs
					



Part II. Getting started with process services in Red Hat Process Automation Manager





				As a business rules and processes developer, you can use Business Central in Red Hat Process Automation Manager or the Red Hat Process Automation Manager BPMN modeler in VS Code to design business processes to meet specific business requirements. Red Hat Process Automation Manager provides sample projects in Business Central that contain business assets for reference purposes. This document describes how to create a new mortgage process project, data objects, and business process to familiarize yourself with Business Central and the process designer.
			

				You will then refer to the Mortgage_Process sample project included in Business Central to review the sample project’s business rules, decision tables, and forms. You will build and deploy the Mortgage_Process sample project and execute the project’s defined functionality.
			
Prerequisites
	
						Red Hat JBoss Enterprise Application Platform 7.4 is installed. For details, see the Red Hat JBoss Enterprise Application Platform 7.4 Installation Guide.
					
	
						Red Hat Process Automation Manager is installed and configured with KIE Server. For more information, see Installing and configuring Red Hat Process Automation Manager on Red Hat JBoss EAP 7.4.
					
	
						Red Hat Process Automation Manager is running and you can log in to Business Central with the developer role. For more information, see Planning a Red Hat Process Automation Manager installation.
					




Chapter 9. Overview




				Business Central enables you to automate your business processes. A business process is a diagram that describes the order in which a series of steps must be executed and consists of predefined nodes and connections. Each node represents one step in the process while the connections specify how to transition from one node to another.
			

				For example, a bank offers a housing mortgage loan service. Using Business Central, the housing mortgage department of the bank creates a complete business process for the mortgage loan.
			

				When a customer wants to buy a new property using credit, the following steps occur:
			
	
						The customer contacts a broker at the bank who assists in filing for a mortgage loan.
					
	
						The broker collects information about the property and the customer, such as the salary of the customer, social security number, the property sale price, and the requested loan amount.
					
	
						The broker then submits a request on behalf of the customer.
					



				Whenever a customer submits a request, a new process instance is created. This ensures consistency in the quality of evaluating each request, provides complete visibility into the status of each request, and makes the process efficient and effective.
			

Chapter 10. Sample projects and business assets in Business Central




				Business Central contains sample projects with business assets that you can use as a reference for the rules, processes, or other assets that you create in your own Red Hat Process Automation Manager projects. Each sample project is designed differently to demonstrate process automation, decision management, or business optimization assets and logic in Red Hat Process Automation Manager.
			
Note

					Red Hat does not provide support for the sample code included in the Red Hat Process Automation Manager distribution.
				


				The following sample projects are available in Business Central:
			
	
						Course_Scheduling: (Business optimization) Course scheduling and curriculum decision process. Assigns lectures to rooms and determines a student’s curriculum based on factors such as course conflicts and class room capacity.
					
	
						Dinner_Party: (Business optimization) Guest seating optimization using guided decision tables. Assigns guest seating based on each guest’s job type, political beliefs, and known relationships.
					
	
						Employee_Rostering: (Business optimization) Employee rostering optimization using decision and solver assets. Assigns employees to shifts based on skills.
					
	
						Evaluation_Process: (Process automation) Evaluation process using business process assets. Evaluates employees based on performance.
					
	
						IT_Orders: (Process automation and case management) Ordering case using business process and case management assets. Places an IT hardware order based on needs and approvals.
					
	
						Mortgages: (Decision management with rules) Loan approval process using rule-based decision assets. Determines loan eligibility based on applicant data and qualifications.
					
	
						Mortgage_Process: (Process automation) Loan approval process using business process and decision assets. Determines loan eligibility based on applicant data and qualifications.
					
	
						OptaCloud: (Business optimization) Resource allocation optimization using decision and solver assets. Assigns processes to computers with limited resources.
					
	
						Traffic_Violation: (Decision management with DMN) Traffic violation decision service using a Decision Model and Notation (DMN) model. Determines driver penalty and suspension based on traffic violations.
					


Accessing sample projects and business assets in Business Central




					You can use the sample projects in Business Central to explore business assets as a reference for the rules or other assets that you create in your own Red Hat Process Automation Manager projects.
				
Prerequisites
	
							Business Central is installed and running. For installation options, see Planning a Red Hat Process Automation Manager installation.
						


Procedure
	
							In Business Central, go to Menu → Design → Projects. If there are existing projects, you can access the samples by clicking the MySpace default space and selecting Try Samples from the Add Project drop-down menu. If there are no existing projects, click Try samples.
						
	
							Review the descriptions for each sample project to determine which project you want to explore. Each sample project is designed differently to demonstrate process automation, decision management, or business optimization assets and logic in Red Hat Process Automation Manager.
						
	
							Select one or more sample projects and click Ok to add the projects to your space.
						
	
							In the Projects page of your space, select one of the sample projects to view the assets for that project.
						
	
							Select each asset to explore how the project is designed to achieve the specified goal or workflow. Some of the sample projects contain more than one page of assets. Click the left or right arrows in the upper-right corner to view the full asset list.
						
Figure 10.1. Asset page selection
[image: Navigate through asset pages]



	
							In the upper-right corner of the project Assets page, click Build to build the sample project or Deploy to build the project and then deploy it to KIE Server.
						
Note

								You can also select the Build & Install option to build the project and publish the KJAR file to the configured Maven repository without deploying to a KIE Server. In a development environment, you can click Deploy to deploy the built KJAR file to a KIE Server without stopping any running instances (if applicable), or click Redeploy to deploy the built KJAR file and replace all instances. The next time you deploy or redeploy the built KJAR, the previous deployment unit (KIE container) is automatically updated in the same target KIE Server. In a production environment, the Redeploy option is disabled and you can click Deploy only to deploy the built KJAR file to a new deployment unit (KIE container) on a KIE Server.
							

								To configure the KIE Server environment mode, set the org.kie.server.mode system property to org.kie.server.mode=development or org.kie.server.mode=production. To configure the deployment behavior for a corresponding project in Business Central, go to project Settings → General Settings → Version, toggle the Development Mode option, and click Save. By default, KIE Server and all new projects in Business Central are in development mode. You cannot deploy a project with Development Mode turned on or with a manually added SNAPSHOT version suffix to a KIE Server that is in production mode.
							


							To review project deployment details, click View deployment details in the deployment banner at the top of the screen or in the Deploy drop-down menu. This option directs you to the Menu → Deploy → Execution Servers page.
						





Chapter 11. Red Hat Process Automation Manager BPMN and DMN modelers




				Red Hat Process Automation Manager provides the following extensions or applications that you can use to design Business Process Model and Notation (BPMN) process models and Decision Model and Notation (DMN) decision models using graphical modelers.
			
	
						Business Central: Enables you to view and design BPMN models, DMN models, and test scenario files in a related embedded designer.
					

						To use Business Central, you can set up a development environment containing a Business Central to design business rules and processes, and a KIE Server to execute and test the created business rules and processes.
					

	
						Red Hat Process Automation Manager VS Code extension: Enables you to view and design BPMN models, DMN models, and test scenario files in Visual Studio Code (VS Code). The VS Code extension requires VS Code 1.46.0 or later.
					

						To install the Red Hat Process Automation Manager VS Code extension, select the Extensions menu option in VS Code and search for and install the Red Hat Business Automation Bundle extension.
					

	
						Standalone BPMN and DMN editors: Enable you to view and design BPMN and DMN models embedded in your web applications. To download the necessary files, you can either use the NPM artifacts from the NPM registry or download the JavaScript files directly for the DMN standalone editor library at https://<YOUR_PAGE>/dmn/index.js and for the BPMN standalone editor library at https://<YOUR_PAGE>/bpmn/index.js.
					


Installing the Red Hat Process Automation Manager VS Code extension bundle




					Red Hat Process Automation Manager provides a Red Hat Business Automation Bundle VS Code extension that enables you to design Decision Model and Notation (DMN) decision models, Business Process Model and Notation (BPMN) 2.0 business processes, and test scenarios directly in VS Code. VS Code is the preferred integrated development environment (IDE) for developing new business applications. Red Hat Process Automation Manager also provides individual DMN Editor and BPMN Editor VS Code extensions for DMN or BPMN support only, if needed.
				
Important

						The editors in the VS Code are partially compatible with the editors in the Business Central, and several Business Central features are not supported in the VS Code.
					

Prerequisites
	
							The latest stable version of VS Code is installed.
						


Procedure
	
							In your VS Code IDE, select the Extensions menu option and search for Red Hat Business Automation Bundle for DMN, BPMN, and test scenario file support.
						

							For DMN or BPMN file support only, you can also search for the individual DMN Editor or BPMN Editor extensions.
						

	
							When the Red Hat Business Automation Bundle extension appears in VS Code, select it and click Install.
						
	
							For optimal VS Code editor behavior, after the extension installation is complete, reload or close and re-launch your instance of VS Code.
						



					After you install the VS Code extension bundle, any .dmn, .bpmn, or .bpmn2 files that you open or create in VS Code are automatically displayed as graphical models. Additionally, any .scesim files that you open or create are automatically displayed as tabular test scenario models for testing the functionality of your business decisions.
				

					If the DMN, BPMN, or test scenario modelers open only the XML source of a DMN, BPMN, or test scenario file and displays an error message, review the reported errors and the model file to ensure that all elements are correctly defined.
				
Note

						For new DMN or BPMN models, you can also enter dmn.new or bpmn.new in a web browser to design your DMN or BPMN model in the online modeler. When you finish creating your model, you can click Download in the online modeler page to import your DMN or BPMN file into your Red Hat Process Automation Manager project in VS Code.
					


Configuring the Red Hat Process Automation Manager standalone editors




					Red Hat Process Automation Manager provides standalone editors that are distributed in a self-contained library providing an all-in-one JavaScript file for each editor. The JavaScript file uses a comprehensive API to set and control the editor.
				

					You can install the standalone editors using the following methods:
				
	
							Download each JavaScript file manually
						
	
							Use the NPM package
						


Procedure
	
							Install the standalone editors using one of the following methods:
						

							Download each JavaScript file manually: For this method, follow these steps:
						
	
									Download the JavaScript files.
								
	
									Add the downloaded Javascript files to your hosted application.
								
	
									Add the following <script> tag to your HTML page:
								
Script tag for your HTML page for the DMN editor

										

<script src="https://<YOUR_PAGE>/dmn/index.js"></script>


									
Script tag for your HTML page for the BPMN editor

										

<script src="https://<YOUR_PAGE>/bpmn/index.js"></script>


									




							Use the NPM package: For this method, follow these steps:
						
	
									Add the NPM package to your package.json file:
								
Adding the NPM package

										

npm install @kie-tools/kie-editors-standalone


									

	
									Import each editor library to your TypeScript file:
								
Importing each editor

										

import * as DmnEditor from "@kie-tools/kie-editors-standalone/dist/dmn"
import * as BpmnEditor from "@kie-tools/kie-editors-standalone/dist/bpmn"


									




	
							After you install the standalone editors, open the required editor by using the provided editor API, as shown in the following example for opening a DMN editor. The API is the same for each editor.
						
Opening the DMN standalone editor

								

const editor = DmnEditor.open({
  container: document.getElementById("dmn-editor-container"),
  initialContent: Promise.resolve(""),
  readOnly: false,
  origin: "",
  resources: new Map([
    [
      "MyIncludedModel.dmn",
      {
        contentType: "text",
        content: Promise.resolve("")
      }
    ]
  ])
});


							

							Use the following parameters with the editor API:
						
Table 11.1. Example parameters
	Parameter	Description
	 
											container
										

										 	 
											HTML element in which the editor is appended.
										

										 
	 
											initialContent
										

										 	 
											Promise to a DMN model content. This parameter can be empty, as shown in the following examples:
										

										 	
													Promise.resolve("")
												
	
													Promise.resolve("<DIAGRAM_CONTENT_DIRECTLY_HERE>")
												
	
													fetch("MyDmnModel.dmn").then(content ⇒ content.text())
												



										 
	 
											readOnly (Optional)
										

										 	 
											Enables you to allow changes in the editor. Set to false (default) to allow content editing and true for read-only mode in editor.
										

										 
	 
											origin (Optional)
										

										 	 
											Origin of the repository. The default value is window.location.origin.
										

										 
	 
											resources (Optional)
										

										 	 
											Map of resources for the editor. For example, this parameter is used to provide included models for the DMN editor or work item definitions for the BPMN editor. Each entry in the map contains a resource name and an object that consists of content-type (text or binary) and content (similar to the initialContent parameter).
										

										 




							The returned object contains the methods that are required to manipulate the editor.
						
Table 11.2. Returned object methods
	Method	Description
	 
											getContent(): Promise<string>
										

										 	 
											Returns a promise containing the editor content.
										

										 
	 
											setContent(path: string, content: string): void
										

										 	 
											Sets the content of the editor.
										

										 
	 
											getPreview(): Promise<string>
										

										 	 
											Returns a promise containing an SVG string of the current diagram.
										

										 
	 
											subscribeToContentChanges(callback: (isDirty: boolean) ⇒ void): (isDirty: boolean) ⇒ void
										

										 	 
											Sets a callback to be called when the content changes in the editor and returns the same callback to be used for unsubscription.
										

										 
	 
											unsubscribeToContentChanges(callback: (isDirty: boolean) ⇒ void): void
										

										 	 
											Unsubscribes the passed callback when the content changes in the editor.
										

										 
	 
											markAsSaved(): void
										

										 	 
											Resets the editor state that indicates that the content in the editor is saved. Also, it activates the subscribed callbacks related to content change.
										

										 
	 
											undo(): void
										

										 	 
											Undoes the last change in the editor. Also, it activates the subscribed callbacks related to content change.
										

										 
	 
											redo(): void
										

										 	 
											Redoes the last undone change in the editor. Also, it activates the subscribed callbacks related to content change.
										

										 
	 
											close(): void
										

										 	 
											Closes the editor.
										

										 
	 
											getElementPosition(selector: string): Promise<Rect>
										

										 	 
											Provides an alternative to extend the standard query selector when an element lives inside a canvas or a video component. The selector parameter must follow the <PROVIDER>:::<SELECT> format, such as Canvas:::MySquare or Video:::PresenterHand. This method returns a Rect representing the element position.
										

										 
	 
											envelopeApi: MessageBusClientApi<KogitoEditorEnvelopeApi>
										

										 	 
											This is an advanced editor API. For more information about advanced editor API, see MessageBusClientApi and KogitoEditorEnvelopeApi.
										

										 








Chapter 12. Creating and executing DMN and BPMN models using Maven




				You can use Maven archetypes to develop DMN and BPMN models in VS Code using the Red Hat Process Automation Manager VS Code extension instead of Business Central. You can then integrate your archetypes with your Red Hat Process Automation Manager decision and process services in Business Central as needed. This method of developing DMN and BPMN models is helpful for building new business applications using the Red Hat Process Automation Manager VS Code extension.
			
Procedure
	
						In a command terminal, navigate to a local folder where you want to store the new Red Hat Process Automation Manager project.
					
	
						Enter the following command to use a Maven archtype to generate a project within a defined folder:
					
Generating a project using Maven archetype

							

mvn archetype:generate \
    -DarchetypeGroupId=org.kie \
    -DarchetypeArtifactId=kie-kjar-archetype \
    -DarchetypeVersion=7.67.0.Final-redhat-00024


						

						This command generates a Maven project with required dependencies and generates required directories and files to build your business application. You can use the Git version control system (recommended) when developing a project.
					

						If you want to generate multiple projects in the same directory, specify the artifactId and groupId of the generated business application by adding -DgroupId=<groupid> -DartifactId=<artifactId> to the previous command.
					

	
						In your VS Code IDE, click File, select Open Folder, and navigate to the folder that is generated using the previous command.
					
	
						Before creating the first asset, set a package for your business application, for example, org.kie.businessapp, and create respective directories in the following paths:
					
	
								PROJECT_HOME/src/main/java
							
	
								PROJECT_HOME/src/main/resources
							
	
								PROJECT_HOME/src/test/resources
							



						For example, you can create PROJECT_HOME/src/main/java/org/kie/businessapp for org.kie.businessapp package.
					

	
						Use VS Code to create assets for your business application. You can create the assets supported by Red Hat Process Automation Manager VS Code extension using the following ways:
					
	
								To create a business process, create a new file with .bpmn or .bpmn2 in PROJECT_HOME/src/main/resources/org/kie/businessapp directory, such as Process.bpmn.
							
	
								To create a DMN model, create a new file with .dmn in PROJECT_HOME/src/main/resources/org/kie/businessapp directory, such as AgeDecision.dmn.
							
	
								To create a test scenario simulation model, create a new file with .scesim in PROJECT_HOME/src/test/resources/org/kie/businessapp directory, such as TestAgeScenario.scesim.
							



	
						After you create the assets in your Maven archetype, navigate to the root directory (contains pom.xml) of the project in the command line and run the following command to build the knowledge JAR (KJAR) of your project:
					
mvn clean install

						If the build fails, address any problems described in the command line error messages and try again to validate the project until the build is successful. However, if the build is successful, you can find the artifact of your business application in PROJECT_HOME/target directory.
					
Note

							Use mvn clean install command often to validate your project after each major change during development.
						





				You can deploy the generated knowledge JAR (KJAR) of your business application on a running KIE Server using the REST API. For more information about using REST API, see Interacting with Red Hat Process Automation Manager using KIE APIs.
			

Chapter 13. Creating users




				You can create as many Business Central users as you require. User privileges and settings are controlled by the roles assigned to a user and the groups that a user belongs to. For this example, you must create two new users: Katy who will act as the bank’s loan manager and approver, and Bill who will act as the broker requesting the loan. For more information on creating users, see the Creating users chapter of Installing and configuring Red Hat Process Automation Manager on Red Hat JBoss EAP 7.4.
			

				In Business Central, you can use groups and roles to control permissions for a collection of users. You can create as many groups and roles as you want but a group must have at least one user.
			
	
						For this example, the user or users working on the tasks must be assigned to one or more of the following groups and roles:
					
	
								approver group: For the Qualify task
							
	
								broker group: For the Correct Data and Increase Down Payment tasks
							
	
								manager role: For the Final Approval task
							





Procedure
	
						Click the gear icon 
						[image: gear icon]
						 in the upper-right corner and click Users.
					
	
						Click 
						[image: new user]
						 , enter Katy, click Next, and click Create.
					
	
						Click Yes to set a password, enter Katy in both fields, and click Change.
					
	
						Enter Bill, click Next, and click Create.
					
	
						Click Yes to set a password, enter Bill in both fields, and click Change.
					
	
						Click the Groups tab and click 
						[image: new group]
						 , enter approver, and click Next.
					
	
						Select Katy from the user list, and click Add selected users.
					
	
						Enter broker, and click Next.
					
	
						Select Bill from the user list, and click Add selected users.
					
	
						Click the Users tab, select Katy, and click Edit → Roles → Add roles.
					
	
						Select manager, click Add to selected roles, and click Save.
					
	
						Click the Groups tab and click Edit → Groups → Add to groups.
					
	
						Select approver and kie-server, and click Add to selected groups.
					
	
						Click Save.
					
	
						Click the Users tab, select Bill from the user list, and click Edit → Roles → Add roles.
					
	
						Select user, and click Add to selected roles.
					
	
						Click the Groups tab, click 
						[image: new group]
						 , select kie-server, and click Add to selected groups.
					
	
						Click Save.
					



Chapter 14. Creating the mortgage-process project




				A project is a container for assets such as data objects, business processes, guided rules, decision tables, and forms. The project that you are creating is similar to the existing Mortgage_Process sample project in Business Central.
			
Procedure
	
						In Business Central, go to Menu → Design → Projects.
					

						Red Hat Process Automation Manager provides a default space called MySpace, as shown in the following image. You can use the default space to create and test example projects.
					
Figure 14.1. Default space
[image: spaces teams]



	
						Click Add Project.
					
	
						Enter mortgage-process in the Name field.
					
	
						Click Configure Advanced Options and modify the GAV fields with the following values:
					
	
								Group ID: com.myspace
							
	
								Artifact ID: mortgage-process
							
	
								Version: 1.0.0
							



	
						Click Add.
					



				The Assets view of the project opens.
			

Chapter 15. Creating the mortgage-process data objects




				Data objects are the building blocks for the rule assets that you create. Data objects are custom data types implemented as Java classes in specified packages of your project. These custom data types determine what data your assets and your decision services are based on.
			

				The mortgage process project uses the following data objects:
			
	
						Applicant
					
	
						Property
					
	
						ValidationErrorDO
					
	
						Application
					


Creating the Applicant data object




					Create the Applicant data object, which contains information about the applicant. This is the basic information required to apply for the loan in this tutorial.
				
Procedure
	
							In Business Central, click the MySpace default space.
						
	
							Click Menu → Design → Projects and click mortgage-process.
						
	
							Click Add Asset and select Data Object.
						
	
							Enter Applicant in the Data Object field of the Create new Data Object window.
						
	
							Select com.myspace.mortgage_app from the Package drop-down menu and click Ok.
						
	
							Enter Applicant in the Label field of the 'Applicant'- general properties section.
						
	
							Click +add field and input the following Applicant data object values. Click Create and continue after each addition. For the last addition, click Create.
						
Figure 15.1. Applicant data object field values
[image: screen capture of the Applicant data object field values]



	
							Click Save.
						



Creating the Property data object




					Create the Property data object, which contains information about the property details, such as the property age and price.
				
Procedure
	
							In Business Central, click the MySpace default space.
						
	
							Click Menu → Design → Projects and click mortgage-process.
						
	
							Click Add Asset and select Data Object.
						
	
							Enter Property in the Data Object field of the Create new Data Object window.
						
	
							Select com.myspace.mortgage_app from the Package drop-down menu and click Ok.
						
	
							Enter Property in the Label field of the 'Property'- general properties section.
						
	
							Click +add field and input the following Property data object values. Click Create and continue after each addition. For the last addition, click Create.
						
Figure 15.2. Property data object field values
[image: screen capture of the Property data object field values]



	
							Click Save.
						



Creating the ValidationErrorDO data object




					Create the ValidationErrorDO data object, which specifies the cause of an application error.
				
Procedure
	
							In Business Central, click the MySpace default space.
						
	
							Click Menu → Design → Projects and click mortgage-process.
						
	
							Click Add Asset and select Data Object.
						
	
							Enter ValidationErrorDO in the Data Object field of the Create new Data Object window.
						
	
							Select com.myspace.mortgage_app from the Package drop-down menu and click Ok.
						
	
							Enter ValidationErrorDO in the Label field of the 'ValidationErrorDO'- general properties section.
						
	
							Click +add field and input the following ValidationErrorDO data object values. Click Create and continue after each addition. For the last addition, click Create.
						
Figure 15.3. ValidationErrorDO data object field values
[image: screen capture of the ValidationErrorDO data object field values]



	
							Click Save.
						



Creating the Application data object




					Create the Application data object, which contains information about the mortgage details, such as the down payment and the mortgage amount.
				
Procedure
	
							In Business Central, click the MySpace default space.
						
	
							Click Menu → Design → Projects and click mortgage-process.
						
	
							Click Add Asset and select Data Object.
						
	
							Enter Application in the Data Object field of the Create new Data Object window.
						
	
							Select com.myspace.mortgage_app from the Package drop-down menu and click Ok.
						
	
							Enter Application in the Label field of the 'Application'- general properties section.
						
	
							Click +add field and input the following Application data object values. Click Create and continue after each addition. For the last addition, click Create.
						
Figure 15.4. Application data object field values
[image: screen capture of the Application data object field values]



	
							Click Save.
						




Chapter 16. Business processes in Business Central




				A business process is a diagram that describes the order in which a series of steps must be executed using a flow chart. A business process consists of a collection of nodes that are linked to each other using connections. Each of the nodes represents one step in the overall process while the connections specify how to transition from one node to the other.
			

				The sample Mortgage_Process contains the following predefined MortgageApprovalProcess business process.
			

				[image: screen capture of the mortgageApprovalProcess business process]

			
Creating the business process




					The following procedures guide you through the creation of tasks, connections, and gateways that make up the MortgageApprovalProcess business process. The mortgage validation business process determines whether a mortgage application contains all required data. If the specified data requirements are met, the application proceeds on to the mortgage calculation business process.
				
Procedure
	
							In Business Central, go to Menu → Design → Projects → Mortgage-Process.
						
	
							Click Add Asset → Business Process.
						
	
							Enter the following values:
						
	
									Business Process: MortgageApprovalProcess
								
	
									Package: Select com.myspace.mortgage_app
								

									The Package specifies the location inside the existing project where the asset will be created. In this example, it is created in com/myspace/mortgage_app.
								




	
							Click Ok. The diagram editor opens.
						
	
							In the upper-right corner, click the Properties [image: diagram properties]
							 icon.
						
	
							Scroll down and expand Process Data and click 
							[image: the plus sign icon]
							 in the Process Variables section.
						
	
							Enter the following values:
						
	
									Name: application
								
	
									Data Type: Application [com.myspace.mortgage_app]
								





Creating outgoing connections and exclusive gateways




						This section shows you how to create outgoing connections, exclusive gateways, and business rule tasks. Use exclusive gateways to make decisions and react to events based on the available data.
					

						Red Hat Process Automation Manager contains a predefined selection of node types to simplify business process creation. The predefined node panel is located on the left side of the diagram editor.
					

						[image: node panel]

					
Procedure
	
								Drag a start event node onto the canvas.
							
	
								Create an outgoing connection from the start event to an exclusive gateway:
							
	
										On the canvas, click the start event node and click the Create Parallel icon.
									
[image: create parallel]


	
										Hover over the 
										[image: config icon]
										 icon of the parallel and click the Convert into Exclusive icon.
									
[image: exclusive gateway]





	
								Create an outgoing connection from the exclusive gateway to a business rule task:
							
	
										On the canvas, click the exclusive gateway and click the Create Task icon.
									
	
										Hover over the 
										[image: config icon]
										 icon of the task and click the Convert into Business Rule icon.
									
[image: bus rule task]





	
								Configure the business rule task:
							
	
										Click the business rules task.
									
	
										If the Properties panel is not open, click the Properties [image: diagram properties]
										 icon in the upper-right corner.
									
	
										In the Properties panel, enter Validation in the Name field.
									
	
										Expand Implementation/Execution, select New from the Rule Flow Group menu, and input validation.
									
	
										In the On Exit Action field, enter the following Java expression:
									
System.out.println(application.getProperty());

	
										Expand Data Assignments and click 
										[image: btn assign]
										 next to Assignments.
									
	
										In the Validation Data I/O window, click Add and create the following assignments:
									
	
												Data Inputs and Assignements
											
	
														Name: application
													
	
														Data Type: Application [com.myspace.mortgage_app]
													
	
														Source: application
													



	
												Data Outputs and Assignements
											
	
														Name: application
													
	
														Data Type: Application [com.myspace.mortgage_app]
													
	
														Target: application
													
Figure 16.1. Validation Data I/O assignments
[image: Screen capture of the Validation Data I/O assignments]












	
								Click OK in the Validation Data I/O window.
							
	
								Above the canvas, click Save to confirm your changes.
							



Defining the validation data




						This section shows you how to define the validation data that determines whether the application data is correct, contains an error, or has missing information.
					
Procedure
	
								Create an outgoing connection from the Validation task to an exclusive gateway:
							
	
										Click the Validation task and click the Create Parallel icon.
									
	
										Hover over the 
										[image: config icon]
										 icon of the parallel and click the Convert into Exclusive icon.
									
[image: exclusive gateway]





	
								Create an outgoing connection from the exclusive gateway to a new business rule task:
							
	
										Click the exclusive gateway and click the Create Task icon.
									
	
										Drag the new task below the exclusive gateway as shown in the following image.
									
	
										Hover over the 
										[image: config icon]
										 icon of the task and click the Convert into Business Rule icon.
									
[image: new br task]


	
										If the Properties panel is not open, click the Properties [image: diagram properties]
										 icon in the upper-right corner.
									
	
										In the Properties panel, enter Retract Validation in the Name field.
									
	
										Expand Implementation/Execution, select New from the Rule Flow Group menu, and input error.
									



	
								Configure the connection between the exclusive gateway and the business rule task:
							
	
										Click the connection.
									
[image: created connection]


	
										If the Properties panel is not open, click the Properties [image: diagram properties]
										 icon in the upper-right corner.
									
	
										In the Properties panel, enter Invalid in the Name field.
									
	
										Expand Implementation/Execution and select Expression in the Condition Expression section.
									
	
										From the list, select drools and enter ValidationErrorDO() in the Condition Expression field.
									
[image: languagedropdown]





	
								Create an outgoing connection from the Retract Validation task to a new user task:
							
	
										Click the Retract Validation task and click the Create Task icon.
									
	
										Drag the new task below the Validation task as shown below.
									
	
										Hover over the 
										[image: config icon]
										 icon of the task and click the Convert into User icon.
									
[image: user task]


	
										Click the new user task and in the Properties panel, enter Correct Data in the Name field.
									
	
										Expand Implementation/Execution and enter CorrectData in the Task Name field.
									
	
										Select New from the Groups menu, and input broker.
									
	
										Click 
										[image: btn assign]
										 next to Assignments.
									
	
										In the Correct Data Data I/O window, click Add and create the following assignments:
									
	
												Name: application
											
	
												Data Type: Application [com.myspace.mortgage_app]
											
	
												Source: application
											
	
														Data Outputs and Assignements
													



	
												Name: application
											
	
												Data Type: Application [com.myspace.mortgage_app]
											
	
												Target: application
											
Figure 16.2. Correct Data Data I/O assignments
[image: Screen capture of the Correct Data Data I/O assignments]






	
										Click OK in the Correct Data Data I/O window.
									
	
										Above the canvas, click Save.
									



	
								Click the Correct Data user task then click the Create sequence Flow icon and drag it back to the first exclusive gateway. Your workflow should look similar to the following diagram:
							
[image: workflow1]





Calculating the mortgage




						The mortgage calculation business process determines the applicant’s mortgage borrowing limit.
					
Procedure
	
								Return to the second exclusive gateway and create an outgoing connection to a new business rule task.
							
	
								Click the created connection and in the Properties panel, input Valid in the Name field.
							
	
										Expand Implementation/Execution and select Expression in the Condition Expression section.
									
	
										From the list, select drools and enter not ValidationErrorDO() in the Condition Expression field.
									



	
								Click the new business rule task and in the Properties panel, input Mortgage Calculation in the Name field.
							
[image: validconnection]

	
										Expand Implementation/Execution, select New from the Rule Flow Group menu, and input mortgagecalculation.
									



	
								Expand Data Assignments and click 
								[image: btn assign]
								 next to Assignments.
							
	
								In the Mortgage Calculation Data I/O window, click Add to create the following assignments and click Save.
							
Figure 16.3. Mortgage Calculation Data I/O assignments
[image: screen capture of the Mortgage Calculation Data I/O assignments]



	
								Click OK in the Mortgage Calculation Data I/O window.
							
	
								Click an empty space on the canvas, scroll down, expand Process Data, and click 
								[image: the plus sign icon]
								 next to Process Variables. Enter the following values:
							
	
										Name: inlimit
									
	
										Data Type: Boolean
									



	
								Create an outgoing connection from the Mortgage Calculation task to a new user task.
							
	
								Click the user task, enter Qualify in the Name field.
							
	
								Expand Implementation/Execution and enter Qualify in the Task Name field.
							
	
								Select New from the Groups menu, and input approver.
							
	
								Click 
								[image: btn assign]
								 next to Assignments. In the Qualify Data I/O window, click Add to create the following assignments:
							
Figure 16.4. Qualify Data I/O assignments
[image: Screen capture of the Qualify Data I/O assignments]



	
								Click OK in the Qualify Data I/O window.
							
	
								Above the canvas, click Save to confirm your changes.
							
	
								Click the Qualify user task, click the Create parallel menu icon, and convert it to an exclusive gateway.
							
	
								Drag the new exclusive gateway below the Qualify user task.
							
	
								Create an outgoing connection from the exclusive gateway and connect it to a new user task.
							
	
								Click the connection and input In Limit in the Name field of the Properties panel.
							
	
								Expand Implementation/Execution and select Condition in the Condition Expression section.
							
	
								Select inlimit from the Process Variable drop-down menu and select Is true from the Condition drop-down menu.
							
[image: inlimit true]


	
								Click the user task, enter Final Approval in the Name field.
							
	
								Expand Implementation/Execution and enter FinalApproval in the Task Name field.
							
	
								Select New from the Groups menu, and input manager.
							
	
								Click 
								[image: btn assign]
								 next to Assignments. In the Final Approval Data I/O window, click Add to create the following assignments:
							
Figure 16.5. Final Approval Data I/O assignments
[image: Screen capture of the Final Approval Data I/O assignments]



	
								Click OK in the Final Approval Data I/O window.
							
	
								Above the canvas, click Save to confirm your changes.
							



Increasing the down payment




						The Increasing the Down Payment business process checks to see if the applicant qualifies for the loan by increasing their down payment. The final result is either the final loan approval, or loan denial based on the applicant’s inability to increase the down payment.
					
Procedure
	
								Click the Final Approval user task and select Create End from the user task quick menu.
							
	
								Move the end event below the Final Approval user task.
							
[image: create end]


	
								Return to the exclusive gateway that connects with the Final Approval user task. Create a second outgoing connection and connect it to a new user task.
							
[image: new task]


	
								Click the connection and input Not in Limit in the Name field of the Properties panel.
							
	
								Expand Implementation/Execution and select Condition in the Condition Expression section.
							
	
								Select inlimit from the Process Variable drop-down menu and select Is false from the Condition drop-down menu.
							
	
								Click an empty space on the canvas, scroll down, expand Process Data, and click 
								[image: the plus sign icon]
								 next to Process Variables. Enter the following values:
							
	
										Name: incdownpayment
									
	
										Data Type: Boolean
									
[image: proc var new]





	
								Click the new user task and in the Properties panel, input Increase Down Payment in the Name field.
							
	
								Expand Implementation/Execution and enter IncreaseDownPayment in the Task Name field.
							
	
								Select New from the Groups menu, and input broker.
							
	
								Click 
								[image: btn assign]
								 next to Assignments. In the Increase Down Payment Data I/O window, click Add to create the following assignments:
							
Figure 16.6. Increase Down Payment Data I/O assignments
[image: Screen capture of the Increase Down Payment Data I/O assignments]



	
								Click OK in the Increase Down Payment Data I/O window.
							
	
								Above the canvas, click Save to confirm your changes.
							
	
								Click the Increase Down Payment user task, click the Create parallel menu icon, and convert it to an exclusive gateway.
							
	
								Drag the new exclusive gateway below the Increase Down Payment user task.
							
	
								Create an outgoing connection from the exclusive gateway to an end event.
							
	
								Click the connection and input Down payment not increased in the Name field of the Properties panel.
							
	
								Expand Implementation/Execution and select Expresssion in the Condition Expression section.
							
	
								Input return !incdownpayment; and select java from the drop-down menu.
							
	
								Create an outgoing connection from the exclusive gateway and connect it to the first exclusive gateway.
							
	
								Click the connection and input Down payment increased in the Name field of the Properties panel.
							
	
								Expand Implementation/Execution and select Expresssion in the Condition Expression section.
							
	
								Input return incdownpayment; and select java from the drop-down menu.
							
	
								Above the canvas, click Save to confirm your changes and save the entire business process.
							


Figure 16.7. Final version of the business process
[image: Screen capture of the Final version of the business process]





Chapter 17. Guided rules




				Guided rules are business rules that you create in a UI-based guided rules designer in Business Central that leads you through the rule-creation process. The guided rules designer provides fields and options for acceptable input based on the data objects for the rule being defined. The guided rules that you define are compiled into Drools Rule Language (DRL) rules as with all other rule assets.
			

				All data objects related to a guided rule must be in the same project package as the guided rule. Assets in the same package are imported by default. After you create the necessary data objects and the guided rule, you can use the Data Objects tab of the guided rules designer to verify that all required data objects are listed or to import other existing data objects by adding a New item.
			
Viewing the Mortgage_Process business rules




					The goal of this chapter is to introduce you to the predefined business rules for the Mortgage_Process project. For this tutorial, you do not create and define the business rules. Instead, review the WHEN and THEN rules that are already defined in the Mortgage_Process sample project’s preconfigured business rules. For information about creating guided business rules, see Designing a decision service using guided rules.
				
Viewing the Validate Down Payment guided rule




						Review the WHEN and THEN rules so that you understand how the conditions are set and used later when you run the process.
					
Procedure
	
								Click Menu → Design → Projects, and click Mortgage_Process.
							
	
								From the asset list, click the right arrow to view the second page of the asset list and click the Validate Down Payment guided rule.
							
	
								Review the Validate Down Payment guided rule’s WHEN and THEN conditions and values.
							
[image: screen caputure of the Validate Down Payment.drl Guided Rules dialog]





Viewing the RetractValidationErr guided rule




						Review the WHEN and THEN rules so that you understand how the conditions are set and used later when you run the process.
					
Procedure
	
								Click Menu → Design → Projects, and click Mortgage_Process.
							
	
								From the asset list, click the right arrow to view the second page of the asset list and click the RetractValidationErr guided rule.
							
	
								Review the RetractValidationErr guided rule’s WHEN and THEN conditions and values.
							
[image: retract val rules]







Chapter 18. Guided decision tables




				Guided decision tables are a wizard-led alternative to spreadsheet decision tables for defining business rules in a tabular format. With guided decision tables, you are led by a UI-based wizard in Business Central that helps you define rule attributes, metadata, conditions, and actions based on specified data objects in your project. After you create your guided decision tables, the rules you defined are compiled into Drools Rule Language (DRL) rules as with all other rule assets.
			

				All data objects related to a guided decision table must be in the same project package as the guided decision table. Assets in the same package are imported by default. After you create the necessary data objects and the guided decision table, you can use the Data Objects tab of the guided decision tables designer to verify that all required data objects are listed or to import other existing data objects by adding a New item.
			
Viewing the mortgage decision table




					The goal of this chapter is to introduce you to the MortgageDecisionTable decision table. For this tutorial, you do not create and set the decision table conditions. Instead, review the values and the conditions that are already defined in the Mortgage_Process sample project’s MortgageDecisionTable Guided Decision Tables asset. For information about creating decision tables, see Designing a decision service using guided decision tables.
				
Prerequisites
	
							The business rules have been defined. For more information, see the section called “Viewing the Mortgage_Process business rules”.
						


Procedure
	
							In Business Central, go to Menu → Design → Projects → Mortgage_Process.
						
	
							Scroll down and click the MortgageDecisionTable Guided Decision Tables asset.
						

							[image: loans guided dt]

						





Chapter 19. Forms in Business Central




				A form is a layout definition for a page, defined as HTML, that is displayed as a dialog window to the user during process and task instantiation. Task forms acquire data from a user for both the process and task instance execution, whereas process forms take input and output from process variables.
			

				The input is then mapped to the task using the data input assignment, which you can use inside of a task. When the task is completed, the data is mapped as a data output assignment to provide the data to the parent process instance.
			
Viewing the Mortgage_Process forms




					The goal of this chapter is to introduce you to the Mortgage_Process sample project’s predefined forms which are used for collecting user data for the mortgage application business process. For this tutorial, you do not create and modify the Mortgage_Process forms. Instead, review the predefined sample forms. For information about creating forms, see Designing business processes using BPMN models.
				
Procedure
	
							In Business Central, go to Menu → Design → Projects → Mortgage_Process.
						
	
							From the asset list, click the right arrow to view the second page of the asset list and select the Applicant form.
						
Figure 19.1. Applicant sample form
[image: screen capture of the Applicant sample form]



	
							Click Menu → Design → Projects → Mortgage_Process.
						
	
							From the asset list, select the Property form. The Property form is shown in the following screenshot:
						
Figure 19.2. Property sample form
[image: screen capture of the Property sample form]



	
							Click Menu → Design → Projects → Mortgage_Process.
						
	
							From the asset list, select the Application form. The Application form is shown in the following screenshot:
						
Figure 19.3. Application sample form
[image: screen capture of the Application sample form]



	
							Click the X icon in the upper-right corner to close the editor.
						




Chapter 20. Deploying the MortgageApprovalProcess process application




				The following chapter instructs you how to build and deploy a new instance of the Mortgage_Process application in Red Hat Process Automation Manager.
			
Prerequisites
	
						KIE Server is deployed and connected to Business Central.
					


Procedure
	
						In Business Central, go to Menu → Design → Projects → Mortgage_Process.
					
	
						Click Deploy.
					
	
								If no KIE container (deployment unit) is included with the project name, a container with default values is automatically created.
							
	
								If an older version of the project is already deployed, go to the project settings and change the project version. When finished, save the change and click Deploy. This deploys a new version of the same project with the latest changes in place, alongside the older version(s).
							
Note

									You can also select the Build & Install option to build the project and publish the KJAR file to the configured Maven repository without deploying to a KIE Server. In a development environment, you can click Deploy to deploy the built KJAR file to a KIE Server without stopping any running instances (if applicable), or click Redeploy to deploy the built KJAR file and replace all instances. The next time you deploy or redeploy the built KJAR, the previous deployment unit (KIE container) is automatically updated in the same target KIE Server. In a production environment, the Redeploy option is disabled and you can click Deploy only to deploy the built KJAR file to a new deployment unit (KIE container) on a KIE Server.
								

									To configure the KIE Server environment mode, set the org.kie.server.mode system property to org.kie.server.mode=development or org.kie.server.mode=production. To configure the deployment behavior for a corresponding project in Business Central, go to project Settings → General Settings → Version and toggle the Development Mode option. By default, KIE Server and all new projects in Business Central are in development mode. You cannot deploy a project with Development Mode turned on or with a manually added SNAPSHOT version suffix to a KIE Server that is in production mode.
								





	
						To review project deployment details, click View deployment details in the deployment banner at the top of the screen or in the Deploy drop-down menu. This option directs you to the Menu → Deploy → Execution Servers page.
					



Chapter 21. Executing the MortgageApprovalProcess process application




				Now that you have deployed the project, you can execute the project’s defined functionality. For this tutorial you input data into a mortgage application form acting as the mortgage broker. The MortgageApprovalProcess business process runs and determines whether or not the applicant has offered an acceptable down payment based on the decision rules that you defined earlier. The business process either ends the rule testing or requests that the applicant increase the down payment to proceed. If the application passes the business rule testing, the bank’s approver reviews the application and either approve or deny the loan.
			
Prerequisites
	
						KIE Server is deployed and connected to Business Central.
					
	
						The Mortgage_Process application has been deployed.
					
	
						The users working on the tasks are members of the following groups and roles:
					
	
								approver group: For the Qualify task
							
	
								broker group: For the Correct Data and Increase Down Payment tasks
							
	
								manager role: For the Final Approval task
							





Procedure
	
						Log in to Red Hat Process Automation Manager as Bill (the broker) and click Menu → Manage → Process Definitions.
					
	
						Click the three vertical dots in the Actions column and select Start to start to open the Application form and input the following values in to the form fields:
					
	
								Down Payment: 30000
							
	
								Years of amortization: 10
							
	
								Name: Ivo
							
	
								Annual Income: 60000
							
	
								SSN: 123456789
							
	
								Age of property: 8
							
	
								Address of property: Brno
							
	
								Locale: Rural
							
	
								Property Sale Price: 50000
							



	
						Click Submit to start a new process instance. After starting the process instance, the Instance Details view opens.
					
	
						Click the Diagram tab to view the process flow within the process diagram. The state of the process is highlighted as it moves through each task.
					
[image: screen capture of the process flow within the process diagram]


	
						Log out of Business Central and log back in as Katy.
					
	
						Click Menu → Track → Task Inbox. This takes you to the Qualify form.
					
	
						Click the three vertical dots in the Actions column and select and click Claim. The Qualify task Status is now Reserved.
					
	
						Click the Qualify task row to open and review the task information. Click Claim and then Start at the bottom of the form.
					

						The application form is now active for approval or denial.
					

	
						To approve the application, select Is mortgage application in limit? and click Complete.
					
	
						In the Task Inbox, click anywhere in the Final Approval row to open the Final Approval task.
					
	
						In the Final Approval row, click the three vertical dots in the Actions column and click Claim.
					
	
						Click anywhere in the Final Approval row to open the Final Approval task. Click Start at the bottom of the form.
					
	
						Note that the Inlimit check box is selected to reflect that that application is ready for final approval. Click Complete.
					


Note

					The Save and Release buttons are only used to either pause the approval process and save the instance if you are waiting on a field value, or to release the task for another user to modify.
				


Chapter 22. Monitoring the MortgageApprovalProcess process application




				The following chapter shows how different bank employees, such as a system administrator or a knowledge worker, might use some of the monitoring capabilities to track an instance of the mortgage approval process.
			
Prerequisites
	
						KIE Server is deployed and connected to Business Central.
					


Procedure
	
						Log in to Red Hat Process Automation Manager and click Menu → Manage → Process Instances.
					
	
						In the Manage Process Instances window, you can set filters, such as State, Errors, Id, and so on.
					
	
						Select Completed in the State filter to view all completed MortgageApprovalProcess instances.
					
	
						Click on the completed process instance.
					
	
						Click each of the following tabs to get a feel for what type of information is available to monitor a specific process instance:
					
	
								Instance Details
							
	
								Process Variables
							
	
								Documents
							
	
								Logs
							
	
								Diagram
							



	
						Click Menu → Track → Process Reports. This view contains a variety of charts that can help a senior process manager to gain an overview of all processes based on Type, Start Date, Running Time, and so on to assist with task reporting.
					


Filtering process instances using default or advanced filters




					Business Central now provides you with default and advanced filters to help you filter and search through running process instances. You can also create custom filters using the Advanced Filters option.
				
Filtering process instances using default filters




						Filter process instances by attributes such as State, Errors, Filter By, Name, Start Date, and Last update.
					
Procedure
	
								In Business Central, go to Menu → Manage → Process Instances.
							
	
								On the Manage Process Instances page, click the filter icon on the left of the page to expand the Filters pane.
							

								This pane lists the following process attributes which you can use to filter process instances:
							
	
										State: Filter process instances based on their state (Active, Aborted, Completed, Pending, and Suspended).
									
	
										Errors: Filter process instances by errors.
									
	
										Filter By: Filter process instances based on Id, Initiator, Correlation Key, or Description attribute.
									
	
												Select the required attribute.
											
	
												Enter the search query in the text field below.
											
	
												Click Apply.
											



	
										Name: Filter process instances by definition names.
									
	
										Definition Id: Filter process instances by process definition IDs.
									
	
										Deployment Id: Filter process instances by process deployment IDs.
									
	
										Parent Process Instance Id: Filter process instances by parent process instance IDs.
									
	
										SLA Compliance: Filter process instances by SLA compliance states.
									
	
										Start Date: Filter process instances by creation dates.
									
	
										Last update: Filter process instances by last modified dates.
									






Filtering process instances using advanced filters




						Use the Advanced Filters option to create custom process instance filters. The newly created custom filter is added to the Saved Filters pane, which is accessible by clicking on the star icon on the left of the Manage Process Instances page.
					
Procedure
	
								In Business Central, go to Menu → Manage → Process Instances.
							
	
								On the Manage Process Instances page, on the left of the page click the Advanced Filters icon.
							
	
								In the Advanced Filters pane, enter the name and description of the filter, and click Add New.
							
	
								Select an attribute from the Select column drop-down list, for example, processName. The content of the drop-down changes to processName != value1.
							
	
								Click the drop-down again and choose the required logical query. For the processName attribute, choose equals to.
							
	
								Change the value of the text field to the name of the process you want to filter.
							
Note

									The name must match the value defined in the business process of the project.
								


	
								Click Save and the processes are filtered according to the filter definition.
							
	
								Click the star icon to open the Saved Filters pane.
							

								In the Saved Filters pane, you can view all the saved advanced filters.
							






Chapter 23. Additional resources



	
						Designing business processes using BPMN models
					



Part III. Getting started with case management in Red Hat Process Automation Manager





				As a business rules and processes developer, you can use case management assets in Business Central to create unpredictable and ad hoc case processes. Case workers or process administrators can also use Business Central for case management and execution. Red Hat Process Automation Manager provides example projects with example business assets in Business Central as a reference. This document describes how to create and test an example IT orders project based on the IT_Orders sample project included in Business Central.
			
Prerequisites
	
						Red Hat JBoss Enterprise Application Platform 7.4 is installed. For installation information, see Red Hat JBoss Enterprise Application Platform 7.4 Installation Guide.
					
	
						Red Hat Process Automation Manager is installed and configured with KIE Server. For more information see Installing and configuring Red Hat Process Automation Manager on Red Hat JBoss EAP 7.4.
					
	
						Red Hat Process Automation Manager is running and you can log in to Business Central with the kie-server, user, and admin roles.
					
	
						You have reviewed the information in Designing and building cases for case management.
					




Chapter 24. Reviewing the IT_Orders sample project




				Before you create your own case management project, review the existing IT_Orders sample case management project in Business Central. This sample project contains predefined case management assets as a reference for your own case projects.
			
Important

					The business process application example includes features that are Technology Preview only. Technology Preview features are not supported with Red Hat production service level agreements (SLAs), might not be functionally complete, and are not recommended for production. These features provide early access to upcoming product features, enabling customers to test functionality and provide feedback during the development process. For more information about Red Hat Technology Preview support, see Technology Preview Features Support Scope.
				

Procedure
	
						In Business Central, go to Menu → Design → Projects. If there are existing projects, you can access the samples by clicking the MySpace default space and selecting Try Samples from the Add Project drop-down menu. If there are no existing projects, click Try samples.
					
	
						Select IT_Orders and click Ok.
					



				The Assets view of the project opens. Select each example asset to explore how the project is designed to achieve the specified goal or workflow.
			

				Review the orderhardware business process to help you understand the business process flow.
			
[image: orderhardware Business Processes (legacy) asset]


Chapter 25. Creating a new IT_Orders case project




				Create a new IT_Orders project in Business Central to gain an understanding of all of the required assets and how they are used in the project.
			
Procedure
	
						Log in to Business Central and go to Menu → Design → Projects.
					

						Business Central provides a default space called MySpace. You can use the default space to create and test example projects.
					

	
						Click the Add Project drop-down arrow and select the Case project option:
					
	
						In the Add Project window, enter IT_Orders_New in the Name field and enter a project Description.
					
	
						Click Add to add the project.
					

						The Assets view of the project opens.
					




Chapter 26. Data objects




				Data objects are the building blocks for the rule assets that you create. Data objects are custom data types implemented as Java objects in specified packages of your project. For example, you might create a Person object with data fields Name, Address, and DateOfBirth to specify personal details for loan application rules. These custom data types determine what data your assets and your decision services are based on.
			
Creating the ITOrderService data object




					The ITOrderService data object specifies the data type that will be used to define the IT Orders variables.
				
Prerequisites
	
							The IT_Orders_New project is created.
						


Procedure
	
							Click Add Asset → Data Object.
						
	
							In the Create new Data Object wizard, enter the following values:
						
	
									Data Object: ITOrderService
								
	
									Package: com.myspace.it_orders_new
								



	
							Click Ok.
						
	
							Click 
							[image: the plus sign icon]
							 next to the Package drop-down menu to specify a new package for the data object.
						
	
							Input org.jbpm.demo.it_orders.services and click Add.
						
	
							Click Save, and then click Yes, Move to confirm your changes.
						



Creating the Survey data object




					The Survey data object contains data fields, such as deliveredOnTime and missingEquipment. You will use the data and values when you design your case.
				
Prerequisites
	
							The IT_Orders_New project is created.
						


Procedure
	
							In Business Central, go to Menu → Design → Projects and click IT_Orders_New.
						
	
							Click Add Asset → Data Object.
						
	
							In the Create new Data Object wizard, enter the following values:
						
	
									Data Object: Survey
								
	
									Package: com.myspace.it_orders_new
								



	
							Click Ok.
						
	
							Add the Survey data object constraints.
						
	
									Click add field.
								
	
									Enter the following values:
								
	
											Id: comment
										
	
											Label: Leave empty
										
	
											Type: String
										



	
									Click Create and continue, and then enter the following values:
								
	
											Id: deliveredOnTime
										
	
											Label: Leave empty
										
	
											Type: Boolean
										



	
									Click Create and continue, and then enter the following values:
								
	
											Id: missingEquipment
										
	
											Label: Leave empty
										
	
											Type: String
										



	
									Click Create and continue, and then enter the following values:
								
	
											Id: satisfied
										
	
											Label: Leave empty
										
	
											Type: Boolean
										



	
									Click Create.
								



	
							Click Save to confirm your changes.
						
Figure 26.1. Survey data object details
[image: screen capture of the survey data objects dialog]







Chapter 27. Designing the case definition




				You design cases using the process designer in Business Central. Case design is the basis of case management and sets the specific goals and tasks for each case. The case flow can be modified dynamically during run time by adding dynamic tasks or processes. In this procedure, you will create this same case definition to familiarize yourself with the case definition design process.
			

				The IT_Orders sample project in Business Central includes the following orderhardware business process case definition.
			
Figure 27.1. orderhardware business process case definition
[image: IT Orders case design]


Prerequisites
	
						You have created a new case in Business Central. For more information, see Chapter 25, Creating a new IT_Orders case project.
					
	
						You have created the data objects. For more information, see Chapter 26, Data objects.
					


Procedure
	
						In Business Central, go to Menu → Design → Projects and click IT_Orders_New.
					
	
						Click Add Asset → Case Definition.
					
	
						In the Create new Case definition window, add the following required information:
					
	
								Case Definition: Input orderhardware. This is usually the subject of the case or project that is being case managed.
							
	
								Package: Select com.myspace.it_orders_new to specify the location that the case file is created in.
							



	
						Click Ok to open the process designer.
					
	
						Define values for the case file variables that are accessible to the sub-processes, subcases, and business rules used in the case.
					
	
								In the upper-right corner, click the Properties [image: diagram properties]
								 icon.
							
	
								Scroll down and expand Case Management, click 
								[image: the plus sign icon]
								 in the Case File Variables section, and enter the following:
							
Figure 27.2. orderhardware case file variables
[image: Case file variables]





Note

							The following case file variables are custom data types:
						
	
									hwSpec: org.jbpm.document.Document (type in this value)
								
	
									survey: Survey [com.myspace.it_orders_new] (select this value)
								




	
						Click Save.
					
	
						Define the roles involved in the case.
					
	
								In the upper-right corner, click the Properties [image: diagram properties]
								 icon.
							
	
								Scroll down and expand Case Management, click 
								[image: the plus sign icon]
								 in the Case Roles section, and enter the following:
							
Figure 27.3. orderhardware case roles
[image: Case roles]


	
										owner: The employee who is making the hardware order request. The role cardinality is set to 1, which means that only one person or group can be assigned to this role.
									
	
										manager: The employee’s manager; the person who will approve or deny the requested hardware. The role cardinality is set to 1, which means that only one person or group can be assigned to this role.
									
	
										supplier: The available suppliers of IT hardware in the system. The role cardinality is set to 2, which means that more than one supplier can be assigned to this role.
									






	
						Click Save.
					


Creating the Place order sub-process




					Create the Place order sub-process, which is a separate business process that is carried out by the supplier. This is a reusable process that occurs during the course of case execution as described in Chapter 27, Designing the case definition.
				
Prerequisites
	
							You have created a new case in Business Central. For more information, see Chapter 25, Creating a new IT_Orders case project.
						
	
							You have created the data objects. For more information, see Chapter 26, Data objects.
						


Procedure
	
							In Business Central, go to Menu → Design → Projects → IT_Orders_New.
						
	
							From the project menu, click Add Asset → Business Process.
						
	
							In the Create new Business Process wizard, enter the following values:
						
	
									Business Process: place-order
								
	
									Package: Select com.myspace.it_orders_new
								



	
							Click Ok. The diagram editor opens.
						
	
							Click an empty space in the canvas, and in the upper-right corner, click the Properties [image: diagram properties]
							 icon.
						
	
							Scroll down, expand Process Data, click 
							[image: the plus sign icon]
							 in the Process Variables section, and enter the following values under Process Variables:
						
Table 27.1. Process variables
	Name	Data Type
	 
											CaseID
										

										 	 
											String
										

										 
	 
											Requestor
										

										 	 
											String
										

										 
	 
											_hwSpec
										

										 	 
											org.jbm.doc
										

										 
	 
											ordered_
										

										 	 
											Boolean
										

										 
	 
											info_
										

										 	 
											String
										

										 
	 
											caseFile_hwSpec
										

										 	 
											org.jbm.doc
										

										 
	 
											caseFile-ordered
										

										 	 
											Boolean
										

										 
	 
											caseFile-orderinf
										

										 	 
											String
										

										 



Figure 27.4. Completed process variables
[image: screen capture of the process variables list]



	
							Click Save.
						
	
							Drag a start event onto the canvas and create an outgoing connection from the start event to a task and convert the new task to a user task.
						
[image: screen capture of Create Task icon]

[image: screen capture of Convert into User icon]


	
							Click the user task and in the Properties panel, input Place order in the Name field.
						
	
							Expand Implementation/Execution, click Add below the Groups menu, click Select → New, and input supplier.
						
	
							click 
							[image: the Properties icon]
							 in the Assignments field and add the following data inputs and outputs in the Place order Data I/O dialog box:
						
Table 27.2. Data inputs and assignements
	Name	Data Type	Source
	 
											_hwSpec
										

										 	 
											org.jbpm.document
										

										 	 
											caseFile_hwSpec
										

										 
	 
											orderNumber
										

										 	 
											String
										

										 	 
											CaseId
										

										 
	 
											Requestor
										

										 	 
											String
										

										 	 
											Requestor
										

										 



Table 27.3. Data outputs and assignements
	Name	Data Type	Target
	 
											ordered_
										

										 	 
											Boolean
										

										 	 
											caseFile_ordered
										

										 
	 
											info_
										

										 	 
											String
										

										 	 
											CaseFile_orderInfo
										

										 



[image: screen capture of the Place order Data I/0 dialog]


							For the first input assignment, select Custom for the Data Type and input org.jbpm.document.Document.
						

	
							Click OK.
						
	
							Select the Skippable check box and enter the following text in the Description field:
						

							Approved order #{CaseId} to be placed
						

	
							Create an outgoing connection from the Place order user task and connect it to an end event.
						
[image: screen capture of the Place order user task]

[image: screen capture of the end event added to the Place order user task]


	
							Click Save to confirm your changes.
						



					You can open the sub-process in a new editor in Business Central by clicking the Place order task in the main process and then clicking the Open Sub-process task icon.
				
[image: screen capture of the Open Sub-process icon]


Creating the Manager approval business process




					The manager approval process determines whether or not the order will be placed or rejected.
				
Procedure
	
							In Business Central, go to Menu → Design → Projects → IT_Orders_New → orderhardware Business Processes.
						
	
							Create and configure the Prepare hardware spec user task:
						
	
									Expand Tasks in the Object Library and drag a user task onto the canvas and convert the new task to a user task.
								
	
									Click the new user task and click the Properties [image: diagram properties]
									 icon in the upper-right corner.
								
	
									Input Prepare hardware spec in the Name field.
								
	
									Expand Implementation/Execution, click Add below the Groups menu, click Select → New, and input supplier.
								
	
									Input PrepareHardwareSpec in the Task Name field.
								
	
									Select the Skippable check box and enter the following text in the Description field:
								

									Prepare hardware specification for #{initiator} (order number #{CaseId})
								

	
									click 
									[image: the Properties icon]
									 in the Assignments field and add the following:
								
[image: Prepare hardware I/O values]


	
									Click OK.
								



	
							Create and configure the manager approval user task:
						
	
									Click the Prepare hardware spec user task and create a new user task.
								
	
									Click the new user task and click the Properties [image: diagram properties]
									 icon in the upper-right corner.
								
	
									Click the user task and in the Properties panel input Manager approval in the Name field.
								
	
									Expand Implementation/Execution, click Add below the Actors menu, click Select → New, and input manager.
								
	
									Input ManagerApproval in the Task Name field.
								
	
									click 
									[image: the Properties icon]
									 in the Assignments field and add the following:
								
[image: Manager approval I/O values]


	
									Click OK.
								
	
									Select the Skippable check box and enter the following text in the Description field:
								

									Approval request for new hardware for #{initiator} (order number #{CaseId})
								

	
									Enter the following Java expression in the On Exit Action field:
								

									kcontext.setVariable("caseFile_managerDecision", approved);
								

	
									Click Save.
								



	
							Click the Manager approval user task and create a Data-based Exclusive (XOR) gateway.
						
[image: Creating a gateway]

[image: Creating a Data-based Exclusive (XOR) gateway]


	
							Create and configure the Place order reusable sub-process:
						
	
									From the Object Library, expand sub-processes, click Reusable, and drag the new element to the canvas on the right side of the Data-based Exclusive (XOR) gateway.
								
[image: Creating a reusable task]


	
									Connect the Data-based Exclusive (XOR) gateway to the sub-process.
								
[image: Creating a Data-based Exclusive (XOR) gateway to sub-process]


	
									Click the new sub task and click the Properties [image: diagram properties]
									 icon in the upper-right corner.
								
	
									Input Place order in the Name field.
								
	
									Expand Data Assignments and click 
									[image: the Properties icon]
									 in the Assignments field and add the following:
								
[image: Place order I/O values]


	
									Click OK.
								
	
									Click the connection from the Data-based Exclusive (XOR) gateway to the sub-process and click the Properties [image: diagram properties]
									 icon.
								
	
									Expand Implementation/Execution, select Condition, and set the following condition expressions.
								
[image: Sequence flow conditions]


	
									Click the Place order user task and create an end event.
								



	
							Create and configure the order rejected user task:
						
	
									Click the Data-based Exclusive (XOR) gateway and create a new user task.
								
	
									Drag the new task to align it below the Place order task.
								
[image: Align new task]


	
									Click the new user task and click the Properties [image: diagram properties]
									 icon in the upper-right corner.
								
	
									Input Order rejected in the Name field.
								
	
									Expand Implementation/Execution and input OrderRejected in the Task Name field.
								
	
									Click Add below the Actors menu, click Select → New, and input owner.
								
	
									click 
									[image: the Properties icon]
									 in the Assignments field and add the following:
								
[image: Order rejected I/O values]


	
									Click OK.
								
	
									Select the Skippable check box and enter the following text in the Description field:
								

									Order #{CaseId} has been rejected by manager
								

	
									Click the Order rejected user task and create an end event.
								
	
									Click Save.
								



	
							Click the connection from the Data-based Exclusive (XOR) gateway to the Order rejected user task and click the Properties [image: diagram properties]
							 icon.
						
	
							Expand Implementation/Execution, select Condition, and set the following condition expressions.
						
[image: Sequence flow conditions]


	
							Click Save.
						
Figure 27.5. Manager approval business process
[image: Manager approval business process]







Chapter 28. Milestones




				Milestones are a special service task that can be configured in the case definition designer by adding the milestone node to the process designer palette. When creating a new case definition, a milestone configured as AdHoc Autostart is included on the design palette by default. Newly created milestones are not set to AdHoc Autostart by default.
			

				Case management milestones generally occur at the end of a stage, but they can also be the result of achieving other milestones. A milestone always requires a condition to be defined in order to track progress. Milestones react to case file data when data is added to a case. A milestone represents a single point of achievement within the case instance. It can be used to flag certain events, which can be useful for Key Performance Indicator (KPI) tracking or identifying the tasks that are still to be completed.
			

				Milestones can be in any of the following states during case execution:
			
	
						Active: The condition has been defined on the milestone but it has not been met.
					
	
						Completed: The milestone condition has been met, the milestone has been achieved, and the case can proceed to the next task.
					
	
						Terminated: The milestone is no longer a part of the case process and is no longer required.
					



				While a milestone is available or completed it can be triggered manually by a signal or automatically if AdHoc Autostart is configured when a case instance starts. Milestones can be triggered as many times as required, however, it is directly achieved when the condition is met.
			
Creating the Hardware spec ready milestone




					Create a HardwareSpecReady milestone that is reached when the required hardware specification document is completed.
				
Procedure
	
							In the process designer, expand Milestone in the Object Library and drag a new milestone on the canvas and place it on the right side of the Place order end event.
						
	
							Click the new milestone and click the Properties [image: diagram properties]
							 icon in the upper-right corner.
						
	
							Input Hardware spec ready in the Name field.
						
	
							Expand Implementation/Execution and select AdHoc Autostart.
						
	
							Expand Data Assignments, click 
							[image: the Properties icon]
							 in the Assignments field, and add the following:
						
[image: HardwareSpecReady I/O values]


							Click the Source column drop-down, select Constant, and input org.kie.api.runtime.process.CaseData(data.get("hwSpec") != null).
						

	
							Click OK.
						



Creating the Manager decision milestone




					This milestone is reached when the managerDecision variable has been given a response.
				
Procedure
	
							In the process designer, expand Milestone in the Object Library and drag a new milestone onto the canvas below the HardwareSpecReady milestone.
						
	
							Click the new milestone and click the Properties [image: diagram properties]
							 icon in the upper-right corner.
						
	
							Input Manager decision in the Name field.
						
	
							Expand Implementation/Execution and select AdHoc Autostart.
						
	
							Expand Data Assignments and click 
							[image: the Properties icon]
							 in the Assignments field and add the following:
						
[image: ManagerDecision I/O values]


							Click the Source column drop-down, select Constant, and input org.kie.api.runtime.process.CaseData(data.get("managerDecision") != null).
						

	
							Click OK.
						



Creating the Order placed milestone




					This milestone is reached when the ordered variable, which is part of the Place order sub-process, has been given a response.
				
Procedure
	
							In the process designer, expand Milestone in the Object Library and drag a new milestone on the canvas below the Prepare hardware spec user task.
						
	
							Click the new milestone and click the Properties [image: diagram properties]
							 icon in the upper-right corner.
						
	
							Input Milestone 1: Order placed in the Name field.
						
	
							Expand Implementation/Execution and select AdHoc Autostart.
						
	
							Expand Data Assignments, click 
							[image: the Properties icon]
							 in the Assignments field, and add the following:
						
[image: Milestone evaluation condition configuration]


							Click the Source column drop-down, select Constant, and input org.kie.api.runtime.process.CaseData(data.get("ordered") == true). This means that a case variable named ordered exists with the value true.
						

	
							Click OK.
						
	
							Click Milestone 1: Order placed and create a new script task.
						
	
							Click the new script task and click the Properties [image: diagram properties]
							 icon in the upper-right corner.
						
	
							Input Notify requestor in the Name field.
						
	
							Expand Implementation/Execution and input System.out.println("Notification::Order placed");.
						
	
							Click the Notify requestor script task and create a signal end event.
						
	
							Click the signal event and in the upper-right corner click the Properties. 
							[image: diagram properties]
							 icon.
						
	
							Expand Implementation/Execution, click the down arrow in the Signal field, and select New.
						
	
							Input Milestone 2: Order shipped.
						
	
							Click the down arrow in the Signal Scope field, select Process Instance.
						
	
							Click Save.
						
Figure 28.1. Order placed milestone
[image: Order placed milestone]






Creating the Order shipped milestone




					The condition for this milestone is that a case file variable named shipped is true. AdHoc Autostart is not enabled for this milestone. Instead, it is triggered by a signal event when the order is ready to be sent.
				
Procedure
	
							In the process designer, expand Milestone in the Object Library and drag a new milestone on the canvas below the Notify requestor script task.
						
	
							Click the new milestone and click the Properties [image: diagram properties]
							 icon in the upper-right corner.
						
	
							Input Milestone 2: Order shipped in the Name field.
						
	
							Expand Implementation/Execution and ensure that AdHoc Autostart is not selected.
						
	
							Expand Data Assignments, click 
							[image: the Properties icon]
							 in the Assignments field, and add the following:
						
[image: Order shipped ready I/O values]


							Click the Source column drop-down, select Constant, and input org.kie.api.runtime.process.CaseData(data.get("shipped") == true). This means that a case variable named shipped exists with the value true.
						

	
							Click OK.
						
	
							Click Milestone 2: Order shipped and create a new script task.
						
	
							Click the new script task and click the Properties [image: diagram properties]
							 icon in the upper-right corner.
						
	
							Input Send to tracking system in the Name field.
						
	
							Expand Implementation/Execution and input System.out.println("Order added to tracking system");.
						
	
							Click the Send to tracking system script task and create a signal end event.
						
	
							Click the signal event and in the upper-right corner click the Properties. 
							[image: diagram properties]
							 icon.
						
	
							Expand Implementation/Execution, click the down arrow in the Signal field, and select New.
						
	
							Input Milestone 3: Delivered to customer.
						
	
							Click the down arrow in the Signal Scope field, select Process Instance.
						
	
							Click Save.
						
Figure 28.2. Order shipped milestone
[image: Order shipped milestone]






Creating the Delivered to customer milestone




					The condition for this milestone is that a case file variable named delivered is true. AdHoc Autostart is not enabled for this milestone. Instead, it is triggered by a signal event after the order has successfully shipped to the customer.
				
Procedure
	
							In the process designer, expand Milestone in the Object Library and drag a new milestone on the canvas below the Send to tracking system script task.
						
	
							Click the new milestone and click the Properties [image: diagram properties]
							 icon in the upper-right corner.
						
	
							Input Milestone 3: Delivered to customer in the Name field.
						
	
							Expand Implementation/Execution and ensure that AdHoc Autostart is not selected.
						
	
							Expand Data Assignments, click 
							[image: the Properties icon]
							 in the Assignments field, and add the following:
						
[image: Delivered to customer I/O values]


							Click the Source column drop-down, select Constant, and input org.kie.api.runtime.process.CaseData(data.get("delivered") == true). This means that a case variable named delivered exists with the value true.
						

	
							Click OK.
						
	
							Click Milestone 3: Delivered to customer and create a new user task.
						
	
									Click the new user task and click the Properties [image: diagram properties]
									 icon in the upper-right corner.
								
	
									Input Customer satisfaction survey in the Name field.
								
	
									Expand Implementation/Execution, click Add below the Actors menu, click Select → New, and input owner.
								
	
									Input CustomerSurvey in the Task Name field.
								
	
									Select the Skippable check box and enter the following text in the in the Description field:
								

									Satisfaction survey for order #{CaseId}
								

	
									click 
									[image: the Properties icon]
									 in the Assignments field and add the following:
								
[image: survey I/O values]


	
									Click OK.
								



	
							Click the Customer satisfaction survey user task and create an end event.
						
	
							Click Save to confirm your changes.
						
Figure 28.3. Delivered to customer milestone
[image: Delivered to customer milestone]






					The IT Orders case can be closed after all milestone sequences are completed. However, due to the ad hoc nature of cases, the case could be reopened if, for example, the order was never received by the customer or the item is faulty. Tasks can be re-triggered or added to the case definition as required, even during run time.
				


Chapter 29. Deploying and testing the IT order case project




				After you create and define all components of the new IT_Orders_New case project, deploy and test the new project.
			
Prerequisites
	
						You have a running KIE Server instance connected to Business Central. For more information see Installing and configuring Red Hat Process Automation Manager on Red Hat JBoss EAP 7.4.
					
	
						You have created a new case in Business Central. For more information, see Chapter 25, Creating a new IT_Orders case project.
					
	
						You have created the data objects. For more information, see Chapter 26, Data objects.
					
	
						You have created the Place order sub-process. For more information, see the section called “Creating the Place order sub-process”.
					
	
						You have designed the orderhardware case definition. For more information, see Chapter 27, Designing the case definition.
					


Procedure
	
						In Business Central, go to Menu → Design → Projects and click IT_Orders_New.
					
	
						Click Deploy.
					
	
						Go to Menu → Manage → Process Definitions → Manage Process Instances → New Process Instance.
					
	
						Go to Menu → Deploy and click Execution Servers and verify that a new container is deployed and started.
					
	
						Use the Case Management Showcase application to start a new case instance. For instructions about using the Showcase application, see Using the Showcase application for case management.
					



Chapter 30. Additional resources



	
						Designing and building cases for case management
					
	
						Using the Showcase application for case management
					
	
						Getting started with process services
					



Part IV. Getting started with Red Hat build of OptaPlanner





				As a business rules developer, you can use Red Hat build of OptaPlanner to find the optimal solution to planning problems based on a set of limited resources and under specific constraints.
			

				Use this document to start developing solvers with OptaPlanner.
			


Chapter 31. Introduction to Red Hat build of OptaPlanner




				OptaPlanner is a lightweight, embeddable planning engine that optimizes planning problems. It helps normal Java programmers solve planning problems efficiently, and it combines optimization heuristics and metaheuristics with very efficient score calculations.
			

				For example, OptaPlanner helps solve various use cases:
			
	
						Employee/Patient Rosters: It helps create timetables for nurses and keeps track of patient bed management.
					
	
						Educational Timetables: It helps schedule lessons, courses, exams, and conference presentations.
					
	
						Shop Schedules: It tracks car assembly lines, machine queue planning, and workforce task planning.
					
	
						Cutting Stock: It minimizes waste by reducing the consumption of resources such as paper and steel.
					



				Every organization faces planning problems; that is, they provide products and services with a limited set of constrained resources (employees, assets, time, and money).
			

				OptaPlanner is open source software under the Apache Software License 2.0. It is 100% pure Java and runs on most Java virtual machines (JVMs).
			
Planning problems




					A planning problem has an optimal goal, based on limited resources and under specific constraints. Optimal goals can be any number of things, such as:
				
	
							Maximized profits - the optimal goal results in the highest possible profit.
						
	
							Minimized ecological footprint - the optimal goal has the least amount of environmental impact.
						
	
							Maximized satisfaction for employees or customers - the optimal goal prioritizes the needs of employees or customers.
						



					The ability to achieve these goals relies on the number of resources available. For example, the following resources might be limited:
				
	
							Number of people
						
	
							Amount of time
						
	
							Budget
						
	
							Physical assets, for example, machinery, vehicles, computers, buildings
						



					You must also take into account the specific constraints related to these resources, such as the number of hours a person works, their ability to use certain machines, or compatibility between pieces of equipment.
				

					Red Hat build of OptaPlanner helps Java programmers solve constraint satisfaction problems efficiently. It combines optimization heuristics and metaheuristics with efficient score calculation.
				

NP-completeness in planning problems




					The provided use cases are probably NP-complete or NP-hard, which means the following statements apply:
				
	
							It is easy to verify a specific solution to a problem in reasonable time.
						
	
							There is no simple way to find the optimal solution of a problem in reasonable time.
						



					The implication is that solving your problem is probably harder than you anticipated, because the two common techniques do not suffice:
				
	
							A brute force algorithm (even a more advanced variant) takes too long.
						
	
							A quick algorithm, for example in the bin packing problem, putting in the largest items first returns a solution that is far from optimal.
						



					By using advanced optimization algorithms, OptaPlanner finds a good solution in reasonable time for such planning problems.
				

Solutions to planning problems




					A planning problem has a number of solutions.
				

					Several categories of solutions are:
				
	Possible solution
	
								A possible solution is any solution, whether or not it breaks any number of constraints. Planning problems often have an incredibly large number of possible solutions. Many of those solutions are not useful.
							
	Feasible solution
	
								A feasible solution is a solution that does not break any (negative) hard constraints. The number of feasible solutions are relative to the number of possible solutions. Sometimes there are no feasible solutions. Every feasible solution is a possible solution.
							
	Optimal solution
	
								Optimal solutions are the solutions with the highest scores. Planning problems usually have a few optimal solutions. They always have at least one optimal solution, even in the case that there are no feasible solutions and the optimal solution is not feasible.
							
	Best solution found
	
								The best solution is the solution with the highest score found by an implementation in a specified amount of time. The best solution found is likely to be feasible and, given enough time, it’s an optimal solution.
							



					Counterintuitively, the number of possible solutions is huge (if calculated correctly), even with a small data set.
				

					In the examples provided in the planner-engine distribution folder, most instances have a large number of possible solutions. As there is no guaranteed way to find the optimal solution, any implementation is forced to evaluate at least a subset of all those possible solutions.
				

					OptaPlanner supports several optimization algorithms to efficiently wade through that incredibly large number of possible solutions.
				

					Depending on the use case, some optimization algorithms perform better than others, but it is impossible to know in advance. Using OptaPlanner, you can switch the optimization algorithm by changing the solver configuration in a few lines of XML or code.
				

Constraints on planning problems




					Usually, a planning problem has minimum two levels of constraints:
				
	
							A (negative) hard constraint must not be broken.
						

							For example, one teacher can not teach two different lessons at the same time.
						

	
							A (negative) soft constraint should not be broken if it can be avoided.
						

							For example, Teacher A does not like to teach on Friday afternoons.
						




					Some problems also have positive constraints:
				
	
							A positive soft constraint (or reward) should be fulfilled if possible.
						

							For example, Teacher B likes to teach on Monday mornings.
						




					Some basic problems only have hard constraints. Some problems have three or more levels of constraints, for example, hard, medium, and soft constraints.
				

					These constraints define the score calculation (otherwise known as the fitness function) of a planning problem. Each solution of a planning problem is graded with a score. With OptaPlanner, score constraints are written in an object oriented language such as Java, or in Drools rules.
				

					This type of code is flexible and scalable.
				

Examples provided with Red Hat build of OptaPlanner




					Several Red Hat build of OptaPlanner examples are shipped with Red Hat Process Automation Manager. You can review the code for examples and modify it as necessary to suit your needs.
				
Note

						Red Hat does not provide support for the example code included in the Red Hat Process Automation Manager distribution.
					


					Some of the OptaPlanner examples solve problems that are presented in academic contests. The Contest column in the following table lists the contests. It also identifies an example as being either realistic or unrealistic for the purpose of a contest. A realistic contest is an official, independent contest that meets the following standards:
				
	
							Clearly defined real-world use cases
						
	
							Real-world constraints
						
	
							Multiple real-world datasets
						
	
							Reproducible results within a specific time limit on specific hardware
						
	
							Serious participation from the academic and/or enterprise Operations Research community.
						



					Realistic contests provide an objective comparison of OptaPlanner with competitive software and academic research.
				
Table 31.1. Examples overview
	Example	Domain	Size	Contest	Directory name
	 
									N queens
								

								 	 
									1 entity class
								

								 
									(1 variable)
								

								 	 
									Entity ⇐ 256
								

								 
									Value ⇐ 256
								

								 
									Search space ⇐ 10^616
								

								 	 
									Pointless (cheatable)
								

								 	 
									nqueens
								

								 
	 
									Cloud balancing
								

								 	 
									1 entity class
								

								 
									(1 variable)
								

								 	 
									Entity ⇐ 2400
								

								 
									Value ⇐ 800
								

								 
									Search space ⇐ 10^6967
								

								 	 
									No (Defined by us)
								

								 	 
									cloudbalancing
								

								 
	 
									Traveling salesman
								

								 	 
									1 entity class
								

								 
									(1 chained variable)
								

								 	 
									Entity ⇐ 980
								

								 
									Value ⇐ 980
								

								 
									Search space ⇐ 10^2504
								

								 	 
									Unrealistic TSP web
								

								 	 
									tsp
								

								 
	 
									Tennis club scheduling
								

								 	 
									1 entity class
								

								 
									(1 variable)
								

								 	 
									Entity ⇐ 72
								

								 
									Value ⇐ 7
								

								 
									Search space ⇐ 10^60
								

								 	 
									No (Defined by us)
								

								 	 
									tennis
								

								 
	 
									Meeting scheduling
								

								 	 
									1 entity class
								

								 
									(2 variables)
								

								 	 
									Entity ⇐ 10
								

								 
									Value ⇐ 320 and ⇐ 5
								

								 
									Search space ⇐ 10^320
								

								 	 
									No (Defined by us)
								

								 	 
									meetingscheduling
								

								 
	 
									Course timetabling
								

								 	 
									1 entity class
								

								 
									(2 variables)
								

								 	 
									Entity ⇐ 434
								

								 
									Value ⇐ 25 and ⇐ 20
								

								 
									Search space ⇐ 10^1171
								

								 	 
									Realistic ITC 2007 track 3
								

								 	 
									curriculumCourse
								

								 
	 
									Machine reassignment
								

								 	 
									1 entity class
								

								 
									(1 variable)
								

								 	 
									Entity ⇐ 50000
								

								 
									Value ⇐ 5000
								

								 
									Search space ⇐ 10^184948
								

								 	 
									Nearly realistic ROADEF 2012
								

								 	 
									machineReassignment
								

								 
	 
									Vehicle routing
								

								 	 
									1 entity class
								

								 
									(1 chained variable)
								

								 
									1 shadow entity class
								

								 
									(1 automatic shadow variable)
								

								 	 
									Entity ⇐ 2740
								

								 
									Value ⇐ 2795
								

								 
									Search space ⇐ 10^8380
								

								 	 
									Unrealistic VRP web
								

								 	 
									vehiclerouting
								

								 
	 
									Vehicle routing with time windows
								

								 	 
									All of Vehicle routing
								

								 
									(1 shadow variable)
								

								 	 
									Entity ⇐ 2740
								

								 
									Value ⇐ 2795
								

								 
									Search space ⇐ 10^8380
								

								 	 
									Unrealistic VRP web
								

								 	 
									vehiclerouting
								

								 
	 
									Project job scheduling
								

								 	 
									1 entity class
								

								 
									(2 variables)
								

								 
									(1 shadow variable)
								

								 	 
									Entity ⇐ 640
								

								 
									Value ⇐ ? and ⇐ ?
								

								 
									Search space ⇐ ?
								

								 	 
									Nearly realistic MISTA 2013
								

								 	 
									projectjobscheduling
								

								 
	 
									Task assigning
								

								 	 
									1 entity class
								

								 
									(1 chained variable)
								

								 
									(1 shadow variable)
								

								 
									1 shadow entity class
								

								 
									(1 automatic shadow variable)
								

								 	 
									Entity ⇐ 500
								

								 
									Value ⇐ 520
								

								 
									Search space ⇐ 10^1168
								

								 	 
									No Defined by us
								

								 	 
									taskassigning
								

								 
	 
									Exam timetabling
								

								 	 
									2 entity classes (same hierarchy)
								

								 
									(2 variables)
								

								 	 
									Entity ⇐ 1096
								

								 
									Value ⇐ 80 and ⇐ 49
								

								 
									Search space ⇐ 10^3374
								

								 	 
									Realistic ITC 2007 track 1
								

								 	 
									examination
								

								 
	 
									Nurse rostering
								

								 	 
									1 entity class
								

								 
									(1 variable)
								

								 	 
									Entity ⇐ 752
								

								 
									Value ⇐ 50
								

								 
									Search space ⇐ 10^1277
								

								 	 
									Realistic INRC 2010
								

								 	 
									nurserostering
								

								 
	 
									Traveling tournament
								

								 	 
									1 entity class
								

								 
									(1 variable)
								

								 	 
									Entity ⇐ 1560
								

								 
									Value ⇐ 78
								

								 
									Search space ⇐ 10^2301
								

								 	 
									Unrealistic TTP
								

								 	 
									travelingtournament
								

								 
	 
									Cheap time scheduling
								

								 	 
									1 entity class
								

								 
									(2 variables)
								

								 	 
									Entity ⇐ 500
								

								 
									Value ⇐ 100 and ⇐ 288
								

								 
									Search space ⇐ 10^20078
								

								 	 
									Nearly realistic ICON Energy
								

								 	 
									cheaptimescheduling
								

								 
	 
									Investment
								

								 	 
									1 entity class
								

								 
									(1 variable)
								

								 	 
									Entity ⇐ 11
								

								 
									Value = 1000
								

								 
									Search space ⇐ 10^4
								

								 	 
									No Defined by us
								

								 	 
									investment
								

								 
	 
									Conference scheduling
								

								 	 
									1 entity class
								

								 
									(2 variables)
								

								 	 
									Entity ⇐ 216
								

								 
									Value ⇐ 18 and ⇐ 20
								

								 
									Search space ⇐ 10^552
								

								 	 
									No Defined by us
								

								 	 
									conferencescheduling
								

								 
	 
									Rock tour
								

								 	 
									1 entity class
								

								 
									(1 chained variable)
								

								 
									(4 shadow variables)
								

								 
									1 shadow entity class
								

								 
									(1 automatic shadow variable)
								

								 	 
									Entity ⇐ 47
								

								 
									Value ⇐ 48
								

								 
									Search space ⇐ 10^59
								

								 	 
									No Defined by us
								

								 	 
									rocktour
								

								 
	 
									Flight crew scheduling
								

								 	 
									1 entity class
								

								 
									(1 variable)
								

								 
									1 shadow entity class
								

								 
									(1 automatic shadow variable)
								

								 	 
									Entity ⇐ 4375
								

								 
									Value ⇐ 750
								

								 
									Search space ⇐ 10^12578
								

								 	 
									No Defined by us
								

								 	 
									flightcrewscheduling
								

								 




N queens




					Place n number of queens on an n sized chessboard so that no two queens can attack each other. The most common n queens puzzle is the eight queens puzzle, with n = 8:
				
[image: nQueensScreenshot]


					Constraints:
				
	
							Use a chessboard of n columns and n rows.
						
	
							Place n queens on the chessboard.
						
	
							No two queens can attack each other. A queen can attack any other queen on the same horizontal, vertical, or diagonal line.
						



					This documentation heavily uses the four queens puzzle as the primary example.
				

					A proposed solution could be:
				
Figure 31.1. A wrong solution for the four queens puzzle
[image: partiallySolvedNQueens04Explained]



					The above solution is wrong because queens A1 and B0 can attack each other (so can queens B0 and D0). Removing queen B0 would respect the "no two queens can attack each other" constraint, but would break the "place n queens" constraint.
				

					Below is a correct solution:
				
Figure 31.2. A correct solution for the Four queens puzzle
[image: solvedNQueens04]



					All the constraints have been met, so the solution is correct.
				

					Note that most n queens puzzles have multiple correct solutions. We will focus on finding a single correct solution for a specific n, not on finding the number of possible correct solutions for a specific n.
				

Problem size

						

4queens   has   4 queens with a search space of    256.
8queens   has   8 queens with a search space of   10^7.
16queens  has  16 queens with a search space of  10^19.
32queens  has  32 queens with a search space of  10^48.
64queens  has  64 queens with a search space of 10^115.
256queens has 256 queens with a search space of 10^616.


					

					The implementation of the n queens example has not been optimized because it functions as a beginner example. Nevertheless, it can easily handle 64 queens. With a few changes it has been shown to easily handle 5000 queens and more.
				
Domain model for N queens




						This example uses the domain model to solve the four queens problem.
					
	
								Creating a Domain Model
							

								A good domain model will make it easier to understand and solve your planning problem.
							

								This is the domain model for the n queens example:
							
public class Column {

    private int index;

    // ... getters and setters
}
public class Row {

    private int index;

    // ... getters and setters
}
public class Queen {

    private Column column;
    private Row row;

    public int getAscendingDiagonalIndex() {...}
    public int getDescendingDiagonalIndex() {...}

    // ... getters and setters
}

	
								Calculating the Search Space.
							

								A Queen instance has a Column (for example: 0 is column A, 1 is column B, …​) and a Row (its row, for example: 0 is row 0, 1 is row 1, …​).
							

								The ascending diagonal line and the descending diagonal line can be calculated based on the column and the row.
							

								The column and row indexes start from the upper left corner of the chessboard.
							
public class NQueens {

    private int n;
    private List<Column> columnList;
    private List<Row> rowList;

    private List<Queen> queenList;

    private SimpleScore score;

    // ... getters and setters
}

	
								Finding the Solution
							

								A single NQueens instance contains a list of all Queen instances. It is the Solution implementation which will be supplied to, solved by, and retrieved from the Solver.
							




						Notice that in the four queens example, the NQueens getN() method will always return four.
					
Figure 31.3. A solution for Four Queens
[image: partiallySolvedNQueens04Explained]


Table 31.2. Details of the solution in the domain model
	 	columnIndex	rowIndex	ascendingDiagonalIndex (columnIndex + rowIndex)	descendingDiagonalIndex (columnIndex - rowIndex)
	 
										A1
									

									 	 
										0
									

									 	 
										1
									

									 	 
										1 (**)
									

									 	 
										-1
									

									 
	 
										B0
									

									 	 
										1
									

									 	 
										0 (*)
									

									 	 
										1 (**)
									

									 	 
										1
									

									 
	 
										C2
									

									 	 
										2
									

									 	 
										2
									

									 	 
										4
									

									 	 
										0
									

									 
	 
										D0
									

									 	 
										3
									

									 	 
										0 (*)
									

									 	 
										3
									

									 	 
										3
									

									 




						When two queens share the same column, row or diagonal line, such as (*) and (**), they can attack each other.
					


Cloud balancing




					For information about this example, see Red Hat build of OptaPlanner quick start guides.
				

Traveling salesman (TSP - Traveling Salesman Problem)




					Given a list of cities, find the shortest tour for a salesman that visits each city exactly once.
				

					The problem is defined by Wikipedia. It is one of the most intensively studied problems in computational mathematics. Yet, in the real world, it is often only part of a planning problem, along with other constraints, such as employee shift rostering constraints.
				
Problem size

						

dj38     has  38 cities with a search space of   10^43.
europe40 has  40 cities with a search space of   10^46.
st70     has  70 cities with a search space of   10^98.
pcb442   has 442 cities with a search space of  10^976.
lu980    has 980 cities with a search space of 10^2504.


					
Problem difficulty

						Despite TSP’s simple definition, the problem is surprisingly hard to solve. Because it is an NP-hard problem (like most planning problems), the optimal solution for a specific problem dataset can change a lot when that problem dataset is slightly altered:
					
[image: tspOptimalSolutionVolatility]


Tennis club scheduling




					Every week the tennis club has four teams playing round robin against each other. Assign those four spots to the teams fairly.
				

					Hard constraints:
				
	
							Conflict: A team can only play once per day.
						
	
							Unavailability: Some teams are unavailable on some dates.
						



					Medium constraints:
				
	
							Fair assignment: All teams should play an (almost) equal number of times.
						



					Soft constraints:
				
	
							Evenly confrontation: Each team should play against every other team an equal number of times.
						


Problem size

						

munich-7teams has 7 teams, 18 days, 12 unavailabilityPenalties and 72 teamAssignments with a search space of 10^60.


					
Figure 31.4. Domain model
[image: tennisClassDiagram]



Meeting scheduling




					Assign each meeting to a starting time and a room. Meetings have different durations.
				

					Hard constraints:
				
	
							Room conflict: Two meetings must not use the same room at the same time.
						
	
							Required attendance: A person cannot have two required meetings at the same time.
						
	
							Required room capacity: A meeting must not be in a room that doesn’t fit all of the meeting’s attendees.
						
	
							Start and end on same day: A meeting shouldn’t be scheduled over multiple days.
						



					Medium constraints:
				
	
							Preferred attendance: A person cannot have two preferred meetings at the same time, nor a preferred and a required meeting at the same time.
						



					Soft constraints:
				
	
							Sooner rather than later: Schedule all meetings as soon as possible.
						
	
							A break between meetings: Any two meetings should have at least one time grain break between them.
						
	
							Overlapping meetings: To minimize the number of meetings in parallel so people don’t have to choose one meeting over the other.
						
	
							Assign larger rooms first: If a larger room is available any meeting should be assigned to that room in order to accommodate as many people as possible even if they haven’t signed up to that meeting.
						
	
							Room stability: If a person has two consecutive meetings with two or less time grains break between them they better be in the same room.
						


Problem size

						

50meetings-160timegrains-5rooms  has  50 meetings, 160 timeGrains and 5 rooms with a search space of 10^145.
100meetings-320timegrains-5rooms has 100 meetings, 320 timeGrains and 5 rooms with a search space of 10^320.
200meetings-640timegrains-5rooms has 200 meetings, 640 timeGrains and 5 rooms with a search space of 10^701.
400meetings-1280timegrains-5rooms has 400 meetings, 1280 timeGrains and 5 rooms with a search space of 10^1522.
800meetings-2560timegrains-5rooms has 800 meetings, 2560 timeGrains and 5 rooms with a search space of 10^3285.


					

Course timetabling (ITC 2007 Track 3 - Curriculum Course Scheduling)




					Schedule each lecture into a timeslot and into a room.
				

					Hard constraints:
				
	
							Teacher conflict: A teacher must not have two lectures in the same period.
						
	
							Curriculum conflict: A curriculum must not have two lectures in the same period.
						
	
							Room occupancy: Two lectures must not be in the same room in the same period.
						
	
							Unavailable period (specified per dataset): A specific lecture must not be assigned to a specific period.
						



					Soft constraints:
				
	
							Room capacity: A room’s capacity should not be less than the number of students in its lecture.
						
	
							Minimum working days: Lectures of the same course should be spread out into a minimum number of days.
						
	
							Curriculum compactness: Lectures belonging to the same curriculum should be adjacent to each other (so in consecutive periods).
						
	
							Room stability: Lectures of the same course should be assigned to the same room.
						



					The problem is defined by the International Timetabling Competition 2007 track 3.
				
Problem size

						

comp01 has 24 teachers,  14 curricula,  30 courses, 160 lectures, 30 periods,  6 rooms and   53 unavailable period constraints with a search space of  10^360.
comp02 has 71 teachers,  70 curricula,  82 courses, 283 lectures, 25 periods, 16 rooms and  513 unavailable period constraints with a search space of  10^736.
comp03 has 61 teachers,  68 curricula,  72 courses, 251 lectures, 25 periods, 16 rooms and  382 unavailable period constraints with a search space of  10^653.
comp04 has 70 teachers,  57 curricula,  79 courses, 286 lectures, 25 periods, 18 rooms and  396 unavailable period constraints with a search space of  10^758.
comp05 has 47 teachers, 139 curricula,  54 courses, 152 lectures, 36 periods,  9 rooms and  771 unavailable period constraints with a search space of  10^381.
comp06 has 87 teachers,  70 curricula, 108 courses, 361 lectures, 25 periods, 18 rooms and  632 unavailable period constraints with a search space of  10^957.
comp07 has 99 teachers,  77 curricula, 131 courses, 434 lectures, 25 periods, 20 rooms and  667 unavailable period constraints with a search space of 10^1171.
comp08 has 76 teachers,  61 curricula,  86 courses, 324 lectures, 25 periods, 18 rooms and  478 unavailable period constraints with a search space of  10^859.
comp09 has 68 teachers,  75 curricula,  76 courses, 279 lectures, 25 periods, 18 rooms and  405 unavailable period constraints with a search space of  10^740.
comp10 has 88 teachers,  67 curricula, 115 courses, 370 lectures, 25 periods, 18 rooms and  694 unavailable period constraints with a search space of  10^981.
comp11 has 24 teachers,  13 curricula,  30 courses, 162 lectures, 45 periods,  5 rooms and   94 unavailable period constraints with a search space of  10^381.
comp12 has 74 teachers, 150 curricula,  88 courses, 218 lectures, 36 periods, 11 rooms and 1368 unavailable period constraints with a search space of  10^566.
comp13 has 77 teachers,  66 curricula,  82 courses, 308 lectures, 25 periods, 19 rooms and  468 unavailable period constraints with a search space of  10^824.
comp14 has 68 teachers,  60 curricula,  85 courses, 275 lectures, 25 periods, 17 rooms and  486 unavailable period constraints with a search space of  10^722.


					
Figure 31.5. Domain model
[image: curriculumCourseClassDiagram]



Machine reassignment (Google ROADEF 2012)




					Assign each process to a machine. All processes already have an original (unoptimized) assignment. Each process requires an amount of each resource (such as CPU or RAM). This is a more complex version of the Cloud Balancing example.
				

					Hard constraints:
				
	
							Maximum capacity: The maximum capacity for each resource for each machine must not be exceeded.
						
	
							Conflict: Processes of the same service must run on distinct machines.
						
	
							Spread: Processes of the same service must be spread out across locations.
						
	
							Dependency: The processes of a service depending on another service must run in the neighborhood of a process of the other service.
						
	
							Transient usage: Some resources are transient and count towards the maximum capacity of both the original machine as the newly assigned machine.
						



					Soft constraints:
				
	
							Load: The safety capacity for each resource for each machine should not be exceeded.
						
	
							Balance: Leave room for future assignments by balancing the available resources on each machine.
						
	
							Process move cost: A process has a move cost.
						
	
							Service move cost: A service has a move cost.
						
	
							Machine move cost: Moving a process from machine A to machine B has another A-B specific move cost.
						



					The problem is defined by the Google ROADEF/EURO Challenge 2012.
				
[image: cloudOptimizationIsLikeTetris]

Figure 31.6. Value proposition
[image: cloudOptimizationValueProposition]


Problem size

						

model_a1_1 has  2 resources,  1 neighborhoods,   4 locations,    4 machines,    79 services,   100 processes and 1 balancePenalties with a search space of     10^60.
model_a1_2 has  4 resources,  2 neighborhoods,   4 locations,  100 machines,   980 services,  1000 processes and 0 balancePenalties with a search space of   10^2000.
model_a1_3 has  3 resources,  5 neighborhoods,  25 locations,  100 machines,   216 services,  1000 processes and 0 balancePenalties with a search space of   10^2000.
model_a1_4 has  3 resources, 50 neighborhoods,  50 locations,   50 machines,   142 services,  1000 processes and 1 balancePenalties with a search space of   10^1698.
model_a1_5 has  4 resources,  2 neighborhoods,   4 locations,   12 machines,   981 services,  1000 processes and 1 balancePenalties with a search space of   10^1079.
model_a2_1 has  3 resources,  1 neighborhoods,   1 locations,  100 machines,  1000 services,  1000 processes and 0 balancePenalties with a search space of   10^2000.
model_a2_2 has 12 resources,  5 neighborhoods,  25 locations,  100 machines,   170 services,  1000 processes and 0 balancePenalties with a search space of   10^2000.
model_a2_3 has 12 resources,  5 neighborhoods,  25 locations,  100 machines,   129 services,  1000 processes and 0 balancePenalties with a search space of   10^2000.
model_a2_4 has 12 resources,  5 neighborhoods,  25 locations,   50 machines,   180 services,  1000 processes and 1 balancePenalties with a search space of   10^1698.
model_a2_5 has 12 resources,  5 neighborhoods,  25 locations,   50 machines,   153 services,  1000 processes and 0 balancePenalties with a search space of   10^1698.
model_b_1  has 12 resources,  5 neighborhoods,  10 locations,  100 machines,  2512 services,  5000 processes and 0 balancePenalties with a search space of  10^10000.
model_b_2  has 12 resources,  5 neighborhoods,  10 locations,  100 machines,  2462 services,  5000 processes and 1 balancePenalties with a search space of  10^10000.
model_b_3  has  6 resources,  5 neighborhoods,  10 locations,  100 machines, 15025 services, 20000 processes and 0 balancePenalties with a search space of  10^40000.
model_b_4  has  6 resources,  5 neighborhoods,  50 locations,  500 machines,  1732 services, 20000 processes and 1 balancePenalties with a search space of  10^53979.
model_b_5  has  6 resources,  5 neighborhoods,  10 locations,  100 machines, 35082 services, 40000 processes and 0 balancePenalties with a search space of  10^80000.
model_b_6  has  6 resources,  5 neighborhoods,  50 locations,  200 machines, 14680 services, 40000 processes and 1 balancePenalties with a search space of  10^92041.
model_b_7  has  6 resources,  5 neighborhoods,  50 locations, 4000 machines, 15050 services, 40000 processes and 1 balancePenalties with a search space of 10^144082.
model_b_8  has  3 resources,  5 neighborhoods,  10 locations,  100 machines, 45030 services, 50000 processes and 0 balancePenalties with a search space of 10^100000.
model_b_9  has  3 resources,  5 neighborhoods, 100 locations, 1000 machines,  4609 services, 50000 processes and 1 balancePenalties with a search space of 10^150000.
model_b_10 has  3 resources,  5 neighborhoods, 100 locations, 5000 machines,  4896 services, 50000 processes and 1 balancePenalties with a search space of 10^184948.


					
Figure 31.7. Domain model
[image: machineReassignmentClassDiagram]



Vehicle routing




					Using a fleet of vehicles, pick up the objects of each customer and bring them to the depot. Each vehicle can service multiple customers, but it has a limited capacity.
				
[image: vehicleRoutingUseCase]


					Besides the basic case (CVRP), there is also a variant with time windows (CVRPTW).
				

					Hard constraints:
				
	
							Vehicle capacity: a vehicle cannot carry more items then its capacity.
						
	
							Time windows (only in CVRPTW):
						
	
									Travel time: Traveling from one location to another takes time.
								
	
									Customer service duration: A vehicle must stay at the customer for the length of the service duration.
								
	
									Customer ready time: A vehicle may arrive before the customer’s ready time, but it must wait until the ready time before servicing.
								
	
									Customer due time: A vehicle must arrive on time, before the customer’s due time.
								






					Soft constraints:
				
	
							Total distance: Minimize the total distance driven (fuel consumption) of all vehicles.
						



					The capacitated vehicle routing problem (CVRP) and its time-windowed variant (CVRPTW) are defined by the VRP web.
				
Figure 31.8. Value proposition
[image: vehicleRoutingValueProposition]


Problem size

						CVRP instances (without time windows):
					
belgium-n50-k10             has  1 depots, 10 vehicles and   49 customers with a search space of   10^74.
belgium-n100-k10            has  1 depots, 10 vehicles and   99 customers with a search space of  10^170.
belgium-n500-k20            has  1 depots, 20 vehicles and  499 customers with a search space of 10^1168.
belgium-n1000-k20           has  1 depots, 20 vehicles and  999 customers with a search space of 10^2607.
belgium-n2750-k55           has  1 depots, 55 vehicles and 2749 customers with a search space of 10^8380.
belgium-road-km-n50-k10     has  1 depots, 10 vehicles and   49 customers with a search space of   10^74.
belgium-road-km-n100-k10    has  1 depots, 10 vehicles and   99 customers with a search space of  10^170.
belgium-road-km-n500-k20    has  1 depots, 20 vehicles and  499 customers with a search space of 10^1168.
belgium-road-km-n1000-k20   has  1 depots, 20 vehicles and  999 customers with a search space of 10^2607.
belgium-road-km-n2750-k55   has  1 depots, 55 vehicles and 2749 customers with a search space of 10^8380.
belgium-road-time-n50-k10   has  1 depots, 10 vehicles and   49 customers with a search space of   10^74.
belgium-road-time-n100-k10  has  1 depots, 10 vehicles and   99 customers with a search space of  10^170.
belgium-road-time-n500-k20  has  1 depots, 20 vehicles and  499 customers with a search space of 10^1168.
belgium-road-time-n1000-k20 has  1 depots, 20 vehicles and  999 customers with a search space of 10^2607.
belgium-road-time-n2750-k55 has  1 depots, 55 vehicles and 2749 customers with a search space of 10^8380.
belgium-d2-n50-k10          has  2 depots, 10 vehicles and   48 customers with a search space of   10^74.
belgium-d3-n100-k10         has  3 depots, 10 vehicles and   97 customers with a search space of  10^170.
belgium-d5-n500-k20         has  5 depots, 20 vehicles and  495 customers with a search space of 10^1168.
belgium-d8-n1000-k20        has  8 depots, 20 vehicles and  992 customers with a search space of 10^2607.
belgium-d10-n2750-k55       has 10 depots, 55 vehicles and 2740 customers with a search space of 10^8380.

A-n32-k5  has 1 depots,  5 vehicles and  31 customers with a search space of  10^40.
A-n33-k5  has 1 depots,  5 vehicles and  32 customers with a search space of  10^41.
A-n33-k6  has 1 depots,  6 vehicles and  32 customers with a search space of  10^42.
A-n34-k5  has 1 depots,  5 vehicles and  33 customers with a search space of  10^43.
A-n36-k5  has 1 depots,  5 vehicles and  35 customers with a search space of  10^46.
A-n37-k5  has 1 depots,  5 vehicles and  36 customers with a search space of  10^48.
A-n37-k6  has 1 depots,  6 vehicles and  36 customers with a search space of  10^49.
A-n38-k5  has 1 depots,  5 vehicles and  37 customers with a search space of  10^49.
A-n39-k5  has 1 depots,  5 vehicles and  38 customers with a search space of  10^51.
A-n39-k6  has 1 depots,  6 vehicles and  38 customers with a search space of  10^52.
A-n44-k7  has 1 depots,  7 vehicles and  43 customers with a search space of  10^61.
A-n45-k6  has 1 depots,  6 vehicles and  44 customers with a search space of  10^62.
A-n45-k7  has 1 depots,  7 vehicles and  44 customers with a search space of  10^63.
A-n46-k7  has 1 depots,  7 vehicles and  45 customers with a search space of  10^65.
A-n48-k7  has 1 depots,  7 vehicles and  47 customers with a search space of  10^68.
A-n53-k7  has 1 depots,  7 vehicles and  52 customers with a search space of  10^77.
A-n54-k7  has 1 depots,  7 vehicles and  53 customers with a search space of  10^79.
A-n55-k9  has 1 depots,  9 vehicles and  54 customers with a search space of  10^82.
A-n60-k9  has 1 depots,  9 vehicles and  59 customers with a search space of  10^91.
A-n61-k9  has 1 depots,  9 vehicles and  60 customers with a search space of  10^93.
A-n62-k8  has 1 depots,  8 vehicles and  61 customers with a search space of  10^94.
A-n63-k9  has 1 depots,  9 vehicles and  62 customers with a search space of  10^97.
A-n63-k10 has 1 depots, 10 vehicles and  62 customers with a search space of  10^98.
A-n64-k9  has 1 depots,  9 vehicles and  63 customers with a search space of  10^99.
A-n65-k9  has 1 depots,  9 vehicles and  64 customers with a search space of 10^101.
A-n69-k9  has 1 depots,  9 vehicles and  68 customers with a search space of 10^108.
A-n80-k10 has 1 depots, 10 vehicles and  79 customers with a search space of 10^130.
F-n45-k4  has 1 depots,  4 vehicles and  44 customers with a search space of  10^60.
F-n72-k4  has 1 depots,  4 vehicles and  71 customers with a search space of 10^108.
F-n135-k7 has 1 depots,  7 vehicles and 134 customers with a search space of 10^240.

					CVRPTW instances (with time windows):
				
belgium-tw-d2-n50-k10    has  2 depots, 10 vehicles and   48 customers with a search space of   10^74.
belgium-tw-d3-n100-k10   has  3 depots, 10 vehicles and   97 customers with a search space of  10^170.
belgium-tw-d5-n500-k20   has  5 depots, 20 vehicles and  495 customers with a search space of 10^1168.
belgium-tw-d8-n1000-k20  has  8 depots, 20 vehicles and  992 customers with a search space of 10^2607.
belgium-tw-d10-n2750-k55 has 10 depots, 55 vehicles and 2740 customers with a search space of 10^8380.
belgium-tw-n50-k10       has  1 depots, 10 vehicles and   49 customers with a search space of   10^74.
belgium-tw-n100-k10      has  1 depots, 10 vehicles and   99 customers with a search space of  10^170.
belgium-tw-n500-k20      has  1 depots, 20 vehicles and  499 customers with a search space of 10^1168.
belgium-tw-n1000-k20     has  1 depots, 20 vehicles and  999 customers with a search space of 10^2607.
belgium-tw-n2750-k55     has  1 depots, 55 vehicles and 2749 customers with a search space of 10^8380.

Solomon_025_C101       has 1 depots,  25 vehicles and   25 customers with a search space of   10^40.
Solomon_025_C201       has 1 depots,  25 vehicles and   25 customers with a search space of   10^40.
Solomon_025_R101       has 1 depots,  25 vehicles and   25 customers with a search space of   10^40.
Solomon_025_R201       has 1 depots,  25 vehicles and   25 customers with a search space of   10^40.
Solomon_025_RC101      has 1 depots,  25 vehicles and   25 customers with a search space of   10^40.
Solomon_025_RC201      has 1 depots,  25 vehicles and   25 customers with a search space of   10^40.
Solomon_100_C101       has 1 depots,  25 vehicles and  100 customers with a search space of  10^185.
Solomon_100_C201       has 1 depots,  25 vehicles and  100 customers with a search space of  10^185.
Solomon_100_R101       has 1 depots,  25 vehicles and  100 customers with a search space of  10^185.
Solomon_100_R201       has 1 depots,  25 vehicles and  100 customers with a search space of  10^185.
Solomon_100_RC101      has 1 depots,  25 vehicles and  100 customers with a search space of  10^185.
Solomon_100_RC201      has 1 depots,  25 vehicles and  100 customers with a search space of  10^185.
Homberger_0200_C1_2_1  has 1 depots,  50 vehicles and  200 customers with a search space of  10^429.
Homberger_0200_C2_2_1  has 1 depots,  50 vehicles and  200 customers with a search space of  10^429.
Homberger_0200_R1_2_1  has 1 depots,  50 vehicles and  200 customers with a search space of  10^429.
Homberger_0200_R2_2_1  has 1 depots,  50 vehicles and  200 customers with a search space of  10^429.
Homberger_0200_RC1_2_1 has 1 depots,  50 vehicles and  200 customers with a search space of  10^429.
Homberger_0200_RC2_2_1 has 1 depots,  50 vehicles and  200 customers with a search space of  10^429.
Homberger_0400_C1_4_1  has 1 depots, 100 vehicles and  400 customers with a search space of  10^978.
Homberger_0400_C2_4_1  has 1 depots, 100 vehicles and  400 customers with a search space of  10^978.
Homberger_0400_R1_4_1  has 1 depots, 100 vehicles and  400 customers with a search space of  10^978.
Homberger_0400_R2_4_1  has 1 depots, 100 vehicles and  400 customers with a search space of  10^978.
Homberger_0400_RC1_4_1 has 1 depots, 100 vehicles and  400 customers with a search space of  10^978.
Homberger_0400_RC2_4_1 has 1 depots, 100 vehicles and  400 customers with a search space of  10^978.
Homberger_0600_C1_6_1  has 1 depots, 150 vehicles and  600 customers with a search space of 10^1571.
Homberger_0600_C2_6_1  has 1 depots, 150 vehicles and  600 customers with a search space of 10^1571.
Homberger_0600_R1_6_1  has 1 depots, 150 vehicles and  600 customers with a search space of 10^1571.
Homberger_0600_R2_6_1  has 1 depots, 150 vehicles and  600 customers with a search space of 10^1571.
Homberger_0600_RC1_6_1 has 1 depots, 150 vehicles and  600 customers with a search space of 10^1571.
Homberger_0600_RC2_6_1 has 1 depots, 150 vehicles and  600 customers with a search space of 10^1571.
Homberger_0800_C1_8_1  has 1 depots, 200 vehicles and  800 customers with a search space of 10^2195.
Homberger_0800_C2_8_1  has 1 depots, 200 vehicles and  800 customers with a search space of 10^2195.
Homberger_0800_R1_8_1  has 1 depots, 200 vehicles and  800 customers with a search space of 10^2195.
Homberger_0800_R2_8_1  has 1 depots, 200 vehicles and  800 customers with a search space of 10^2195.
Homberger_0800_RC1_8_1 has 1 depots, 200 vehicles and  800 customers with a search space of 10^2195.
Homberger_0800_RC2_8_1 has 1 depots, 200 vehicles and  800 customers with a search space of 10^2195.
Homberger_1000_C110_1  has 1 depots, 250 vehicles and 1000 customers with a search space of 10^2840.
Homberger_1000_C210_1  has 1 depots, 250 vehicles and 1000 customers with a search space of 10^2840.
Homberger_1000_R110_1  has 1 depots, 250 vehicles and 1000 customers with a search space of 10^2840.
Homberger_1000_R210_1  has 1 depots, 250 vehicles and 1000 customers with a search space of 10^2840.
Homberger_1000_RC110_1 has 1 depots, 250 vehicles and 1000 customers with a search space of 10^2840.
Homberger_1000_RC210_1 has 1 depots, 250 vehicles and 1000 customers with a search space of 10^2840.
Domain model for Vehicle routing



[image: vehicleRoutingClassDiagram]


						The vehicle routing with time windows domain model makes heavy use of the shadow variable feature. This allows it to express its constraints more naturally, because properties such as arrivalTime and departureTime, are directly available on the domain model.
					
Road Distances Instead of Air Distances

							In the real world, vehicles cannot follow a straight line from location to location: they have to use roads and highways. From a business point of view, this matters a lot:
						
[image: vehicleRoutingDistanceType]


						For the optimization algorithm, this does not matter much, as long as the distance between two points can be looked up (and are preferably precalculated). The road cost does not even need to be a distance. It can also be travel time, fuel cost, or a weighted function of those. There are several technologies available to precalculate road costs, such as GraphHopper (embeddable, offline Java engine), Open MapQuest (web service) and Google Maps Client API (web service).
					
[image: integrationWithRealMaps]


						There are also several technologies to render it, such as Leaflet and Google Maps for developers.
					
[image: vehicleRoutingLeafletAndGoogleMaps]


						It is even possible to render the actual road routes with GraphHopper or Google Map Directions, but because of route overlaps on highways, it can become harder to see the standstill order:
					
[image: vehicleRoutingGoogleMapsDirections]


						Take special care that the road costs between two points use the same optimization criteria as the one used in OptaPlanner. For example, GraphHopper will by default return the fastest route, not the shortest route. Don’t use the km (or miles) distances of the fastest GPS routes to optimize the shortest trip in OptaPlanner: this leads to a suboptimal solution as shown below:
					
[image: roadDistanceTriangleInequality]


						Contrary to popular belief, most users do not want the shortest route: they want the fastest route instead. They prefer highways over normal roads. They prefer normal roads over dirt roads. In the real world, the fastest and shortest route are rarely the same.
					


Project job scheduling




					Schedule all jobs in time and execution mode to minimize project delays. Each job is part of a project. A job can be executed in different ways: each way is an execution mode that implies a different duration but also different resource usages. This is a form of flexible job shop scheduling.
				
[image: projectJobSchedulingUseCase]


					Hard constraints:
				
	
							Job precedence: a job can only start when all its predecessor jobs are finished.
						
	
							Resource capacity: do not use more resources than available.
						
	
									Resources are local (shared between jobs of the same project) or global (shared between all jobs)
								
	
									Resources are renewable (capacity available per day) or nonrenewable (capacity available for all days)
								






					Medium constraints:
				
	
							Total project delay: minimize the duration (makespan) of each project.
						



					Soft constraints:
				
	
							Total makespan: minimize the duration of the whole multi-project schedule.
						



					The problem is defined by the MISTA 2013 challenge.
				
Problem size

						

Schedule A-1  has  2 projects,  24 jobs,   64 execution modes,  7 resources and  150 resource requirements.
Schedule A-2  has  2 projects,  44 jobs,  124 execution modes,  7 resources and  420 resource requirements.
Schedule A-3  has  2 projects,  64 jobs,  184 execution modes,  7 resources and  630 resource requirements.
Schedule A-4  has  5 projects,  60 jobs,  160 execution modes, 16 resources and  390 resource requirements.
Schedule A-5  has  5 projects, 110 jobs,  310 execution modes, 16 resources and  900 resource requirements.
Schedule A-6  has  5 projects, 160 jobs,  460 execution modes, 16 resources and 1440 resource requirements.
Schedule A-7  has 10 projects, 120 jobs,  320 execution modes, 22 resources and  900 resource requirements.
Schedule A-8  has 10 projects, 220 jobs,  620 execution modes, 22 resources and 1860 resource requirements.
Schedule A-9  has 10 projects, 320 jobs,  920 execution modes, 31 resources and 2880 resource requirements.
Schedule A-10 has 10 projects, 320 jobs,  920 execution modes, 31 resources and 2970 resource requirements.
Schedule B-1  has 10 projects, 120 jobs,  320 execution modes, 31 resources and  900 resource requirements.
Schedule B-2  has 10 projects, 220 jobs,  620 execution modes, 22 resources and 1740 resource requirements.
Schedule B-3  has 10 projects, 320 jobs,  920 execution modes, 31 resources and 3060 resource requirements.
Schedule B-4  has 15 projects, 180 jobs,  480 execution modes, 46 resources and 1530 resource requirements.
Schedule B-5  has 15 projects, 330 jobs,  930 execution modes, 46 resources and 2760 resource requirements.
Schedule B-6  has 15 projects, 480 jobs, 1380 execution modes, 46 resources and 4500 resource requirements.
Schedule B-7  has 20 projects, 240 jobs,  640 execution modes, 61 resources and 1710 resource requirements.
Schedule B-8  has 20 projects, 440 jobs, 1240 execution modes, 42 resources and 3180 resource requirements.
Schedule B-9  has 20 projects, 640 jobs, 1840 execution modes, 61 resources and 5940 resource requirements.
Schedule B-10 has 20 projects, 460 jobs, 1300 execution modes, 42 resources and 4260 resource requirements.


					

Task assigning




					Assign each task to a spot in an employee’s queue. Each task has a duration which is affected by the employee’s affinity level with the task’s customer.
				

					Hard constraints:
				
	
							Skill: Each task requires one or more skills. The employee must possess all these skills.
						



					Soft level 0 constraints:
				
	
							Critical tasks: Complete critical tasks first, sooner than major and minor tasks.
						



					Soft level 1 constraints:
				
	
							Minimize makespan: Reduce the time to complete all tasks.
						
	
									Start with the longest working employee first, then the second longest working employee and so forth, to create fairness and load balancing.
								






					Soft level 2 constraints:
				
	
							Major tasks: Complete major tasks as soon as possible, sooner than minor tasks.
						



					Soft level 3 constraints:
				
	
							Minor tasks: Complete minor tasks as soon as possible.
						


Figure 31.9. Value proposition
[image: taskAssigningValueProposition]


Problem size

						

24tasks-8employees   has  24 tasks, 6 skills,  8 employees,   4 task types and  4 customers with a search space of   10^30.
50tasks-5employees   has  50 tasks, 5 skills,  5 employees,  10 task types and 10 customers with a search space of   10^69.
100tasks-5employees  has 100 tasks, 5 skills,  5 employees,  20 task types and 15 customers with a search space of  10^164.
500tasks-20employees has 500 tasks, 6 skills, 20 employees, 100 task types and 60 customers with a search space of 10^1168.


					
Figure 31.10. Domain model
[image: taskAssigningClassDiagram]



Exam timetabling (ITC 2007 track 1 - Examination)




					Schedule each exam into a period and into a room. Multiple exams can share the same room during the same period.
				
[image: examinationTimetablingUseCase]


					Hard constraints:
				
	
							Exam conflict: Two exams that share students must not occur in the same period.
						
	
							Room capacity: A room’s seating capacity must suffice at all times.
						
	
							Period duration: A period’s duration must suffice for all of its exams.
						
	
							Period related hard constraints (specified per dataset):
						
	
									Coincidence: Two specified exams must use the same period (but possibly another room).
								
	
									Exclusion: Two specified exams must not use the same period.
								
	
									After: A specified exam must occur in a period after another specified exam’s period.
								



	
							Room related hard constraints (specified per dataset):
						
	
									Exclusive: One specified exam should not have to share its room with any other exam.
								






					Soft constraints (each of which has a parametrized penalty):
				
	
							The same student should not have two exams in a row.
						
	
							The same student should not have two exams on the same day.
						
	
							Period spread: Two exams that share students should be a number of periods apart.
						
	
							Mixed durations: Two exams that share a room should not have different durations.
						
	
							Front load: Large exams should be scheduled earlier in the schedule.
						
	
							Period penalty (specified per dataset): Some periods have a penalty when used.
						
	
							Room penalty (specified per dataset): Some rooms have a penalty when used.
						



					It uses large test data sets of real-life universities.
				

					The problem is defined by the International Timetabling Competition 2007 track 1. Geoffrey De Smet finished 4th in that competition with a very early version of OptaPlanner. Many improvements have been made since then.
				

Problem Size

						

exam_comp_set1 has  7883 students,  607 exams, 54 periods,  7 rooms,  12 period constraints and  0 room constraints with a search space of 10^1564.
exam_comp_set2 has 12484 students,  870 exams, 40 periods, 49 rooms,  12 period constraints and  2 room constraints with a search space of 10^2864.
exam_comp_set3 has 16365 students,  934 exams, 36 periods, 48 rooms, 168 period constraints and 15 room constraints with a search space of 10^3023.
exam_comp_set4 has  4421 students,  273 exams, 21 periods,  1 rooms,  40 period constraints and  0 room constraints with a search space of  10^360.
exam_comp_set5 has  8719 students, 1018 exams, 42 periods,  3 rooms,  27 period constraints and  0 room constraints with a search space of 10^2138.
exam_comp_set6 has  7909 students,  242 exams, 16 periods,  8 rooms,  22 period constraints and  0 room constraints with a search space of  10^509.
exam_comp_set7 has 13795 students, 1096 exams, 80 periods, 15 rooms,  28 period constraints and  0 room constraints with a search space of 10^3374.
exam_comp_set8 has  7718 students,  598 exams, 80 periods,  8 rooms,  20 period constraints and  1 room constraints with a search space of 10^1678.


					
Domain model for exam timetabling




						The following diagram shows the main examination domain classes:
					
Figure 31.11. Examination domain class diagram
[image: examinationDomainDiagram]



						Notice that we’ve split up the exam concept into an Exam class and a Topic class. The Exam instances change during solving (this is the planning entity class), when their period or room property changes. The Topic, Period and Room instances never change during solving (these are problem facts, just like some other classes).
					


Nurse rostering (INRC 2010)




					For each shift, assign a nurse to work that shift.
				
[image: employeeShiftRosteringUseCase]


					Hard constraints:
				
	
							No unassigned shifts (built-in): Every shift need to be assigned to an employee.
						
	
							Shift conflict: An employee can have only one shift per day.
						



					Soft constraints:
				
	
							Contract obligations. The business frequently violates these, so they decided to define these as soft constraints instead of hard constraints.
						
	
									Minimum and maximum assignments: Each employee needs to work more than x shifts and less than y shifts (depending on their contract).
								
	
									Minimum and maximum consecutive working days: Each employee needs to work between x and y days in a row (depending on their contract).
								
	
									Minimum and maximum consecutive free days: Each employee needs to be free between x and y days in a row (depending on their contract).
								
	
									Minimum and maximum consecutive working weekends: Each employee needs to work between x and y weekends in a row (depending on their contract).
								
	
									Complete weekends: Each employee needs to work every day in a weekend or not at all.
								
	
									Identical shift types during weekend: Each weekend shift for the same weekend of the same employee must be the same shift type.
								
	
									Unwanted patterns: A combination of unwanted shift types in a row, for example a late shift followed by an early shift followed by a late shift.
								



	
							Employee wishes:
						
	
									Day on request: An employee wants to work on a specific day.
								
	
									Day off request: An employee does not want to work on a specific day.
								
	
									Shift on request: An employee wants to be assigned to a specific shift.
								
	
									Shift off request: An employee does not want to be assigned to a specific shift.
								



	
							Alternative skill: An employee assigned to a skill should have a proficiency in every skill required by that shift.
						



					The problem is defined by the International Nurse Rostering Competition 2010.
				
Figure 31.12. Value proposition
[image: employeeRosteringValueProposition]


Problem size

						There are three dataset types:
					
	
							Sprint: must be solved in seconds.
						
	
							Medium: must be solved in minutes.
						
	
							Long: must be solved in hours.
						


toy1          has 1 skills, 3 shiftTypes, 2 patterns, 1 contracts,  6 employees,  7 shiftDates,  35 shiftAssignments and   0 requests with a search space of   10^27.
toy2          has 1 skills, 3 shiftTypes, 3 patterns, 2 contracts, 20 employees, 28 shiftDates, 180 shiftAssignments and 140 requests with a search space of  10^234.

sprint01      has 1 skills, 4 shiftTypes, 3 patterns, 4 contracts, 10 employees, 28 shiftDates, 152 shiftAssignments and 150 requests with a search space of  10^152.
sprint02      has 1 skills, 4 shiftTypes, 3 patterns, 4 contracts, 10 employees, 28 shiftDates, 152 shiftAssignments and 150 requests with a search space of  10^152.
sprint03      has 1 skills, 4 shiftTypes, 3 patterns, 4 contracts, 10 employees, 28 shiftDates, 152 shiftAssignments and 150 requests with a search space of  10^152.
sprint04      has 1 skills, 4 shiftTypes, 3 patterns, 4 contracts, 10 employees, 28 shiftDates, 152 shiftAssignments and 150 requests with a search space of  10^152.
sprint05      has 1 skills, 4 shiftTypes, 3 patterns, 4 contracts, 10 employees, 28 shiftDates, 152 shiftAssignments and 150 requests with a search space of  10^152.
sprint06      has 1 skills, 4 shiftTypes, 3 patterns, 4 contracts, 10 employees, 28 shiftDates, 152 shiftAssignments and 150 requests with a search space of  10^152.
sprint07      has 1 skills, 4 shiftTypes, 3 patterns, 4 contracts, 10 employees, 28 shiftDates, 152 shiftAssignments and 150 requests with a search space of  10^152.
sprint08      has 1 skills, 4 shiftTypes, 3 patterns, 4 contracts, 10 employees, 28 shiftDates, 152 shiftAssignments and 150 requests with a search space of  10^152.
sprint09      has 1 skills, 4 shiftTypes, 3 patterns, 4 contracts, 10 employees, 28 shiftDates, 152 shiftAssignments and 150 requests with a search space of  10^152.
sprint10      has 1 skills, 4 shiftTypes, 3 patterns, 4 contracts, 10 employees, 28 shiftDates, 152 shiftAssignments and 150 requests with a search space of  10^152.
sprint_hint01 has 1 skills, 4 shiftTypes, 8 patterns, 3 contracts, 10 employees, 28 shiftDates, 152 shiftAssignments and 150 requests with a search space of  10^152.
sprint_hint02 has 1 skills, 4 shiftTypes, 0 patterns, 3 contracts, 10 employees, 28 shiftDates, 152 shiftAssignments and 150 requests with a search space of  10^152.
sprint_hint03 has 1 skills, 4 shiftTypes, 8 patterns, 3 contracts, 10 employees, 28 shiftDates, 152 shiftAssignments and 150 requests with a search space of  10^152.
sprint_late01 has 1 skills, 4 shiftTypes, 8 patterns, 3 contracts, 10 employees, 28 shiftDates, 152 shiftAssignments and 150 requests with a search space of  10^152.
sprint_late02 has 1 skills, 3 shiftTypes, 4 patterns, 3 contracts, 10 employees, 28 shiftDates, 144 shiftAssignments and 139 requests with a search space of  10^144.
sprint_late03 has 1 skills, 4 shiftTypes, 8 patterns, 3 contracts, 10 employees, 28 shiftDates, 160 shiftAssignments and 150 requests with a search space of  10^160.
sprint_late04 has 1 skills, 4 shiftTypes, 8 patterns, 3 contracts, 10 employees, 28 shiftDates, 160 shiftAssignments and 150 requests with a search space of  10^160.
sprint_late05 has 1 skills, 4 shiftTypes, 8 patterns, 3 contracts, 10 employees, 28 shiftDates, 152 shiftAssignments and 150 requests with a search space of  10^152.
sprint_late06 has 1 skills, 4 shiftTypes, 0 patterns, 3 contracts, 10 employees, 28 shiftDates, 152 shiftAssignments and 150 requests with a search space of  10^152.
sprint_late07 has 1 skills, 4 shiftTypes, 0 patterns, 3 contracts, 10 employees, 28 shiftDates, 152 shiftAssignments and 150 requests with a search space of  10^152.
sprint_late08 has 1 skills, 4 shiftTypes, 0 patterns, 3 contracts, 10 employees, 28 shiftDates, 152 shiftAssignments and   0 requests with a search space of  10^152.
sprint_late09 has 1 skills, 4 shiftTypes, 0 patterns, 3 contracts, 10 employees, 28 shiftDates, 152 shiftAssignments and   0 requests with a search space of  10^152.
sprint_late10 has 1 skills, 4 shiftTypes, 0 patterns, 3 contracts, 10 employees, 28 shiftDates, 152 shiftAssignments and 150 requests with a search space of  10^152.

medium01      has 1 skills, 4 shiftTypes, 0 patterns, 4 contracts, 31 employees, 28 shiftDates, 608 shiftAssignments and 403 requests with a search space of  10^906.
medium02      has 1 skills, 4 shiftTypes, 0 patterns, 4 contracts, 31 employees, 28 shiftDates, 608 shiftAssignments and 403 requests with a search space of  10^906.
medium03      has 1 skills, 4 shiftTypes, 0 patterns, 4 contracts, 31 employees, 28 shiftDates, 608 shiftAssignments and 403 requests with a search space of  10^906.
medium04      has 1 skills, 4 shiftTypes, 0 patterns, 4 contracts, 31 employees, 28 shiftDates, 608 shiftAssignments and 403 requests with a search space of  10^906.
medium05      has 1 skills, 4 shiftTypes, 0 patterns, 4 contracts, 31 employees, 28 shiftDates, 608 shiftAssignments and 403 requests with a search space of  10^906.
medium_hint01 has 1 skills, 4 shiftTypes, 7 patterns, 4 contracts, 30 employees, 28 shiftDates, 428 shiftAssignments and 390 requests with a search space of  10^632.
medium_hint02 has 1 skills, 4 shiftTypes, 7 patterns, 3 contracts, 30 employees, 28 shiftDates, 428 shiftAssignments and 390 requests with a search space of  10^632.
medium_hint03 has 1 skills, 4 shiftTypes, 7 patterns, 4 contracts, 30 employees, 28 shiftDates, 428 shiftAssignments and 390 requests with a search space of  10^632.
medium_late01 has 1 skills, 4 shiftTypes, 7 patterns, 4 contracts, 30 employees, 28 shiftDates, 424 shiftAssignments and 390 requests with a search space of  10^626.
medium_late02 has 1 skills, 4 shiftTypes, 7 patterns, 3 contracts, 30 employees, 28 shiftDates, 428 shiftAssignments and 390 requests with a search space of  10^632.
medium_late03 has 1 skills, 4 shiftTypes, 0 patterns, 4 contracts, 30 employees, 28 shiftDates, 428 shiftAssignments and 390 requests with a search space of  10^632.
medium_late04 has 1 skills, 4 shiftTypes, 7 patterns, 3 contracts, 30 employees, 28 shiftDates, 416 shiftAssignments and 390 requests with a search space of  10^614.
medium_late05 has 2 skills, 5 shiftTypes, 7 patterns, 4 contracts, 30 employees, 28 shiftDates, 452 shiftAssignments and 390 requests with a search space of  10^667.

long01        has 2 skills, 5 shiftTypes, 3 patterns, 3 contracts, 49 employees, 28 shiftDates, 740 shiftAssignments and 735 requests with a search space of 10^1250.
long02        has 2 skills, 5 shiftTypes, 3 patterns, 3 contracts, 49 employees, 28 shiftDates, 740 shiftAssignments and 735 requests with a search space of 10^1250.
long03        has 2 skills, 5 shiftTypes, 3 patterns, 3 contracts, 49 employees, 28 shiftDates, 740 shiftAssignments and 735 requests with a search space of 10^1250.
long04        has 2 skills, 5 shiftTypes, 3 patterns, 3 contracts, 49 employees, 28 shiftDates, 740 shiftAssignments and 735 requests with a search space of 10^1250.
long05        has 2 skills, 5 shiftTypes, 3 patterns, 3 contracts, 49 employees, 28 shiftDates, 740 shiftAssignments and 735 requests with a search space of 10^1250.
long_hint01   has 2 skills, 5 shiftTypes, 9 patterns, 3 contracts, 50 employees, 28 shiftDates, 740 shiftAssignments and   0 requests with a search space of 10^1257.
long_hint02   has 2 skills, 5 shiftTypes, 7 patterns, 3 contracts, 50 employees, 28 shiftDates, 740 shiftAssignments and   0 requests with a search space of 10^1257.
long_hint03   has 2 skills, 5 shiftTypes, 7 patterns, 3 contracts, 50 employees, 28 shiftDates, 740 shiftAssignments and   0 requests with a search space of 10^1257.
long_late01   has 2 skills, 5 shiftTypes, 9 patterns, 3 contracts, 50 employees, 28 shiftDates, 752 shiftAssignments and   0 requests with a search space of 10^1277.
long_late02   has 2 skills, 5 shiftTypes, 9 patterns, 4 contracts, 50 employees, 28 shiftDates, 752 shiftAssignments and   0 requests with a search space of 10^1277.
long_late03   has 2 skills, 5 shiftTypes, 9 patterns, 3 contracts, 50 employees, 28 shiftDates, 752 shiftAssignments and   0 requests with a search space of 10^1277.
long_late04   has 2 skills, 5 shiftTypes, 9 patterns, 4 contracts, 50 employees, 28 shiftDates, 752 shiftAssignments and   0 requests with a search space of 10^1277.
long_late05   has 2 skills, 5 shiftTypes, 9 patterns, 3 contracts, 50 employees, 28 shiftDates, 740 shiftAssignments and   0 requests with a search space of 10^1257.
Figure 31.13. Domain model
[image: nurseRosteringClassDiagram]



Traveling tournament problem (TTP)




					Schedule matches between n number of teams.
				
[image: travelingTournamentUseCase]


					Hard constraints:
				
	
							Each team plays twice against every other team: once home and once away.
						
	
							Each team has exactly one match on each timeslot.
						
	
							No team must have more than three consecutive home or three consecutive away matches.
						
	
							No repeaters: no two consecutive matches of the same two opposing teams.
						



					Soft constraints:
				
	
							Minimize the total distance traveled by all teams.
						



					The problem is defined on Michael Trick’s website (which contains the world records too).
				
Problem size

						

1-nl04     has  6 days,  4 teams and   12 matches with a search space of    10^5.
1-nl06     has 10 days,  6 teams and   30 matches with a search space of   10^19.
1-nl08     has 14 days,  8 teams and   56 matches with a search space of   10^43.
1-nl10     has 18 days, 10 teams and   90 matches with a search space of   10^79.
1-nl12     has 22 days, 12 teams and  132 matches with a search space of  10^126.
1-nl14     has 26 days, 14 teams and  182 matches with a search space of  10^186.
1-nl16     has 30 days, 16 teams and  240 matches with a search space of  10^259.
2-bra24    has 46 days, 24 teams and  552 matches with a search space of  10^692.
3-nfl16    has 30 days, 16 teams and  240 matches with a search space of  10^259.
3-nfl18    has 34 days, 18 teams and  306 matches with a search space of  10^346.
3-nfl20    has 38 days, 20 teams and  380 matches with a search space of  10^447.
3-nfl22    has 42 days, 22 teams and  462 matches with a search space of  10^562.
3-nfl24    has 46 days, 24 teams and  552 matches with a search space of  10^692.
3-nfl26    has 50 days, 26 teams and  650 matches with a search space of  10^838.
3-nfl28    has 54 days, 28 teams and  756 matches with a search space of  10^999.
3-nfl30    has 58 days, 30 teams and  870 matches with a search space of 10^1175.
3-nfl32    has 62 days, 32 teams and  992 matches with a search space of 10^1367.
4-super04  has  6 days,  4 teams and   12 matches with a search space of    10^5.
4-super06  has 10 days,  6 teams and   30 matches with a search space of   10^19.
4-super08  has 14 days,  8 teams and   56 matches with a search space of   10^43.
4-super10  has 18 days, 10 teams and   90 matches with a search space of   10^79.
4-super12  has 22 days, 12 teams and  132 matches with a search space of  10^126.
4-super14  has 26 days, 14 teams and  182 matches with a search space of  10^186.
5-galaxy04 has  6 days,  4 teams and   12 matches with a search space of    10^5.
5-galaxy06 has 10 days,  6 teams and   30 matches with a search space of   10^19.
5-galaxy08 has 14 days,  8 teams and   56 matches with a search space of   10^43.
5-galaxy10 has 18 days, 10 teams and   90 matches with a search space of   10^79.
5-galaxy12 has 22 days, 12 teams and  132 matches with a search space of  10^126.
5-galaxy14 has 26 days, 14 teams and  182 matches with a search space of  10^186.
5-galaxy16 has 30 days, 16 teams and  240 matches with a search space of  10^259.
5-galaxy18 has 34 days, 18 teams and  306 matches with a search space of  10^346.
5-galaxy20 has 38 days, 20 teams and  380 matches with a search space of  10^447.
5-galaxy22 has 42 days, 22 teams and  462 matches with a search space of  10^562.
5-galaxy24 has 46 days, 24 teams and  552 matches with a search space of  10^692.
5-galaxy26 has 50 days, 26 teams and  650 matches with a search space of  10^838.
5-galaxy28 has 54 days, 28 teams and  756 matches with a search space of  10^999.
5-galaxy30 has 58 days, 30 teams and  870 matches with a search space of 10^1175.
5-galaxy32 has 62 days, 32 teams and  992 matches with a search space of 10^1367.
5-galaxy34 has 66 days, 34 teams and 1122 matches with a search space of 10^1576.
5-galaxy36 has 70 days, 36 teams and 1260 matches with a search space of 10^1801.
5-galaxy38 has 74 days, 38 teams and 1406 matches with a search space of 10^2042.
5-galaxy40 has 78 days, 40 teams and 1560 matches with a search space of 10^2301.


					

Cheap time scheduling




					Schedule all tasks in time and on a machine to minimize power cost. Power prices differ in time. This is a form of job shop scheduling.
				

					Hard constraints:
				
	
							Start time limits: Each task must start between its earliest start and latest start limit.
						
	
							Maximum capacity: The maximum capacity for each resource for each machine must not be exceeded.
						
	
							Startup and shutdown: Each machine must be active in the periods during which it has assigned tasks. Between tasks it is allowed to be idle to avoid startup and shutdown costs.
						



					Medium constraints:
				
	
							Power cost: Minimize the total power cost of the whole schedule.
						
	
									Machine power cost: Each active or idle machine consumes power, which infers a power cost (depending on the power price during that time).
								
	
									Task power cost: Each task consumes power too, which infers a power cost (depending on the power price during its time).
								
	
									Machine startup and shutdown cost: Every time a machine starts up or shuts down, an extra cost is incurred.
								






					Soft constraints (addendum to the original problem definition):
				
	
							Start early: Prefer starting a task sooner rather than later.
						



					The problem is defined by the ICON challenge.
				
Problem size

						

sample01   has 3 resources,   2 machines, 288 periods and   25 tasks with a search space of    10^53.
sample02   has 3 resources,   2 machines, 288 periods and   50 tasks with a search space of   10^114.
sample03   has 3 resources,   2 machines, 288 periods and  100 tasks with a search space of   10^226.
sample04   has 3 resources,   5 machines, 288 periods and  100 tasks with a search space of   10^266.
sample05   has 3 resources,   2 machines, 288 periods and  250 tasks with a search space of   10^584.
sample06   has 3 resources,   5 machines, 288 periods and  250 tasks with a search space of   10^673.
sample07   has 3 resources,   2 machines, 288 periods and 1000 tasks with a search space of  10^2388.
sample08   has 3 resources,   5 machines, 288 periods and 1000 tasks with a search space of  10^2748.
sample09   has 4 resources,  20 machines, 288 periods and 2000 tasks with a search space of  10^6668.
instance00 has 1 resources,  10 machines, 288 periods and  200 tasks with a search space of   10^595.
instance01 has 1 resources,  10 machines, 288 periods and  200 tasks with a search space of   10^599.
instance02 has 1 resources,  10 machines, 288 periods and  200 tasks with a search space of   10^599.
instance03 has 1 resources,  10 machines, 288 periods and  200 tasks with a search space of   10^591.
instance04 has 1 resources,  10 machines, 288 periods and  200 tasks with a search space of   10^590.
instance05 has 2 resources,  25 machines, 288 periods and  200 tasks with a search space of   10^667.
instance06 has 2 resources,  25 machines, 288 periods and  200 tasks with a search space of   10^660.
instance07 has 2 resources,  25 machines, 288 periods and  200 tasks with a search space of   10^662.
instance08 has 2 resources,  25 machines, 288 periods and  200 tasks with a search space of   10^651.
instance09 has 2 resources,  25 machines, 288 periods and  200 tasks with a search space of   10^659.
instance10 has 2 resources,  20 machines, 288 periods and  500 tasks with a search space of  10^1657.
instance11 has 2 resources,  20 machines, 288 periods and  500 tasks with a search space of  10^1644.
instance12 has 2 resources,  20 machines, 288 periods and  500 tasks with a search space of  10^1637.
instance13 has 2 resources,  20 machines, 288 periods and  500 tasks with a search space of  10^1659.
instance14 has 2 resources,  20 machines, 288 periods and  500 tasks with a search space of  10^1643.
instance15 has 3 resources,  40 machines, 288 periods and  500 tasks with a search space of  10^1782.
instance16 has 3 resources,  40 machines, 288 periods and  500 tasks with a search space of  10^1778.
instance17 has 3 resources,  40 machines, 288 periods and  500 tasks with a search space of  10^1764.
instance18 has 3 resources,  40 machines, 288 periods and  500 tasks with a search space of  10^1769.
instance19 has 3 resources,  40 machines, 288 periods and  500 tasks with a search space of  10^1778.
instance20 has 3 resources,  50 machines, 288 periods and 1000 tasks with a search space of  10^3689.
instance21 has 3 resources,  50 machines, 288 periods and 1000 tasks with a search space of  10^3678.
instance22 has 3 resources,  50 machines, 288 periods and 1000 tasks with a search space of  10^3706.
instance23 has 3 resources,  50 machines, 288 periods and 1000 tasks with a search space of  10^3676.
instance24 has 3 resources,  50 machines, 288 periods and 1000 tasks with a search space of  10^3681.
instance25 has 3 resources,  60 machines, 288 periods and 1000 tasks with a search space of  10^3774.
instance26 has 3 resources,  60 machines, 288 periods and 1000 tasks with a search space of  10^3737.
instance27 has 3 resources,  60 machines, 288 periods and 1000 tasks with a search space of  10^3744.
instance28 has 3 resources,  60 machines, 288 periods and 1000 tasks with a search space of  10^3731.
instance29 has 3 resources,  60 machines, 288 periods and 1000 tasks with a search space of  10^3746.
instance30 has 4 resources,  70 machines, 288 periods and 2000 tasks with a search space of  10^7718.
instance31 has 4 resources,  70 machines, 288 periods and 2000 tasks with a search space of  10^7740.
instance32 has 4 resources,  70 machines, 288 periods and 2000 tasks with a search space of  10^7686.
instance33 has 4 resources,  70 machines, 288 periods and 2000 tasks with a search space of  10^7672.
instance34 has 4 resources,  70 machines, 288 periods and 2000 tasks with a search space of  10^7695.
instance35 has 4 resources,  80 machines, 288 periods and 2000 tasks with a search space of  10^7807.
instance36 has 4 resources,  80 machines, 288 periods and 2000 tasks with a search space of  10^7814.
instance37 has 4 resources,  80 machines, 288 periods and 2000 tasks with a search space of  10^7764.
instance38 has 4 resources,  80 machines, 288 periods and 2000 tasks with a search space of  10^7736.
instance39 has 4 resources,  80 machines, 288 periods and 2000 tasks with a search space of  10^7783.
instance40 has 4 resources,  90 machines, 288 periods and 4000 tasks with a search space of 10^15976.
instance41 has 4 resources,  90 machines, 288 periods and 4000 tasks with a search space of 10^15935.
instance42 has 4 resources,  90 machines, 288 periods and 4000 tasks with a search space of 10^15887.
instance43 has 4 resources,  90 machines, 288 periods and 4000 tasks with a search space of 10^15896.
instance44 has 4 resources,  90 machines, 288 periods and 4000 tasks with a search space of 10^15885.
instance45 has 4 resources, 100 machines, 288 periods and 5000 tasks with a search space of 10^20173.
instance46 has 4 resources, 100 machines, 288 periods and 5000 tasks with a search space of 10^20132.
instance47 has 4 resources, 100 machines, 288 periods and 5000 tasks with a search space of 10^20126.
instance48 has 4 resources, 100 machines, 288 periods and 5000 tasks with a search space of 10^20110.
instance49 has 4 resources, 100 machines, 288 periods and 5000 tasks with a search space of 10^20078.


					

Investment asset class allocation (Portfolio Optimization)




					Decide the relative quantity to invest in each asset class.
				

					Hard constraints:
				
	
							Risk maximum: the total standard deviation must not be higher than the standard deviation maximum.
						
	
									Total standard deviation calculation takes asset class correlations into account by applying Markowitz Portfolio Theory.
								



	
							Region maximum: Each region has a quantity maximum.
						
	
							Sector maximum: Each sector has a quantity maximum.
						



					Soft constraints:
				
	
							Maximize expected return.
						


Problem size

						

de_smet_1 has 1 regions, 3 sectors and 11 asset classes with a search space of 10^4.
irrinki_1 has 2 regions, 3 sectors and 6 asset classes with a search space of 10^3.


					

					Larger datasets have not been created or tested yet, but should not pose a problem. A good source of data is this Asset Correlation website.
				

Conference scheduling




					Assign each conference talk to a timeslot and a room. Timeslots can overlap. Read and write to and from an *.xlsx file that can be edited with LibreOffice or Excel.
				

					Hard constraints:
				
	
							Talk type of timeslot: The type of a talk must match the timeslot’s talk type.
						
	
							Room unavailable timeslots: A talk’s room must be available during the talk’s timeslot.
						
	
							Room conflict: Two talks can’t use the same room during overlapping timeslots.
						
	
							Speaker unavailable timeslots: Every talk’s speaker must be available during the talk’s timeslot.
						
	
							Speaker conflict: Two talks can’t share a speaker during overlapping timeslots.
						
	
							Generic purpose timeslot and room tags:
						
	
									Speaker required timeslot tag: If a speaker has a required timeslot tag, then all of his or her talks must be assigned to a timeslot with that tag.
								
	
									Speaker prohibited timeslot tag: If a speaker has a prohibited timeslot tag, then all of his or her talks cannot be assigned to a timeslot with that tag.
								
	
									Talk required timeslot tag: If a talk has a required timeslot tag, then it must be assigned to a timeslot with that tag.
								
	
									Talk prohibited timeslot tag: If a talk has a prohibited timeslot tag, then it cannot be assigned to a timeslot with that tag.
								
	
									Speaker required room tag: If a speaker has a required room tag, then all of his or her talks must be assigned to a room with that tag.
								
	
									Speaker prohibited room tag: If a speaker has a prohibited room tag, then all of his or her talks cannot be assigned to a room with that tag.
								
	
									Talk required room tag: If a talk has a required room tag, then it must be assigned to a room with that tag.
								
	
									Talk prohibited room tag: If a talk has a prohibited room tag, then it cannot be assigned to a room with that tag.
								



	
							Talk mutually-exclusive-talks tag: Talks that share such a tag must not be scheduled in overlapping timeslots.
						
	
							Talk prerequisite talks: A talk must be scheduled after all its prerequisite talks.
						



					Soft constraints:
				
	
							Theme track conflict: Minimize the number of talks that share a theme tag during overlapping timeslots.
						
	
							Sector conflict: Minimize the number of talks that share a same sector tag during overlapping timeslots.
						
	
							Content audience level flow violation: For every content tag, schedule the introductory talks before the advanced talks.
						
	
							Audience level diversity: For every timeslot, maximize the number of talks with a different audience level.
						
	
							Language diversity: For every timeslot, maximize the number of talks with a different language.
						
	
							Generic purpose timeslot and room tags:
						
	
									Speaker preferred timeslot tag: If a speaker has a preferred timeslot tag, then all of his or her talks should be assigned to a timeslot with that tag.
								
	
									Speaker undesired timeslot tag: If a speaker has an undesired timeslot tag, then none of his or her talks should be assigned to a timeslot with that tag.
								
	
									Talk preferred timeslot tag: If a talk has a preferred timeslot tag, then it should be assigned to a timeslot with that tag.
								
	
									Talk undesired timeslot tag: If a talk has an undesired timeslot tag, then it should not be assigned to a timeslot with that tag.
								
	
									Speaker preferred room tag: If a speaker has a preferred room tag, then all of his or her talks should be assigned to a room with that tag.
								
	
									Speaker undesired room tag: If a speaker has an undesired room tag, then none of his or her talks should be assigned to a room with that tag.
								
	
									Talk preferred room tag: If a talk has a preferred room tag, then it should be assigned to a room with that tag.
								
	
									Talk undesired room tag: If a talk has an undesired room tag, then it should not be assigned to a room with that tag.
								



	
							Same day talks: All talks that share a theme tag or content tag should be scheduled in the minimum number of days (ideally in the same day).
						


Figure 31.14. Value proposition
[image: conferenceSchedulingValueProposition]


Problem size

						

18talks-6timeslots-5rooms    has  18 talks,  6 timeslots and  5 rooms with a search space of  10^26.
36talks-12timeslots-5rooms   has  36 talks, 12 timeslots and  5 rooms with a search space of  10^64.
72talks-12timeslots-10rooms  has  72 talks, 12 timeslots and 10 rooms with a search space of 10^149.
108talks-18timeslots-10rooms has 108 talks, 18 timeslots and 10 rooms with a search space of 10^243.
216talks-18timeslots-20rooms has 216 talks, 18 timeslots and 20 rooms with a search space of 10^552.


					

Rock tour




					Drive the rock bank bus from show to show, but schedule shows only on available days.
				

					Hard constraints:
				
	
							Schedule every required show.
						
	
							Schedule as many shows as possible.
						



					Medium constraints:
				
	
							Maximize revenue opportunity.
						
	
							Minimize driving time.
						
	
							Visit sooner than later.
						



					Soft constraints:
				
	
							Avoid long driving times.
						


Problem size

						

47shows has 47 shows with a search space of 10^59.


					

Flight crew scheduling




					Assign flights to pilots and flight attendants.
				

					Hard constraints:
				
	
							Required skill: each flight assignment has a required skill. For example, flight AB0001 requires 2 pilots and 3 flight attendants.
						
	
							Flight conflict: each employee can only attend one flight at the same time
						
	
							Transfer between two flights: between two flights, an employee must be able to transfer from the arrival airport to the departure airport. For example, Ann arrives in Brussels at 10:00 and departs in Amsterdam at 15:00.
						
	
							Employee unavailability: the employee must be available on the day of the flight. For example, Ann is on PTO on 1-Feb.
						



					Soft constraints:
				
	
							First assignment departing from home
						
	
							Last assignment arriving at home
						
	
							Load balance flight duration total per employee
						


Problem size

						

175flights-7days-Europe  has 2 skills, 50 airports, 150 employees, 175 flights and  875 flight assignments with a search space of  10^1904.
700flights-28days-Europe has 2 skills, 50 airports, 150 employees, 700 flights and 3500 flight assignments with a search space of  10^7616.
875flights-7days-Europe  has 2 skills, 50 airports, 750 employees, 875 flights and 4375 flight assignments with a search space of 10^12578.
175flights-7days-US      has 2 skills, 48 airports, 150 employees, 175 flights and  875 flight assignments with a search space of  10^1904.


					


Chapter 32. Downloading Red Hat build of OptaPlanner examples




				You can download the Red Hat build of OptaPlanner examples as a part of the {PRODUCTPAM} add-ons package available on the Red Hat Customer Portal.
			
Procedure
	
						Navigate to the Software Downloads page in the Red Hat Customer Portal (login required), and select the product and version from the drop-down options:
					
	
								Product: Process Automation Manager
							
	
								Version: 7.13.5
							



	
						Download Red Hat Process Automation Manager 7.13 Add Ons.
					
	
						Extract the rhpam-7.13.5-add-ons.zip file. The extracted add-ons folder contains the rhpam-7.13.5-planner-engine.zip file.
					
	
						Extract the rhpam-7.13.5-planner-engine.zip file.
					


Result

					The extracted rhpam-7.13.5-planner-engine directory contains example source code under the following subdirectories:
				
	
						examples/sources/src/main/java/org/optaplanner/examples
					
	
						examples/sources/src/main/resources/org/optaplanner/examples
					


Running OptaPlanner examples




					Red Hat build of OptaPlanner includes several examples that demonstrate a variety of planning use cases. Download and use the examples to explore different types of planning solutions.
				
Prerequisites
	
							You have downloaded and extracted the examples as described in Chapter 32, Downloading Red Hat build of OptaPlanner examples.
						


Procedure
	
							To run the examples, in the rhpam-7.13.5-planner-engine/examples directory enter one of the following commands:
						

							Linux or Mac:
						
$ ./runExamples.sh

							Windows:
						
$ runExamples.bat

							The OptaPlanner Examples window opens.
						

	
							Select an example to run that example.
						


Note

						Red Hat build of OptaPlanner has no GUI dependencies. It runs just as well on a server or a mobile JVM as it does on the desktop.
					


Running the Red Hat build of OptaPlanner examples in an IDE (IntelliJ, Eclipse, or Netbeans)




					If you use an integrated development environment (IDE), such as IntelliJ, Eclipse, or Netbeans, you can run your downloaded OptaPlanner examples within your development environment.
				
Prerequisites
	
							You have downloaded and extracted the OptaPlanner examples as described in Chapter 32, Downloading Red Hat build of OptaPlanner examples.
						


Procedure
	
							Open the OptaPlanner examples as a new project:
						
	
									For IntelliJ or Netbeans, open examples/sources/pom.xml as the new project. The Maven integration guides you through the rest of the installation. Skip the rest of the steps in this procedure.
								
	
									For Eclipse, open a new project for the /examples/binaries directory, located under the rhpam-7.13.5-planner-engine directory.
								



	
							Add all the JAR files that are in the binaries directory to the classpath, except for the examples/binaries/optaplanner-examples-7.67.0.Final-redhat-00024.jar file.
						
	
							Add the Java source directory src/main/java and the Java resources directory src/main/resources, located under the rhpam-7.13.5-planner-engine/examples/sources/ directory.
						
	
							Create a run configuration:
						
	
									Main class: org.optaplanner.examples.app.OptaPlannerExamplesApp
								
	
									VM parameters (optional): -Xmx512M -server -Dorg.optaplanner.examples.dataDir=examples/sources/data
								
	
									Working directory: examples/sources
								



	
							Run the run configuration.
						




Chapter 33. Getting started with OptaPlanner in Business Central: An employee rostering example




				You can build and deploy the employee-rostering sample project in Business Central. The project demonstrates how to create each of the Business Central assets required to solve the shift rostering planning problem and use Red Hat build of OptaPlanner to find the best possible solution.
			

				You can deploy the preconfigured employee-rostering project in Business Central. Alternatively, you can create the project yourself using Business Central.
			
Note

					The employee-rostering sample project in Business Central does not include a data set. You must supply a data set in XML format using a REST API call.
				

Deploying the employee rostering sample project in Business Central




					Business Central includes a number of sample projects that you can use to get familiar with the product and its features. The employee rostering sample project is designed and created to demonstrate the shift rostering use case for Red Hat build of OptaPlanner. Use the following procedure to deploy and run the employee rostering sample in Business Central.
				
Prerequisites
	
							Red Hat Process Automation Manager has been downloaded and installed. For installation options, see Planning a Red Hat Process Automation Manager installation.
						
	
							You have started Red Hat Process Automation Manager, as described the installation documentation, and you are logged in to Business Central as a user with admin permissions.
						


Procedure
	
							In Business Central, click Menu → Design → Projects.
						
	
							In the preconfigured MySpace space, click Try Samples.
						
	
							Select employee-rostering from the list of sample projects and click Ok in the upper-right corner to import the project.
						
	
							After the asset list has complied, click Build & Deploy to deploy the employee rostering example.
						



					The rest of this document explains each of the project assets and their configuration.
				

Re-creating the employee rostering sample project




					The employee rostering sample project is a preconfigured project available in Business Central. You can learn about how to deploy this project in the section called “Deploying the employee rostering sample project in Business Central”.
				

					You can create the employee rostering example "from scratch". You can use the workflow in this example to create a similar project of your own in Business Central.
				
Setting up the employee rostering project




						To start developing a solver in Business Central, you must set up the project.
					
Prerequisites
	
								Red Hat Process Automation Manager has been downloaded and installed.
							
	
								You have deployed Business Central and logged in with a user that has the admin role.
							


Procedure
	
								Create a new project in Business Central by clicking Menu → Design → Projects → Add Project.
							
	
								In the Add Project window, fill out the following fields:
							
	
										Name: employee-rostering
									
	
										Description(optional): Employee rostering problem optimization using OptaPlanner. Assigns employees to shifts based on their skill.
									



								Optional: Click Configure Advanced Options to populate the Group ID, Artifact ID, and Version information.
							
	
										Group ID: employeerostering
									
	
										Artifact ID: employeerostering
									
	
										Version: 1.0.0-SNAPSHOT
									



	
								Click Add to add the project to the Business Central project repository.
							



Problem facts and planning entities




						Each of the domain classes in the employee rostering planning problem is categorized as one of the following:
					
	
								An unrelated class: not used by any of the score constraints. From a planning standpoint, this data is obsolete.
							
	
								A problem fact class: used by the score constraints, but does not change during planning (as long as the problem stays the same), for example, Shift and Employee. All the properties of a problem fact class are problem properties.
							
	
								A planning entity class: used by the score constraints and changes during planning, for example, ShiftAssignment. The properties that change during planning are planning variables. The other properties are problem properties.
							

								Ask yourself the following questions:
							

	
								What class changes during planning?
							
	
								Which class has variables that I want the Solver to change?
							

								That class is a planning entity.
							

								A planning entity class needs to be annotated with the @PlanningEntity annotation, or defined in Business Central using the Red Hat build of OptaPlanner dock in the domain designer.
							

								Each planning entity class has one or more planning variables, and must also have one or more defining properties.
							

								Most use cases have only one planning entity class, and only one planning variable per planning entity class.
							




Creating the data model for the employee rostering project




						Use this section to create the data objects required to run the employee rostering sample project in Business Central.
					
Prerequisites
	
								You have completed the project setup described in the section called “Setting up the employee rostering project”.
							


Procedure
	
								With your new project, either click Data Object in the project perspective, or click Add Asset → Data Object to create a new data object.
							
	
								Name the first data object Timeslot, and select employeerostering.employeerostering as the Package.
							

								Click Ok.
							

	
								In the Data Objects perspective, click +add field to add fields to the Timeslot data object.
							
	
								In the id field, type endTime.
							
	
								Click the drop-down menu next to Type and select LocalDateTime.
							
	
								Click Create and continue to add another field.
							
	
								Add another field with the id startTime and Type LocalDateTime.
							
	
								Click Create.
							
	
								Click Save in the upper-right corner to save the Timeslot data object.
							
	
								Click the x in the upper-right corner to close the Data Objects perspective and return to the Assets menu.
							
	
								Using the previous steps, create the following data objects and their attributes:
							
Table 33.1. Skill
	id	Type
	 
												name
											

											 	 
												String
											

											 



Table 33.2. Employee
	id	Type
	 
												name
											

											 	 
												String
											

											 
	 
												skills
											

											 	 
												employeerostering.employeerostering.Skill[List]
											

											 



Table 33.3. Shift
	id	Type
	 
												requiredSkill
											

											 	 
												employeerostering.employeerostering.Skill
											

											 
	 
												timeslot
											

											 	 
												employeerostering.employeerostering.Timeslot
											

											 



Table 33.4. DayOffRequest
	id	Type
	 
												date
											

											 	 
												LocalDate
											

											 
	 
												employee
											

											 	 
												employeerostering.employeerostering.Employee
											

											 



Table 33.5. ShiftAssignment
	id	Type
	 
												employee
											

											 	 
												employeerostering.employeerostering.Employee
											

											 
	 
												shift
											

											 	 
												employeerostering.employeerostering.Shift
											

											 







						For more examples of creating data objects, see Getting started with decision services.
					
Creating the employee roster planning entity




							In order to solve the employee rostering planning problem, you must create a planning entity and a solver. The planning entity is defined in the domain designer using the attributes available in the Red Hat build of OptaPlanner dock.
						

							Use the following procedure to define the ShiftAssignment data object as the planning entity for the employee rostering example.
						
Prerequisites
	
									You have created the relevant data objects and planning entity required to run the employee rostering example by completing the procedures in the section called “Creating the data model for the employee rostering project”.
								


Procedure
	
									From the project Assets menu, open the ShiftAssignment data object.
								
	
									In the Data Objects perspective, open the OptaPlanner dock by clicking the 
									[image: OptaPlanner icon]
									 on the right.
								
	
									Select Planning Entity.
								
	
									Select employee from the list of fields under the ShiftAssignment data object.
								
	
									In the OptaPlanner dock, select Planning Variable.
								

									In the Value Range Id input field, type employeeRange. This adds the @ValueRangeProvider annotation to the planning entity, which you can view by clicking the Source tab in the designer.
								

									The value range of a planning variable is defined with the @ValueRangeProvider annotation. A @ValueRangeProvider annotation always has a property id, which is referenced by the @PlanningVariable property valueRangeProviderRefs.
								

	
									Close the dock and click Save to save the data object.
								



Creating the employee roster planning solution




							The employee roster problem relies on a defined planning solution. The planning solution is defined in the domain designer using the attributes available in the Red Hat build of OptaPlanner dock.
						
Prerequisites
	
									You have created the relevant data objects and planning entity required to run the employee rostering example by completing the procedures in the section called “Creating the data model for the employee rostering project” and the section called “Creating the employee roster planning entity”.
								


Procedure
	
									Create a new data object with the identifier EmployeeRoster.
								
	
									Create the following fields:
								
Table 33.6. EmployeeRoster
	id	Type
	 
													dayOffRequestList
												

												 	 
													employeerostering.employeerostering.DayOffRequest[List]
												

												 
	 
													shiftAssignmentList
												

												 	 
													employeerostering.employeerostering.ShiftAssignment[List]
												

												 
	 
													shiftList
												

												 	 
													employeerostering.employeerostering.Shift[List]
												

												 
	 
													skillList
												

												 	 
													employeerostering.employeerostering.Skill[List]
												

												 
	 
													timeslotList
												

												 	 
													employeerostering.employeerostering.Timeslot[List]
												

												 




	
									In the Data Objects perspective, open the OptaPlanner dock by clicking the 
									[image: OptaPlanner icon]
									 on the right.
								
	
									Select Planning Solution.
								
	
									Leave the default Hard soft score as the Solution Score Type. This automatically generates a score field in the EmployeeRoster data object with the solution score as the type.
								
	
									Add a new field with the following attributes:
								
	id	Type
	 
													employeeList
												

												 	 
													employeerostering.employeerostering.Employee[List]
												

												 



	
									With the employeeList field selected, open the OptaPlanner dock and select the Planning Value Range Provider box.
								

									In the id field, type employeeRange. Close the dock.
								

	
									Click Save in the upper-right corner to save the asset.
								




Employee rostering constraints




						Employee rostering is a planning problem. All planning problems include constraints that must be satisfied in order to find an optimal solution.
					

						The employee rostering sample project in Business Central includes the following hard and soft constraints:
					
	Hard constraint
		
											Employees are only assigned one shift per day.
										
	
											All shifts that require a particular employee skill are assigned an employee with that particular skill.
										



	Soft constraints
		
											All employees are assigned a shift.
										
	
											If an employee requests a day off, their shift is reassigned to another employee.
										






						Hard and soft constraints are defined in Business Central using either the free-form DRL designer, or using guided rules.
					
DRL (Drools Rule Language) rules




							DRL (Drools Rule Language) rules are business rules that you define directly in .drl text files. These DRL files are the source in which all other rule assets in Business Central are ultimately rendered. You can create and manage DRL files within the Business Central interface, or create them externally as part of a Maven or Java project using Red Hat CodeReady Studio or another integrated development environment (IDE). A DRL file can contain one or more rules that define at a minimum the rule conditions (when) and actions (then). The DRL designer in Business Central provides syntax highlighting for Java, DRL, and XML.
						

							DRL files consist of the following components:
						
Components in a DRL file

								

package

import

function  // Optional

query  // Optional

declare   // Optional

global   // Optional

rule "rule name"
    // Attributes
    when
        // Conditions
    then
        // Actions
end

rule "rule2 name"

...


							

							The following example DRL rule determines the age limit in a loan application decision service:
						
Example rule for loan application age limit

								

rule "Underage"
  salience 15
  agenda-group "applicationGroup"
  when
    $application : LoanApplication()
    Applicant( age < 21 )
  then
    $application.setApproved( false );
    $application.setExplanation( "Underage" );
end


							

							A DRL file can contain single or multiple rules, queries, and functions, and can define resource declarations such as imports, globals, and attributes that are assigned and used by your rules and queries. The DRL package must be listed at the top of a DRL file and the rules are typically listed last. All other DRL components can follow any order.
						

							Each rule must have a unique name within the rule package. If you use the same rule name more than once in any DRL file in the package, the rules fail to compile. Always enclose rule names with double quotation marks (rule "rule name") to prevent possible compilation errors, especially if you use spaces in rule names.
						

							All data objects related to a DRL rule must be in the same project package as the DRL file in Business Central. Assets in the same package are imported by default. Existing assets in other packages can be imported with the DRL rule.
						

Defining constraints for employee rostering using the DRL designer




							You can create constraint definitions for the employee rostering example using the free-form DRL designer in Business Central.
						

							Use this procedure to create a hard constraint where no employee is assigned a shift that begins less than 10 hours after their previous shift ended.
						
Procedure
	
									In Business Central, go to Menu → Design → Projects and click the project name.
								
	
									Click Add Asset → DRL file.
								
	
									In the DRL file name field, type ComplexScoreRules.
								
	
									Select the employeerostering.employeerostering package.
								
	
									Click +Ok to create the DRL file.
								
	
									In the Model tab of the DRL designer, define the Employee10HourShiftSpace rule as a DRL file:
								
package employeerostering.employeerostering;

rule "Employee10HourShiftSpace"
    when
        $shiftAssignment : ShiftAssignment( $employee : employee != null, $shiftEndDateTime : shift.timeslot.endTime)
        ShiftAssignment( this != $shiftAssignment, $employee == employee, $shiftEndDateTime <= shift.timeslot.endTime,
                $shiftEndDateTime.until(shift.timeslot.startTime, java.time.temporal.ChronoUnit.HOURS) <10)
    then
        scoreHolder.addHardConstraintMatch(kcontext, -1);
end

	
									Click Save to save the DRL file.
								



							For more information about creating DRL files, see Designing a decision service using DRL rules.
						


Creating rules for employee rostering using guided rules




						You can create rules that define hard and soft constraints for employee rostering using the guided rules designer in Business Central.
					
Guided rules




							Guided rules are business rules that you create in a UI-based guided rules designer in Business Central that leads you through the rule-creation process. The guided rules designer provides fields and options for acceptable input based on the data objects for the rule being defined. The guided rules that you define are compiled into Drools Rule Language (DRL) rules as with all other rule assets.
						

							All data objects related to a guided rule must be in the same project package as the guided rule. Assets in the same package are imported by default. After you create the necessary data objects and the guided rule, you can use the Data Objects tab of the guided rules designer to verify that all required data objects are listed or to import other existing data objects by adding a New item.
						

Creating a guided rule to balance employee shift numbers




							The BalanceEmployeesShiftNumber guided rule creates a soft constraint that ensures shifts are assigned to employees in a way that is balanced as evenly as possible. It does this by creating a score penalty that increases when shift distribution is less even. The score formula, implemented by the rule, incentivizes the Solver to distribute shifts in a more balanced way.
						
[image: BalanceEmployeesShiftNumber Guided Rule]

Procedure
	
									In Business Central, go to Menu → Design → Projects and click the project name.
								
	
									Click Add Asset → Guided Rule.
								
	
									Enter BalanceEmployeesShiftNumber as the Guided Rule name and select the employeerostering.employeerostering Package.
								
	
									Click Ok to create the rule asset.
								
	
									Add a WHEN condition by clicking the 
									[image: 5686]
									 in the WHEN field.
								
	
									Select Employee in the Add a condition to the rule window. Click +Ok.
								
	
									Click the Employee condition to modify the constraints and add the variable name $employee.
								
	
									Add the WHEN condition From Accumulate.
								
	
											Above the From Accumulate condition, click click to add pattern and select Number as the fact type from the drop-down list.
										
	
											Add the variable name $shiftCount to the Number condition.
										
	
											Below the From Accumulate condition, click click to add pattern and select the ShiftAssignment fact type from the drop-down list.
										
	
											Add the variable name $shiftAssignment to the ShiftAssignment fact type.
										
	
											Click the ShiftAssignment condition again and from the Add a restriction on a field drop-down list, select employee.
										
	
											Select equal to from the drop-down list next to the employee constraint.
										
	
											Click the 
											[image: edit]
											 icon next to the drop-down button to add a variable, and click Bound variable in the Field value window.
										
	
											Select $employee from the drop-down list.
										
	
											In the Function box type count($shiftAssignment).
										



	
									Add the THEN condition by clicking the 
									[image: 5686]
									 in the THEN field.
								
	
									Select Modify Soft Score in the Add a new action window. Click +Ok.
								
	
											Type the following expression into the box: -($shiftCount.intValue()*$shiftCount.intValue())
										



	
									Click Validate in the upper-right corner to check all rule conditions are valid. If the rule validation fails, address any problems described in the error message, review all components in the rule, and try again to validate the rule until the rule passes.
								
	
									Click Save to save the rule.
								



							For more information about creating guided rules, see Designing a decision service using guided rules.
						

Creating a guided rule for no more than one shift per day




							The OneEmployeeShiftPerDay guided rule creates a hard constraint that employees are not assigned more than one shift per day. In the employee rostering example, this constraint is created using the guided rule designer.
						
[image: OneEmployeeShiftPerDay Guided Rule]

Procedure
	
									In Business Central, go to Menu → Design → Projects and click the project name.
								
	
									Click Add Asset → Guided Rule.
								
	
									Enter OneEmployeeShiftPerDay as the Guided Rule name and select the employeerostering.employeerostering Package.
								
	
									Click Ok to create the rule asset.
								
	
									Add a WHEN condition by clicking the 
									[image: 5686]
									 in the WHEN field.
								
	
									Select Free form DRL from the Add a condition to the rule window.
								
	
									In the free form DRL box, type the following condition:
								
$shiftAssignment : ShiftAssignment( employee != null )
		ShiftAssignment( this != $shiftAssignment , employee == $shiftAssignment.employee , shift.timeslot.startTime.toLocalDate() == $shiftAssignment.shift.timeslot.startTime.toLocalDate() )

									This condition states that a shift cannot be assigned to an employee that already has another shift assignment on the same day.
								

	
									Add the THEN condition by clicking the 
									[image: 5686]
									 in the THEN field.
								
	
									Select Add free form DRL from the Add a new action window.
								
	
									In the free form DRL box, type the following condition:
								
scoreHolder.addHardConstraintMatch(kcontext, -1);

	
									Click Validate in the upper-right corner to check all rule conditions are valid. If the rule validation fails, address any problems described in the error message, review all components in the rule, and try again to validate the rule until the rule passes.
								
	
									Click Save to save the rule.
								



							For more information about creating guided rules, see Designing a decision service using guided rules.
						

Creating a guided rule to match skills to shift requirements




							The ShiftReqiredSkillsAreMet guided rule creates a hard constraint that ensures all shifts are assigned an employee with the correct set of skills. In the employee rostering example, this constraint is created using the guided rule designer.
						
[image: ShiftRequiredSkillsAreMet Guided Rule]

Procedure
	
									In Business Central, go to Menu → Design → Projects and click the project name.
								
	
									Click Add Asset → Guided Rule.
								
	
									Enter ShiftReqiredSkillsAreMet as the Guided Rule name and select the employeerostering.employeerostering Package.
								
	
									Click Ok to create the rule asset.
								
	
									Add a WHEN condition by clicking the 
									[image: 5686]
									 in the WHEN field.
								
	
									Select ShiftAssignment in the Add a condition to the rule window. Click +Ok.
								
	
									Click the ShiftAssignment condition, and select employee from the Add a restriction on a field drop-down list.
								
	
									In the designer, click the drop-down list next to employee and select is not null.
								
	
									Click the ShiftAssignment condition, and click Expression editor.
								
	
											In the designer, click [not bound] to open the Expression editor, and bind the expression to the variable $requiredSkill. Click Set.
										
	
											In the designer, next to $requiredSkill, select shift from the first drop-down list, then requiredSkill from the next drop-down list.
										



	
									Click the ShiftAssignment condition, and click Expression editor.
								
	
											In the designer, next to [not bound], select employee from the first drop-down list, then skills from the next drop-down list.
										
	
											Leave the next drop-down list as Choose.
										
	
											In the next drop-down box, change please choose to excludes.
										
	
											Click the 
											[image: edit]
											 icon next to excludes, and in the Field value window, click the New formula button.
										
	
											Type $requiredSkill into the formula box.
										



	
									Add the THEN condition by clicking the 
									[image: 5686]
									 in the THEN field.
								
	
									Select Modify Hard Score in the Add a new action window. Click +Ok.
								
	
									Type -1 into the score actions box.
								
	
									Click Validate in the upper-right corner to check all rule conditions are valid. If the rule validation fails, address any problems described in the error message, review all components in the rule, and try again to validate the rule until the rule passes.
								
	
									Click Save to save the rule.
								



							For more information about creating guided rules, see Designing a decision service using guided rules.
						

Creating a guided rule to manage day off requests




							The DayOffRequest guided rule creates a soft constraint. This constraint allows a shift to be reassigned to another employee in the event the employee who was originally assigned the shift is no longer able to work that day. In the employee rostering example, this constraint is created using the guided rule designer.
						
[image: DayOffRequest Guided Rule]

Procedure
	
									In Business Central, go to Menu → Design → Projects and click the project name.
								
	
									Click Add Asset → Guided Rule.
								
	
									Enter DayOffRequest as the Guided Rule name and select the employeerostering.employeerostering Package.
								
	
									Click Ok to create the rule asset.
								
	
									Add a WHEN condition by clicking the 
									[image: 5686]
									 in the WHEN field.
								
	
									Select Free form DRL from the Add a condition to the rule window.
								
	
									In the free form DRL box, type the following condition:
								
$dayOffRequest : DayOffRequest( )
		ShiftAssignment( employee == $dayOffRequest.employee , shift.timeslot.startTime.toLocalDate() == $dayOffRequest.date )

									This condition states if a shift is assigned to an employee who has made a day off request, the employee can be unassigned the shift on that day.
								

	
									Add the THEN condition by clicking the 
									[image: 5686]
									 in the THEN field.
								
	
									Select Add free form DRL from the Add a new action window.
								
	
									In the free form DRL box, type the following condition:
								
scoreHolder.addSoftConstraintMatch(kcontext, -100);

	
									Click Validate in the upper-right corner to check all rule conditions are valid. If the rule validation fails, address any problems described in the error message, review all components in the rule, and try again to validate the rule until the rule passes.
								
	
									Click Save to save the rule.
								



							For more information about creating guided rules, see Designing a decision service using guided rules.
						


Creating a solver configuration for employee rostering




						You can create and edit Solver configurations in Business Central. The Solver configuration designer creates a solver configuration that can be run after the project is deployed.
					
Prerequisites
	
								Red Hat Process Automation Manager has been downloaded and installed.
							
	
								You have created and configured all of the relevant assets for the employee rostering example.
							


Procedure
	
								In Business Central, click Menu → Projects, and click your project to open it.
							
	
								In the Assets perspective, click Add Asset → Solver configuration
							
	
								In the Create new Solver configuration window, type the name EmployeeRosteringSolverConfig for your Solver and click Ok.
							

								This opens the Solver configuration designer.
							

	
								In the Score Director Factory configuration section, define a KIE base that contains scoring rule definitions. The employee rostering sample project uses defaultKieBase.
							
	
										Select one of the KIE sessions defined within the KIE base. The employee rostering sample project uses defaultKieSession.
									



	
								Click Validate in the upper-right corner to check the Score Director Factory configuration is correct. If validation fails, address any problems described in the error message, and try again to validate until the configuration passes.
							
	
								Click Save to save the Solver configuration.
							



Configuring Solver termination for the employee rostering project




						You can configure the Solver to terminate after a specified amount of time. By default, the planning engine is given an unlimited time period to solve a problem instance.
					

						The employee rostering sample project is set up to run for 30 seconds.
					
Prerequisites
	
								You have created all relevant assets for the employee rostering project and created the EmployeeRosteringSolverConfig solver configuration in Business Central as described in the section called “Creating a solver configuration for employee rostering”.
							


Procedure
	
								Open the EmployeeRosteringSolverConfig from the Assets perspective. This will open the Solver configuration designer.
							
	
								In the Termination section, click Add to create new termination element within the selected logical group.
							
	
								Select the Time spent termination type from the drop-down list. This is added as an input field in the termination configuration.
							
	
								Use the arrows next to the time elements to adjust the amount of time spent to 30 seconds.
							
	
								Click Validate in the upper-right corner to check the Score Director Factory configuration is correct. If validation fails, address any problems described in the error message, and try again to validate until the configuration passes.
							
	
								Click Save to save the Solver configuration.
							




Accessing the solver using the REST API




					After deploying or re-creating the sample solver, you can access it using the REST API.
				

					You must register a solver instance using the REST API. Then you can supply data sets and retrieve optimized solutions.
				
Prerequisites
	
							The employee rostering project is set up and deployed according to the previous sections in this document. You can either deploy the sample project, as described in the section called “Deploying the employee rostering sample project in Business Central”, or re-create the project, as described in the section called “Re-creating the employee rostering sample project”.
						


Registering the Solver using the REST API




						You must register the solver instance using the REST API before you can use the solver.
					

						Each solver instance is capable of optimizing one planning problem at a time.
					
Procedure
	
								Create a HTTP request using the following header:
							
authorization: admin:admin
X-KIE-ContentType: xstream
content-type: application/xml

	
								Register the Solver using the following request:
							
	PUT
	
											http://localhost:8080/kie-server/services/rest/server/containers/employeerostering_1.0.0-SNAPSHOT/solvers/EmployeeRosteringSolver
										
	Request body
	<solver-instance>
  <solver-config-file>employeerostering/employeerostering/EmployeeRosteringSolverConfig.solver.xml</solver-config-file>
</solver-instance>







Calling the Solver using the REST API




						After registering the solver instance, you can use the REST API to submit a data set to the solver and to retrieve an optimized solution.
					
Procedure
	
								Create a HTTP request using the following header:
							
authorization: admin:admin
X-KIE-ContentType: xstream
content-type: application/xml

	
								Submit a request to the Solver with a data set, as in the following example:
							
	POST
	
											http://localhost:8080/kie-server/services/rest/server/containers/employeerostering_1.0.0-SNAPSHOT/solvers/EmployeeRosteringSolver/state/solving
										
	Request body
	<employeerostering.employeerostering.EmployeeRoster>
  <employeeList>
    <employeerostering.employeerostering.Employee>
      <name>John</name>
      <skills>
        <employeerostering.employeerostering.Skill>
          <name>reading</name>
        </employeerostering.employeerostering.Skill>
      </skills>
    </employeerostering.employeerostering.Employee>
    <employeerostering.employeerostering.Employee>
      <name>Mary</name>
      <skills>
        <employeerostering.employeerostering.Skill>
          <name>writing</name>
        </employeerostering.employeerostering.Skill>
      </skills>
    </employeerostering.employeerostering.Employee>
    <employeerostering.employeerostering.Employee>
      <name>Petr</name>
      <skills>
        <employeerostering.employeerostering.Skill>
          <name>speaking</name>
        </employeerostering.employeerostering.Skill>
      </skills>
    </employeerostering.employeerostering.Employee>
  </employeeList>
  <shiftList>
    <employeerostering.employeerostering.Shift>
      <timeslot>
        <startTime>2017-01-01T00:00:00</startTime>
        <endTime>2017-01-01T01:00:00</endTime>
      </timeslot>
      <requiredSkill reference="../../../employeeList/employeerostering.employeerostering.Employee/skills/employeerostering.employeerostering.Skill"/>
    </employeerostering.employeerostering.Shift>
    <employeerostering.employeerostering.Shift>
      <timeslot reference="../../employeerostering.employeerostering.Shift/timeslot"/>
      <requiredSkill reference="../../../employeeList/employeerostering.employeerostering.Employee[3]/skills/employeerostering.employeerostering.Skill"/>
    </employeerostering.employeerostering.Shift>
    <employeerostering.employeerostering.Shift>
      <timeslot reference="../../employeerostering.employeerostering.Shift/timeslot"/>
      <requiredSkill reference="../../../employeeList/employeerostering.employeerostering.Employee[2]/skills/employeerostering.employeerostering.Skill"/>
    </employeerostering.employeerostering.Shift>
  </shiftList>
  <skillList>
    <employeerostering.employeerostering.Skill reference="../../employeeList/employeerostering.employeerostering.Employee/skills/employeerostering.employeerostering.Skill"/>
    <employeerostering.employeerostering.Skill reference="../../employeeList/employeerostering.employeerostering.Employee[3]/skills/employeerostering.employeerostering.Skill"/>
    <employeerostering.employeerostering.Skill reference="../../employeeList/employeerostering.employeerostering.Employee[2]/skills/employeerostering.employeerostering.Skill"/>
  </skillList>
  <timeslotList>
    <employeerostering.employeerostering.Timeslot reference="../../shiftList/employeerostering.employeerostering.Shift/timeslot"/>
  </timeslotList>
  <dayOffRequestList/>
  <shiftAssignmentList>
    <employeerostering.employeerostering.ShiftAssignment>
      <shift reference="../../../shiftList/employeerostering.employeerostering.Shift"/>
    </employeerostering.employeerostering.ShiftAssignment>
    <employeerostering.employeerostering.ShiftAssignment>
      <shift reference="../../../shiftList/employeerostering.employeerostering.Shift[3]"/>
    </employeerostering.employeerostering.ShiftAssignment>
    <employeerostering.employeerostering.ShiftAssignment>
      <shift reference="../../../shiftList/employeerostering.employeerostering.Shift[2]"/>
    </employeerostering.employeerostering.ShiftAssignment>
  </shiftAssignmentList>
</employeerostering.employeerostering.EmployeeRoster>




	
								Request the best solution to the planning problem:
							
	GET
	
											http://localhost:8080/kie-server/services/rest/server/containers/employeerostering_1.0.0-SNAPSHOT/solvers/EmployeeRosteringSolver/bestsolution
										
Example response

												

<solver-instance>
  <container-id>employee-rostering</container-id>
  <solver-id>solver1</solver-id>
  <solver-config-file>employeerostering/employeerostering/EmployeeRosteringSolverConfig.solver.xml</solver-config-file>
  <status>NOT_SOLVING</status>
  <score scoreClass="org.optaplanner.core.api.score.buildin.hardsoft.HardSoftScore">0hard/0soft</score>
  <best-solution class="employeerostering.employeerostering.EmployeeRoster">
    <employeeList>
      <employeerostering.employeerostering.Employee>
        <name>John</name>
        <skills>
          <employeerostering.employeerostering.Skill>
            <name>reading</name>
          </employeerostering.employeerostering.Skill>
        </skills>
      </employeerostering.employeerostering.Employee>
      <employeerostering.employeerostering.Employee>
        <name>Mary</name>
        <skills>
          <employeerostering.employeerostering.Skill>
            <name>writing</name>
          </employeerostering.employeerostering.Skill>
        </skills>
      </employeerostering.employeerostering.Employee>
      <employeerostering.employeerostering.Employee>
        <name>Petr</name>
        <skills>
          <employeerostering.employeerostering.Skill>
            <name>speaking</name>
          </employeerostering.employeerostering.Skill>
        </skills>
      </employeerostering.employeerostering.Employee>
    </employeeList>
    <shiftList>
      <employeerostering.employeerostering.Shift>
        <timeslot>
          <startTime>2017-01-01T00:00:00</startTime>
          <endTime>2017-01-01T01:00:00</endTime>
        </timeslot>
        <requiredSkill reference="../../../employeeList/employeerostering.employeerostering.Employee/skills/employeerostering.employeerostering.Skill"/>
      </employeerostering.employeerostering.Shift>
      <employeerostering.employeerostering.Shift>
        <timeslot reference="../../employeerostering.employeerostering.Shift/timeslot"/>
        <requiredSkill reference="../../../employeeList/employeerostering.employeerostering.Employee[3]/skills/employeerostering.employeerostering.Skill"/>
      </employeerostering.employeerostering.Shift>
      <employeerostering.employeerostering.Shift>
        <timeslot reference="../../employeerostering.employeerostering.Shift/timeslot"/>
        <requiredSkill reference="../../../employeeList/employeerostering.employeerostering.Employee[2]/skills/employeerostering.employeerostering.Skill"/>
      </employeerostering.employeerostering.Shift>
    </shiftList>
    <skillList>
      <employeerostering.employeerostering.Skill reference="../../employeeList/employeerostering.employeerostering.Employee/skills/employeerostering.employeerostering.Skill"/>
      <employeerostering.employeerostering.Skill reference="../../employeeList/employeerostering.employeerostering.Employee[3]/skills/employeerostering.employeerostering.Skill"/>
      <employeerostering.employeerostering.Skill reference="../../employeeList/employeerostering.employeerostering.Employee[2]/skills/employeerostering.employeerostering.Skill"/>
    </skillList>
    <timeslotList>
      <employeerostering.employeerostering.Timeslot reference="../../shiftList/employeerostering.employeerostering.Shift/timeslot"/>
    </timeslotList>
    <dayOffRequestList/>
    <shiftAssignmentList/>
    <score>0hard/0soft</score>
  </best-solution>
</solver-instance>


											









Chapter 34. Getting Started with OptaPlanner and Quarkus




				You can use the https://code.quarkus.redhat.com website to generate a Red Hat build of OptaPlanner Quarkus Maven project and automatically add and configure the extensions that you want to use in your application. You can then download the Quarkus Maven repository or use the online Maven repository with your project.
			
Apache Maven and Red Hat build of Quarkus




					Apache Maven is a distributed build automation tool used in Java application development to create, manage, and build software projects. Maven uses standard configuration files called Project Object Model (POM) files to define projects and manage the build process. POM files describe the module and component dependencies, build order, and targets for the resulting project packaging and output using an XML file. This ensures that the project is built in a correct and uniform manner.
				
Maven repositories

						A Maven repository stores Java libraries, plug-ins, and other build artifacts. The default public repository is the Maven 2 Central Repository, but repositories can be private and internal within a company to share common artifacts among development teams. Repositories are also available from third parties.
					

					You can use the online Maven repository with your Quarkus projects or you can download the Red Hat build of Quarkus Maven repository.
				
Maven plug-ins

						Maven plug-ins are defined parts of a POM file that achieve one or more goals. Quarkus applications use the following Maven plug-ins:
					
	
							Quarkus Maven plug-in (quarkus-maven-plugin): Enables Maven to create Quarkus projects, supports the generation of uber-JAR files, and provides a development mode.
						
	
							Maven Surefire plug-in (maven-surefire-plugin): Used during the test phase of the build lifecycle to execute unit tests on your application. The plug-in generates text and XML files that contain the test reports.
						


Configuring the Maven settings.xml file for the online repository




						You can use the online Maven repository with your Maven project by configuring your user settings.xml file. This is the recommended approach. Maven settings used with a repository manager or repository on a shared server provide better control and manageability of projects.
					
Note

							When you configure the repository by modifying the Maven settings.xml file, the changes apply to all of your Maven projects.
						

Procedure
	
								Open the Maven ~/.m2/settings.xml file in a text editor or integrated development environment (IDE).
							
Note

									If there is not a settings.xml file in the ~/.m2/ directory, copy the settings.xml file from the $MAVEN_HOME/.m2/conf/ directory into the ~/.m2/ directory.
								


	
								Add the following lines to the <profiles> element of the settings.xml file:
							
<!-- Configure the Maven repository -->
<profile>
  <id>red-hat-enterprise-maven-repository</id>
  <repositories>
    <repository>
      <id>red-hat-enterprise-maven-repository</id>
      <url>https://maven.repository.redhat.com/ga/</url>
      <releases>
        <enabled>true</enabled>
      </releases>
      <snapshots>
        <enabled>false</enabled>
      </snapshots>
    </repository>
  </repositories>
  <pluginRepositories>
    <pluginRepository>
      <id>red-hat-enterprise-maven-repository</id>
      <url>https://maven.repository.redhat.com/ga/</url>
      <releases>
        <enabled>true</enabled>
      </releases>
      <snapshots>
        <enabled>false</enabled>
      </snapshots>
    </pluginRepository>
  </pluginRepositories>
</profile>

	
								Add the following lines to the <activeProfiles> element of the settings.xml file and save the file.
							
<activeProfile>red-hat-enterprise-maven-repository</activeProfile>




Downloading and configuring the Quarkus Maven repository




						If you do not want to use the online Maven repository, you can download and configure the Quarkus Maven repository to create a Quarkus application with Maven. The Quarkus Maven repository contains many of the requirements that Java developers typically use to build their applications. This procedure describes how to edit the settings.xml file to configure the Quarkus Maven repository.
					
Note

							When you configure the repository by modifying the Maven settings.xml file, the changes apply to all of your Maven projects.
						

Procedure
	
								Download the Red Hat build of Quarkus Maven repository ZIP file from the Software Downloads page of the Red Hat Customer Portal (login required).
							
	
								Expand the downloaded archive.
							
	
								Change directory to the ~/.m2/ directory and open the Maven settings.xml file in a text editor or integrated development environment (IDE).
							
	
								Add the following lines to the <profiles> element of the settings.xml file, where QUARKUS_MAVEN_REPOSITORY is the path of the Quarkus Maven repository that you downloaded. The format of QUARKUS_MAVEN_REPOSITORY must be file://$PATH, for example file:///home/userX/rh-quarkus-2.13.GA-maven-repository/maven-repository.
							
<!-- Configure the Quarkus Maven repository -->
<profile>
  <id>red-hat-enterprise-maven-repository</id>
  <repositories>
    <repository>
      <id>red-hat-enterprise-maven-repository</id>
      <url>QUARKUS_MAVEN_REPOSITORY</url>
      <releases>
        <enabled>true</enabled>
      </releases>
      <snapshots>
        <enabled>false</enabled>
      </snapshots>
    </repository>
  </repositories>
  <pluginRepositories>
    <pluginRepository>
      <id>red-hat-enterprise-maven-repository</id>
      <url>QUARKUS_MAVEN_REPOSITORY</url>
      <releases>
        <enabled>true</enabled>
      </releases>
      <snapshots>
        <enabled>false</enabled>
      </snapshots>
    </pluginRepository>
  </pluginRepositories>
</profile>

	
								Add the following lines to the <activeProfiles> element of the settings.xml file and save the file.
							
<activeProfile>red-hat-enterprise-maven-repository</activeProfile>



Important

							If your Maven repository contains outdated artifacts, you might encounter one of the following Maven error messages when you build or deploy your project, where ARTIFACT_NAME is the name of a missing artifact and PROJECT_NAME is the name of the project you are trying to build:
						
	
									Missing artifact PROJECT_NAME
								
	
									[ERROR] Failed to execute goal on project ARTIFACT_NAME; Could not resolve dependencies for PROJECT_NAME
								



							To resolve the issue, delete the cached version of your local repository located in the ~/.m2/repository directory to force a download of the latest Maven artifacts.
						



Creating an OptaPlanner Red Hat build of Quarkus Maven project using the Maven plug-in




					You can get up and running with a Red Hat build of OptaPlanner and Quarkus application using Apache Maven and the Quarkus Maven plug-in.
				
Prerequisites
	
							OpenJDK 11 or later is installed. Red Hat build of Open JDK is available from the Software Downloads page in the Red Hat Customer Portal (login required).
						
	
							Apache Maven 3.6 or higher is installed. Maven is available from the Apache Maven Project website.
						


Procedure
	
							In a command terminal, enter the following command to verify that Maven is using JDK 11 and that the Maven version is 3.6 or higher:
						
mvn --version

	
							If the preceding command does not return JDK 11, add the path to JDK 11 to the PATH environment variable and enter the preceding command again.
						
	
							To generate a Quarkus OptaPlanner quickstart project, enter the following command:
						
mvn com.redhat.quarkus.platform:quarkus-maven-plugin:2.13.Final-redhat-00006:create \
    -DprojectGroupId=com.example \
    -DprojectArtifactId=optaplanner-quickstart  \
    -Dextensions="resteasy,resteasy-jackson,optaplanner-quarkus,optaplanner-quarkus-jackson" \
    -DplatformGroupId=com.redhat.quarkus.platform
    -DplatformVersion=2.13.Final-redhat-00006 \
    -DnoExamples

							This command create the following elements in the ./optaplanner-quickstart directory:
						
	
									The Maven structure
								
	
									Example Dockerfile file in src/main/docker
								
	
									The application configuration file
								
Table 34.1. Properties used in the mvn io.quarkus:quarkus-maven-plugin:2.13.Final-redhat-00006:create command
	Property	Description
	 
													projectGroupId
												

												 	 
													The group ID of the project.
												

												 
	 
													projectArtifactId
												

												 	 
													The artifact ID of the project.
												

												 
	 
													extensions
												

												 	 
													A comma-separated list of Quarkus extensions to use with this project. For a full list of Quarkus extensions, enter mvn quarkus:list-extensions on the command line.
												

												 
	 
													noExamples
												

												 	 
													Creates a project with the project structure but without tests or classes.
												

												 




									The values of the projectGroupID and the projectArtifactID properties are used to generate the project version. The default project version is 1.0.0-SNAPSHOT.
								




	
							To view your OptaPlanner project, change directory to the OptaPlanner Quickstarts directory:
						
cd optaplanner-quickstart

	
							Review the pom.xml file. The content should be similar to the following example:
						
<dependencyManagement>
  <dependencies>
    <dependency>
      <groupId>io.quarkus.platform</groupId>
      <artifactId>quarkus-bom</artifactId>
      <version>2.13.Final-redhat-00006</version>
      <type>pom</type>
      <scope>import</scope>
    </dependency>
    <dependency>
      <groupId>io.quarkus.platform</groupId>
      <artifactId>quarkus-optaplanner-bom</artifactId>
      <version>2.13.Final-redhat-00006</version>
      <type>pom</type>
      <scope>import</scope>
    </dependency>
  </dependencies>
</dependencyManagement>
<dependencies>
  <dependency>
    <groupId>io.quarkus</groupId>
    <artifactId>quarkus-resteasy</artifactId>
  </dependency>
  <dependency>
    <groupId>io.quarkus</groupId>
    <artifactId>quarkus-resteasy-jackson</artifactId>
  </dependency>
  <dependency>
    <groupId>org.optaplanner</groupId>
    <artifactId>optaplanner-quarkus</artifactId>
  </dependency>
  <dependency>
    <groupId>org.optaplanner</groupId>
    <artifactId>optaplanner-quarkus-jackson</artifactId>
  </dependency>
  <dependency>
    <groupId>io.quarkus</groupId>
    <artifactId>quarkus-junit5</artifactId>
    <scope>test</scope>
  </dependency>
</dependencies>




Creating a Red Hat build of Quarkus Maven project using code.quarkus.redhat.com




					You can use the code.quarkus.redhat.com website to generate a Red Hat build of OptaPlanner Quarkus Maven project and automatically add and configure the extensions that you want to use in your application. In addition, code.quarkus.redhat.com automatically manages the configuration parameters required to compile your project into a native executable.
				

					This section walks you through the process of generating an OptaPlanner Maven project and includes the following topics:
				
	
							Specifying basic details about your application.
						
	
							Choosing the extensions that you want to include in your project.
						
	
							Generating a downloadable archive with your project files.
						
	
							Using the custom commands for compiling and starting your application.
						


Prerequisites
	
							You have a web browser.
						


Procedure
	
							Open https://code.quarkus.redhat.com in your web browser:
						
	
							Specify details about your project:
						
	
							Enter a group name for your project. The format of the name follows the Java package naming convention, for example, com.example.
						
	
							Enter a name that you want to use for Maven artifacts generated from your project, for example code-with-quarkus.
						
	
							Select Build Tool > Maven to specify that you want to create a Maven project. The build tool that you choose determines the items:
						
	
									The directory structure of your generated project
								
	
									The format of configuration files used in your generated project
								
	
									The custom build script and command for compiling and starting your application that code.quarkus.redhat.com displays for you after you generate your project
								
Note

										Red Hat provides support for using code.quarkus.redhat.com to create OptaPlanner Maven projects only. Generating Gradle projects is not supported by Red Hat.
									





	
							Enter a version to be used in artifacts generated from your project. The default value of this field is 1.0.0-SNAPSHOT. Using semantic versioning is recommended, but you can use a different type of versioning if you prefer.
						
	
							Enter the package name of artifacts that the build tool generates when you package your project.
						

							According to the Java package naming conventions the package name should match the group name that you use for your project, but you can specify a different name.
						
Note

								The code.quarkus.redhat.com website automatically uses the latest release of OptaPlanner. You can manually change the BOM version in the pom.xml file after you generate your project.
							


	
							Select the following extensions to include as dependencies:
						
	
									RESTEasy JAX-RS (quarkus-resteasy)
								
	
									RESTEasy Jackson (quarkus-resteasy-jackson)
								
	
									OptaPlanner AI constraint solver(optaplanner-quarkus)
								
	
									OptaPlanner Jackson (optaplanner-quarkus-jackson)
								

									Red Hat provides different levels of support for individual extensions on the list, which are indicated by labels next to the name of each extension:
								
	
											SUPPORTED extensions are fully supported by Red Hat for use in enterprise applications in production environments.
										
	
											TECH-PREVIEW extensions are subject to limited support by Red Hat in production environments under the Technology Preview Features Support Scope.
										
	
											DEV-SUPPORT extensions are not supported by Red Hat for use in production environments, but the core functionalities that they provide are supported by Red Hat developers for use in developing new applications.
										
	
											DEPRECATED extension are planned to be replaced with a newer technology or implementation that provides the same functionality.
										

											Unlabeled extensions are not supported by Red Hat for use in production environments.
										







	
							Select Generate your application to confirm your choices and display the overlay screen with the download link for the archive that contains your generated project. The overlay screen also shows the custom command that you can use to compile and start your application.
						
	
							Select Download the ZIP to save the archive with the generated project files to your system.
						
	
							Extract the contents of the archive.
						
	
							Navigate to the directory that contains your extracted project files:
						
cd <directory_name>

	
							Compile and start your application in development mode:
						
./mvnw compile quarkus:dev




Creating a Red Hat build of Quarkus Maven project using the Quarkus CLI




					You can use the Quarkus command line interface (CLI) to create a Quarkus OptaPlanner project.
				
Prerequisites
	
							You have installed the Quarkus CLI. For information, see Building Quarkus Apps with Quarkus Command Line Interface.
						


Procedure
	
							Create a Quarkus application:
						
quarkus create app -P io.quarkus:quarkus-bom:2.13.Final-redhat-00006

	
							To view the available extensions, enter the following command:
						
quarkus ext -i

							This command returns the following extensions:
						
optaplanner-quarkus
optaplanner-quarkus-benchmark
optaplanner-quarkus-jackson
optaplanner-quarkus-jsonb

	
							Enter the following command to add extensions to the project’s pom.xml file:
						
quarkus ext add resteasy-jackson
quarkus ext add optaplanner-quarkus
quarkus ext add optaplanner-quarkus-jackson

	
							Open the pom.xml file in a text editor. The contents of the file should look similar to the following example:
						
<?xml version="1.0"?>
<project xsi:schemaLocation="http://maven.apache.org/POM/4.0.0 https://maven.apache.org/xsd/maven-4.0.0.xsd" xmlns="http://maven.apache.org/POM/4.0.0"
	xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
  <modelVersion>4.0.0</modelVersion>
  <groupId>org.acme</groupId>
  <artifactId>code-with-quarkus-optaplanner</artifactId>
  <version>1.0.0-SNAPSHOT</version>
  <properties>
	<compiler-plugin.version>3.8.1</compiler-plugin.version>
	<maven.compiler.parameters>true</maven.compiler.parameters>
	<maven.compiler.source>11</maven.compiler.source>
	<maven.compiler.target>11</maven.compiler.target>
	<project.build.sourceEncoding>UTF-8</project.build.sourceEncoding>
	<project.reporting.outputEncoding>UTF-8</project.reporting.outputEncoding>
	<quarkus.platform.artifact-id>quarkus-bom</quarkus.platform.artifact-id>
	<quarkus.platform.group-id>io.quarkus</quarkus.platform.group-id>
	<quarkus.platform.version>2.13.Final-redhat-00006</quarkus.platform.version>
	<surefire-plugin.version>3.0.0-M5</surefire-plugin.version>
  </properties>
  <dependencyManagement>
	<dependencies>
  	<dependency>
    	<groupId>${quarkus.platform.group-id}</groupId>
    	<artifactId>${quarkus.platform.artifact-id}</artifactId>
    	<version>${quarkus.platform.version}</version>
    	<type>pom</type>
    	<scope>import</scope>
  	</dependency>
  	<dependency>
    	<groupId>io.quarkus.platform</groupId>
    	<artifactId>optaplanner-quarkus</artifactId>
    	<version>2.2.2.Final</version>
    	<type>pom</type>
    	<scope>import</scope>
  	</dependency>
	</dependencies>
  </dependencyManagement>
  <dependencies>
	<dependency>
  	<groupId>io.quarkus</groupId>
  	<artifactId>quarkus-arc</artifactId>
	</dependency>
	<dependency>
  	<groupId>io.quarkus</groupId>
  	<artifactId>quarkus-resteasy</artifactId>
	</dependency>
	<dependency>
  	<groupId>org.optaplanner</groupId>
  	<artifactId>optaplanner-quarkus</artifactId>
	</dependency>
	<dependency>
  	<groupId>org.optaplanner</groupId>
  	<artifactId>optaplanner-quarkus-jackson</artifactId>
	</dependency>
	<dependency>
  	<groupId>io.quarkus</groupId>
  	<artifactId>quarkus-resteasy-jackson</artifactId>
	</dependency>
	<dependency>
  	<groupId>io.quarkus</groupId>
  	<artifactId>quarkus-junit5</artifactId>
  	<scope>test</scope>
	</dependency>
	<dependency>
  	<groupId>io.rest-assured</groupId>
  	<artifactId>rest-assured</artifactId>
  	<scope>test</scope>
	</dependency>
  </dependencies>
  <build>
	<plugins>
  	<plugin>
    	<groupId>${quarkus.platform.group-id}</groupId>
    	<artifactId>quarkus-maven-plugin</artifactId>
    	<version>${quarkus.platform.version}</version>
    	<extensions>true</extensions>
    	<executions>
      	<execution>
        	<goals>
          	<goal>build</goal>
          	<goal>generate-code</goal>
          	<goal>generate-code-tests</goal>
        	</goals>
      	</execution>
    	</executions>
  	</plugin>
  	<plugin>
    	<artifactId>maven-compiler-plugin</artifactId>
    	<version>${compiler-plugin.version}</version>
    	<configuration>
      	<parameters>${maven.compiler.parameters}</parameters>
    	</configuration>
  	</plugin>
  	<plugin>
    	<artifactId>maven-surefire-plugin</artifactId>
    	<version>${surefire-plugin.version}</version>
    	<configuration>
      	<systemPropertyVariables>
        	<java.util.logging.manager>org.jboss.logmanager.LogManager</java.util.logging.manager>
        	<maven.home>${maven.home}</maven.home>
      	</systemPropertyVariables>
    	</configuration>
  	</plugin>
	</plugins>
  </build>
  <profiles>
	<profile>
  	<id>native</id>
  	<activation>
    	<property>
      	<name>native</name>
    	</property>
  	</activation>
  	<build>
    	<plugins>
      	<plugin>
        	<artifactId>maven-failsafe-plugin</artifactId>
        	<version>${surefire-plugin.version}</version>
        	<executions>
          	<execution>
            	<goals>
              	<goal>integration-test</goal>
              	<goal>verify</goal>
            	</goals>
            	<configuration>
              	<systemPropertyVariables>
                	<native.image.path>${project.build.directory}/${project.build.finalName}-runner</native.image.path>
                	<java.util.logging.manager>org.jboss.logmanager.LogManager</java.util.logging.manager>
                	<maven.home>${maven.home}</maven.home>
              	</systemPropertyVariables>
            	</configuration>
          	</execution>
        	</executions>
      	</plugin>
    	</plugins>
  	</build>
  	<properties>
    	<quarkus.package.type>native</quarkus.package.type>
  	</properties>
	</profile>
  </profiles>
</project>





Appendix A. Versioning information




			Documentation last updated on Thursday, March 14th, 2024.
		

Appendix B. Contact information




			Red Hat Process Automation Manager documentation team: brms-docs@redhat.com
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# Highlight.js

Highlight.js — это подсветчик синтаксиса, написанный на JavaScript. Он работает
и в браузере, и на сервере. Он работает с практически любой HTML разметкой, не
зависит от каких-либо фреймворков и умеет автоматически определять язык.


## Начало работы

Минимум, что нужно сделать для использования highlight.js на веб-странице — это
подключить библиотеку, CSS-стили и вызывать [`initHighlightingOnLoad`][1]:

```html
<link rel="stylesheet" href="/path/to/styles/default.css">
<script src="/path/to/highlight.pack.js"></script>
<script>hljs.initHighlightingOnLoad();</script>
```

Библиотека найдёт и раскрасит код внутри тегов `<pre><code>`, попытавшись
автоматически определить язык. Когда автоопределение не срабатывает, можно явно
указать язык в атрибуте class:

```html
<pre><code class="html">...</code></pre>
```

Список поддерживаемых классов языков доступен в [справочнике по классам][8].
Класс также можно предваоить префиксами `language-` или `lang-`.

Чтобы отключить подсветку для какого-то блока, используйте класс `nohighlight`:

```html
<pre><code class="nohighlight">...</code></pre>
```

## Инициализация вручную

Чтобы иметь чуть больше контроля за инициализацией подсветки, вы можете
использовать функции [`highlightBlock`][2] и [`configure`][3]. Таким образом
можно управлять тем, *что* подсвечивать и *когда*.

Вот пример инициализация, эквивалентной вызову [`initHighlightingOnLoad`][1], но
с использованием jQuery:

```javascript
$(document).ready(function() {
  $('pre code').each(function(i, block) {
    hljs.highlightBlock(block);
  });
});
```

Вы можете использовать любые теги разметки вместо `<pre><code>`. Если
используете контейнер, не сохраняющий переводы строк, вам нужно сказать
highlight.js использовать для них тег `<br>`:

```javascript
hljs.configure({useBR: true});

$('div.code').each(function(i, block) {
  hljs.highlightBlock(block);
});
```

Другие опции можно найти в документации функции [`configure`][3].


## Установка библиотеки

Highlight.js можно использовать в браузере прямо с CDN хостинга или скачать
индивидуальную сборку, а также установив модуль на сервере. На
[страница загрузки][4] подробно описаны все варианты.

Обратите внимание, что библиотека не предназначена для использования в виде
исходного кода на GitHub, а требует отдельной сборки. Если вам не подходит ни
один из готовых вариантов, читайте [документацию по сборке][5].


## Лицензия

Highlight.js распространяется под лицензией BSD. Подробнее читайте файл
[LICENSE][10].


## Ссылки

Официальный сайт билиотеки расположен по адресу <https://highlightjs.org/>.

Более подробная документация по API и другим темам расположена на
<http://highlightjs.readthedocs.org/>.

Авторы и контрибьютора перечислена в файле [AUTHORS.ru.txt][9] file.

[1]: http://highlightjs.readthedocs.org/en/latest/api.html#inithighlightingonload
[2]: http://highlightjs.readthedocs.org/en/latest/api.html#highlightblock-block
[3]: http://highlightjs.readthedocs.org/en/latest/api.html#configure-options
[4]: https://highlightjs.org/download/
[5]: http://highlightjs.readthedocs.org/en/latest/building-testing.html
[8]: http://highlightjs.readthedocs.org/en/latest/css-classes-reference.html
[9]: https://github.com/isagalaev/highlight.js/blob/master/AUTHORS.ru.txt
[10]: https://github.com/isagalaev/highlight.js/blob/master/LICENSE
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## Version 8.4

We've got the new [demo page][]! The obvious new feature is the new look, but
apart from that it's got smarter: by presenting languages in groups it avoids
running 10000 highlighting attempts after first load which was slowing it down
and giving bad overall impression. It is now also being generated from test
code snippets so the authors of new languages don't have to update both tests
and the demo page with the same thing.

Other notable changes:

- The `template_comment` class is gone in favor of the more general `comment`.
- Number parsing unified and improved across languages.
- C++, Java and C# now use unified grammar to highlight titles in
  function/method definitions.
- The browser build is now usable as an AMD module, there's no separate build
  target for that anymore.
- OCaml has got a [comprehensive overhaul][ocaml] by [Mickaël Delahaye][].
- Clojure's data structures and literals are now highlighted outside of lists
  and we can now highlight Clojure's REPL sessions.

New languages:

- *AspectJ* by [Hakan Özler][]
- *STEP Part 21* by [Adam Joseph Cook][]
- *SML* derived by [Edwin Dalorzo][] from OCaml definition
- *Mercury* by [mucaho][]
- *Smali* by [Dennis Titze][]
- *Verilog* by [Jon Evans][]
- *Stata* by [Brian Quistorff][]

[Hakan Özler]: https://github.com/ozlerhakan
[Adam Joseph Cook]: https://github.com/adamjcook
[demo page]: https://highlightjs.org/static/demo/
[Ivan Sagalaev]: https://github.com/isagalaev
[Edwin Dalorzo]: https://github.com/edalorzo
[mucaho]: https://github.com/mucaho
[Dennis Titze]: https://github.com/titze
[Jon Evans]: https://github.com/craftyjon
[Brian Quistorff]: https://github.com/bquistorff
[ocaml]: https://github.com/isagalaev/highlight.js/pull/608#issue-46190207
[Mickaël Delahaye]: https://github.com/polazarus


## Version 8.3

We streamlined our tool chain, it is now based entirely on node.js instead of
being a mix of node.js, Python and Java. The build script options and arguments
remained the same, and we've noted all the changes in the [documentation][b].
Apart from reducing complexity, the new build script is also faster from not
having to start Java machine repeatedly. The credits for the work go to [Jeremy
Hull][].

Some notable fixes:

- PHP and JavaScript mixed in HTML now live happily with each other.
- JavaScript regexes now understand ES6 flags "u" and "y".
- `throw` keyword is no longer detected as a method name in Java.
- Fixed parsing of numbers and symbols in Clojure thanks to [input from Ivan
  Kleshnin][ik].

New languages in this release:

- *Less* by [Max Mikhailov][]
- *Stylus* by [Bryant Williams][]
- *Tcl* by [Radek Liska][]
- *Puppet* by [Jose Molina Colmenero][]
- *Processing* by [Erik Paluka][]
- *Twig* templates by [Luke Holder][]
- *PowerShell* by [David Mohundro][], based on [the work of Nicholas
  Blumhardt][ps]
- *XL* by [Christophe de Dinechin][]
- *LiveScript* by [Taneli Vatanen][] and [Jen Evers-Corvina][]
- *ERB* (Ruby in HTML) by [Lucas Mazza][]
- *Roboconf* by [Vincent Zurczak][]

[b]: http://highlightjs.readthedocs.org/en/latest/building-testing.html
[Jeremy Hull]: https://github.com/sourrust
[ik]: https://twitter.com/IvanKleshnin/status/514041599484231680
[Max Mikhailov]: https://github.com/seven-phases-max
[Bryant Williams]: https://github.com/scien
[Radek Liska]: https://github.com/Nindaleth
[Jose Molina Colmenero]: https://github.com/Moliholy
[Erik Paluka]: https://github.com/paluka
[Luke Holder]: https://github.com/lukeholder
[David Mohundro]: https://github.com/drmohundro
[ps]: https://github.com/OctopusDeploy/Library/blob/master/app/shared/presentation/highlighting/powershell.js
[Christophe de Dinechin]: https://github.com/c3d
[Taneli Vatanen]: https://github.com/Daiz-
[Jen Evers-Corvina]: https://github.com/sevvie
[Lucas Mazza]: https://github.com/lucasmazza
[Vincent Zurczak]: https://github.com/vincent-zurczak

## Version 8.2

We've finally got [real tests][test] and [continuous testing on Travis][ci]
thanks to [Jeremy Hull][] and [Chris Eidhof][]. The tests designed to cover
everything: language detection, correct parsing of individual language features
and various special cases. This is a very important change that gives us
confidence in extending language definitions and refactoring library core.

We're going to redesign the old [demo/test suite][demo] into an interactive
demo web app. If you're confident front-end developer or designer and want to
help us with it, drop a comment into [the issue][#542] on GitHub.

[test]: https://github.com/isagalaev/highlight.js/tree/master/test
[demo]: https://highlightjs.org/static/test.html
[#542]: https://github.com/isagalaev/highlight.js/issues/542
[ci]: https://travis-ci.org/isagalaev/highlight.js
[Jeremy Hull]: https://github.com/sourrust
[Chris Eidhof]: https://github.com/chriseidhof

As usually there's a handful of new languages in this release:

- *Groovy* by [Guillaume Laforge][]
- *Dart* by [Maxim Dikun][]
- *Dust* by [Michael Allen][]
- *Scheme* by [JP Verkamp][]
- *G-Code* by [Adam Joseph Cook][]
- *Q* from Kx Systems by [Sergey Vidyuk][]

[Guillaume Laforge]: https://github.com/glaforge
[Maxim Dikun]: https://github.com/dikmax
[Michael Allen]: https://github.com/bfui
[JP Verkamp]: https://github.com/jpverkamp
[Adam Joseph Cook]: https://github.com/adamjcook
[Sergey Vidyuk]: https://github.com/sv

Other improvements:

- [Erik Osheim][] heavily reworked Scala definitions making it richer.
- [Lucas Mazza][] fixed Ruby hashes highlighting
- Lisp variants (Lisp, Clojure and Scheme) are unified in regard to naming
  the first symbol in parentheses: it's "keyword" in general case and also
  "built_in" for built-in functions in Clojure and Scheme.

[Erik Osheim]: https://github.com/non
[Lucas Mazza]: https://github.com/lucasmazza

## Version 8.1

New languages:

- *Gherkin* by [Sam Pikesley][]
- *Elixir* by [Josh Adams][]
- *NSIS* by [Jan T. Sott][]
- *VIM script* by [Jun Yang][]
- *Protocol Buffers* by [Dan Tao][]
- *Nix* by [Domen Kožar][]
- *x86asm* by [innocenat][]
- *Cap’n Proto* and *Thrift* by [Oleg Efimov][]
- *Monkey* by [Arthur Bikmullin][]
- *TypeScript* by [Panu Horsmalahti][]
- *Nimrod* by [Flaviu Tamas][]
- *Gradle* by [Damian Mee][]
- *Haxe* by [Christopher Kaster][]
- *Swift* by [Chris Eidhof][] and [Nate Cook][]

New styles:

- *Kimbie*, light and dark variants by [Jan T. Sott][]
- *Color brewer* by [Fabrício Tavares de Oliveira][]
- *Codepen.io embed* by [Justin Perry][]
- *Hybrid* by [Nic West][]

[Sam Pikesley]: https://github.com/pikesley
[Sindre Sorhus]: https://github.com/sindresorhus
[Josh Adams]: https://github.com/knewter
[Jan T. Sott]: https://github.com/idleberg
[Jun Yang]: https://github.com/harttle
[Dan Tao]: https://github.com/dtao
[Domen Kožar]: https://github.com/iElectric
[innocenat]: https://github.com/innocenat
[Oleg Efimov]: https://github.com/Sannis
[Arthur Bikmullin]: https://github.com/devolonter
[Panu Horsmalahti]: https://github.com/panuhorsmalahti
[Flaviu Tamas]: https://github.com/flaviut
[Damian Mee]: https://github.com/chester1000
[Christopher Kaster]: http://christopher.kaster.ws
[Fabrício Tavares de Oliveira]: https://github.com/fabriciotav
[Justin Perry]: https://github.com/ourmaninamsterdam
[Nic West]: https://github.com/nicwest
[Chris Eidhof]: https://github.com/chriseidhof
[Nate Cook]: https://github.com/natecook1000

Other improvements:

- The README is heavily reworked and brought up to date by [Jeremy Hull][].
- Added [`listLanguages()`][ll] method in the API.
- Improved C/C++/C# detection.
- Added a bunch of new language aliases, documented the existing ones. Thanks to
  [Sindre Sorhus][] for background research.
- Added phrasal English words to boost relevance in comments.
- Many improvements to SQL definition made by [Heiko August][],
  [Nikolay Lisienko][] and [Travis Odom][].
- The shorter `lang-` prefix for language names in HTML classes supported
  alongside `language-`. Thanks to [Jeff Escalante][].
- Ruby's got support for interactive console sessions. Thanks to
  [Pascal Hurni][].
- Added built-in functions for R language. Thanks to [Artem A. Klevtsov][].
- Rust's got definition for lifetime parameters and improved string syntax.
  Thanks to [Roman Shmatov][].
- Various improvements to Objective-C definition by [Matt Diephouse][].
- Fixed highlighting of generics in Java.

[ll]: http://highlightjs.readthedocs.org/en/latest/api.html#listlanguages
[Sindre Sorhus]: https://github.com/sindresorhus
[Heiko August]: https://github.com/auge8472
[Nikolay Lisienko]: https://github.com/neor-ru
[Travis Odom]: https://github.com/Burstaholic
[Jeff Escalante]: https://github.com/jenius
[Pascal Hurni]: https://github.com/phurni
[Jiyin Yiyong]: https://github.com/jiyinyiyong
[Artem A. Klevtsov]: https://github.com/unikum
[Roman Shmatov]: https://github.com/shmatov
[Jeremy Hull]: https://github.com/sourrust
[Matt Diephouse]: https://github.com/mdiep


## Version 8.0

This new major release is quite a big overhaul bringing both new features and
some backwards incompatible changes. However, chances are that the majority of
users won't be affected by the latter: the basic scenario described in the
README is left intact.

Here's what did change in an incompatible way:

- We're now prefixing all classes located in [CSS classes reference][cr] with
  `hljs-`, by default, because some class names would collide with other
  people's stylesheets. If you were using an older version, you might still want
  the previous behavior, but still want to upgrade. To suppress this new
  behavior, you would initialize like so:

  ```html
  <script type="text/javascript">
    hljs.configure({classPrefix: ''});
    hljs.initHighlightingOnLoad();
  </script>
  ```

- `tabReplace` and `useBR` that were used in different places are also unified
  into the global options object and are to be set using `configure(options)`.
  This function is documented in our [API docs][]. Also note that these
  parameters are gone from `highlightBlock` and `fixMarkup` which are now also
  rely on `configure`.

- We removed public-facing (though undocumented) object `hljs.LANGUAGES` which
  was used to register languages with the library in favor of two new methods:
  `registerLanguage` and `getLanguage`. Both are documented in our [API docs][].

- Result returned from `highlight` and `highlightAuto` no longer contains two
  separate attributes contributing to relevance score, `relevance` and
  `keyword_count`. They are now unified in `relevance`.

Another technically compatible change that nonetheless might need attention:

- The structure of the NPM package was refactored, so if you had installed it
  locally, you'll have to update your paths. The usual `require('highlight.js')`
  works as before. This is contributed by [Dmitry Smolin][].

New features:

- Languages now can be recognized by multiple names like "js" for JavaScript or
  "html" for, well, HTML (which earlier insisted on calling it "xml"). These
  aliases can be specified in the class attribute of the code container in your
  HTML as well as in various API calls. For now there are only a few very common
  aliases but we'll expand it in the future. All of them are listed in the
  [class reference][cr].

- Language detection can now be restricted to a subset of languages relevant in
  a given context — a web page or even a single highlighting call. This is
  especially useful for node.js build that includes all the known languages.
  Another example is a StackOverflow-style site where users specify languages
  as tags rather than in the markdown-formatted code snippets. This is
  documented in the [API reference][] (see methods `highlightAuto` and
  `configure`).

- Language definition syntax streamlined with [variants][] and
  [beginKeywords][].

New languages and styles:

- *Oxygene* by [Carlo Kok][]
- *Mathematica* by [Daniel Kvasnička][]
- *Autohotkey* by [Seongwon Lee][]
- *Atelier* family of styles in 10 variants by [Bram de Haan][]
- *Paraíso* styles by [Jan T. Sott][]

Miscellaneous improvements:

- Highlighting `=>` prompts in Clojure.
- [Jeremy Hull][] fixed a lot of styles for consistency.
- Finally, highlighting PHP and HTML [mixed in peculiar ways][php-html].
- Objective C and C# now properly highlight titles in method definition.
- Big overhaul of relevance counting for a number of languages. Please do report
  bugs about mis-detection of non-trivial code snippets!

[API reference]: http://highlightjs.readthedocs.org/en/latest/api.html

[cr]: http://highlightjs.readthedocs.org/en/latest/css-classes-reference.html
[api docs]: http://highlightjs.readthedocs.org/en/latest/api.html
[variants]: https://groups.google.com/d/topic/highlightjs/VoGC9-1p5vk/discussion
[beginKeywords]: https://github.com/isagalaev/highlight.js/commit/6c7fdea002eb3949577a85b3f7930137c7c3038d
[php-html]: https://twitter.com/highlightjs/status/408890903017689088

[Carlo Kok]: https://github.com/carlokok
[Bram de Haan]: https://github.com/atelierbram
[Daniel Kvasnička]: https://github.com/dkvasnicka
[Dmitry Smolin]: https://github.com/dimsmol
[Jeremy Hull]: https://github.com/sourrust
[Seongwon Lee]: https://github.com/dlimpid
[Jan T. Sott]: https://github.com/idleberg


## Version 7.5

A catch-up release dealing with some of the accumulated contributions. This one
is probably will be the last before the 8.0 which will be slightly backwards
incompatible regarding some advanced use-cases.

One outstanding change in this version is the addition of 6 languages to the
[hosted script][d]: Markdown, ObjectiveC, CoffeeScript, Apache, Nginx and
Makefile. It now weighs about 6K more but we're going to keep it under 30K.

New languages:

- OCaml by [Mehdi Dogguy][mehdid] and [Nicolas Braud-Santoni][nbraud]
- [LiveCode Server][lcs] by [Ralf Bitter][revig]
- Scilab by [Sylvestre Ledru][sylvestre]
- basic support for Makefile by [Ivan Sagalaev][isagalaev]

Improvements:

- Ruby's got support for characters like `?A`, `?1`, `?\012` etc. and `%r{..}`
  regexps.
- Clojure now allows a function call in the beginning of s-expressions
  `(($filter "myCount") (arr 1 2 3 4 5))`.
- Haskell's got new keywords and now recognizes more things like pragmas,
  preprocessors, modules, containers, FFIs etc. Thanks to [Zena Treep][treep]
  for the implementation and to [Jeremy Hull][sourrust] for guiding it.
- Miscellaneous fixes in PHP, Brainfuck, SCSS, Asciidoc, CMake, Python and F#.

[mehdid]: https://github.com/mehdid
[nbraud]: https://github.com/nbraud
[revig]: https://github.com/revig
[lcs]: http://livecode.com/developers/guides/server/
[sylvestre]: https://github.com/sylvestre
[isagalaev]: https://github.com/isagalaev
[treep]: https://github.com/treep
[sourrust]: https://github.com/sourrust
[d]: http://highlightjs.org/download/


## New core developers

The latest long period of almost complete inactivity in the project coincided
with growing interest to it led to a decision that now seems completely obvious:
we need more core developers.

So without further ado let me welcome to the core team two long-time
contributors: [Jeremy Hull][] and [Oleg
Efimov][].

Hope now we'll be able to work through stuff faster!

P.S. The historical commit is [here][1] for the record.

[Jeremy Hull]: https://github.com/sourrust
[Oleg Efimov]: https://github.com/sannis
[1]: https://github.com/isagalaev/highlight.js/commit/f3056941bda56d2b72276b97bc0dd5f230f2473f


## Version 7.4

This long overdue version is a snapshot of the current source tree with all the
changes that happened during the past year. Sorry for taking so long!

Along with the changes in code highlight.js has finally got its new home at
<http://highlightjs.org/>, moving from its cradle on Software Maniacs which it
outgrew a long time ago. Be sure to report any bugs about the site to
<mailto:info@highlightjs.org>.

On to what's new…

New languages:

- Handlebars templates by [Robin Ward][]
- Oracle Rules Language by [Jason Jacobson][]
- F# by [Joans Follesø][]
- AsciiDoc and Haml by [Dan Allen][]
- Lasso by [Eric Knibbe][]
- SCSS by [Kurt Emch][]
- VB.NET by [Poren Chiang][]
- Mizar by [Kelley van Evert][]

[Robin Ward]: https://github.com/eviltrout
[Jason Jacobson]: https://github.com/jayce7
[Joans Follesø]: https://github.com/follesoe
[Dan Allen]: https://github.com/mojavelinux
[Eric Knibbe]: https://github.com/EricFromCanada
[Kurt Emch]: https://github.com/kemch
[Poren Chiang]: https://github.com/rschiang
[Kelley van Evert]: https://github.com/kelleyvanevert

New style themes:

- Monokai Sublime by [noformnocontent][]
- Railscasts by [Damien White][]
- Obsidian by [Alexander Marenin][]
- Docco by [Simon Madine][]
- Mono Blue by [Ivan Sagalaev][] (uses a single color hue for everything)
- Foundation by [Dan Allen][]

[noformnocontent]: http://nn.mit-license.org/
[Damien White]: https://github.com/visoft
[Alexander Marenin]: https://github.com/ioncreature
[Simon Madine]: https://github.com/thingsinjars
[Ivan Sagalaev]: https://github.com/isagalaev

Other notable changes:

- Corrected many corner cases in CSS.
- Dropped Python 2 version of the build tool.
- Implemented building for the AMD format.
- Updated Rust keywords (thanks to [Dmitry Medvinsky][]).
- Literal regexes can now be used in language definitions.
- CoffeeScript highlighting is now significantly more robust and rich due to
  input from [Cédric Néhémie][].

[Dmitry Medvinsky]: https://github.com/dmedvinsky
[Cédric Néhémie]: https://github.com/abe33


## Version 7.3

- Since this version highlight.js no longer works in IE version 8 and older.
  It's made it possible to reduce the library size and dramatically improve code
  readability and made it easier to maintain. Time to go forward!

- New languages: AppleScript (by [Nathan Grigg][ng] and [Dr. Drang][dd]) and
  Brainfuck (by [Evgeny Stepanischev][bolk]).

- Improvements to existing languages:

    - interpreter prompt in Python (`>>>` and `...`)
    - @-properties and classes in CoffeeScript
    - E4X in JavaScript (by [Oleg Efimov][oe])
    - new keywords in Perl (by [Kirk Kimmel][kk])
    - big Ruby syntax update (by [Vasily Polovnyov][vast])
    - small fixes in Bash

- Also Oleg Efimov did a great job of moving all the docs for language and style
  developers and contributors from the old wiki under the source code in the
  "docs" directory. Now these docs are nicely presented at
  <http://highlightjs.readthedocs.org/>.

[ng]: https://github.com/nathan11g
[dd]: https://github.com/drdrang
[bolk]: https://github.com/bolknote
[oe]: https://github.com/Sannis
[kk]: https://github.com/kimmel
[vast]: https://github.com/vast


## Version 7.2

A regular bug-fix release without any significant new features. Enjoy!


## Version 7.1

A Summer crop:

- [Marc Fornos][mf] made the definition for Clojure along with the matching
  style Rainbow (which, of course, works for other languages too).
- CoffeeScript support continues to improve getting support for regular
  expressions.
- Yoshihide Jimbo ported to highlight.js [five Tomorrow styles][tm] from the
  [project by Chris Kempson][tm0].
- Thanks to [Casey Duncun][cd] the library can now be built in the popular
  [AMD format][amd].
- And last but not least, we've got a fair number of correctness and consistency
  fixes, including a pretty significant refactoring of Ruby.

[mf]: https://github.com/mfornos
[tm]: http://jmblog.github.com/color-themes-for-highlightjs/
[tm0]: https://github.com/ChrisKempson/Tomorrow-Theme
[cd]: https://github.com/caseman
[amd]: http://requirejs.org/docs/whyamd.html


## Version 7.0

The reason for the new major version update is a global change of keyword syntax
which resulted in the library getting smaller once again. For example, the
hosted build is 2K less than at the previous version while supporting two new
languages.

Notable changes:

- The library now works not only in a browser but also with [node.js][]. It is
  installable with `npm install highlight.js`. [API][] docs are available on our
  wiki.

- The new unique feature (apparently) among syntax highlighters is highlighting
  *HTTP* headers and an arbitrary language in the request body. The most useful
  languages here are *XML* and *JSON* both of which highlight.js does support.
  Here's [the detailed post][p] about the feature.

- Two new style themes: a dark "south" *[Pojoaque][]* by Jason Tate and an
  emulation of*XCode* IDE by [Angel Olloqui][ao].

- Three new languages: *D* by [Aleksandar Ružičić][ar], *R* by [Joe Cheng][jc]
  and *GLSL* by [Sergey Tikhomirov][st].

- *Nginx* syntax has become a million times smaller and more universal thanks to
  remaking it in a more generic manner that doesn't require listing all the
  directives in the known universe.

- Function titles are now highlighted in *PHP*.

- *Haskell* and *VHDL* were significantly reworked to be more rich and correct
  by their respective maintainers [Jeremy Hull][sr] and [Igor Kalnitsky][ik].

And last but not least, many bugs have been fixed around correctness and
language detection.

Overall highlight.js currently supports 51 languages and 20 style themes.

[node.js]: http://nodejs.org/
[api]: http://softwaremaniacs.org/wiki/doku.php/highlight.js:api
[p]: http://softwaremaniacs.org/blog/2012/05/10/http-and-json-in-highlight-js/en/
[pojoaque]: http://web-cms-designs.com/ftopict-10-pojoaque-style-for-highlight-js-code-highlighter.html
[ao]: https://github.com/angelolloqui
[ar]: https://github.com/raleksandar
[jc]: https://github.com/jcheng5
[st]: https://github.com/tikhomirov
[sr]: https://github.com/sourrust
[ik]: https://github.com/ikalnitsky


## Version 6.2

A lot of things happened in highlight.js since the last version! We've got nine
new contributors, the discussion group came alive, and the main branch on GitHub
now counts more than 350 followers. Here are most significant results coming
from all this activity:

- 5 (five!) new languages: Rust, ActionScript, CoffeeScript, MatLab and
  experimental support for markdown. Thanks go to [Andrey Vlasovskikh][av],
  [Alexander Myadzel][am], [Dmytrii Nagirniak][dn], [Oleg Efimov][oe], [Denis
  Bardadym][db] and [John Crepezzi][jc].

- 2 new style themes: Monokai by [Luigi Maselli][lm] and stylistic imitation of
  another well-known highlighter Google Code Prettify by [Aahan Krish][ak].

- A vast number of [correctness fixes and code refactorings][log], mostly made
  by [Oleg Efimov][oe] and [Evgeny Stepanischev][es].

[av]: https://github.com/vlasovskikh
[am]: https://github.com/myadzel
[dn]: https://github.com/dnagir
[oe]: https://github.com/Sannis
[db]: https://github.com/btd
[jc]: https://github.com/seejohnrun
[lm]: http://grigio.org/
[ak]: https://github.com/geekpanth3r
[es]: https://github.com/bolknote
[log]: https://github.com/isagalaev/highlight.js/commits/


## Version 6.1 — Solarized

[Jeremy Hull][jh] has implemented my dream feature — a port of [Solarized][]
style theme famous for being based on the intricate color theory to achieve
correct contrast and color perception. It is now available for highlight.js in
both variants — light and dark.

This version also adds a new original style Arta. Its author pumbur maintains a
[heavily modified fork of highlight.js][pb] on GitHub.

[jh]: https://github.com/sourrust
[solarized]: http://ethanschoonover.com/solarized
[pb]: https://github.com/pumbur/highlight.js


## Version 6.0

New major version of the highlighter has been built on a significantly
refactored syntax. Due to this it's even smaller than the previous one while
supporting more languages!

New languages are:

- Haskell by [Jeremy Hull][sourrust]
- Erlang in two varieties — module and REPL — made collectively by [Nikolay
  Zakharov][desh], [Dmitry Kovega][arhibot] and [Sergey Ignatov][ignatov]
- Objective C by [Valerii Hiora][vhbit]
- Vala by [Antono Vasiljev][antono]
- Go by [Stephan Kountso][steplg]

[sourrust]: https://github.com/sourrust
[desh]: http://desh.su/
[arhibot]: https://github.com/arhibot
[ignatov]: https://github.com/ignatov
[vhbit]: https://github.com/vhbit
[antono]: https://github.com/antono
[steplg]: https://github.com/steplg

Also this version is marginally faster and fixes a number of small long-standing
bugs.

Developer overview of the new language syntax is available in a [blog post about
recent beta release][beta].

[beta]: http://softwaremaniacs.org/blog/2011/04/25/highlight-js-60-beta/en/

P.S. New version is not yet available on a Yandex CDN, so for now you have to
download [your own copy][d].

[d]: /soft/highlight/en/download/


## Version 5.14

Fixed bugs in HTML/XML detection and relevance introduced in previous
refactoring.

Also test.html now shows the second best result of language detection by
relevance.


## Version 5.13

Past weekend began with a couple of simple additions for existing languages but
ended up in a big code refactoring bringing along nice improvements for language
developers.

### For users

- Description of C++ has got new keywords from the upcoming [C++ 0x][] standard.
- Description of HTML has got new tags from [HTML 5][].
- CSS-styles have been unified to use consistent padding and also have lost
  pop-outs with names of detected languages.
- [Igor Kalnitsky][ik] has sent two new language descriptions: CMake & VHDL.

This makes total number of languages supported by highlight.js to reach 35.

Bug fixes:

- Custom classes on `<pre>` tags are not being overridden anymore
- More correct highlighting of code blocks inside non-`<pre>` containers:
  highlighter now doesn't insist on replacing them with its own container and
  just replaces the contents.
- Small fixes in browser compatibility and heuristics.

[c++ 0x]: http://ru.wikipedia.org/wiki/C%2B%2B0x
[html 5]: http://en.wikipedia.org/wiki/HTML5
[ik]: http://kalnitsky.org.ua/

### For developers

The most significant change is the ability to include language submodes right
under `contains` instead of defining explicit named submodes in the main array:

    contains: [
      'string',
      'number',
      {begin: '\\n', end: hljs.IMMEDIATE_RE}
    ]

This is useful for auxiliary modes needed only in one place to define parsing.
Note that such modes often don't have `className` and hence won't generate a
separate `<span>` in the resulting markup. This is similar in effect to
`noMarkup: true`. All existing languages have been refactored accordingly.

Test file test.html has at last become a real test. Now it not only puts the
detected language name under the code snippet but also tests if it matches the
expected one. Test summary is displayed right above all language snippets.


## CDN

Fine people at [Yandex][] agreed to host highlight.js on their big fast servers.
[Link up][l]!

[yandex]: http://yandex.com/
[l]: http://softwaremaniacs.org/soft/highlight/en/download/


## Version 5.10 — "Paris".

Though I'm on a vacation in Paris, I decided to release a new version with a
couple of small fixes:

- Tomas Vitvar discovered that TAB replacement doesn't always work when used
  with custom markup in code
- SQL parsing is even more rigid now and doesn't step over SmallTalk in tests


## Version 5.9

A long-awaited version is finally released.

New languages:

- Andrew Fedorov made a definition for Lua
- a long-time highlight.js contributor [Peter Leonov][pl] made a definition for
  Nginx config
- [Vladimir Moskva][vm] made a definition for TeX

[pl]: http://kung-fu-tzu.ru/
[vm]: http://fulc.ru/

Fixes for existing languages:

- [Loren Segal][ls] reworked the Ruby definition and added highlighting for
  [YARD][] inline documentation
- the definition of SQL has become more solid and now it shouldn't be overly
  greedy when it comes to language detection

[ls]: http://gnuu.org/
[yard]: http://yardoc.org/

The highlighter has become more usable as a library allowing to do highlighting
from initialization code of JS frameworks and in ajax methods (see.
readme.eng.txt).

Also this version drops support for the [WordPress][wp] plugin. Everyone is
welcome to [pick up its maintenance][p] if needed.

[wp]: http://wordpress.org/
[p]: http://bazaar.launchpad.net/~isagalaev/+junk/highlight/annotate/342/src/wp_highlight.js.php


## Version 5.8

- Jan Berkel has contributed a definition for Scala. +1 to hotness!
- All CSS-styles are rewritten to work only inside `<pre>` tags to avoid
  conflicts with host site styles.


## Version 5.7.

Fixed escaping of quotes in VBScript strings.


## Version 5.5

This version brings a small change: now .ini-files allow digits, underscores and
square brackets in key names.


## Version 5.4

Fixed small but upsetting bug in the packer which caused incorrect highlighting
of explicitly specified languages. Thanks to Andrew Fedorov for precise
diagnostics!


## Version 5.3

The version to fulfil old promises.

The most significant change is that highlight.js now preserves custom user
markup in code along with its own highlighting markup. This means that now it's
possible to use, say, links in code. Thanks to [Vladimir Dolzhenko][vd] for the
[initial proposal][1] and for making a proof-of-concept patch.

Also in this version:

- [Vasily Polovnyov][vp] has sent a GitHub-like style and has implemented
  support for CSS @-rules and Ruby symbols.
- Yura Zaripov has sent two styles: Brown Paper and School Book.
- Oleg Volchkov has sent a definition for [Parser 3][p3].

[1]: http://softwaremaniacs.org/forum/highlightjs/6612/
[p3]: http://www.parser.ru/
[vp]: http://vasily.polovnyov.ru/
[vd]: http://dolzhenko.blogspot.com/


## Version 5.2

- at last it's possible to replace indentation TABs with something sensible
  (e.g. 2 or 4 spaces)
- new keywords and built-ins for 1C by Sergey Baranov
- a couple of small fixes to Apache highlighting


## Version 5.1

This is one of those nice version consisting entirely of new and shiny
contributions!

- [Vladimir Ermakov][vooon] created highlighting for AVR Assembler
- [Ruslan Keba][rukeba] created highlighting for Apache config file. Also his
  original visual style for it is now available for all highlight.js languages
  under the name "Magula".
- [Shuen-Huei Guan][drake] (aka Drake) sent new keywords for RenderMan
  languages. Also thanks go to [Konstantin Evdokimenko][ke] for his advice on
  the matter.

[vooon]: http://vehq.ru/about/
[rukeba]: http://rukeba.com/
[drake]: http://drakeguan.org/
[ke]: http://k-evdokimenko.moikrug.ru/


## Version 5.0

The main change in the new major version of highlight.js is a mechanism for
packing several languages along with the library itself into a single compressed
file. Now sites using several languages will load considerably faster because
the library won't dynamically include additional files while loading.

Also this version fixes a long-standing bug with Javascript highlighting that
couldn't distinguish between regular expressions and division operations.

And as usually there were a couple of minor correctness fixes.

Great thanks to all contributors! Keep using highlight.js.


## Version 4.3

This version comes with two contributions from [Jason Diamond][jd]:

- language definition for C# (yes! it was a long-missed thing!)
- Visual Studio-like highlighting style

Plus there are a couple of minor bug fixes for parsing HTML and XML attributes.

[jd]: http://jason.diamond.name/weblog/


## Version 4.2

The biggest news is highlighting for Lisp, courtesy of Vasily Polovnyov. It's
somewhat experimental meaning that for highlighting "keywords" it doesn't use
any pre-defined set of a Lisp dialect. Instead it tries to highlight first word
in parentheses wherever it makes sense. I'd like to ask people programming in
Lisp to confirm if it's a good idea and send feedback to [the forum][f].

Other changes:

- Smalltalk was excluded from DEFAULT_LANGUAGES to save traffic
- [Vladimir Epifanov][voldmar] has implemented javascript style switcher for
  test.html
- comments now allowed inside Ruby function definition
- [MEL][] language from [Shuen-Huei Guan][drake]
- whitespace now allowed between `<pre>` and `<code>`
- better auto-detection of C++ and PHP
- HTML allows embedded VBScript (`<% .. %>`)

[f]: http://softwaremaniacs.org/forum/highlightjs/
[voldmar]: http://voldmar.ya.ru/
[mel]: http://en.wikipedia.org/wiki/Maya_Embedded_Language
[drake]: http://drakeguan.org/


## Version 4.1

Languages:

- Bash from Vah
- DOS bat-files from Alexander Makarov (Sam)
- Diff files from Vasily Polovnyov
- Ini files from myself though initial idea was from Sam

Styles:

- Zenburn from Vladimir Epifanov, this is an imitation of a
  [well-known theme for Vim][zenburn].
- Ascetic from myself, as a realization of ideals of non-flashy highlighting:
  just one color in only three gradations :-)

In other news. [One small bug][bug] was fixed, built-in keywords were added for
Python and C++ which improved auto-detection for the latter (it was shame that
[my wife's blog][alenacpp] had issues with it from time to time). And lastly
thanks go to Sam for getting rid of my stylistic comments in code that were
getting in the way of [JSMin][].

[zenburn]: http://en.wikipedia.org/wiki/Zenburn
[alenacpp]: http://alenacpp.blogspot.com/
[bug]: http://softwaremaniacs.org/forum/viewtopic.php?id=1823
[jsmin]: http://code.google.com/p/jsmin-php/


## Version 4.0

New major version is a result of vast refactoring and of many contributions.

Visible new features:

- Highlighting of embedded languages. Currently is implemented highlighting of
  Javascript and CSS inside HTML.
- Bundled 5 ready-made style themes!

Invisible new features:

- Highlight.js no longer pollutes global namespace. Only one object and one
  function for backward compatibility.
- Performance is further increased by about 15%.

Changing of a major version number caused by a new format of language definition
files. If you use some third-party language files they should be updated.


## Version 3.5

A very nice version in my opinion fixing a number of small bugs and slightly
increased speed in a couple of corner cases. Thanks to everybody who reports
bugs in he [forum][f] and by email!

There is also a new language — XML. A custom XML formerly was detected as HTML
and didn't highlight custom tags. In this version I tried to make custom XML to
be detected and highlighted by its own rules. Which by the way include such
things as CDATA sections and processing instructions (`<? ... ?>`).

[f]: http://softwaremaniacs.org/forum/viewforum.php?id=6


## Version 3.3

[Vladimir Gubarkov][xonix] has provided an interesting and useful addition.
File export.html contains a little program that shows and allows to copy and
paste an HTML code generated by the highlighter for any code snippet. This can
be useful in situations when one can't use the script itself on a site.


[xonix]: http://xonixx.blogspot.com/


## Version 3.2 consists completely of contributions:

- Vladimir Gubarkov has described SmallTalk
- Yuri Ivanov has described 1C
- Peter Leonov has packaged the highlighter as a Firefox extension
- Vladimir Ermakov has compiled a mod for phpBB

Many thanks to you all!


## Version 3.1

Three new languages are available: Django templates, SQL and Axapta. The latter
two are sent by [Dmitri Roudakov][1]. However I've almost entirely rewrote an
SQL definition but I'd never started it be it from the ground up :-)

The engine itself has got a long awaited feature of grouping keywords
("keyword", "built-in function", "literal"). No more hacks!

[1]: http://roudakov.ru/


## Version 3.0

It is major mainly because now highlight.js has grown large and has become
modular. Now when you pass it a list of languages to highlight it will
dynamically load into a browser only those languages.

Also:

- Konstantin Evdokimenko of [RibKit][] project has created a highlighting for
  RenderMan Shading Language and RenderMan Interface Bytestream. Yay for more
  languages!
- Heuristics for C++ and HTML got better.
- I've implemented (at last) a correct handling of backslash escapes in C-like
  languages.

There is also a small backwards incompatible change in the new version. The
function initHighlighting that was used to initialize highlighting instead of
initHighlightingOnLoad a long time ago no longer works. If you by chance still
use it — replace it with the new one.

[RibKit]: http://ribkit.sourceforge.net/


## Version 2.9

Highlight.js is a parser, not just a couple of regular expressions. That said
I'm glad to announce that in the new version 2.9 has support for:

- in-string substitutions for Ruby -- `#{...}`
- strings from from numeric symbol codes (like #XX) for Delphi


## Version 2.8

A maintenance release with more tuned heuristics. Fully backwards compatible.


## Version 2.7

- Nikita Ledyaev presents highlighting for VBScript, yay!
- A couple of bugs with escaping in strings were fixed thanks to Mickle
- Ongoing tuning of heuristics

Fixed bugs were rather unpleasant so I encourage everyone to upgrade!


## Version 2.4

- Peter Leonov provides another improved highlighting for Perl
- Javascript gets a new kind of keywords — "literals". These are the words
  "true", "false" and "null"

Also highlight.js homepage now lists sites that use the library. Feel free to
add your site by [dropping me a message][mail] until I find the time to build a
submit form.

[mail]: mailto:Maniac@SoftwareManiacs.Org


## Version 2.3

This version fixes IE breakage in previous version. My apologies to all who have
already downloaded that one!


## Version 2.2

- added highlighting for Javascript
- at last fixed parsing of Delphi's escaped apostrophes in strings
- in Ruby fixed highlighting of keywords 'def' and 'class', same for 'sub' in
  Perl


## Version 2.0

- Ruby support by [Anton Kovalyov][ak]
- speed increased by orders of magnitude due to new way of parsing
- this same way allows now correct highlighting of keywords in some tricky
  places (like keyword "End" at the end of Delphi classes)

[ak]: http://anton.kovalyov.net/


## Version 1.0

Version 1.0 of javascript syntax highlighter is released!

It's the first version available with English description. Feel free to post
your comments and question to [highlight.js forum][forum]. And don't be afraid
if you find there some fancy Cyrillic letters -- it's for Russian users too :-)

[forum]: http://softwaremaniacs.org/forum/viewforum.php?id=6
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(function(a,b){function cy(a){return f.isWindow(a)?a:a.nodeType===9?a.defaultView||a.parentWindow:!1}function cv(a){if(!ck[a]){var b=c.body,d=f("<"+a+">").appendTo(b),e=d.css("display");d.remove();if(e==="none"||e===""){cl||(cl=c.createElement("iframe"),cl.frameBorder=cl.width=cl.height=0),b.appendChild(cl);if(!cm||!cl.createElement)cm=(cl.contentWindow||cl.contentDocument).document,cm.write((c.compatMode==="CSS1Compat"?"<!doctype html>":"")+"<html><body>"),cm.close();d=cm.createElement(a),cm.body.appendChild(d),e=f.css(d,"display"),b.removeChild(cl)}ck[a]=e}return ck[a]}function cu(a,b){var c={};f.each(cq.concat.apply([],cq.slice(0,b)),function(){c[this]=a});return c}function ct(){cr=b}function cs(){setTimeout(ct,0);return cr=f.now()}function cj(){try{return new a.ActiveXObject("Microsoft.XMLHTTP")}catch(b){}}function ci(){try{return new a.XMLHttpRequest}catch(b){}}function cc(a,c){a.dataFilter&&(c=a.dataFilter(c,a.dataType));var d=a.dataTypes,e={},g,h,i=d.length,j,k=d[0],l,m,n,o,p;for(g=1;g<i;g++){if(g===1)for(h in a.converters)typeof h=="string"&&(e[h.toLowerCase()]=a.converters[h]);l=k,k=d[g];if(k==="*")k=l;else if(l!=="*"&&l!==k){m=l+" "+k,n=e[m]||e["* "+k];if(!n){p=b;for(o in e){j=o.split(" ");if(j[0]===l||j[0]==="*"){p=e[j[1]+" "+k];if(p){o=e[o],o===!0?n=p:p===!0&&(n=o);break}}}}!n&&!p&&f.error("No conversion from "+m.replace(" "," to ")),n!==!0&&(c=n?n(c):p(o(c)))}}return c}function cb(a,c,d){var e=a.contents,f=a.dataTypes,g=a.responseFields,h,i,j,k;for(i in g)i in d&&(c[g[i]]=d[i]);while(f[0]==="*")f.shift(),h===b&&(h=a.mimeType||c.getResponseHeader("content-type"));if(h)for(i in e)if(e[i]&&e[i].test(h)){f.unshift(i);break}if(f[0]in d)j=f[0];else{for(i in d){if(!f[0]||a.converters[i+" "+f[0]]){j=i;break}k||(k=i)}j=j||k}if(j){j!==f[0]&&f.unshift(j);return d[j]}}function ca(a,b,c,d){if(f.isArray(b))f.each(b,function(b,e){c||bE.test(a)?d(a,e):ca(a+"["+(typeof e=="object"||f.isArray(e)?b:"")+"]",e,c,d)});else if(!c&&b!=null&&typeof b=="object")for(var e in b)ca(a+"["+e+"]",b[e],c,d);else d(a,b)}function b_(a,c){var d,e,g=f.ajaxSettings.flatOptions||{};for(d in c)c[d]!==b&&((g[d]?a:e||(e={}))[d]=c[d]);e&&f.extend(!0,a,e)}function b$(a,c,d,e,f,g){f=f||c.dataTypes[0],g=g||{},g[f]=!0;var h=a[f],i=0,j=h?h.length:0,k=a===bT,l;for(;i<j&&(k||!l);i++)l=h[i](c,d,e),typeof l=="string"&&(!k||g[l]?l=b:(c.dataTypes.unshift(l),l=b$(a,c,d,e,l,g)));(k||!l)&&!g["*"]&&(l=b$(a,c,d,e,"*",g));return l}function bZ(a){return function(b,c){typeof b!="string"&&(c=b,b="*");if(f.isFunction(c)){var d=b.toLowerCase().split(bP),e=0,g=d.length,h,i,j;for(;e<g;e++)h=d[e],j=/^\+/.test(h),j&&(h=h.substr(1)||"*"),i=a[h]=a[h]||[],i[j?"unshift":"push"](c)}}}function bC(a,b,c){var d=b==="width"?a.offsetWidth:a.offsetHeight,e=b==="width"?bx:by,g=0,h=e.length;if(d>0){if(c!=="border")for(;g<h;g++)c||(d-=parseFloat(f.css(a,"padding"+e[g]))||0),c==="margin"?d+=parseFloat(f.css(a,c+e[g]))||0:d-=parseFloat(f.css(a,"border"+e[g]+"Width"))||0;return d+"px"}d=bz(a,b,b);if(d<0||d==null)d=a.style[b]||0;d=parseFloat(d)||0;if(c)for(;g<h;g++)d+=parseFloat(f.css(a,"padding"+e[g]))||0,c!=="padding"&&(d+=parseFloat(f.css(a,"border"+e[g]+"Width"))||0),c==="margin"&&(d+=parseFloat(f.css(a,c+e[g]))||0);return d+"px"}function bp(a,b){b.src?f.ajax({url:b.src,async:!1,dataType:"script"}):f.globalEval((b.text||b.textContent||b.innerHTML||"").replace(bf,"/*$0*/")),b.parentNode&&b.parentNode.removeChild(b)}function bo(a){var b=c.createElement("div");bh.appendChild(b),b.innerHTML=a.outerHTML;return b.firstChild}function bn(a){var b=(a.nodeName||"").toLowerCase();b==="input"?bm(a):b!=="script"&&typeof a.getElementsByTagName!="undefined"&&f.grep(a.getElementsByTagName("input"),bm)}function bm(a){if(a.type==="checkbox"||a.type==="radio")a.defaultChecked=a.checked}function bl(a){return typeof a.getElementsByTagName!="undefined"?a.getElementsByTagName("*"):typeof a.querySelectorAll!="undefined"?a.querySelectorAll("*"):[]}function bk(a,b){var c;if(b.nodeType===1){b.clearAttributes&&b.clearAttributes(),b.mergeAttributes&&b.mergeAttributes(a),c=b.nodeName.toLowerCase();if(c==="object")b.outerHTML=a.outerHTML;else if(c!=="input"||a.type!=="checkbox"&&a.type!=="radio"){if(c==="option")b.selected=a.defaultSelected;else if(c==="input"||c==="textarea")b.defaultValue=a.defaultValue}else a.checked&&(b.defaultChecked=b.checked=a.checked),b.value!==a.value&&(b.value=a.value);b.removeAttribute(f.expando)}}function bj(a,b){if(b.nodeType===1&&!!f.hasData(a)){var c,d,e,g=f._data(a),h=f._data(b,g),i=g.events;if(i){delete h.handle,h.events={};for(c in i)for(d=0,e=i[c].length;d<e;d++)f.event.add(b,c+(i[c][d].namespace?".":"")+i[c][d].namespace,i[c][d],i[c][d].data)}h.data&&(h.data=f.extend({},h.data))}}function bi(a,b){return f.nodeName(a,"table")?a.getElementsByTagName("tbody")[0]||a.appendChild(a.ownerDocument.createElement("tbody")):a}function U(a){var b=V.split("|"),c=a.createDocumentFragment();if(c.createElement)while(b.length)c.createElement(b.pop());return c}function T(a,b,c){b=b||0;if(f.isFunction(b))return f.grep(a,function(a,d){var e=!!b.call(a,d,a);return e===c});if(b.nodeType)return f.grep(a,function(a,d){return a===b===c});if(typeof b=="string"){var d=f.grep(a,function(a){return a.nodeType===1});if(O.test(b))return f.filter(b,d,!c);b=f.filter(b,d)}return f.grep(a,function(a,d){return f.inArray(a,b)>=0===c})}function S(a){return!a||!a.parentNode||a.parentNode.nodeType===11}function K(){return!0}function J(){return!1}function n(a,b,c){var d=b+"defer",e=b+"queue",g=b+"mark",h=f._data(a,d);h&&(c==="queue"||!f._data(a,e))&&(c==="mark"||!f._data(a,g))&&setTimeout(function(){!f._data(a,e)&&!f._data(a,g)&&(f.removeData(a,d,!0),h.fire())},0)}function m(a){for(var b in a){if(b==="data"&&f.isEmptyObject(a[b]))continue;if(b!=="toJSON")return!1}return!0}function l(a,c,d){if(d===b&&a.nodeType===1){var e="data-"+c.replace(k,"-$1").toLowerCase();d=a.getAttribute(e);if(typeof d=="string"){try{d=d==="true"?!0:d==="false"?!1:d==="null"?null:f.isNumeric(d)?parseFloat(d):j.test(d)?f.parseJSON(d):d}catch(g){}f.data(a,c,d)}else d=b}return d}function h(a){var b=g[a]={},c,d;a=a.split(/\s+/);for(c=0,d=a.length;c<d;c++)b[a[c]]=!0;return b}var c=a.document,d=a.navigator,e=a.location,f=function(){function J(){if(!e.isReady){try{c.documentElement.doScroll("left")}catch(a){setTimeout(J,1);return}e.ready()}}var e=function(a,b){return new e.fn.init(a,b,h)},f=a.jQuery,g=a.$,h,i=/^(?:[^#<]*(<[\w\W]+>)[^>]*$|#([\w\-]*)$)/,j=/\S/,k=/^\s+/,l=/\s+$/,m=/^<(\w+)\s*\/?>(?:<\/\1>)?$/,n=/^[\],:{}\s]*$/,o=/\\(?:["\\\/bfnrt]|u[0-9a-fA-F]{4})/g,p=/"[^"\\\n\r]*"|true|false|null|-?\d+(?:\.\d*)?(?:[eE][+\-]?\d+)?/g,q=/(?:^|:|,)(?:\s*\[)+/g,r=/(webkit)[ \/]([\w.]+)/,s=/(opera)(?:.*version)?[ \/]([\w.]+)/,t=/(msie) ([\w.]+)/,u=/(mozilla)(?:.*? rv:([\w.]+))?/,v=/-([a-z]|[0-9])/ig,w=/^-ms-/,x=function(a,b){return(b+"").toUpperCase()},y=d.userAgent,z,A,B,C=Object.prototype.toString,D=Object.prototype.hasOwnProperty,E=Array.prototype.push,F=Array.prototype.slice,G=String.prototype.trim,H=Array.prototype.indexOf,I={};e.fn=e.prototype={constructor:e,init:function(a,d,f){var g,h,j,k;if(!a)return this;if(a.nodeType){this.context=this[0]=a,this.length=1;return this}if(a==="body"&&!d&&c.body){this.context=c,this[0]=c.body,this.selector=a,this.length=1;return this}if(typeof a=="string"){a.charAt(0)!=="<"||a.charAt(a.length-1)!==">"||a.length<3?g=i.exec(a):g=[null,a,null];if(g&&(g[1]||!d)){if(g[1]){d=d instanceof e?d[0]:d,k=d?d.ownerDocument||d:c,j=m.exec(a),j?e.isPlainObject(d)?(a=[c.createElement(j[1])],e.fn.attr.call(a,d,!0)):a=[k.createElement(j[1])]:(j=e.buildFragment([g[1]],[k]),a=(j.cacheable?e.clone(j.fragment):j.fragment).childNodes);return e.merge(this,a)}h=c.getElementById(g[2]);if(h&&h.parentNode){if(h.id!==g[2])return f.find(a);this.length=1,this[0]=h}this.context=c,this.selector=a;return this}return!d||d.jquery?(d||f).find(a):this.constructor(d).find(a)}if(e.isFunction(a))return f.ready(a);a.selector!==b&&(this.selector=a.selector,this.context=a.context);return e.makeArray(a,this)},selector:"",jquery:"1.7.1",length:0,size:function(){return this.length},toArray:function(){return F.call(this,0)},get:function(a){return a==null?this.toArray():a<0?this[this.length+a]:this[a]},pushStack:function(a,b,c){var d=this.constructor();e.isArray(a)?E.apply(d,a):e.merge(d,a),d.prevObject=this,d.context=this.context,b==="find"?d.selector=this.selector+(this.selector?" ":"")+c:b&&(d.selector=this.selector+"."+b+"("+c+")");return d},each:function(a,b){return e.each(this,a,b)},ready:function(a){e.bindReady(),A.add(a);return this},eq:function(a){a=+a;return a===-1?this.slice(a):this.slice(a,a+1)},first:function(){return this.eq(0)},last:function(){return this.eq(-1)},slice:function(){return this.pushStack(F.apply(this,arguments),"slice",F.call(arguments).join(","))},map:function(a){return this.pushStack(e.map(this,function(b,c){return a.call(b,c,b)}))},end:function(){return this.prevObject||this.constructor(null)},push:E,sort:[].sort,splice:[].splice},e.fn.init.prototype=e.fn,e.extend=e.fn.extend=function(){var a,c,d,f,g,h,i=arguments[0]||{},j=1,k=arguments.length,l=!1;typeof i=="boolean"&&(l=i,i=arguments[1]||{},j=2),typeof i!="object"&&!e.isFunction(i)&&(i={}),k===j&&(i=this,--j);for(;j<k;j++)if((a=arguments[j])!=null)for(c in a){d=i[c],f=a[c];if(i===f)continue;l&&f&&(e.isPlainObject(f)||(g=e.isArray(f)))?(g?(g=!1,h=d&&e.isArray(d)?d:[]):h=d&&e.isPlainObject(d)?d:{},i[c]=e.extend(l,h,f)):f!==b&&(i[c]=f)}return i},e.extend({noConflict:function(b){a.$===e&&(a.$=g),b&&a.jQuery===e&&(a.jQuery=f);return e},isReady:!1,readyWait:1,holdReady:function(a){a?e.readyWait++:e.ready(!0)},ready:function(a){if(a===!0&&!--e.readyWait||a!==!0&&!e.isReady){if(!c.body)return setTimeout(e.ready,1);e.isReady=!0;if(a!==!0&&--e.readyWait>0)return;A.fireWith(c,[e]),e.fn.trigger&&e(c).trigger("ready").off("ready")}},bindReady:function(){if(!A){A=e.Callbacks("once memory");if(c.readyState==="complete")return setTimeout(e.ready,1);if(c.addEventListener)c.addEventListener("DOMContentLoaded",B,!1),a.addEventListener("load",e.ready,!1);else if(c.attachEvent){c.attachEvent("onreadystatechange",B),a.attachEvent("onload",e.ready);var b=!1;try{b=a.frameElement==null}catch(d){}c.documentElement.doScroll&&b&&J()}}},isFunction:function(a){return e.type(a)==="function"},isArray:Array.isArray||function(a){return e.type(a)==="array"},isWindow:function(a){return a&&typeof a=="object"&&"setInterval"in a},isNumeric:function(a){return!isNaN(parseFloat(a))&&isFinite(a)},type:function(a){return a==null?String(a):I[C.call(a)]||"object"},isPlainObject:function(a){if(!a||e.type(a)!=="object"||a.nodeType||e.isWindow(a))return!1;try{if(a.constructor&&!D.call(a,"constructor")&&!D.call(a.constructor.prototype,"isPrototypeOf"))return!1}catch(c){return!1}var d;for(d in a);return d===b||D.call(a,d)},isEmptyObject:function(a){for(var b in a)return!1;return!0},error:function(a){throw new Error(a)},parseJSON:function(b){if(typeof b!="string"||!b)return null;b=e.trim(b);if(a.JSON&&a.JSON.parse)return a.JSON.parse(b);if(n.test(b.replace(o,"@").replace(p,"]").replace(q,"")))return(new Function("return "+b))();e.error("Invalid JSON: "+b)},parseXML:function(c){var d,f;try{a.DOMParser?(f=new DOMParser,d=f.parseFromString(c,"text/xml")):(d=new ActiveXObject("Microsoft.XMLDOM"),d.async="false",d.loadXML(c))}catch(g){d=b}(!d||!d.documentElement||d.getElementsByTagName("parsererror").length)&&e.error("Invalid XML: "+c);return d},noop:function(){},globalEval:function(b){b&&j.test(b)&&(a.execScript||function(b){a.eval.call(a,b)})(b)},camelCase:function(a){return a.replace(w,"ms-").replace(v,x)},nodeName:function(a,b){return a.nodeName&&a.nodeName.toUpperCase()===b.toUpperCase()},each:function(a,c,d){var f,g=0,h=a.length,i=h===b||e.isFunction(a);if(d){if(i){for(f in a)if(c.apply(a[f],d)===!1)break}else for(;g<h;)if(c.apply(a[g++],d)===!1)break}else if(i){for(f in a)if(c.call(a[f],f,a[f])===!1)break}else for(;g<h;)if(c.call(a[g],g,a[g++])===!1)break;return a},trim:G?function(a){return a==null?"":G.call(a)}:function(a){return a==null?"":(a+"").replace(k,"").replace(l,"")},makeArray:function(a,b){var c=b||[];if(a!=null){var d=e.type(a);a.length==null||d==="string"||d==="function"||d==="regexp"||e.isWindow(a)?E.call(c,a):e.merge(c,a)}return c},inArray:function(a,b,c){var d;if(b){if(H)return H.call(b,a,c);d=b.length,c=c?c<0?Math.max(0,d+c):c:0;for(;c<d;c++)if(c in b&&b[c]===a)return c}return-1},merge:function(a,c){var d=a.length,e=0;if(typeof c.length=="number")for(var f=c.length;e<f;e++)a[d++]=c[e];else while(c[e]!==b)a[d++]=c[e++];a.length=d;return a},grep:function(a,b,c){var d=[],e;c=!!c;for(var f=0,g=a.length;f<g;f++)e=!!b(a[f],f),c!==e&&d.push(a[f]);return d},map:function(a,c,d){var f,g,h=[],i=0,j=a.length,k=a instanceof e||j!==b&&typeof j=="number"&&(j>0&&a[0]&&a[j-1]||j===0||e.isArray(a));if(k)for(;i<j;i++)f=c(a[i],i,d),f!=null&&(h[h.length]=f);else for(g in a)f=c(a[g],g,d),f!=null&&(h[h.length]=f);return h.concat.apply([],h)},guid:1,proxy:function(a,c){if(typeof c=="string"){var d=a[c];c=a,a=d}if(!e.isFunction(a))return b;var f=F.call(arguments,2),g=function(){return a.apply(c,f.concat(F.call(arguments)))};g.guid=a.guid=a.guid||g.guid||e.guid++;return g},access:function(a,c,d,f,g,h){var i=a.length;if(typeof c=="object"){for(var j in c)e.access(a,j,c[j],f,g,d);return a}if(d!==b){f=!h&&f&&e.isFunction(d);for(var k=0;k<i;k++)g(a[k],c,f?d.call(a[k],k,g(a[k],c)):d,h);return a}return i?g(a[0],c):b},now:function(){return(new Date).getTime()},uaMatch:function(a){a=a.toLowerCase();var b=r.exec(a)||s.exec(a)||t.exec(a)||a.indexOf("compatible")<0&&u.exec(a)||[];return{browser:b[1]||"",version:b[2]||"0"}},sub:function(){function a(b,c){return new a.fn.init(b,c)}e.extend(!0,a,this),a.superclass=this,a.fn=a.prototype=this(),a.fn.constructor=a,a.sub=this.sub,a.fn.init=function(d,f){f&&f instanceof e&&!(f instanceof a)&&(f=a(f));return e.fn.init.call(this,d,f,b)},a.fn.init.prototype=a.fn;var b=a(c);return a},browser:{}}),e.each("Boolean Number String Function Array Date RegExp Object".split(" "),function(a,b){I["[object "+b+"]"]=b.toLowerCase()}),z=e.uaMatch(y),z.browser&&(e.browser[z.browser]=!0,e.browser.version=z.version),e.browser.webkit&&(e.browser.safari=!0),j.test(" ")&&(k=/^[\s\xA0]+/,l=/[\s\xA0]+$/),h=e(c),c.addEventListener?B=function(){c.removeEventListener("DOMContentLoaded",B,!1),e.ready()}:c.attachEvent&&(B=function(){c.readyState==="complete"&&(c.detachEvent("onreadystatechange",B),e.ready())});return e}(),g={};f.Callbacks=function(a){a=a?g[a]||h(a):{};var c=[],d=[],e,i,j,k,l,m=function(b){var d,e,g,h,i;for(d=0,e=b.length;d<e;d++)g=b[d],h=f.type(g),h==="array"?m(g):h==="function"&&(!a.unique||!o.has(g))&&c.push(g)},n=function(b,f){f=f||[],e=!a.memory||[b,f],i=!0,l=j||0,j=0,k=c.length;for(;c&&l<k;l++)if(c[l].apply(b,f)===!1&&a.stopOnFalse){e=!0;break}i=!1,c&&(a.once?e===!0?o.disable():c=[]:d&&d.length&&(e=d.shift(),o.fireWith(e[0],e[1])))},o={add:function(){if(c){var a=c.length;m(arguments),i?k=c.length:e&&e!==!0&&(j=a,n(e[0],e[1]))}return this},remove:function(){if(c){var b=arguments,d=0,e=b.length;for(;d<e;d++)for(var f=0;f<c.length;f++)if(b[d]===c[f]){i&&f<=k&&(k--,f<=l&&l--),c.splice(f--,1);if(a.unique)break}}return this},has:function(a){if(c){var b=0,d=c.length;for(;b<d;b++)if(a===c[b])return!0}return!1},empty:function(){c=[];return this},disable:function(){c=d=e=b;return this},disabled:function(){return!c},lock:function(){d=b,(!e||e===!0)&&o.disable();return this},locked:function(){return!d},fireWith:function(b,c){d&&(i?a.once||d.push([b,c]):(!a.once||!e)&&n(b,c));return this},fire:function(){o.fireWith(this,arguments);return this},fired:function(){return!!e}};return o};var i=[].slice;f.extend({Deferred:function(a){var b=f.Callbacks("once memory"),c=f.Callbacks("once memory"),d=f.Callbacks("memory"),e="pending",g={resolve:b,reject:c,notify:d},h={done:b.add,fail:c.add,progress:d.add,state:function(){return e},isResolved:b.fired,isRejected:c.fired,then:function(a,b,c){i.done(a).fail(b).progress(c);return this},always:function(){i.done.apply(i,arguments).fail.apply(i,arguments);return this},pipe:function(a,b,c){return f.Deferred(function(d){f.each({done:[a,"resolve"],fail:[b,"reject"],progress:[c,"notify"]},function(a,b){var c=b[0],e=b[1],g;f.isFunction(c)?i[a](function(){g=c.apply(this,arguments),g&&f.isFunction(g.promise)?g.promise().then(d.resolve,d.reject,d.notify):d[e+"With"](this===i?d:this,[g])}):i[a](d[e])})}).promise()},promise:function(a){if(a==null)a=h;else for(var b in h)a[b]=h[b];return a}},i=h.promise({}),j;for(j in g)i[j]=g[j].fire,i[j+"With"]=g[j].fireWith;i.done(function(){e="resolved"},c.disable,d.lock).fail(function(){e="rejected"},b.disable,d.lock),a&&a.call(i,i);return i},when:function(a){function m(a){return function(b){e[a]=arguments.length>1?i.call(arguments,0):b,j.notifyWith(k,e)}}function l(a){return function(c){b[a]=arguments.length>1?i.call(arguments,0):c,--g||j.resolveWith(j,b)}}var b=i.call(arguments,0),c=0,d=b.length,e=Array(d),g=d,h=d,j=d<=1&&a&&f.isFunction(a.promise)?a:f.Deferred(),k=j.promise();if(d>1){for(;c<d;c++)b[c]&&b[c].promise&&f.isFunction(b[c].promise)?b[c].promise().then(l(c),j.reject,m(c)):--g;g||j.resolveWith(j,b)}else j!==a&&j.resolveWith(j,d?[a]:[]);return k}}),f.support=function(){var b,d,e,g,h,i,j,k,l,m,n,o,p,q=c.createElement("div"),r=c.documentElement;q.setAttribute("className","t"),q.innerHTML="   <link/><table></table><a href='/a' style='top:1px;float:left;opacity:.55;'>a</a><input type='checkbox'/>",d=q.getElementsByTagName("*"),e=q.getElementsByTagName("a")[0];if(!d||!d.length||!e)return{};g=c.createElement("select"),h=g.appendChild(c.createElement("option")),i=q.getElementsByTagName("input")[0],b={leadingWhitespace:q.firstChild.nodeType===3,tbody:!q.getElementsByTagName("tbody").length,htmlSerialize:!!q.getElementsByTagName("link").length,style:/top/.test(e.getAttribute("style")),hrefNormalized:e.getAttribute("href")==="/a",opacity:/^0.55/.test(e.style.opacity),cssFloat:!!e.style.cssFloat,checkOn:i.value==="on",optSelected:h.selected,getSetAttribute:q.className!=="t",enctype:!!c.createElement("form").enctype,html5Clone:c.createElement("nav").cloneNode(!0).outerHTML!=="<:nav></:nav>",submitBubbles:!0,changeBubbles:!0,focusinBubbles:!1,deleteExpando:!0,noCloneEvent:!0,inlineBlockNeedsLayout:!1,shrinkWrapBlocks:!1,reliableMarginRight:!0},i.checked=!0,b.noCloneChecked=i.cloneNode(!0).checked,g.disabled=!0,b.optDisabled=!h.disabled;try{delete q.test}catch(s){b.deleteExpando=!1}!q.addEventListener&&q.attachEvent&&q.fireEvent&&(q.attachEvent("onclick",function(){b.noCloneEvent=!1}),q.cloneNode(!0).fireEvent("onclick")),i=c.createElement("input"),i.value="t",i.setAttribute("type","radio"),b.radioValue=i.value==="t",i.setAttribute("checked","checked"),q.appendChild(i),k=c.createDocumentFragment(),k.appendChild(q.lastChild),b.checkClone=k.cloneNode(!0).cloneNode(!0).lastChild.checked,b.appendChecked=i.checked,k.removeChild(i),k.appendChild(q),q.innerHTML="",a.getComputedStyle&&(j=c.createElement("div"),j.style.width="0",j.style.marginRight="0",q.style.width="2px",q.appendChild(j),b.reliableMarginRight=(parseInt((a.getComputedStyle(j,null)||{marginRight:0}).marginRight,10)||0)===0);if(q.attachEvent)for(o in{submit:1,change:1,focusin:1})n="on"+o,p=n in q,p||(q.setAttribute(n,"return;"),p=typeof q[n]=="function"),b[o+"Bubbles"]=p;k.removeChild(q),k=g=h=j=q=i=null,f(function(){var a,d,e,g,h,i,j,k,m,n,o,r=c.getElementsByTagName("body")[0];!r||(j=1,k="position:absolute;top:0;left:0;width:1px;height:1px;margin:0;",m="visibility:hidden;border:0;",n="style='"+k+"border:5px solid #000;padding:0;'",o="<div "+n+"><div></div></div>"+"<table "+n+" cellpadding='0' cellspacing='0'>"+"<tr><td></td></tr></table>",a=c.createElement("div"),a.style.cssText=m+"width:0;height:0;position:static;top:0;margin-top:"+j+"px",r.insertBefore(a,r.firstChild),q=c.createElement("div"),a.appendChild(q),q.innerHTML="<table><tr><td style='padding:0;border:0;display:none'></td><td>t</td></tr></table>",l=q.getElementsByTagName("td"),p=l[0].offsetHeight===0,l[0].style.display="",l[1].style.display="none",b.reliableHiddenOffsets=p&&l[0].offsetHeight===0,q.innerHTML="",q.style.width=q.style.paddingLeft="1px",f.boxModel=b.boxModel=q.offsetWidth===2,typeof q.style.zoom!="undefined"&&(q.style.display="inline",q.style.zoom=1,b.inlineBlockNeedsLayout=q.offsetWidth===2,q.style.display="",q.innerHTML="<div style='width:4px;'></div>",b.shrinkWrapBlocks=q.offsetWidth!==2),q.style.cssText=k+m,q.innerHTML=o,d=q.firstChild,e=d.firstChild,h=d.nextSibling.firstChild.firstChild,i={doesNotAddBorder:e.offsetTop!==5,doesAddBorderForTableAndCells:h.offsetTop===5},e.style.position="fixed",e.style.top="20px",i.fixedPosition=e.offsetTop===20||e.offsetTop===15,e.style.position=e.style.top="",d.style.overflow="hidden",d.style.position="relative",i.subtractsBorderForOverflowNotVisible=e.offsetTop===-5,i.doesNotIncludeMarginInBodyOffset=r.offsetTop!==j,r.removeChild(a),q=a=null,f.extend(b,i))});return b}();var j=/^(?:\{.*\}|\[.*\])$/,k=/([A-Z])/g;f.extend({cache:{},uuid:0,expando:"jQuery"+(f.fn.jquery+Math.random()).replace(/\D/g,""),noData:{embed:!0,object:"clsid:D27CDB6E-AE6D-11cf-96B8-444553540000",applet:!0},hasData:function(a){a=a.nodeType?f.cache[a[f.expando]]:a[f.expando];return!!a&&!m(a)},data:function(a,c,d,e){if(!!f.acceptData(a)){var g,h,i,j=f.expando,k=typeof c=="string",l=a.nodeType,m=l?f.cache:a,n=l?a[j]:a[j]&&j,o=c==="events";if((!n||!m[n]||!o&&!e&&!m[n].data)&&k&&d===b)return;n||(l?a[j]=n=++f.uuid:n=j),m[n]||(m[n]={},l||(m[n].toJSON=f.noop));if(typeof c=="object"||typeof c=="function")e?m[n]=f.extend(m[n],c):m[n].data=f.extend(m[n].data,c);g=h=m[n],e||(h.data||(h.data={}),h=h.data),d!==b&&(h[f.camelCase(c)]=d);if(o&&!h[c])return g.events;k?(i=h[c],i==null&&(i=h[f.camelCase(c)])):i=h;return i}},removeData:function(a,b,c){if(!!f.acceptData(a)){var d,e,g,h=f.expando,i=a.nodeType,j=i?f.cache:a,k=i?a[h]:h;if(!j[k])return;if(b){d=c?j[k]:j[k].data;if(d){f.isArray(b)||(b in d?b=[b]:(b=f.camelCase(b),b in d?b=[b]:b=b.split(" ")));for(e=0,g=b.length;e<g;e++)delete d[b[e]];if(!(c?m:f.isEmptyObject)(d))return}}if(!c){delete j[k].data;if(!m(j[k]))return}f.support.deleteExpando||!j.setInterval?delete j[k]:j[k]=null,i&&(f.support.deleteExpando?delete a[h]:a.removeAttribute?a.removeAttribute(h):a[h]=null)}},_data:function(a,b,c){return f.data(a,b,c,!0)},acceptData:function(a){if(a.nodeName){var b=f.noData[a.nodeName.toLowerCase()];if(b)return b!==!0&&a.getAttribute("classid")===b}return!0}}),f.fn.extend({data:function(a,c){var d,e,g,h=null;if(typeof a=="undefined"){if(this.length){h=f.data(this[0]);if(this[0].nodeType===1&&!f._data(this[0],"parsedAttrs")){e=this[0].attributes;for(var i=0,j=e.length;i<j;i++)g=e[i].name,g.indexOf("data-")===0&&(g=f.camelCase(g.substring(5)),l(this[0],g,h[g]));f._data(this[0],"parsedAttrs",!0)}}return h}if(typeof a=="object")return this.each(function(){f.data(this,a)});d=a.split("."),d[1]=d[1]?"."+d[1]:"";if(c===b){h=this.triggerHandler("getData"+d[1]+"!",[d[0]]),h===b&&this.length&&(h=f.data(this[0],a),h=l(this[0],a,h));return h===b&&d[1]?this.data(d[0]):h}return this.each(function(){var b=f(this),e=[d[0],c];b.triggerHandler("setData"+d[1]+"!",e),f.data(this,a,c),b.triggerHandler("changeData"+d[1]+"!",e)})},removeData:function(a){return this.each(function(){f.removeData(this,a)})}}),f.extend({_mark:function(a,b){a&&(b=(b||"fx")+"mark",f._data(a,b,(f._data(a,b)||0)+1))},_unmark:function(a,b,c){a!==!0&&(c=b,b=a,a=!1);if(b){c=c||"fx";var d=c+"mark",e=a?0:(f._data(b,d)||1)-1;e?f._data(b,d,e):(f.removeData(b,d,!0),n(b,c,"mark"))}},queue:function(a,b,c){var d;if(a){b=(b||"fx")+"queue",d=f._data(a,b),c&&(!d||f.isArray(c)?d=f._data(a,b,f.makeArray(c)):d.push(c));return d||[]}},dequeue:function(a,b){b=b||"fx";var c=f.queue(a,b),d=c.shift(),e={};d==="inprogress"&&(d=c.shift()),d&&(b==="fx"&&c.unshift("inprogress"),f._data(a,b+".run",e),d.call(a,function(){f.dequeue(a,b)},e)),c.length||(f.removeData(a,b+"queue "+b+".run",!0),n(a,b,"queue"))}}),f.fn.extend({queue:function(a,c){typeof a!="string"&&(c=a,a="fx");if(c===b)return f.queue(this[0],a);return this.each(function(){var b=f.queue(this,a,c);a==="fx"&&b[0]!=="inprogress"&&f.dequeue(this,a)})},dequeue:function(a){return this.each(function(){f.dequeue(this,a)})},delay:function(a,b){a=f.fx?f.fx.speeds[a]||a:a,b=b||"fx";return this.queue(b,function(b,c){var d=setTimeout(b,a);c.stop=function(){clearTimeout(d)}})},clearQueue:function(a){return this.queue(a||"fx",[])},promise:function(a,c){function m(){--h||d.resolveWith(e,[e])}typeof a!="string"&&(c=a,a=b),a=a||"fx";var d=f.Deferred(),e=this,g=e.length,h=1,i=a+"defer",j=a+"queue",k=a+"mark",l;while(g--)if(l=f.data(e[g],i,b,!0)||(f.data(e[g],j,b,!0)||f.data(e[g],k,b,!0))&&f.data(e[g],i,f.Callbacks("once memory"),!0))h++,l.add(m);m();return d.promise()}});var o=/[\n\t\r]/g,p=/\s+/,q=/\r/g,r=/^(?:button|input)$/i,s=/^(?:button|input|object|select|textarea)$/i,t=/^a(?:rea)?$/i,u=/^(?:autofocus|autoplay|async|checked|controls|defer|disabled|hidden|loop|multiple|open|readonly|required|scoped|selected)$/i,v=f.support.getSetAttribute,w,x,y;f.fn.extend({attr:function(a,b){return f.access(this,a,b,!0,f.attr)},removeAttr:function(a){return this.each(function(){f.removeAttr(this,a)})},prop:function(a,b){return f.access(this,a,b,!0,f.prop)},removeProp:function(a){a=f.propFix[a]||a;return this.each(function(){try{this[a]=b,delete this[a]}catch(c){}})},addClass:function(a){var b,c,d,e,g,h,i;if(f.isFunction(a))return this.each(function(b){f(this).addClass(a.call(this,b,this.className))});if(a&&typeof a=="string"){b=a.split(p);for(c=0,d=this.length;c<d;c++){e=this[c];if(e.nodeType===1)if(!e.className&&b.length===1)e.className=a;else{g=" "+e.className+" ";for(h=0,i=b.length;h<i;h++)~g.indexOf(" "+b[h]+" ")||(g+=b[h]+" ");e.className=f.trim(g)}}}return this},removeClass:function(a){var c,d,e,g,h,i,j;if(f.isFunction(a))return this.each(function(b){f(this).removeClass(a.call(this,b,this.className))});if(a&&typeof a=="string"||a===b){c=(a||"").split(p);for(d=0,e=this.length;d<e;d++){g=this[d];if(g.nodeType===1&&g.className)if(a){h=(" "+g.className+" ").replace(o," ");for(i=0,j=c.length;i<j;i++)h=h.replace(" "+c[i]+" "," ");g.className=f.trim(h)}else g.className=""}}return this},toggleClass:function(a,b){var c=typeof a,d=typeof b=="boolean";if(f.isFunction(a))return this.each(function(c){f(this).toggleClass(a.call(this,c,this.className,b),b)});return this.each(function(){if(c==="string"){var e,g=0,h=f(this),i=b,j=a.split(p);while(e=j[g++])i=d?i:!h.hasClass(e),h[i?"addClass":"removeClass"](e)}else if(c==="undefined"||c==="boolean")this.className&&f._data(this,"__className__",this.className),this.className=this.className||a===!1?"":f._data(this,"__className__")||""})},hasClass:function(a){var b=" "+a+" ",c=0,d=this.length;for(;c<d;c++)if(this[c].nodeType===1&&(" "+this[c].className+" ").replace(o," ").indexOf(b)>-1)return!0;return!1},val:function(a){var c,d,e,g=this[0];{if(!!arguments.length){e=f.isFunction(a);return this.each(function(d){var g=f(this),h;if(this.nodeType===1){e?h=a.call(this,d,g.val()):h=a,h==null?h="":typeof h=="number"?h+="":f.isArray(h)&&(h=f.map(h,function(a){return a==null?"":a+""})),c=f.valHooks[this.nodeName.toLowerCase()]||f.valHooks[this.type];if(!c||!("set"in c)||c.set(this,h,"value")===b)this.value=h}})}if(g){c=f.valHooks[g.nodeName.toLowerCase()]||f.valHooks[g.type];if(c&&"get"in c&&(d=c.get(g,"value"))!==b)return d;d=g.value;return typeof d=="string"?d.replace(q,""):d==null?"":d}}}}),f.extend({valHooks:{option:{get:function(a){var b=a.attributes.value;return!b||b.specified?a.value:a.text}},select:{get:function(a){var b,c,d,e,g=a.selectedIndex,h=[],i=a.options,j=a.type==="select-one";if(g<0)return null;c=j?g:0,d=j?g+1:i.length;for(;c<d;c++){e=i[c];if(e.selected&&(f.support.optDisabled?!e.disabled:e.getAttribute("disabled")===null)&&(!e.parentNode.disabled||!f.nodeName(e.parentNode,"optgroup"))){b=f(e).val();if(j)return b;h.push(b)}}if(j&&!h.length&&i.length)return f(i[g]).val();return h},set:function(a,b){var c=f.makeArray(b);f(a).find("option").each(function(){this.selected=f.inArray(f(this).val(),c)>=0}),c.length||(a.selectedIndex=-1);return c}}},attrFn:{val:!0,css:!0,html:!0,text:!0,data:!0,width:!0,height:!0,offset:!0},attr:function(a,c,d,e){var g,h,i,j=a.nodeType;if(!!a&&j!==3&&j!==8&&j!==2){if(e&&c in f.attrFn)return f(a)[c](d);if(typeof a.getAttribute=="undefined")return f.prop(a,c,d);i=j!==1||!f.isXMLDoc(a),i&&(c=c.toLowerCase(),h=f.attrHooks[c]||(u.test(c)?x:w));if(d!==b){if(d===null){f.removeAttr(a,c);return}if(h&&"set"in h&&i&&(g=h.set(a,d,c))!==b)return g;a.setAttribute(c,""+d);return d}if(h&&"get"in h&&i&&(g=h.get(a,c))!==null)return g;g=a.getAttribute(c);return g===null?b:g}},removeAttr:function(a,b){var c,d,e,g,h=0;if(b&&a.nodeType===1){d=b.toLowerCase().split(p),g=d.length;for(;h<g;h++)e=d[h],e&&(c=f.propFix[e]||e,f.attr(a,e,""),a.removeAttribute(v?e:c),u.test(e)&&c in a&&(a[c]=!1))}},attrHooks:{type:{set:function(a,b){if(r.test(a.nodeName)&&a.parentNode)f.error("type property can't be changed");else if(!f.support.radioValue&&b==="radio"&&f.nodeName(a,"input")){var c=a.value;a.setAttribute("type",b),c&&(a.value=c);return b}}},value:{get:function(a,b){if(w&&f.nodeName(a,"button"))return w.get(a,b);return b in a?a.value:null},set:function(a,b,c){if(w&&f.nodeName(a,"button"))return w.set(a,b,c);a.value=b}}},propFix:{tabindex:"tabIndex",readonly:"readOnly","for":"htmlFor","class":"className",maxlength:"maxLength",cellspacing:"cellSpacing",cellpadding:"cellPadding",rowspan:"rowSpan",colspan:"colSpan",usemap:"useMap",frameborder:"frameBorder",contenteditable:"contentEditable"},prop:function(a,c,d){var e,g,h,i=a.nodeType;if(!!a&&i!==3&&i!==8&&i!==2){h=i!==1||!f.isXMLDoc(a),h&&(c=f.propFix[c]||c,g=f.propHooks[c]);return d!==b?g&&"set"in g&&(e=g.set(a,d,c))!==b?e:a[c]=d:g&&"get"in g&&(e=g.get(a,c))!==null?e:a[c]}},propHooks:{tabIndex:{get:function(a){var c=a.getAttributeNode("tabindex");return c&&c.specified?parseInt(c.value,10):s.test(a.nodeName)||t.test(a.nodeName)&&a.href?0:b}}}}),f.attrHooks.tabindex=f.propHooks.tabIndex,x={get:function(a,c){var d,e=f.prop(a,c);return e===!0||typeof e!="boolean"&&(d=a.getAttributeNode(c))&&d.nodeValue!==!1?c.toLowerCase():b},set:function(a,b,c){var d;b===!1?f.removeAttr(a,c):(d=f.propFix[c]||c,d in a&&(a[d]=!0),a.setAttribute(c,c.toLowerCase()));return c}},v||(y={name:!0,id:!0},w=f.valHooks.button={get:function(a,c){var d;d=a.getAttributeNode(c);return d&&(y[c]?d.nodeValue!=="":d.specified)?d.nodeValue:b},set:function(a,b,d){var e=a.getAttributeNode(d);e||(e=c.createAttribute(d),a.setAttributeNode(e));return e.nodeValue=b+""}},f.attrHooks.tabindex.set=w.set,f.each(["width","height"],function(a,b){f.attrHooks[b]=f.extend(f.attrHooks[b],{set:function(a,c){if(c===""){a.setAttribute(b,"auto");return c}}})}),f.attrHooks.contenteditable={get:w.get,set:function(a,b,c){b===""&&(b="false"),w.set(a,b,c)}}),f.support.hrefNormalized||f.each(["href","src","width","height"],function(a,c){f.attrHooks[c]=f.extend(f.attrHooks[c],{get:function(a){var d=a.getAttribute(c,2);return d===null?b:d}})}),f.support.style||(f.attrHooks.style={get:function(a){return a.style.cssText.toLowerCase()||b},set:function(a,b){return a.style.cssText=""+b}}),f.support.optSelected||(f.propHooks.selected=f.extend(f.propHooks.selected,{get:function(a){var b=a.parentNode;b&&(b.selectedIndex,b.parentNode&&b.parentNode.selectedIndex);return null}})),f.support.enctype||(f.propFix.enctype="encoding"),f.support.checkOn||f.each(["radio","checkbox"],function(){f.valHooks[this]={get:function(a){return a.getAttribute("value")===null?"on":a.value}}}),f.each(["radio","checkbox"],function(){f.valHooks[this]=f.extend(f.valHooks[this],{set:function(a,b){if(f.isArray(b))return a.checked=f.inArray(f(a).val(),b)>=0}})});var z=/^(?:textarea|input|select)$/i,A=/^([^\.]*)?(?:\.(.+))?$/,B=/\bhover(\.\S+)?\b/,C=/^key/,D=/^(?:mouse|contextmenu)|click/,E=/^(?:focusinfocus|focusoutblur)$/,F=/^(\w*)(?:#([\w\-]+))?(?:\.([\w\-]+))?$/,G=function(a){var b=F.exec(a);b&&(b[1]=(b[1]||"").toLowerCase(),b[3]=b[3]&&new RegExp("(?:^|\\s)"+b[3]+"(?:\\s|$)"));return b},H=function(a,b){var c=a.attributes||{};return(!b[1]||a.nodeName.toLowerCase()===b[1])&&(!b[2]||(c.id||{}).value===b[2])&&(!b[3]||b[3].test((c["class"]||{}).value))},I=function(a){return f.event.special.hover?a:a.replace(B,"mouseenter$1 mouseleave$1")};
f.event={add:function(a,c,d,e,g){var h,i,j,k,l,m,n,o,p,q,r,s;if(!(a.nodeType===3||a.nodeType===8||!c||!d||!(h=f._data(a)))){d.handler&&(p=d,d=p.handler),d.guid||(d.guid=f.guid++),j=h.events,j||(h.events=j={}),i=h.handle,i||(h.handle=i=function(a){return typeof f!="undefined"&&(!a||f.event.triggered!==a.type)?f.event.dispatch.apply(i.elem,arguments):b},i.elem=a),c=f.trim(I(c)).split(" ");for(k=0;k<c.length;k++){l=A.exec(c[k])||[],m=l[1],n=(l[2]||"").split(".").sort(),s=f.event.special[m]||{},m=(g?s.delegateType:s.bindType)||m,s=f.event.special[m]||{},o=f.extend({type:m,origType:l[1],data:e,handler:d,guid:d.guid,selector:g,quick:G(g),namespace:n.join(".")},p),r=j[m];if(!r){r=j[m]=[],r.delegateCount=0;if(!s.setup||s.setup.call(a,e,n,i)===!1)a.addEventListener?a.addEventListener(m,i,!1):a.attachEvent&&a.attachEvent("on"+m,i)}s.add&&(s.add.call(a,o),o.handler.guid||(o.handler.guid=d.guid)),g?r.splice(r.delegateCount++,0,o):r.push(o),f.event.global[m]=!0}a=null}},global:{},remove:function(a,b,c,d,e){var g=f.hasData(a)&&f._data(a),h,i,j,k,l,m,n,o,p,q,r,s;if(!!g&&!!(o=g.events)){b=f.trim(I(b||"")).split(" ");for(h=0;h<b.length;h++){i=A.exec(b[h])||[],j=k=i[1],l=i[2];if(!j){for(j in o)f.event.remove(a,j+b[h],c,d,!0);continue}p=f.event.special[j]||{},j=(d?p.delegateType:p.bindType)||j,r=o[j]||[],m=r.length,l=l?new RegExp("(^|\\.)"+l.split(".").sort().join("\\.(?:.*\\.)?")+"(\\.|$)"):null;for(n=0;n<r.length;n++)s=r[n],(e||k===s.origType)&&(!c||c.guid===s.guid)&&(!l||l.test(s.namespace))&&(!d||d===s.selector||d==="**"&&s.selector)&&(r.splice(n--,1),s.selector&&r.delegateCount--,p.remove&&p.remove.call(a,s));r.length===0&&m!==r.length&&((!p.teardown||p.teardown.call(a,l)===!1)&&f.removeEvent(a,j,g.handle),delete o[j])}f.isEmptyObject(o)&&(q=g.handle,q&&(q.elem=null),f.removeData(a,["events","handle"],!0))}},customEvent:{getData:!0,setData:!0,changeData:!0},trigger:function(c,d,e,g){if(!e||e.nodeType!==3&&e.nodeType!==8){var h=c.type||c,i=[],j,k,l,m,n,o,p,q,r,s;if(E.test(h+f.event.triggered))return;h.indexOf("!")>=0&&(h=h.slice(0,-1),k=!0),h.indexOf(".")>=0&&(i=h.split("."),h=i.shift(),i.sort());if((!e||f.event.customEvent[h])&&!f.event.global[h])return;c=typeof c=="object"?c[f.expando]?c:new f.Event(h,c):new f.Event(h),c.type=h,c.isTrigger=!0,c.exclusive=k,c.namespace=i.join("."),c.namespace_re=c.namespace?new RegExp("(^|\\.)"+i.join("\\.(?:.*\\.)?")+"(\\.|$)"):null,o=h.indexOf(":")<0?"on"+h:"";if(!e){j=f.cache;for(l in j)j[l].events&&j[l].events[h]&&f.event.trigger(c,d,j[l].handle.elem,!0);return}c.result=b,c.target||(c.target=e),d=d!=null?f.makeArray(d):[],d.unshift(c),p=f.event.special[h]||{};if(p.trigger&&p.trigger.apply(e,d)===!1)return;r=[[e,p.bindType||h]];if(!g&&!p.noBubble&&!f.isWindow(e)){s=p.delegateType||h,m=E.test(s+h)?e:e.parentNode,n=null;for(;m;m=m.parentNode)r.push([m,s]),n=m;n&&n===e.ownerDocument&&r.push([n.defaultView||n.parentWindow||a,s])}for(l=0;l<r.length&&!c.isPropagationStopped();l++)m=r[l][0],c.type=r[l][1],q=(f._data(m,"events")||{})[c.type]&&f._data(m,"handle"),q&&q.apply(m,d),q=o&&m[o],q&&f.acceptData(m)&&q.apply(m,d)===!1&&c.preventDefault();c.type=h,!g&&!c.isDefaultPrevented()&&(!p._default||p._default.apply(e.ownerDocument,d)===!1)&&(h!=="click"||!f.nodeName(e,"a"))&&f.acceptData(e)&&o&&e[h]&&(h!=="focus"&&h!=="blur"||c.target.offsetWidth!==0)&&!f.isWindow(e)&&(n=e[o],n&&(e[o]=null),f.event.triggered=h,e[h](),f.event.triggered=b,n&&(e[o]=n));return c.result}},dispatch:function(c){c=f.event.fix(c||a.event);var d=(f._data(this,"events")||{})[c.type]||[],e=d.delegateCount,g=[].slice.call(arguments,0),h=!c.exclusive&&!c.namespace,i=[],j,k,l,m,n,o,p,q,r,s,t;g[0]=c,c.delegateTarget=this;if(e&&!c.target.disabled&&(!c.button||c.type!=="click")){m=f(this),m.context=this.ownerDocument||this;for(l=c.target;l!=this;l=l.parentNode||this){o={},q=[],m[0]=l;for(j=0;j<e;j++)r=d[j],s=r.selector,o[s]===b&&(o[s]=r.quick?H(l,r.quick):m.is(s)),o[s]&&q.push(r);q.length&&i.push({elem:l,matches:q})}}d.length>e&&i.push({elem:this,matches:d.slice(e)});for(j=0;j<i.length&&!c.isPropagationStopped();j++){p=i[j],c.currentTarget=p.elem;for(k=0;k<p.matches.length&&!c.isImmediatePropagationStopped();k++){r=p.matches[k];if(h||!c.namespace&&!r.namespace||c.namespace_re&&c.namespace_re.test(r.namespace))c.data=r.data,c.handleObj=r,n=((f.event.special[r.origType]||{}).handle||r.handler).apply(p.elem,g),n!==b&&(c.result=n,n===!1&&(c.preventDefault(),c.stopPropagation()))}}return c.result},props:"attrChange attrName relatedNode srcElement altKey bubbles cancelable ctrlKey currentTarget eventPhase metaKey relatedTarget shiftKey target timeStamp view which".split(" "),fixHooks:{},keyHooks:{props:"char charCode key keyCode".split(" "),filter:function(a,b){a.which==null&&(a.which=b.charCode!=null?b.charCode:b.keyCode);return a}},mouseHooks:{props:"button buttons clientX clientY fromElement offsetX offsetY pageX pageY screenX screenY toElement".split(" "),filter:function(a,d){var e,f,g,h=d.button,i=d.fromElement;a.pageX==null&&d.clientX!=null&&(e=a.target.ownerDocument||c,f=e.documentElement,g=e.body,a.pageX=d.clientX+(f&&f.scrollLeft||g&&g.scrollLeft||0)-(f&&f.clientLeft||g&&g.clientLeft||0),a.pageY=d.clientY+(f&&f.scrollTop||g&&g.scrollTop||0)-(f&&f.clientTop||g&&g.clientTop||0)),!a.relatedTarget&&i&&(a.relatedTarget=i===a.target?d.toElement:i),!a.which&&h!==b&&(a.which=h&1?1:h&2?3:h&4?2:0);return a}},fix:function(a){if(a[f.expando])return a;var d,e,g=a,h=f.event.fixHooks[a.type]||{},i=h.props?this.props.concat(h.props):this.props;a=f.Event(g);for(d=i.length;d;)e=i[--d],a[e]=g[e];a.target||(a.target=g.srcElement||c),a.target.nodeType===3&&(a.target=a.target.parentNode),a.metaKey===b&&(a.metaKey=a.ctrlKey);return h.filter?h.filter(a,g):a},special:{ready:{setup:f.bindReady},load:{noBubble:!0},focus:{delegateType:"focusin"},blur:{delegateType:"focusout"},beforeunload:{setup:function(a,b,c){f.isWindow(this)&&(this.onbeforeunload=c)},teardown:function(a,b){this.onbeforeunload===b&&(this.onbeforeunload=null)}}},simulate:function(a,b,c,d){var e=f.extend(new f.Event,c,{type:a,isSimulated:!0,originalEvent:{}});d?f.event.trigger(e,null,b):f.event.dispatch.call(b,e),e.isDefaultPrevented()&&c.preventDefault()}},f.event.handle=f.event.dispatch,f.removeEvent=c.removeEventListener?function(a,b,c){a.removeEventListener&&a.removeEventListener(b,c,!1)}:function(a,b,c){a.detachEvent&&a.detachEvent("on"+b,c)},f.Event=function(a,b){if(!(this instanceof f.Event))return new f.Event(a,b);a&&a.type?(this.originalEvent=a,this.type=a.type,this.isDefaultPrevented=a.defaultPrevented||a.returnValue===!1||a.getPreventDefault&&a.getPreventDefault()?K:J):this.type=a,b&&f.extend(this,b),this.timeStamp=a&&a.timeStamp||f.now(),this[f.expando]=!0},f.Event.prototype={preventDefault:function(){this.isDefaultPrevented=K;var a=this.originalEvent;!a||(a.preventDefault?a.preventDefault():a.returnValue=!1)},stopPropagation:function(){this.isPropagationStopped=K;var a=this.originalEvent;!a||(a.stopPropagation&&a.stopPropagation(),a.cancelBubble=!0)},stopImmediatePropagation:function(){this.isImmediatePropagationStopped=K,this.stopPropagation()},isDefaultPrevented:J,isPropagationStopped:J,isImmediatePropagationStopped:J},f.each({mouseenter:"mouseover",mouseleave:"mouseout"},function(a,b){f.event.special[a]={delegateType:b,bindType:b,handle:function(a){var c=this,d=a.relatedTarget,e=a.handleObj,g=e.selector,h;if(!d||d!==c&&!f.contains(c,d))a.type=e.origType,h=e.handler.apply(this,arguments),a.type=b;return h}}}),f.support.submitBubbles||(f.event.special.submit={setup:function(){if(f.nodeName(this,"form"))return!1;f.event.add(this,"click._submit keypress._submit",function(a){var c=a.target,d=f.nodeName(c,"input")||f.nodeName(c,"button")?c.form:b;d&&!d._submit_attached&&(f.event.add(d,"submit._submit",function(a){this.parentNode&&!a.isTrigger&&f.event.simulate("submit",this.parentNode,a,!0)}),d._submit_attached=!0)})},teardown:function(){if(f.nodeName(this,"form"))return!1;f.event.remove(this,"._submit")}}),f.support.changeBubbles||(f.event.special.change={setup:function(){if(z.test(this.nodeName)){if(this.type==="checkbox"||this.type==="radio")f.event.add(this,"propertychange._change",function(a){a.originalEvent.propertyName==="checked"&&(this._just_changed=!0)}),f.event.add(this,"click._change",function(a){this._just_changed&&!a.isTrigger&&(this._just_changed=!1,f.event.simulate("change",this,a,!0))});return!1}f.event.add(this,"beforeactivate._change",function(a){var b=a.target;z.test(b.nodeName)&&!b._change_attached&&(f.event.add(b,"change._change",function(a){this.parentNode&&!a.isSimulated&&!a.isTrigger&&f.event.simulate("change",this.parentNode,a,!0)}),b._change_attached=!0)})},handle:function(a){var b=a.target;if(this!==b||a.isSimulated||a.isTrigger||b.type!=="radio"&&b.type!=="checkbox")return a.handleObj.handler.apply(this,arguments)},teardown:function(){f.event.remove(this,"._change");return z.test(this.nodeName)}}),f.support.focusinBubbles||f.each({focus:"focusin",blur:"focusout"},function(a,b){var d=0,e=function(a){f.event.simulate(b,a.target,f.event.fix(a),!0)};f.event.special[b]={setup:function(){d++===0&&c.addEventListener(a,e,!0)},teardown:function(){--d===0&&c.removeEventListener(a,e,!0)}}}),f.fn.extend({on:function(a,c,d,e,g){var h,i;if(typeof a=="object"){typeof c!="string"&&(d=c,c=b);for(i in a)this.on(i,c,d,a[i],g);return this}d==null&&e==null?(e=c,d=c=b):e==null&&(typeof c=="string"?(e=d,d=b):(e=d,d=c,c=b));if(e===!1)e=J;else if(!e)return this;g===1&&(h=e,e=function(a){f().off(a);return h.apply(this,arguments)},e.guid=h.guid||(h.guid=f.guid++));return this.each(function(){f.event.add(this,a,e,d,c)})},one:function(a,b,c,d){return this.on.call(this,a,b,c,d,1)},off:function(a,c,d){if(a&&a.preventDefault&&a.handleObj){var e=a.handleObj;f(a.delegateTarget).off(e.namespace?e.type+"."+e.namespace:e.type,e.selector,e.handler);return this}if(typeof a=="object"){for(var g in a)this.off(g,c,a[g]);return this}if(c===!1||typeof c=="function")d=c,c=b;d===!1&&(d=J);return this.each(function(){f.event.remove(this,a,d,c)})},bind:function(a,b,c){return this.on(a,null,b,c)},unbind:function(a,b){return this.off(a,null,b)},live:function(a,b,c){f(this.context).on(a,this.selector,b,c);return this},die:function(a,b){f(this.context).off(a,this.selector||"**",b);return this},delegate:function(a,b,c,d){return this.on(b,a,c,d)},undelegate:function(a,b,c){return arguments.length==1?this.off(a,"**"):this.off(b,a,c)},trigger:function(a,b){return this.each(function(){f.event.trigger(a,b,this)})},triggerHandler:function(a,b){if(this[0])return f.event.trigger(a,b,this[0],!0)},toggle:function(a){var b=arguments,c=a.guid||f.guid++,d=0,e=function(c){var e=(f._data(this,"lastToggle"+a.guid)||0)%d;f._data(this,"lastToggle"+a.guid,e+1),c.preventDefault();return b[e].apply(this,arguments)||!1};e.guid=c;while(d<b.length)b[d++].guid=c;return this.click(e)},hover:function(a,b){return this.mouseenter(a).mouseleave(b||a)}}),f.each("blur focus focusin focusout load resize scroll unload click dblclick mousedown mouseup mousemove mouseover mouseout mouseenter mouseleave change select submit keydown keypress keyup error contextmenu".split(" "),function(a,b){f.fn[b]=function(a,c){c==null&&(c=a,a=null);return arguments.length>0?this.on(b,null,a,c):this.trigger(b)},f.attrFn&&(f.attrFn[b]=!0),C.test(b)&&(f.event.fixHooks[b]=f.event.keyHooks),D.test(b)&&(f.event.fixHooks[b]=f.event.mouseHooks)}),function(){function x(a,b,c,e,f,g){for(var h=0,i=e.length;h<i;h++){var j=e[h];if(j){var k=!1;j=j[a];while(j){if(j[d]===c){k=e[j.sizset];break}if(j.nodeType===1){g||(j[d]=c,j.sizset=h);if(typeof b!="string"){if(j===b){k=!0;break}}else if(m.filter(b,[j]).length>0){k=j;break}}j=j[a]}e[h]=k}}}function w(a,b,c,e,f,g){for(var h=0,i=e.length;h<i;h++){var j=e[h];if(j){var k=!1;j=j[a];while(j){if(j[d]===c){k=e[j.sizset];break}j.nodeType===1&&!g&&(j[d]=c,j.sizset=h);if(j.nodeName.toLowerCase()===b){k=j;break}j=j[a]}e[h]=k}}}var a=/((?:\((?:\([^()]+\)|[^()]+)+\)|\[(?:\[[^\[\]]*\]|['"][^'"]*['"]|[^\[\]'"]+)+\]|\\.|[^ >+~,(\[\\]+)+|[>+~])(\s*,\s*)?((?:.|\r|\n)*)/g,d="sizcache"+(Math.random()+"").replace(".",""),e=0,g=Object.prototype.toString,h=!1,i=!0,j=/\\/g,k=/\r\n/g,l=/\W/;[0,0].sort(function(){i=!1;return 0});var m=function(b,d,e,f){e=e||[],d=d||c;var h=d;if(d.nodeType!==1&&d.nodeType!==9)return[];if(!b||typeof b!="string")return e;var i,j,k,l,n,q,r,t,u=!0,v=m.isXML(d),w=[],x=b;do{a.exec(""),i=a.exec(x);if(i){x=i[3],w.push(i[1]);if(i[2]){l=i[3];break}}}while(i);if(w.length>1&&p.exec(b))if(w.length===2&&o.relative[w[0]])j=y(w[0]+w[1],d,f);else{j=o.relative[w[0]]?[d]:m(w.shift(),d);while(w.length)b=w.shift(),o.relative[b]&&(b+=w.shift()),j=y(b,j,f)}else{!f&&w.length>1&&d.nodeType===9&&!v&&o.match.ID.test(w[0])&&!o.match.ID.test(w[w.length-1])&&(n=m.find(w.shift(),d,v),d=n.expr?m.filter(n.expr,n.set)[0]:n.set[0]);if(d){n=f?{expr:w.pop(),set:s(f)}:m.find(w.pop(),w.length===1&&(w[0]==="~"||w[0]==="+")&&d.parentNode?d.parentNode:d,v),j=n.expr?m.filter(n.expr,n.set):n.set,w.length>0?k=s(j):u=!1;while(w.length)q=w.pop(),r=q,o.relative[q]?r=w.pop():q="",r==null&&(r=d),o.relative[q](k,r,v)}else k=w=[]}k||(k=j),k||m.error(q||b);if(g.call(k)==="[object Array]")if(!u)e.push.apply(e,k);else if(d&&d.nodeType===1)for(t=0;k[t]!=null;t++)k[t]&&(k[t]===!0||k[t].nodeType===1&&m.contains(d,k[t]))&&e.push(j[t]);else for(t=0;k[t]!=null;t++)k[t]&&k[t].nodeType===1&&e.push(j[t]);else s(k,e);l&&(m(l,h,e,f),m.uniqueSort(e));return e};m.uniqueSort=function(a){if(u){h=i,a.sort(u);if(h)for(var b=1;b<a.length;b++)a[b]===a[b-1]&&a.splice(b--,1)}return a},m.matches=function(a,b){return m(a,null,null,b)},m.matchesSelector=function(a,b){return m(b,null,null,[a]).length>0},m.find=function(a,b,c){var d,e,f,g,h,i;if(!a)return[];for(e=0,f=o.order.length;e<f;e++){h=o.order[e];if(g=o.leftMatch[h].exec(a)){i=g[1],g.splice(1,1);if(i.substr(i.length-1)!=="\\"){g[1]=(g[1]||"").replace(j,""),d=o.find[h](g,b,c);if(d!=null){a=a.replace(o.match[h],"");break}}}}d||(d=typeof b.getElementsByTagName!="undefined"?b.getElementsByTagName("*"):[]);return{set:d,expr:a}},m.filter=function(a,c,d,e){var f,g,h,i,j,k,l,n,p,q=a,r=[],s=c,t=c&&c[0]&&m.isXML(c[0]);while(a&&c.length){for(h in o.filter)if((f=o.leftMatch[h].exec(a))!=null&&f[2]){k=o.filter[h],l=f[1],g=!1,f.splice(1,1);if(l.substr(l.length-1)==="\\")continue;s===r&&(r=[]);if(o.preFilter[h]){f=o.preFilter[h](f,s,d,r,e,t);if(!f)g=i=!0;else if(f===!0)continue}if(f)for(n=0;(j=s[n])!=null;n++)j&&(i=k(j,f,n,s),p=e^i,d&&i!=null?p?g=!0:s[n]=!1:p&&(r.push(j),g=!0));if(i!==b){d||(s=r),a=a.replace(o.match[h],"");if(!g)return[];break}}if(a===q)if(g==null)m.error(a);else break;q=a}return s},m.error=function(a){throw new Error("Syntax error, unrecognized expression: "+a)};var n=m.getText=function(a){var b,c,d=a.nodeType,e="";if(d){if(d===1||d===9){if(typeof a.textContent=="string")return a.textContent;if(typeof a.innerText=="string")return a.innerText.replace(k,"");for(a=a.firstChild;a;a=a.nextSibling)e+=n(a)}else if(d===3||d===4)return a.nodeValue}else for(b=0;c=a[b];b++)c.nodeType!==8&&(e+=n(c));return e},o=m.selectors={order:["ID","NAME","TAG"],match:{ID:/#((?:[\w\u00c0-\uFFFF\-]|\\.)+)/,CLASS:/\.((?:[\w\u00c0-\uFFFF\-]|\\.)+)/,NAME:/\[name=['"]*((?:[\w\u00c0-\uFFFF\-]|\\.)+)['"]*\]/,ATTR:/\[\s*((?:[\w\u00c0-\uFFFF\-]|\\.)+)\s*(?:(\S?=)\s*(?:(['"])(.*?)\3|(#?(?:[\w\u00c0-\uFFFF\-]|\\.)*)|)|)\s*\]/,TAG:/^((?:[\w\u00c0-\uFFFF\*\-]|\\.)+)/,CHILD:/:(only|nth|last|first)-child(?:\(\s*(even|odd|(?:[+\-]?\d+|(?:[+\-]?\d*)?n\s*(?:[+\-]\s*\d+)?))\s*\))?/,POS:/:(nth|eq|gt|lt|first|last|even|odd)(?:\((\d*)\))?(?=[^\-]|$)/,PSEUDO:/:((?:[\w\u00c0-\uFFFF\-]|\\.)+)(?:\((['"]?)((?:\([^\)]+\)|[^\(\)]*)+)\2\))?/},leftMatch:{},attrMap:{"class":"className","for":"htmlFor"},attrHandle:{href:function(a){return a.getAttribute("href")},type:function(a){return a.getAttribute("type")}},relative:{"+":function(a,b){var c=typeof b=="string",d=c&&!l.test(b),e=c&&!d;d&&(b=b.toLowerCase());for(var f=0,g=a.length,h;f<g;f++)if(h=a[f]){while((h=h.previousSibling)&&h.nodeType!==1);a[f]=e||h&&h.nodeName.toLowerCase()===b?h||!1:h===b}e&&m.filter(b,a,!0)},">":function(a,b){var c,d=typeof b=="string",e=0,f=a.length;if(d&&!l.test(b)){b=b.toLowerCase();for(;e<f;e++){c=a[e];if(c){var g=c.parentNode;a[e]=g.nodeName.toLowerCase()===b?g:!1}}}else{for(;e<f;e++)c=a[e],c&&(a[e]=d?c.parentNode:c.parentNode===b);d&&m.filter(b,a,!0)}},"":function(a,b,c){var d,f=e++,g=x;typeof b=="string"&&!l.test(b)&&(b=b.toLowerCase(),d=b,g=w),g("parentNode",b,f,a,d,c)},"~":function(a,b,c){var d,f=e++,g=x;typeof b=="string"&&!l.test(b)&&(b=b.toLowerCase(),d=b,g=w),g("previousSibling",b,f,a,d,c)}},find:{ID:function(a,b,c){if(typeof b.getElementById!="undefined"&&!c){var d=b.getElementById(a[1]);return d&&d.parentNode?[d]:[]}},NAME:function(a,b){if(typeof b.getElementsByName!="undefined"){var c=[],d=b.getElementsByName(a[1]);for(var e=0,f=d.length;e<f;e++)d[e].getAttribute("name")===a[1]&&c.push(d[e]);return c.length===0?null:c}},TAG:function(a,b){if(typeof b.getElementsByTagName!="undefined")return b.getElementsByTagName(a[1])}},preFilter:{CLASS:function(a,b,c,d,e,f){a=" "+a[1].replace(j,"")+" ";if(f)return a;for(var g=0,h;(h=b[g])!=null;g++)h&&(e^(h.className&&(" "+h.className+" ").replace(/[\t\n\r]/g," ").indexOf(a)>=0)?c||d.push(h):c&&(b[g]=!1));return!1},ID:function(a){return a[1].replace(j,"")},TAG:function(a,b){return a[1].replace(j,"").toLowerCase()},CHILD:function(a){if(a[1]==="nth"){a[2]||m.error(a[0]),a[2]=a[2].replace(/^\+|\s*/g,"");var b=/(-?)(\d*)(?:n([+\-]?\d*))?/.exec(a[2]==="even"&&"2n"||a[2]==="odd"&&"2n+1"||!/\D/.test(a[2])&&"0n+"+a[2]||a[2]);a[2]=b[1]+(b[2]||1)-0,a[3]=b[3]-0}else a[2]&&m.error(a[0]);a[0]=e++;return a},ATTR:function(a,b,c,d,e,f){var g=a[1]=a[1].replace(j,"");!f&&o.attrMap[g]&&(a[1]=o.attrMap[g]),a[4]=(a[4]||a[5]||"").replace(j,""),a[2]==="~="&&(a[4]=" "+a[4]+" ");return a},PSEUDO:function(b,c,d,e,f){if(b[1]==="not")if((a.exec(b[3])||"").length>1||/^\w/.test(b[3]))b[3]=m(b[3],null,null,c);else{var g=m.filter(b[3],c,d,!0^f);d||e.push.apply(e,g);return!1}else if(o.match.POS.test(b[0])||o.match.CHILD.test(b[0]))return!0;return b},POS:function(a){a.unshift(!0);return a}},filters:{enabled:function(a){return a.disabled===!1&&a.type!=="hidden"},disabled:function(a){return a.disabled===!0},checked:function(a){return a.checked===!0},selected:function(a){a.parentNode&&a.parentNode.selectedIndex;return a.selected===!0},parent:function(a){return!!a.firstChild},empty:function(a){return!a.firstChild},has:function(a,b,c){return!!m(c[3],a).length},header:function(a){return/h\d/i.test(a.nodeName)},text:function(a){var b=a.getAttribute("type"),c=a.type;return a.nodeName.toLowerCase()==="input"&&"text"===c&&(b===c||b===null)},radio:function(a){return a.nodeName.toLowerCase()==="input"&&"radio"===a.type},checkbox:function(a){return a.nodeName.toLowerCase()==="input"&&"checkbox"===a.type},file:function(a){return a.nodeName.toLowerCase()==="input"&&"file"===a.type},password:function(a){return a.nodeName.toLowerCase()==="input"&&"password"===a.type},submit:function(a){var b=a.nodeName.toLowerCase();return(b==="input"||b==="button")&&"submit"===a.type},image:function(a){return a.nodeName.toLowerCase()==="input"&&"image"===a.type},reset:function(a){var b=a.nodeName.toLowerCase();return(b==="input"||b==="button")&&"reset"===a.type},button:function(a){var b=a.nodeName.toLowerCase();return b==="input"&&"button"===a.type||b==="button"},input:function(a){return/input|select|textarea|button/i.test(a.nodeName)},focus:function(a){return a===a.ownerDocument.activeElement}},setFilters:{first:function(a,b){return b===0},last:function(a,b,c,d){return b===d.length-1},even:function(a,b){return b%2===0},odd:function(a,b){return b%2===1},lt:function(a,b,c){return b<c[3]-0},gt:function(a,b,c){return b>c[3]-0},nth:function(a,b,c){return c[3]-0===b},eq:function(a,b,c){return c[3]-0===b}},filter:{PSEUDO:function(a,b,c,d){var e=b[1],f=o.filters[e];if(f)return f(a,c,b,d);if(e==="contains")return(a.textContent||a.innerText||n([a])||"").indexOf(b[3])>=0;if(e==="not"){var g=b[3];for(var h=0,i=g.length;h<i;h++)if(g[h]===a)return!1;return!0}m.error(e)},CHILD:function(a,b){var c,e,f,g,h,i,j,k=b[1],l=a;switch(k){case"only":case"first":while(l=l.previousSibling)if(l.nodeType===1)return!1;if(k==="first")return!0;l=a;case"last":while(l=l.nextSibling)if(l.nodeType===1)return!1;return!0;case"nth":c=b[2],e=b[3];if(c===1&&e===0)return!0;f=b[0],g=a.parentNode;if(g&&(g[d]!==f||!a.nodeIndex)){i=0;for(l=g.firstChild;l;l=l.nextSibling)l.nodeType===1&&(l.nodeIndex=++i);g[d]=f}j=a.nodeIndex-e;return c===0?j===0:j%c===0&&j/c>=0}},ID:function(a,b){return a.nodeType===1&&a.getAttribute("id")===b},TAG:function(a,b){return b==="*"&&a.nodeType===1||!!a.nodeName&&a.nodeName.toLowerCase()===b},CLASS:function(a,b){return(" "+(a.className||a.getAttribute("class"))+" ").indexOf(b)>-1},ATTR:function(a,b){var c=b[1],d=m.attr?m.attr(a,c):o.attrHandle[c]?o.attrHandle[c](a):a[c]!=null?a[c]:a.getAttribute(c),e=d+"",f=b[2],g=b[4];return d==null?f==="!=":!f&&m.attr?d!=null:f==="="?e===g:f==="*="?e.indexOf(g)>=0:f==="~="?(" "+e+" ").indexOf(g)>=0:g?f==="!="?e!==g:f==="^="?e.indexOf(g)===0:f==="$="?e.substr(e.length-g.length)===g:f==="|="?e===g||e.substr(0,g.length+1)===g+"-":!1:e&&d!==!1},POS:function(a,b,c,d){var e=b[2],f=o.setFilters[e];if(f)return f(a,c,b,d)}}},p=o.match.POS,q=function(a,b){return"\\"+(b-0+1)};for(var r in o.match)o.match[r]=new RegExp(o.match[r].source+/(?![^\[]*\])(?![^\(]*\))/.source),o.leftMatch[r]=new RegExp(/(^(?:.|\r|\n)*?)/.source+o.match[r].source.replace(/\\(\d+)/g,q));var s=function(a,b){a=Array.prototype.slice.call(a,0);if(b){b.push.apply(b,a);return b}return a};try{Array.prototype.slice.call(c.documentElement.childNodes,0)[0].nodeType}catch(t){s=function(a,b){var c=0,d=b||[];if(g.call(a)==="[object Array]")Array.prototype.push.apply(d,a);else if(typeof a.length=="number")for(var e=a.length;c<e;c++)d.push(a[c]);else for(;a[c];c++)d.push(a[c]);return d}}var u,v;c.documentElement.compareDocumentPosition?u=function(a,b){if(a===b){h=!0;return 0}if(!a.compareDocumentPosition||!b.compareDocumentPosition)return a.compareDocumentPosition?-1:1;return a.compareDocumentPosition(b)&4?-1:1}:(u=function(a,b){if(a===b){h=!0;return 0}if(a.sourceIndex&&b.sourceIndex)return a.sourceIndex-b.sourceIndex;var c,d,e=[],f=[],g=a.parentNode,i=b.parentNode,j=g;if(g===i)return v(a,b);if(!g)return-1;if(!i)return 1;while(j)e.unshift(j),j=j.parentNode;j=i;while(j)f.unshift(j),j=j.parentNode;c=e.length,d=f.length;for(var k=0;k<c&&k<d;k++)if(e[k]!==f[k])return v(e[k],f[k]);return k===c?v(a,f[k],-1):v(e[k],b,1)},v=function(a,b,c){if(a===b)return c;var d=a.nextSibling;while(d){if(d===b)return-1;d=d.nextSibling}return 1}),function(){var a=c.createElement("div"),d="script"+(new Date).getTime(),e=c.documentElement;a.innerHTML="<a name='"+d+"'/>",e.insertBefore(a,e.firstChild),c.getElementById(d)&&(o.find.ID=function(a,c,d){if(typeof c.getElementById!="undefined"&&!d){var e=c.getElementById(a[1]);return e?e.id===a[1]||typeof e.getAttributeNode!="undefined"&&e.getAttributeNode("id").nodeValue===a[1]?[e]:b:[]}},o.filter.ID=function(a,b){var c=typeof a.getAttributeNode!="undefined"&&a.getAttributeNode("id");return a.nodeType===1&&c&&c.nodeValue===b}),e.removeChild(a),e=a=null}(),function(){var a=c.createElement("div");a.appendChild(c.createComment("")),a.getElementsByTagName("*").length>0&&(o.find.TAG=function(a,b){var c=b.getElementsByTagName(a[1]);if(a[1]==="*"){var d=[];for(var e=0;c[e];e++)c[e].nodeType===1&&d.push(c[e]);c=d}return c}),a.innerHTML="<a href='#'></a>",a.firstChild&&typeof a.firstChild.getAttribute!="undefined"&&a.firstChild.getAttribute("href")!=="#"&&(o.attrHandle.href=function(a){return a.getAttribute("href",2)}),a=null}(),c.querySelectorAll&&function(){var a=m,b=c.createElement("div"),d="__sizzle__";b.innerHTML="<p class='TEST'></p>";if(!b.querySelectorAll||b.querySelectorAll(".TEST").length!==0){m=function(b,e,f,g){e=e||c;if(!g&&!m.isXML(e)){var h=/^(\w+$)|^\.([\w\-]+$)|^#([\w\-]+$)/.exec(b);if(h&&(e.nodeType===1||e.nodeType===9)){if(h[1])return s(e.getElementsByTagName(b),f);if(h[2]&&o.find.CLASS&&e.getElementsByClassName)return s(e.getElementsByClassName(h[2]),f)}if(e.nodeType===9){if(b==="body"&&e.body)return s([e.body],f);if(h&&h[3]){var i=e.getElementById(h[3]);if(!i||!i.parentNode)return s([],f);if(i.id===h[3])return s([i],f)}try{return s(e.querySelectorAll(b),f)}catch(j){}}else if(e.nodeType===1&&e.nodeName.toLowerCase()!=="object"){var k=e,l=e.getAttribute("id"),n=l||d,p=e.parentNode,q=/^\s*[+~]/.test(b);l?n=n.replace(/'/g,"\\$&"):e.setAttribute("id",n),q&&p&&(e=e.parentNode);try{if(!q||p)return s(e.querySelectorAll("[id='"+n+"'] "+b),f)}catch(r){}finally{l||k.removeAttribute("id")}}}return a(b,e,f,g)};for(var e in a)m[e]=a[e];b=null}}(),function(){var a=c.documentElement,b=a.matchesSelector||a.mozMatchesSelector||a.webkitMatchesSelector||a.msMatchesSelector;if(b){var d=!b.call(c.createElement("div"),"div"),e=!1;try{b.call(c.documentElement,"[test!='']:sizzle")}catch(f){e=!0}m.matchesSelector=function(a,c){c=c.replace(/\=\s*([^'"\]]*)\s*\]/g,"='$1']");if(!m.isXML(a))try{if(e||!o.match.PSEUDO.test(c)&&!/!=/.test(c)){var f=b.call(a,c);if(f||!d||a.document&&a.document.nodeType!==11)return f}}catch(g){}return m(c,null,null,[a]).length>0}}}(),function(){var a=c.createElement("div");a.innerHTML="<div class='test e'></div><div class='test'></div>";if(!!a.getElementsByClassName&&a.getElementsByClassName("e").length!==0){a.lastChild.className="e";if(a.getElementsByClassName("e").length===1)return;o.order.splice(1,0,"CLASS"),o.find.CLASS=function(a,b,c){if(typeof b.getElementsByClassName!="undefined"&&!c)return b.getElementsByClassName(a[1])},a=null}}(),c.documentElement.contains?m.contains=function(a,b){return a!==b&&(a.contains?a.contains(b):!0)}:c.documentElement.compareDocumentPosition?m.contains=function(a,b){return!!(a.compareDocumentPosition(b)&16)}:m.contains=function(){return!1},m.isXML=function(a){var b=(a?a.ownerDocument||a:0).documentElement;return b?b.nodeName!=="HTML":!1};var y=function(a,b,c){var d,e=[],f="",g=b.nodeType?[b]:b;while(d=o.match.PSEUDO.exec(a))f+=d[0],a=a.replace(o.match.PSEUDO,"");a=o.relative[a]?a+"*":a;for(var h=0,i=g.length;h<i;h++)m(a,g[h],e,c);return m.filter(f,e)};m.attr=f.attr,m.selectors.attrMap={},f.find=m,f.expr=m.selectors,f.expr[":"]=f.expr.filters,f.unique=m.uniqueSort,f.text=m.getText,f.isXMLDoc=m.isXML,f.contains=m.contains}();var L=/Until$/,M=/^(?:parents|prevUntil|prevAll)/,N=/,/,O=/^.[^:#\[\.,]*$/,P=Array.prototype.slice,Q=f.expr.match.POS,R={children:!0,contents:!0,next:!0,prev:!0};f.fn.extend({find:function(a){var b=this,c,d;if(typeof a!="string")return f(a).filter(function(){for(c=0,d=b.length;c<d;c++)if(f.contains(b[c],this))return!0});var e=this.pushStack("","find",a),g,h,i;for(c=0,d=this.length;c<d;c++){g=e.length,f.find(a,this[c],e);if(c>0)for(h=g;h<e.length;h++)for(i=0;i<g;i++)if(e[i]===e[h]){e.splice(h--,1);break}}return e},has:function(a){var b=f(a);return this.filter(function(){for(var a=0,c=b.length;a<c;a++)if(f.contains(this,b[a]))return!0})},not:function(a){return this.pushStack(T(this,a,!1),"not",a)},filter:function(a){return this.pushStack(T(this,a,!0),"filter",a)},is:function(a){return!!a&&(typeof a=="string"?Q.test(a)?f(a,this.context).index(this[0])>=0:f.filter(a,this).length>0:this.filter(a).length>0)},closest:function(a,b){var c=[],d,e,g=this[0];if(f.isArray(a)){var h=1;while(g&&g.ownerDocument&&g!==b){for(d=0;d<a.length;d++)f(g).is(a[d])&&c.push({selector:a[d],elem:g,level:h});g=g.parentNode,h++}return c}var i=Q.test(a)||typeof a!="string"?f(a,b||this.context):0;for(d=0,e=this.length;d<e;d++){g=this[d];while(g){if(i?i.index(g)>-1:f.find.matchesSelector(g,a)){c.push(g);break}g=g.parentNode;if(!g||!g.ownerDocument||g===b||g.nodeType===11)break}}c=c.length>1?f.unique(c):c;return this.pushStack(c,"closest",a)},index:function(a){if(!a)return this[0]&&this[0].parentNode?this.prevAll().length:-1;if(typeof a=="string")return f.inArray(this[0],f(a));return f.inArray(a.jquery?a[0]:a,this)},add:function(a,b){var c=typeof a=="string"?f(a,b):f.makeArray(a&&a.nodeType?[a]:a),d=f.merge(this.get(),c);return this.pushStack(S(c[0])||S(d[0])?d:f.unique(d))},andSelf:function(){return this.add(this.prevObject)}}),f.each({parent:function(a){var b=a.parentNode;return b&&b.nodeType!==11?b:null},parents:function(a){return f.dir(a,"parentNode")},parentsUntil:function(a,b,c){return f.dir(a,"parentNode",c)},next:function(a){return f.nth(a,2,"nextSibling")},prev:function(a){return f.nth(a,2,"previousSibling")},nextAll:function(a){return f.dir(a,"nextSibling")},prevAll:function(a){return f.dir(a,"previousSibling")},nextUntil:function(a,b,c){return f.dir(a,"nextSibling",c)},prevUntil:function(a,b,c){return f.dir(a,"previousSibling",c)},siblings:function(a){return f.sibling(a.parentNode.firstChild,a)},children:function(a){return f.sibling(a.firstChild)},contents:function(a){return f.nodeName(a,"iframe")?a.contentDocument||a.contentWindow.document:f.makeArray(a.childNodes)}},function(a,b){f.fn[a]=function(c,d){var e=f.map(this,b,c);L.test(a)||(d=c),d&&typeof d=="string"&&(e=f.filter(d,e)),e=this.length>1&&!R[a]?f.unique(e):e,(this.length>1||N.test(d))&&M.test(a)&&(e=e.reverse());return this.pushStack(e,a,P.call(arguments).join(","))}}),f.extend({filter:function(a,b,c){c&&(a=":not("+a+")");return b.length===1?f.find.matchesSelector(b[0],a)?[b[0]]:[]:f.find.matches(a,b)},dir:function(a,c,d){var e=[],g=a[c];while(g&&g.nodeType!==9&&(d===b||g.nodeType!==1||!f(g).is(d)))g.nodeType===1&&e.push(g),g=g[c];return e},nth:function(a,b,c,d){b=b||1;var e=0;for(;a;a=a[c])if(a.nodeType===1&&++e===b)break;return a},sibling:function(a,b){var c=[];for(;a;a=a.nextSibling)a.nodeType===1&&a!==b&&c.push(a);return c}});var V="abbr|article|aside|audio|canvas|datalist|details|figcaption|figure|footer|header|hgroup|mark|meter|nav|output|progress|section|summary|time|video",W=/ jQuery\d+="(?:\d+|null)"/g,X=/^\s+/,Y=/<(?!area|br|col|embed|hr|img|input|link|meta|param)(([\w:]+)[^>]*)\/>/ig,Z=/<([\w:]+)/,$=/<tbody/i,_=/<|&#?\w+;/,ba=/<(?:script|style)/i,bb=/<(?:script|object|embed|option|style)/i,bc=new RegExp("<(?:"+V+")","i"),bd=/checked\s*(?:[^=]|=\s*.checked.)/i,be=/\/(java|ecma)script/i,bf=/^\s*<!(?:\[CDATA\[|\-\-)/,bg={option:[1,"<select multiple='multiple'>","</select>"],legend:[1,"<fieldset>","</fieldset>"],thead:[1,"<table>","</table>"],tr:[2,"<table><tbody>","</tbody></table>"],td:[3,"<table><tbody><tr>","</tr></tbody></table>"],col:[2,"<table><tbody></tbody><colgroup>","</colgroup></table>"],area:[1,"<map>","</map>"],_default:[0,"",""]},bh=U(c);bg.optgroup=bg.option,bg.tbody=bg.tfoot=bg.colgroup=bg.caption=bg.thead,bg.th=bg.td,f.support.htmlSerialize||(bg._default=[1,"div<div>","</div>"]),f.fn.extend({text:function(a){if(f.isFunction(a))return this.each(function(b){var c=f(this);c.text(a.call(this,b,c.text()))});if(typeof a!="object"&&a!==b)return this.empty().append((this[0]&&this[0].ownerDocument||c).createTextNode(a));return f.text(this)},wrapAll:function(a){if(f.isFunction(a))return this.each(function(b){f(this).wrapAll(a.call(this,b))});if(this[0]){var b=f(a,this[0].ownerDocument).eq(0).clone(!0);this[0].parentNode&&b.insertBefore(this[0]),b.map(function(){var a=this;while(a.firstChild&&a.firstChild.nodeType===1)a=a.firstChild;return a}).append(this)}return this},wrapInner:function(a){if(f.isFunction(a))return this.each(function(b){f(this).wrapInner(a.call(this,b))});return this.each(function(){var b=f(this),c=b.contents();c.length?c.wrapAll(a):b.append(a)})},wrap:function(a){var b=f.isFunction(a);return this.each(function(c){f(this).wrapAll(b?a.call(this,c):a)})},unwrap:function(){return this.parent().each(function(){f.nodeName(this,"body")||f(this).replaceWith(this.childNodes)}).end()},append:function(){return this.domManip(arguments,!0,function(a){this.nodeType===1&&this.appendChild(a)})},prepend:function(){return this.domManip(arguments,!0,function(a){this.nodeType===1&&this.insertBefore(a,this.firstChild)})},before:function(){if(this[0]&&this[0].parentNode)return this.domManip(arguments,!1,function(a){this.parentNode.insertBefore(a,this)});if(arguments.length){var a=f.clean(arguments);a.push.apply(a,this.toArray());return this.pushStack(a,"before",arguments)}},after:function(){if(this[0]&&this[0].parentNode)return this.domManip(arguments,!1,function(a){this.parentNode.insertBefore(a,this.nextSibling)});if(arguments.length){var a=this.pushStack(this,"after",arguments);a.push.apply(a,f.clean(arguments));return a}},remove:function(a,b){for(var c=0,d;(d=this[c])!=null;c++)if(!a||f.filter(a,[d]).length)!b&&d.nodeType===1&&(f.cleanData(d.getElementsByTagName("*")),f.cleanData([d])),d.parentNode&&d.parentNode.removeChild(d);return this},empty:function()
{for(var a=0,b;(b=this[a])!=null;a++){b.nodeType===1&&f.cleanData(b.getElementsByTagName("*"));while(b.firstChild)b.removeChild(b.firstChild)}return this},clone:function(a,b){a=a==null?!1:a,b=b==null?a:b;return this.map(function(){return f.clone(this,a,b)})},html:function(a){if(a===b)return this[0]&&this[0].nodeType===1?this[0].innerHTML.replace(W,""):null;if(typeof a=="string"&&!ba.test(a)&&(f.support.leadingWhitespace||!X.test(a))&&!bg[(Z.exec(a)||["",""])[1].toLowerCase()]){a=a.replace(Y,"<$1></$2>");try{for(var c=0,d=this.length;c<d;c++)this[c].nodeType===1&&(f.cleanData(this[c].getElementsByTagName("*")),this[c].innerHTML=a)}catch(e){this.empty().append(a)}}else f.isFunction(a)?this.each(function(b){var c=f(this);c.html(a.call(this,b,c.html()))}):this.empty().append(a);return this},replaceWith:function(a){if(this[0]&&this[0].parentNode){if(f.isFunction(a))return this.each(function(b){var c=f(this),d=c.html();c.replaceWith(a.call(this,b,d))});typeof a!="string"&&(a=f(a).detach());return this.each(function(){var b=this.nextSibling,c=this.parentNode;f(this).remove(),b?f(b).before(a):f(c).append(a)})}return this.length?this.pushStack(f(f.isFunction(a)?a():a),"replaceWith",a):this},detach:function(a){return this.remove(a,!0)},domManip:function(a,c,d){var e,g,h,i,j=a[0],k=[];if(!f.support.checkClone&&arguments.length===3&&typeof j=="string"&&bd.test(j))return this.each(function(){f(this).domManip(a,c,d,!0)});if(f.isFunction(j))return this.each(function(e){var g=f(this);a[0]=j.call(this,e,c?g.html():b),g.domManip(a,c,d)});if(this[0]){i=j&&j.parentNode,f.support.parentNode&&i&&i.nodeType===11&&i.childNodes.length===this.length?e={fragment:i}:e=f.buildFragment(a,this,k),h=e.fragment,h.childNodes.length===1?g=h=h.firstChild:g=h.firstChild;if(g){c=c&&f.nodeName(g,"tr");for(var l=0,m=this.length,n=m-1;l<m;l++)d.call(c?bi(this[l],g):this[l],e.cacheable||m>1&&l<n?f.clone(h,!0,!0):h)}k.length&&f.each(k,bp)}return this}}),f.buildFragment=function(a,b,d){var e,g,h,i,j=a[0];b&&b[0]&&(i=b[0].ownerDocument||b[0]),i.createDocumentFragment||(i=c),a.length===1&&typeof j=="string"&&j.length<512&&i===c&&j.charAt(0)==="<"&&!bb.test(j)&&(f.support.checkClone||!bd.test(j))&&(f.support.html5Clone||!bc.test(j))&&(g=!0,h=f.fragments[j],h&&h!==1&&(e=h)),e||(e=i.createDocumentFragment(),f.clean(a,i,e,d)),g&&(f.fragments[j]=h?e:1);return{fragment:e,cacheable:g}},f.fragments={},f.each({appendTo:"append",prependTo:"prepend",insertBefore:"before",insertAfter:"after",replaceAll:"replaceWith"},function(a,b){f.fn[a]=function(c){var d=[],e=f(c),g=this.length===1&&this[0].parentNode;if(g&&g.nodeType===11&&g.childNodes.length===1&&e.length===1){e[b](this[0]);return this}for(var h=0,i=e.length;h<i;h++){var j=(h>0?this.clone(!0):this).get();f(e[h])[b](j),d=d.concat(j)}return this.pushStack(d,a,e.selector)}}),f.extend({clone:function(a,b,c){var d,e,g,h=f.support.html5Clone||!bc.test("<"+a.nodeName)?a.cloneNode(!0):bo(a);if((!f.support.noCloneEvent||!f.support.noCloneChecked)&&(a.nodeType===1||a.nodeType===11)&&!f.isXMLDoc(a)){bk(a,h),d=bl(a),e=bl(h);for(g=0;d[g];++g)e[g]&&bk(d[g],e[g])}if(b){bj(a,h);if(c){d=bl(a),e=bl(h);for(g=0;d[g];++g)bj(d[g],e[g])}}d=e=null;return h},clean:function(a,b,d,e){var g;b=b||c,typeof b.createElement=="undefined"&&(b=b.ownerDocument||b[0]&&b[0].ownerDocument||c);var h=[],i;for(var j=0,k;(k=a[j])!=null;j++){typeof k=="number"&&(k+="");if(!k)continue;if(typeof k=="string")if(!_.test(k))k=b.createTextNode(k);else{k=k.replace(Y,"<$1></$2>");var l=(Z.exec(k)||["",""])[1].toLowerCase(),m=bg[l]||bg._default,n=m[0],o=b.createElement("div");b===c?bh.appendChild(o):U(b).appendChild(o),o.innerHTML=m[1]+k+m[2];while(n--)o=o.lastChild;if(!f.support.tbody){var p=$.test(k),q=l==="table"&&!p?o.firstChild&&o.firstChild.childNodes:m[1]==="<table>"&&!p?o.childNodes:[];for(i=q.length-1;i>=0;--i)f.nodeName(q[i],"tbody")&&!q[i].childNodes.length&&q[i].parentNode.removeChild(q[i])}!f.support.leadingWhitespace&&X.test(k)&&o.insertBefore(b.createTextNode(X.exec(k)[0]),o.firstChild),k=o.childNodes}var r;if(!f.support.appendChecked)if(k[0]&&typeof (r=k.length)=="number")for(i=0;i<r;i++)bn(k[i]);else bn(k);k.nodeType?h.push(k):h=f.merge(h,k)}if(d){g=function(a){return!a.type||be.test(a.type)};for(j=0;h[j];j++)if(e&&f.nodeName(h[j],"script")&&(!h[j].type||h[j].type.toLowerCase()==="text/javascript"))e.push(h[j].parentNode?h[j].parentNode.removeChild(h[j]):h[j]);else{if(h[j].nodeType===1){var s=f.grep(h[j].getElementsByTagName("script"),g);h.splice.apply(h,[j+1,0].concat(s))}d.appendChild(h[j])}}return h},cleanData:function(a){var b,c,d=f.cache,e=f.event.special,g=f.support.deleteExpando;for(var h=0,i;(i=a[h])!=null;h++){if(i.nodeName&&f.noData[i.nodeName.toLowerCase()])continue;c=i[f.expando];if(c){b=d[c];if(b&&b.events){for(var j in b.events)e[j]?f.event.remove(i,j):f.removeEvent(i,j,b.handle);b.handle&&(b.handle.elem=null)}g?delete i[f.expando]:i.removeAttribute&&i.removeAttribute(f.expando),delete d[c]}}}});var bq=/alpha\([^)]*\)/i,br=/opacity=([^)]*)/,bs=/([A-Z]|^ms)/g,bt=/^-?\d+(?:px)?$/i,bu=/^-?\d/,bv=/^([\-+])=([\-+.\de]+)/,bw={position:"absolute",visibility:"hidden",display:"block"},bx=["Left","Right"],by=["Top","Bottom"],bz,bA,bB;f.fn.css=function(a,c){if(arguments.length===2&&c===b)return this;return f.access(this,a,c,!0,function(a,c,d){return d!==b?f.style(a,c,d):f.css(a,c)})},f.extend({cssHooks:{opacity:{get:function(a,b){if(b){var c=bz(a,"opacity","opacity");return c===""?"1":c}return a.style.opacity}}},cssNumber:{fillOpacity:!0,fontWeight:!0,lineHeight:!0,opacity:!0,orphans:!0,widows:!0,zIndex:!0,zoom:!0},cssProps:{"float":f.support.cssFloat?"cssFloat":"styleFloat"},style:function(a,c,d,e){if(!!a&&a.nodeType!==3&&a.nodeType!==8&&!!a.style){var g,h,i=f.camelCase(c),j=a.style,k=f.cssHooks[i];c=f.cssProps[i]||i;if(d===b){if(k&&"get"in k&&(g=k.get(a,!1,e))!==b)return g;return j[c]}h=typeof d,h==="string"&&(g=bv.exec(d))&&(d=+(g[1]+1)*+g[2]+parseFloat(f.css(a,c)),h="number");if(d==null||h==="number"&&isNaN(d))return;h==="number"&&!f.cssNumber[i]&&(d+="px");if(!k||!("set"in k)||(d=k.set(a,d))!==b)try{j[c]=d}catch(l){}}},css:function(a,c,d){var e,g;c=f.camelCase(c),g=f.cssHooks[c],c=f.cssProps[c]||c,c==="cssFloat"&&(c="float");if(g&&"get"in g&&(e=g.get(a,!0,d))!==b)return e;if(bz)return bz(a,c)},swap:function(a,b,c){var d={};for(var e in b)d[e]=a.style[e],a.style[e]=b[e];c.call(a);for(e in b)a.style[e]=d[e]}}),f.curCSS=f.css,f.each(["height","width"],function(a,b){f.cssHooks[b]={get:function(a,c,d){var e;if(c){if(a.offsetWidth!==0)return bC(a,b,d);f.swap(a,bw,function(){e=bC(a,b,d)});return e}},set:function(a,b){if(!bt.test(b))return b;b=parseFloat(b);if(b>=0)return b+"px"}}}),f.support.opacity||(f.cssHooks.opacity={get:function(a,b){return br.test((b&&a.currentStyle?a.currentStyle.filter:a.style.filter)||"")?parseFloat(RegExp.$1)/100+"":b?"1":""},set:function(a,b){var c=a.style,d=a.currentStyle,e=f.isNumeric(b)?"alpha(opacity="+b*100+")":"",g=d&&d.filter||c.filter||"";c.zoom=1;if(b>=1&&f.trim(g.replace(bq,""))===""){c.removeAttribute("filter");if(d&&!d.filter)return}c.filter=bq.test(g)?g.replace(bq,e):g+" "+e}}),f(function(){f.support.reliableMarginRight||(f.cssHooks.marginRight={get:function(a,b){var c;f.swap(a,{display:"inline-block"},function(){b?c=bz(a,"margin-right","marginRight"):c=a.style.marginRight});return c}})}),c.defaultView&&c.defaultView.getComputedStyle&&(bA=function(a,b){var c,d,e;b=b.replace(bs,"-$1").toLowerCase(),(d=a.ownerDocument.defaultView)&&(e=d.getComputedStyle(a,null))&&(c=e.getPropertyValue(b),c===""&&!f.contains(a.ownerDocument.documentElement,a)&&(c=f.style(a,b)));return c}),c.documentElement.currentStyle&&(bB=function(a,b){var c,d,e,f=a.currentStyle&&a.currentStyle[b],g=a.style;f===null&&g&&(e=g[b])&&(f=e),!bt.test(f)&&bu.test(f)&&(c=g.left,d=a.runtimeStyle&&a.runtimeStyle.left,d&&(a.runtimeStyle.left=a.currentStyle.left),g.left=b==="fontSize"?"1em":f||0,f=g.pixelLeft+"px",g.left=c,d&&(a.runtimeStyle.left=d));return f===""?"auto":f}),bz=bA||bB,f.expr&&f.expr.filters&&(f.expr.filters.hidden=function(a){var b=a.offsetWidth,c=a.offsetHeight;return b===0&&c===0||!f.support.reliableHiddenOffsets&&(a.style&&a.style.display||f.css(a,"display"))==="none"},f.expr.filters.visible=function(a){return!f.expr.filters.hidden(a)});var bD=/%20/g,bE=/\[\]$/,bF=/\r?\n/g,bG=/#.*$/,bH=/^(.*?):[ \t]*([^\r\n]*)\r?$/mg,bI=/^(?:color|date|datetime|datetime-local|email|hidden|month|number|password|range|search|tel|text|time|url|week)$/i,bJ=/^(?:about|app|app\-storage|.+\-extension|file|res|widget):$/,bK=/^(?:GET|HEAD)$/,bL=/^\/\//,bM=/\?/,bN=/<script\b[^<]*(?:(?!<\/script>)<[^<]*)*<\/script>/gi,bO=/^(?:select|textarea)/i,bP=/\s+/,bQ=/([?&])_=[^&]*/,bR=/^([\w\+\.\-]+:)(?:\/\/([^\/?#:]*)(?::(\d+))?)?/,bS=f.fn.load,bT={},bU={},bV,bW,bX=["*/"]+["*"];try{bV=e.href}catch(bY){bV=c.createElement("a"),bV.href="",bV=bV.href}bW=bR.exec(bV.toLowerCase())||[],f.fn.extend({load:function(a,c,d){if(typeof a!="string"&&bS)return bS.apply(this,arguments);if(!this.length)return this;var e=a.indexOf(" ");if(e>=0){var g=a.slice(e,a.length);a=a.slice(0,e)}var h="GET";c&&(f.isFunction(c)?(d=c,c=b):typeof c=="object"&&(c=f.param(c,f.ajaxSettings.traditional),h="POST"));var i=this;f.ajax({url:a,type:h,dataType:"html",data:c,complete:function(a,b,c){c=a.responseText,a.isResolved()&&(a.done(function(a){c=a}),i.html(g?f("<div>").append(c.replace(bN,"")).find(g):c)),d&&i.each(d,[c,b,a])}});return this},serialize:function(){return f.param(this.serializeArray())},serializeArray:function(){return this.map(function(){return this.elements?f.makeArray(this.elements):this}).filter(function(){return this.name&&!this.disabled&&(this.checked||bO.test(this.nodeName)||bI.test(this.type))}).map(function(a,b){var c=f(this).val();return c==null?null:f.isArray(c)?f.map(c,function(a,c){return{name:b.name,value:a.replace(bF,"\r\n")}}):{name:b.name,value:c.replace(bF,"\r\n")}}).get()}}),f.each("ajaxStart ajaxStop ajaxComplete ajaxError ajaxSuccess ajaxSend".split(" "),function(a,b){f.fn[b]=function(a){return this.on(b,a)}}),f.each(["get","post"],function(a,c){f[c]=function(a,d,e,g){f.isFunction(d)&&(g=g||e,e=d,d=b);return f.ajax({type:c,url:a,data:d,success:e,dataType:g})}}),f.extend({getScript:function(a,c){return f.get(a,b,c,"script")},getJSON:function(a,b,c){return f.get(a,b,c,"json")},ajaxSetup:function(a,b){b?b_(a,f.ajaxSettings):(b=a,a=f.ajaxSettings),b_(a,b);return a},ajaxSettings:{url:bV,isLocal:bJ.test(bW[1]),global:!0,type:"GET",contentType:"application/x-www-form-urlencoded",processData:!0,async:!0,accepts:{xml:"application/xml, text/xml",html:"text/html",text:"text/plain",json:"application/json, text/javascript","*":bX},contents:{xml:/xml/,html:/html/,json:/json/},responseFields:{xml:"responseXML",text:"responseText"},converters:{"* text":a.String,"text html":!0,"text json":f.parseJSON,"text xml":f.parseXML},flatOptions:{context:!0,url:!0}},ajaxPrefilter:bZ(bT),ajaxTransport:bZ(bU),ajax:function(a,c){function w(a,c,l,m){if(s!==2){s=2,q&&clearTimeout(q),p=b,n=m||"",v.readyState=a>0?4:0;var o,r,u,w=c,x=l?cb(d,v,l):b,y,z;if(a>=200&&a<300||a===304){if(d.ifModified){if(y=v.getResponseHeader("Last-Modified"))f.lastModified[k]=y;if(z=v.getResponseHeader("Etag"))f.etag[k]=z}if(a===304)w="notmodified",o=!0;else try{r=cc(d,x),w="success",o=!0}catch(A){w="parsererror",u=A}}else{u=w;if(!w||a)w="error",a<0&&(a=0)}v.status=a,v.statusText=""+(c||w),o?h.resolveWith(e,[r,w,v]):h.rejectWith(e,[v,w,u]),v.statusCode(j),j=b,t&&g.trigger("ajax"+(o?"Success":"Error"),[v,d,o?r:u]),i.fireWith(e,[v,w]),t&&(g.trigger("ajaxComplete",[v,d]),--f.active||f.event.trigger("ajaxStop"))}}typeof a=="object"&&(c=a,a=b),c=c||{};var d=f.ajaxSetup({},c),e=d.context||d,g=e!==d&&(e.nodeType||e instanceof f)?f(e):f.event,h=f.Deferred(),i=f.Callbacks("once memory"),j=d.statusCode||{},k,l={},m={},n,o,p,q,r,s=0,t,u,v={readyState:0,setRequestHeader:function(a,b){if(!s){var c=a.toLowerCase();a=m[c]=m[c]||a,l[a]=b}return this},getAllResponseHeaders:function(){return s===2?n:null},getResponseHeader:function(a){var c;if(s===2){if(!o){o={};while(c=bH.exec(n))o[c[1].toLowerCase()]=c[2]}c=o[a.toLowerCase()]}return c===b?null:c},overrideMimeType:function(a){s||(d.mimeType=a);return this},abort:function(a){a=a||"abort",p&&p.abort(a),w(0,a);return this}};h.promise(v),v.success=v.done,v.error=v.fail,v.complete=i.add,v.statusCode=function(a){if(a){var b;if(s<2)for(b in a)j[b]=[j[b],a[b]];else b=a[v.status],v.then(b,b)}return this},d.url=((a||d.url)+"").replace(bG,"").replace(bL,bW[1]+"//"),d.dataTypes=f.trim(d.dataType||"*").toLowerCase().split(bP),d.crossDomain==null&&(r=bR.exec(d.url.toLowerCase()),d.crossDomain=!(!r||r[1]==bW[1]&&r[2]==bW[2]&&(r[3]||(r[1]==="http:"?80:443))==(bW[3]||(bW[1]==="http:"?80:443)))),d.data&&d.processData&&typeof d.data!="string"&&(d.data=f.param(d.data,d.traditional)),b$(bT,d,c,v);if(s===2)return!1;t=d.global,d.type=d.type.toUpperCase(),d.hasContent=!bK.test(d.type),t&&f.active++===0&&f.event.trigger("ajaxStart");if(!d.hasContent){d.data&&(d.url+=(bM.test(d.url)?"&":"?")+d.data,delete d.data),k=d.url;if(d.cache===!1){var x=f.now(),y=d.url.replace(bQ,"$1_="+x);d.url=y+(y===d.url?(bM.test(d.url)?"&":"?")+"_="+x:"")}}(d.data&&d.hasContent&&d.contentType!==!1||c.contentType)&&v.setRequestHeader("Content-Type",d.contentType),d.ifModified&&(k=k||d.url,f.lastModified[k]&&v.setRequestHeader("If-Modified-Since",f.lastModified[k]),f.etag[k]&&v.setRequestHeader("If-None-Match",f.etag[k])),v.setRequestHeader("Accept",d.dataTypes[0]&&d.accepts[d.dataTypes[0]]?d.accepts[d.dataTypes[0]]+(d.dataTypes[0]!=="*"?", "+bX+"; q=0.01":""):d.accepts["*"]);for(u in d.headers)v.setRequestHeader(u,d.headers[u]);if(d.beforeSend&&(d.beforeSend.call(e,v,d)===!1||s===2)){v.abort();return!1}for(u in{success:1,error:1,complete:1})v[u](d[u]);p=b$(bU,d,c,v);if(!p)w(-1,"No Transport");else{v.readyState=1,t&&g.trigger("ajaxSend",[v,d]),d.async&&d.timeout>0&&(q=setTimeout(function(){v.abort("timeout")},d.timeout));try{s=1,p.send(l,w)}catch(z){if(s<2)w(-1,z);else throw z}}return v},param:function(a,c){var d=[],e=function(a,b){b=f.isFunction(b)?b():b,d[d.length]=encodeURIComponent(a)+"="+encodeURIComponent(b)};c===b&&(c=f.ajaxSettings.traditional);if(f.isArray(a)||a.jquery&&!f.isPlainObject(a))f.each(a,function(){e(this.name,this.value)});else for(var g in a)ca(g,a[g],c,e);return d.join("&").replace(bD,"+")}}),f.extend({active:0,lastModified:{},etag:{}});var cd=f.now(),ce=/(\=)\?(&|$)|\?\?/i;f.ajaxSetup({jsonp:"callback",jsonpCallback:function(){return f.expando+"_"+cd++}}),f.ajaxPrefilter("json jsonp",function(b,c,d){var e=b.contentType==="application/x-www-form-urlencoded"&&typeof b.data=="string";if(b.dataTypes[0]==="jsonp"||b.jsonp!==!1&&(ce.test(b.url)||e&&ce.test(b.data))){var g,h=b.jsonpCallback=f.isFunction(b.jsonpCallback)?b.jsonpCallback():b.jsonpCallback,i=a[h],j=b.url,k=b.data,l="$1"+h+"$2";b.jsonp!==!1&&(j=j.replace(ce,l),b.url===j&&(e&&(k=k.replace(ce,l)),b.data===k&&(j+=(/\?/.test(j)?"&":"?")+b.jsonp+"="+h))),b.url=j,b.data=k,a[h]=function(a){g=[a]},d.always(function(){a[h]=i,g&&f.isFunction(i)&&a[h](g[0])}),b.converters["script json"]=function(){g||f.error(h+" was not called");return g[0]},b.dataTypes[0]="json";return"script"}}),f.ajaxSetup({accepts:{script:"text/javascript, application/javascript, application/ecmascript, application/x-ecmascript"},contents:{script:/javascript|ecmascript/},converters:{"text script":function(a){f.globalEval(a);return a}}}),f.ajaxPrefilter("script",function(a){a.cache===b&&(a.cache=!1),a.crossDomain&&(a.type="GET",a.global=!1)}),f.ajaxTransport("script",function(a){if(a.crossDomain){var d,e=c.head||c.getElementsByTagName("head")[0]||c.documentElement;return{send:function(f,g){d=c.createElement("script"),d.async="async",a.scriptCharset&&(d.charset=a.scriptCharset),d.src=a.url,d.onload=d.onreadystatechange=function(a,c){if(c||!d.readyState||/loaded|complete/.test(d.readyState))d.onload=d.onreadystatechange=null,e&&d.parentNode&&e.removeChild(d),d=b,c||g(200,"success")},e.insertBefore(d,e.firstChild)},abort:function(){d&&d.onload(0,1)}}}});var cf=a.ActiveXObject?function(){for(var a in ch)ch[a](0,1)}:!1,cg=0,ch;f.ajaxSettings.xhr=a.ActiveXObject?function(){return!this.isLocal&&ci()||cj()}:ci,function(a){f.extend(f.support,{ajax:!!a,cors:!!a&&"withCredentials"in a})}(f.ajaxSettings.xhr()),f.support.ajax&&f.ajaxTransport(function(c){if(!c.crossDomain||f.support.cors){var d;return{send:function(e,g){var h=c.xhr(),i,j;c.username?h.open(c.type,c.url,c.async,c.username,c.password):h.open(c.type,c.url,c.async);if(c.xhrFields)for(j in c.xhrFields)h[j]=c.xhrFields[j];c.mimeType&&h.overrideMimeType&&h.overrideMimeType(c.mimeType),!c.crossDomain&&!e["X-Requested-With"]&&(e["X-Requested-With"]="XMLHttpRequest");try{for(j in e)h.setRequestHeader(j,e[j])}catch(k){}h.send(c.hasContent&&c.data||null),d=function(a,e){var j,k,l,m,n;try{if(d&&(e||h.readyState===4)){d=b,i&&(h.onreadystatechange=f.noop,cf&&delete ch[i]);if(e)h.readyState!==4&&h.abort();else{j=h.status,l=h.getAllResponseHeaders(),m={},n=h.responseXML,n&&n.documentElement&&(m.xml=n),m.text=h.responseText;try{k=h.statusText}catch(o){k=""}!j&&c.isLocal&&!c.crossDomain?j=m.text?200:404:j===1223&&(j=204)}}}catch(p){e||g(-1,p)}m&&g(j,k,m,l)},!c.async||h.readyState===4?d():(i=++cg,cf&&(ch||(ch={},f(a).unload(cf)),ch[i]=d),h.onreadystatechange=d)},abort:function(){d&&d(0,1)}}}});var ck={},cl,cm,cn=/^(?:toggle|show|hide)$/,co=/^([+\-]=)?([\d+.\-]+)([a-z%]*)$/i,cp,cq=[["height","marginTop","marginBottom","paddingTop","paddingBottom"],["width","marginLeft","marginRight","paddingLeft","paddingRight"],["opacity"]],cr;f.fn.extend({show:function(a,b,c){var d,e;if(a||a===0)return this.animate(cu("show",3),a,b,c);for(var g=0,h=this.length;g<h;g++)d=this[g],d.style&&(e=d.style.display,!f._data(d,"olddisplay")&&e==="none"&&(e=d.style.display=""),e===""&&f.css(d,"display")==="none"&&f._data(d,"olddisplay",cv(d.nodeName)));for(g=0;g<h;g++){d=this[g];if(d.style){e=d.style.display;if(e===""||e==="none")d.style.display=f._data(d,"olddisplay")||""}}return this},hide:function(a,b,c){if(a||a===0)return this.animate(cu("hide",3),a,b,c);var d,e,g=0,h=this.length;for(;g<h;g++)d=this[g],d.style&&(e=f.css(d,"display"),e!=="none"&&!f._data(d,"olddisplay")&&f._data(d,"olddisplay",e));for(g=0;g<h;g++)this[g].style&&(this[g].style.display="none");return this},_toggle:f.fn.toggle,toggle:function(a,b,c){var d=typeof a=="boolean";f.isFunction(a)&&f.isFunction(b)?this._toggle.apply(this,arguments):a==null||d?this.each(function(){var b=d?a:f(this).is(":hidden");f(this)[b?"show":"hide"]()}):this.animate(cu("toggle",3),a,b,c);return this},fadeTo:function(a,b,c,d){return this.filter(":hidden").css("opacity",0).show().end().animate({opacity:b},a,c,d)},animate:function(a,b,c,d){function g(){e.queue===!1&&f._mark(this);var b=f.extend({},e),c=this.nodeType===1,d=c&&f(this).is(":hidden"),g,h,i,j,k,l,m,n,o;b.animatedProperties={};for(i in a){g=f.camelCase(i),i!==g&&(a[g]=a[i],delete a[i]),h=a[g],f.isArray(h)?(b.animatedProperties[g]=h[1],h=a[g]=h[0]):b.animatedProperties[g]=b.specialEasing&&b.specialEasing[g]||b.easing||"swing";if(h==="hide"&&d||h==="show"&&!d)return b.complete.call(this);c&&(g==="height"||g==="width")&&(b.overflow=[this.style.overflow,this.style.overflowX,this.style.overflowY],f.css(this,"display")==="inline"&&f.css(this,"float")==="none"&&(!f.support.inlineBlockNeedsLayout||cv(this.nodeName)==="inline"?this.style.display="inline-block":this.style.zoom=1))}b.overflow!=null&&(this.style.overflow="hidden");for(i in a)j=new f.fx(this,b,i),h=a[i],cn.test(h)?(o=f._data(this,"toggle"+i)||(h==="toggle"?d?"show":"hide":0),o?(f._data(this,"toggle"+i,o==="show"?"hide":"show"),j[o]()):j[h]()):(k=co.exec(h),l=j.cur(),k?(m=parseFloat(k[2]),n=k[3]||(f.cssNumber[i]?"":"px"),n!=="px"&&(f.style(this,i,(m||1)+n),l=(m||1)/j.cur()*l,f.style(this,i,l+n)),k[1]&&(m=(k[1]==="-="?-1:1)*m+l),j.custom(l,m,n)):j.custom(l,h,""));return!0}var e=f.speed(b,c,d);if(f.isEmptyObject(a))return this.each(e.complete,[!1]);a=f.extend({},a);return e.queue===!1?this.each(g):this.queue(e.queue,g)},stop:function(a,c,d){typeof a!="string"&&(d=c,c=a,a=b),c&&a!==!1&&this.queue(a||"fx",[]);return this.each(function(){function h(a,b,c){var e=b[c];f.removeData(a,c,!0),e.stop(d)}var b,c=!1,e=f.timers,g=f._data(this);d||f._unmark(!0,this);if(a==null)for(b in g)g[b]&&g[b].stop&&b.indexOf(".run")===b.length-4&&h(this,g,b);else g[b=a+".run"]&&g[b].stop&&h(this,g,b);for(b=e.length;b--;)e[b].elem===this&&(a==null||e[b].queue===a)&&(d?e[b](!0):e[b].saveState(),c=!0,e.splice(b,1));(!d||!c)&&f.dequeue(this,a)})}}),f.each({slideDown:cu("show",1),slideUp:cu("hide",1),slideToggle:cu("toggle",1),fadeIn:{opacity:"show"},fadeOut:{opacity:"hide"},fadeToggle:{opacity:"toggle"}},function(a,b){f.fn[a]=function(a,c,d){return this.animate(b,a,c,d)}}),f.extend({speed:function(a,b,c){var d=a&&typeof a=="object"?f.extend({},a):{complete:c||!c&&b||f.isFunction(a)&&a,duration:a,easing:c&&b||b&&!f.isFunction(b)&&b};d.duration=f.fx.off?0:typeof d.duration=="number"?d.duration:d.duration in f.fx.speeds?f.fx.speeds[d.duration]:f.fx.speeds._default;if(d.queue==null||d.queue===!0)d.queue="fx";d.old=d.complete,d.complete=function(a){f.isFunction(d.old)&&d.old.call(this),d.queue?f.dequeue(this,d.queue):a!==!1&&f._unmark(this)};return d},easing:{linear:function(a,b,c,d){return c+d*a},swing:function(a,b,c,d){return(-Math.cos(a*Math.PI)/2+.5)*d+c}},timers:[],fx:function(a,b,c){this.options=b,this.elem=a,this.prop=c,b.orig=b.orig||{}}}),f.fx.prototype={update:function(){this.options.step&&this.options.step.call(this.elem,this.now,this),(f.fx.step[this.prop]||f.fx.step._default)(this)},cur:function(){if(this.elem[this.prop]!=null&&(!this.elem.style||this.elem.style[this.prop]==null))return this.elem[this.prop];var a,b=f.css(this.elem,this.prop);return isNaN(a=parseFloat(b))?!b||b==="auto"?0:b:a},custom:function(a,c,d){function h(a){return e.step(a)}var e=this,g=f.fx;this.startTime=cr||cs(),this.end=c,this.now=this.start=a,this.pos=this.state=0,this.unit=d||this.unit||(f.cssNumber[this.prop]?"":"px"),h.queue=this.options.queue,h.elem=this.elem,h.saveState=function(){e.options.hide&&f._data(e.elem,"fxshow"+e.prop)===b&&f._data(e.elem,"fxshow"+e.prop,e.start)},h()&&f.timers.push(h)&&!cp&&(cp=setInterval(g.tick,g.interval))},show:function(){var a=f._data(this.elem,"fxshow"+this.prop);this.options.orig[this.prop]=a||f.style(this.elem,this.prop),this.options.show=!0,a!==b?this.custom(this.cur(),a):this.custom(this.prop==="width"||this.prop==="height"?1:0,this.cur()),f(this.elem).show()},hide:function(){this.options.orig[this.prop]=f._data(this.elem,"fxshow"+this.prop)||f.style(this.elem,this.prop),this.options.hide=!0,this.custom(this.cur(),0)},step:function(a){var b,c,d,e=cr||cs(),g=!0,h=this.elem,i=this.options;if(a||e>=i.duration+this.startTime){this.now=this.end,this.pos=this.state=1,this.update(),i.animatedProperties[this.prop]=!0;for(b in i.animatedProperties)i.animatedProperties[b]!==!0&&(g=!1);if(g){i.overflow!=null&&!f.support.shrinkWrapBlocks&&f.each(["","X","Y"],function(a,b){h.style["overflow"+b]=i.overflow[a]}),i.hide&&f(h).hide();if(i.hide||i.show)for(b in i.animatedProperties)f.style(h,b,i.orig[b]),f.removeData(h,"fxshow"+b,!0),f.removeData(h,"toggle"+b,!0);d=i.complete,d&&(i.complete=!1,d.call(h))}return!1}i.duration==Infinity?this.now=e:(c=e-this.startTime,this.state=c/i.duration,this.pos=f.easing[i.animatedProperties[this.prop]](this.state,c,0,1,i.duration),this.now=this.start+(this.end-this.start)*this.pos),this.update();return!0}},f.extend(f.fx,{tick:function(){var a,b=f.timers,c=0;for(;c<b.length;c++)a=b[c],!a()&&b[c]===a&&b.splice(c--,1);b.length||f.fx.stop()},interval:13,stop:function(){clearInterval(cp),cp=null},speeds:{slow:600,fast:200,_default:400},step:{opacity:function(a){f.style(a.elem,"opacity",a.now)},_default:function(a){a.elem.style&&a.elem.style[a.prop]!=null?a.elem.style[a.prop]=a.now+a.unit:a.elem[a.prop]=a.now}}}),f.each(["width","height"],function(a,b){f.fx.step[b]=function(a){f.style(a.elem,b,Math.max(0,a.now)+a.unit)}}),f.expr&&f.expr.filters&&(f.expr.filters.animated=function(a){return f.grep(f.timers,function(b){return a===b.elem}).length});var cw=/^t(?:able|d|h)$/i,cx=/^(?:body|html)$/i;"getBoundingClientRect"in c.documentElement?f.fn.offset=function(a){var b=this[0],c;if(a)return this.each(function(b){f.offset.setOffset(this,a,b)});if(!b||!b.ownerDocument)return null;if(b===b.ownerDocument.body)return f.offset.bodyOffset(b);try{c=b.getBoundingClientRect()}catch(d){}var e=b.ownerDocument,g=e.documentElement;if(!c||!f.contains(g,b))return c?{top:c.top,left:c.left}:{top:0,left:0};var h=e.body,i=cy(e),j=g.clientTop||h.clientTop||0,k=g.clientLeft||h.clientLeft||0,l=i.pageYOffset||f.support.boxModel&&g.scrollTop||h.scrollTop,m=i.pageXOffset||f.support.boxModel&&g.scrollLeft||h.scrollLeft,n=c.top+l-j,o=c.left+m-k;return{top:n,left:o}}:f.fn.offset=function(a){var b=this[0];if(a)return this.each(function(b){f.offset.setOffset(this,a,b)});if(!b||!b.ownerDocument)return null;if(b===b.ownerDocument.body)return f.offset.bodyOffset(b);var c,d=b.offsetParent,e=b,g=b.ownerDocument,h=g.documentElement,i=g.body,j=g.defaultView,k=j?j.getComputedStyle(b,null):b.currentStyle,l=b.offsetTop,m=b.offsetLeft;while((b=b.parentNode)&&b!==i&&b!==h){if(f.support.fixedPosition&&k.position==="fixed")break;c=j?j.getComputedStyle(b,null):b.currentStyle,l-=b.scrollTop,m-=b.scrollLeft,b===d&&(l+=b.offsetTop,m+=b.offsetLeft,f.support.doesNotAddBorder&&(!f.support.doesAddBorderForTableAndCells||!cw.test(b.nodeName))&&(l+=parseFloat(c.borderTopWidth)||0,m+=parseFloat(c.borderLeftWidth)||0),e=d,d=b.offsetParent),f.support.subtractsBorderForOverflowNotVisible&&c.overflow!=="visible"&&(l+=parseFloat(c.borderTopWidth)||0,m+=parseFloat(c.borderLeftWidth)||0),k=c}if(k.position==="relative"||k.position==="static")l+=i.offsetTop,m+=i.offsetLeft;f.support.fixedPosition&&k.position==="fixed"&&(l+=Math.max(h.scrollTop,i.scrollTop),m+=Math.max(h.scrollLeft,i.scrollLeft));return{top:l,left:m}},f.offset={bodyOffset:function(a){var b=a.offsetTop,c=a.offsetLeft;f.support.doesNotIncludeMarginInBodyOffset&&(b+=parseFloat(f.css(a,"marginTop"))||0,c+=parseFloat(f.css(a,"marginLeft"))||0);return{top:b,left:c}},setOffset:function(a,b,c){var d=f.css(a,"position");d==="static"&&(a.style.position="relative");var e=f(a),g=e.offset(),h=f.css(a,"top"),i=f.css(a,"left"),j=(d==="absolute"||d==="fixed")&&f.inArray("auto",[h,i])>-1,k={},l={},m,n;j?(l=e.position(),m=l.top,n=l.left):(m=parseFloat(h)||0,n=parseFloat(i)||0),f.isFunction(b)&&(b=b.call(a,c,g)),b.top!=null&&(k.top=b.top-g.top+m),b.left!=null&&(k.left=b.left-g.left+n),"using"in b?b.using.call(a,k):e.css(k)}},f.fn.extend({position:function(){if(!this[0])return null;var a=this[0],b=this.offsetParent(),c=this.offset(),d=cx.test(b[0].nodeName)?{top:0,left:0}:b.offset();c.top-=parseFloat(f.css(a,"marginTop"))||0,c.left-=parseFloat(f.css(a,"marginLeft"))||0,d.top+=parseFloat(f.css(b[0],"borderTopWidth"))||0,d.left+=parseFloat(f.css(b[0],"borderLeftWidth"))||0;return{top:c.top-d.top,left:c.left-d.left}},offsetParent:function(){return this.map(function(){var a=this.offsetParent||c.body;while(a&&!cx.test(a.nodeName)&&f.css(a,"position")==="static")a=a.offsetParent;return a})}}),f.each(["Left","Top"],function(a,c){var d="scroll"+c;f.fn[d]=function(c){var e,g;if(c===b){e=this[0];if(!e)return null;g=cy(e);return g?"pageXOffset"in g?g[a?"pageYOffset":"pageXOffset"]:f.support.boxModel&&g.document.documentElement[d]||g.document.body[d]:e[d]}return this.each(function(){g=cy(this),g?g.scrollTo(a?f(g).scrollLeft():c,a?c:f(g).scrollTop()):this[d]=c})}}),f.each(["Height","Width"],function(a,c){var d=c.toLowerCase();f.fn["inner"+c]=function(){var a=this[0];return a?a.style?parseFloat(f.css(a,d,"padding")):this[d]():null},f.fn["outer"+c]=function(a){var b=this[0];return b?b.style?parseFloat(f.css(b,d,a?"margin":"border")):this[d]():null},f.fn[d]=function(a){var e=this[0];if(!e)return a==null?null:this;if(f.isFunction(a))return this.each(function(b){var c=f(this);c[d](a.call(this,b,c[d]()))});if(f.isWindow(e)){var g=e.document.documentElement["client"+c],h=e.document.body;return e.document.compatMode==="CSS1Compat"&&g||h&&h["client"+c]||g}if(e.nodeType===9)return Math.max(e.documentElement["client"+c],e.body["scroll"+c],e.documentElement["scroll"+c],e.body["offset"+c],e.documentElement["offset"+c]);if(a===b){var i=f.css(e,d),j=parseFloat(i);return f.isNumeric(j)?j:i}return this.css(d,typeof a=="string"?a:a+"px")}}),a.jQuery=a.$=f,typeof define=="function"&&define.amd&&define.amd.jQuery&&define("jquery",[],function(){return f})})(window);
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# Highlight.js

[![Build Status](https://travis-ci.org/isagalaev/highlight.js.svg?branch=master)](https://travis-ci.org/isagalaev/highlight.js)

Highlight.js is a syntax highlighter written in JavaScript. It works in the
browser as well as on the server. It works with pretty much any markup,
doesn't depend on any framework and has automatic language detection.


## Getting Started

The bare minimum for using highlight.js on a web page is linking to the library
along with one of the styles and calling [`initHighlightingOnLoad`][1]:

```html
<link rel="stylesheet" href="/path/to/styles/default.css">
<script src="/path/to/highlight.pack.js"></script>
<script>hljs.initHighlightingOnLoad();</script>
```

This will find and highlight code inside of `<pre><code>` tags trying to detect
the language automatically. If automatic detection doesn't work for you, you can
specify the language in the class attribute:

```html
<pre><code class="html">...</code></pre>
```

The list of supported language classes is available in the [class reference][8].
Classes can also be prefixed with either `language-` or `lang-`.

To disable highlighting altogether use the `nohighlight` class:

```html
<pre><code class="nohighlight">...</code></pre>
```

## Custom Initialization

When you need a bit more control over the initialization of
highlight.js, you can use the [`highlightBlock`][2] and [`configure`][3]
functions. This allows you to control *what* to highlight and *when*.

Here's an equivalent way to calling [`initHighlightingOnLoad`][1] using jQuery:

```javascript
$(document).ready(function() {
  $('pre code').each(function(i, block) {
    hljs.highlightBlock(block);
  });
});
```

You can use any tags instead of `<pre><code>` to mark up your code. If you don't
use a container that preserve line breaks you will need to configure
highlight.js to use the `<br>` tag:

```javascript
hljs.configure({useBR: true});

$('div.code').each(function(i, block) {
  hljs.highlightBlock(block);
});
```

For other options refer to the documentation for [`configure`][3].


## Getting the Library

You can get highlight.js as a hosted or custom-build browser script or as a
server module. Head over to the [download page][4] for all the options.

Note, that the library is not supposed to work straight from the source on
GitHub, it requires building. If none of the pre-packaged options work for you
refer to the [building documentation][5].


## License

Highlight.js is released under the BSD License. See [LICENSE][10] file for
details.


## Links

The official site for the library is at <https://highlightjs.org/>.

Further in-depth documentation for the API and other topics is at
<http://highlightjs.readthedocs.org/>.

Authors and contributors are listed in the [AUTHORS.en.txt][9] file.

[1]: http://highlightjs.readthedocs.org/en/latest/api.html#inithighlightingonload
[2]: http://highlightjs.readthedocs.org/en/latest/api.html#highlightblock-block
[3]: http://highlightjs.readthedocs.org/en/latest/api.html#configure-options
[4]: https://highlightjs.org/download/
[5]: http://highlightjs.readthedocs.org/en/latest/building-testing.html
[8]: http://highlightjs.readthedocs.org/en/latest/css-classes-reference.html
[9]: https://github.com/isagalaev/highlight.js/blob/master/AUTHORS.en.txt
[10]: https://github.com/isagalaev/highlight.js/blob/master/LICENSE
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var work = 1;

function pop(entity) {
	if(entity) {
		var my_parent = entity.parentNode;
		var my_class = my_parent.className;
		my_parent.className = my_class.replace(/popper/,"popped");
	}
}
function unpop(entity) {
	if(entity) {
		var my_parent = entity.parentNode;
		var my_class = my_parent.className;
		my_parent.className = my_class.replace(/popped/,"popper");
	}
}

function siblings(entity){
	var r = [];
	for ( var n = entity.parentNode.firstChild; n; n = n.nextSibling ) 
		if ( n.nodeType == 1 && n != entity)
			r.push( n );		
	return r;
}

/* This activates an element and deactivates all it's siblings */
function activateElement(id) {
	var entity = document.getElementById(id);
	if(entity.className.indexOf("active") == -1) {
		entity.className = entity.className + " active";
	}
	var sibs = siblings(entity);

	for(var i=0; i < sibs.length; i++) {
		if(sibs[i].className.indexOf("active") != -1) {
			deactivateElement(sibs[i]);
		}
	}
}

function deactivateElement(entity) {
	if(entity.className.indexOf("active") != -1) {
		 entity.className = entity.className.replace(/[ ]*active/, '');
	}
}

function getCookie(name) {
	var name_c = window.location.hostname + '-' + name;

	if(document.cookie) {
		var cookies = document.cookie.split(/ *; */);
		for(var i=0; i < cookies.length; i++) {
			var current_c = cookies[i].split("=");
			if(current_c[0] == name_c) {
				return(current_c[1]);
				break;
			}
		}
	}
	return('');
}

function setCookie(name, value, expires, path) {
	name = window.location.hostname + '-' + name;

	var curCookie = name + "=" + value + 
		((expires) ? ";expires=" + expires.toGMTString() : "") + 
		((path) ? ";path=" + path : "");
	document.cookie = curCookie; 
}

function setDefLangCookie(entity) {
	setCookie('switchery', entity.options[entity.selectedIndex].value, '', '/');
}

function initSwitchery() {
	var divs = document.getElementsByTagName('div');
	for(i in divs) {
		if(typeof(divs[i].className) != 'undefined' && divs[i].className.indexOf("switchery") != -1) {
			var lang = getCookie('switchery');
			if(lang != '') {
				var entity = document.getElementById(divs[i].id + '-' + lang);
				if(entity) {
					entity.onclick();
					entity.parentNode.lastChild.value = lang;
				} else {
					divs[i].firstChild.firstChild.onclick();
				}
			} else {
				divs[i].firstChild.firstChild.onclick();
			}
		}
	}

}

function showhide(id) {
	if(work) {
		work = 0;
		var entity = document.getElementById(id);
		if(entity) {
			var my_class = entity.className;
			if(my_class.indexOf("hidden") != -1) {
				entity.className = my_class.replace(/hidden/,"visible");
			}
			else if(my_class.indexOf("visible") != -1) {
				entity.className = my_class.replace(/visible/,"hidden");
			}
		}
	}

	return false;
}

function hide(id) {
	if(work) {
		work = 0;
		var entity = document.getElementById(id);
		if(entity) {
			var my_class = entity.className;
			if(my_class.indexOf("visible") != -1) {
				entity.className = my_class.replace(/visible/,"hidden");
			}
		}
	} else {
		work=1;
	}
}

var preventReset = 0;

function dehighlightTarget(entity) {
	if(preventReset == 0 && entity) {
		var id = entity.href;
		if(id.indexOf("#") != -1) {
			id = id.substr(id.indexOf('#')+1);
		}
		var target = document.getElementById(id);
		if(target) {
			deactivateElement(target);
		}
		}
}

function highlightTarget(entity, norefresh) {
	if(entity) {
		var id = entity.href;
		if(id.indexOf("#") != -1) {
			id = id.substr(id.indexOf('#')+1);
		}
		activateElement(id);
		preventReset = 0;
	} 
	if(norefresh == 1) {
		preventReset=1;
	}
}
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